Handbook

Everything you need to know about creating with your Silhouette
BROUGHT TO YOU BY THE SILHOUETTE EDUCATION TEAM

Hi! Here at Silhouette, we love our machines! We know there is huge amount of information about Silhouette products and software out there. If you are new to Silhouette, you may not be sure where to start. And, for those of you who are more seasoned Silhouette users, maybe there are things you don’t know how to do or things you did not even realize your machine could do. This is why we have developed this all-encompassing handbook that is your first stop to learning everything about Silhouette. You can learn how to use our specialty media, how to create basic or advanced designs in the software, or even which machine is right for your project. We have compiled as much information as possible to give you the skills and knowledge to create your own awesome projects. Use this handbook as a tool to help you whenever you have a question. We made this electronic handbook as easy as possible to navigate through including clickable cross references, hyperlinks to videos, a glossary, and an index. So start clicking and find what you are looking for! Because this is an electronic document, we will continually push out updates as they are available, ensuring you access to the most up-to-date information. We hope this book will not only answer your questions, but will spark your creativity so you can begin making projects of your own!
Introduction

GETTING TO KNOW SILHOUETTE
We’re glad that you have decided to join our thriving and ever-growing community of DIYers, creators, and artists. We are dedicated to bringing you products that will assist you in all your making, creating, and doing. If you can dream it up, we can help you make it a reality.

WHAT IS SILHOUETTE?
Silhouette is a Lindon, Utah based manufacturer of electronic cutting machines and corresponding products. Our goal is to roll out new products and technologies aimed at allowing creative people everywhere the most options and the fewest restrictions when it comes to electronic cutting, designing, and crafting. Welcome to the family!
Now let’s get to the good stuff—our machines! The Silhouette family currently includes three different cutting machines: the Silhouette CAMEO®, the Silhouette Portrait®, and the Silhouette Curio™. It also includes an innovative custom stamping system, the Silhouette Mint™, and Silhouette’s first 3D printer, the Silhouette Alta®. We offer the Silhouette Design Store, an online marketplace full of digital designs available for purchase. Our Design Store contains over 130,000 designs with more arriving each week. Crafters and makers of all kinds use their Silhouettes to cut, stamp, etch, sketch, and so much more.

This book is meant for YOU. This is a tool to help you discover all that you can do with your Silhouette and how to do it. We love our Silhouette products, and we want you to know how to use our machines, software, and creative materials so you can begin creating in no time. We will walk you through the initial set-up of your new Silhouette, show you the ins and outs of Silhouette Studio®, provide you with information about other Silhouette products, and help you with any other questions. Before you know it, you will be a Silhouette expert!

WHY SHOULD YOU OWN A SILHOUETTE?
There are countless reasons to own a Silhouette. Crafters and DIYers have been using our machines for years to create personalized, one-of-a-kind projects to use in their homes, schools, workplaces, and more. But did you know that you don’t have to be a crafter or a DIYer to benefit from owning a Silhouette?

ARE YOU A MAKER?
With your Silhouette’s precision cutting, even the most complex designs can become a reality. Many professional creators or designers love using our Silhouette machines and software because of the ease of use and the ability make ideas come to life. View the video.

ARE YOU AN EDUCATOR?
There are numerous practical uses for a Silhouette in the classroom. Spend less time prepping supplemental materials like reading games or matching exercises, and instead spend your time where you need it most.

With features like PixScan™, cutting things out is as simple as taking a picture, uploading it to your computer, tracing, and sending to your Silhouette to cut. Turn your classroom into a more
welcoming and appealing learning environment with decorations or use your Silhouette to help students with hands-on projects. Think of the possibilities. View the video.

ARE YOU A SMALL BUSINESS OWNER?
Silhouette encourages and supports small businesses by creating reliable, useful machines and accessories to help you meet your goals. Whether you use our cutting machines to help manufacture your handmade products, or you use Mint stamps to brand and promote your business, you’ll find that each member of the Silhouette family works hard to help you deliver. View the video.

ARE YOU A PROFESSIONAL DESIGNER? OR EVEN JUST A BEGINNER?
Our industry-leading software, Silhouette Studio®, makes it easy for designers of any skill level to create a design and send it to their Silhouette. Beginners will find easy-to-use design tools with an interactive workspace that provides a realistic digital rendering of their cut mat and media. And because Silhouette Studio® Business Edition interacts with Adobe Illustrator® and CorelDraw®, professional designers can create physical renderings of their designs in only a few steps. If you want to design and then make your designs into something tangible, you need a Silhouette. View the video.

ARE YOU A CRAFTER?
Here at Silhouette, we sure are! If you see the letters “DIY” and you get a little excited, you need a Silhouette! Do you want to decorate your house, create parties, make quilts or cards, or add personalization to EVERYTHING? Do you see every surface as an opportunity to add a little heat transfer, rhinestones, glitter, or vinyl? Is scrapbooking your happy place? A Silhouette machine is calling your name. View the video.

WHAT CAN YOUR SILHOUETTE DO?
Your Silhouette is limited only by what you can imagine. If you can dream it up, your Silhouette can help you create your project.

Silhouette cutting machines can handle a variety of media types. We offer specialty media made especially for your machine along with the more common media types. The most popular materials to cut with your machine include:

- Cardstock
- Fabric
- Vinyl
- Heat Transfer

With this flexibility, your Silhouette can handle most, if not all, of your creative projects. Whether it be paper crafting, interior decorating, one-of-a-kind apparel, or specialty projects, our line of Silhouette cutting machines can handle it all.
Specialty media includes printable duct tape, magnet paper, rose gold foil, stencil vinyl, wood sheets, double-sided adhesive sheets, sticker paper, window cling material, and glitter heat transfer. These are just a sampling of the products we offer to use specifically with your Silhouette. Turn to page 245 to browse through a catalogue-like listing. All Silhouette products come with recommended cut settings so you will get an amazing cut, every time.

Our Silhouette machines are limited only by your imagination. The more you envision, the more your Silhouette can help you create. View the video.

WHICH SILHOUETTE IS RIGHT FOR YOU?
We know that all of the possibilities with your Silhouette can be a little overwhelming, so we are here to help! The first step to getting exactly what you want out of your Silhouette is making sure that you are paired with the right machine.

The Cameo and the Portrait are the two machines with the most similarities and are perfect for paper crafting projects. The Curio is specialized and has more features, such as the ability to emboss paper and etch metal sheets. The Mint is for creating custom stamps. The Alta is a 3D printer that uses a plastic material called filament to print objects. To see more details on each machine, turn to The Silhouette Family section starting on page 10.

WHAT SHOULD YOU DO WITH THIS BOOK?
This guide was written to help you with all things Silhouette. This means it is part tutorial, part inspiration, part software training, and part catalogue. Don’t try to pick it up and read it cover to cover. (You’d be bored to death!) Instead, look at the things you are interested in. If you are a beginner, we suggest you turn to Chapter Two for a quick crash course. Otherwise, start flipping through and find what you are looking for. Hopefully you’ll see something that will get your creative juices flowing and you’ll begin to see the awesome potential your Silhouette has. What are you waiting for? Let’s get creating!
# Table of Contents

## INTRODUCTION

## THE SILHOUETTE FAMILY

<table>
<thead>
<tr>
<th>Model</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Silhouette Cameo®</td>
<td>11</td>
</tr>
<tr>
<td>Silhouette Portrait®</td>
<td>15</td>
</tr>
<tr>
<td>Silhouette Curio™</td>
<td>17</td>
</tr>
<tr>
<td>Silhouette Alta®</td>
<td>21</td>
</tr>
<tr>
<td>Silhouette Mint™</td>
<td>23</td>
</tr>
</tbody>
</table>

## QUICK START GUIDE

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What You Need to Get Started</td>
<td>26</td>
</tr>
<tr>
<td>Designing with Silhouette Studio®</td>
<td>28</td>
</tr>
<tr>
<td>Cutting Your Design</td>
<td>30</td>
</tr>
</tbody>
</table>

## SILHOUETTE STUDIO®

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup and Design</td>
<td>33</td>
</tr>
<tr>
<td>Store and Library</td>
<td>129</td>
</tr>
<tr>
<td>Sending a Project</td>
<td>142</td>
</tr>
<tr>
<td>Upgrades</td>
<td>153</td>
</tr>
</tbody>
</table>

## SILHOUETTE 3D™

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Silhouette 3D™</td>
<td>190</td>
</tr>
<tr>
<td>Document Tools</td>
<td>191</td>
</tr>
<tr>
<td>Quick-access Toolbar</td>
<td>193</td>
</tr>
<tr>
<td>Document Tabs</td>
<td>194</td>
</tr>
<tr>
<td>Drawing Tools</td>
<td>195</td>
</tr>
<tr>
<td>Navigation Tabs</td>
<td>195</td>
</tr>
<tr>
<td>Design Tab</td>
<td>196</td>
</tr>
<tr>
<td>3D Print Tab</td>
<td>201</td>
</tr>
<tr>
<td>Silhouette Design Store</td>
<td>203</td>
</tr>
<tr>
<td>Preferences</td>
<td>204</td>
</tr>
</tbody>
</table>

## MODELMAKER™

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Silhouette ModelMaker™</td>
<td>206</td>
</tr>
<tr>
<td>Document Tools</td>
<td>207</td>
</tr>
<tr>
<td>ModelMaker™ Setup</td>
<td>208</td>
</tr>
<tr>
<td>Shape Creation</td>
<td>209</td>
</tr>
<tr>
<td>Quick-access Toolbar</td>
<td>213</td>
</tr>
<tr>
<td>Viewing and Zooming</td>
<td>216</td>
</tr>
<tr>
<td>Net Settings</td>
<td>217</td>
</tr>
<tr>
<td>Printing the Design</td>
<td>220</td>
</tr>
<tr>
<td>Cutting Shapes with a Silhouette Machine</td>
<td>221</td>
</tr>
</tbody>
</table>
# Table of Contents

## MINT STUDIO™
- Designing with Mint Studio™
- Document Tools
- Drawing Tools
- Mint Studio™ Tools
- Stamp Tools

## ACCESSORIES AND TOOLS
- Blades and Carriage Tools
- Tools
- Mats and Bases
- Travel & Storage Accessories
- Miscellaneous

## CREATIVE MATERIALS
- Adhesive Cardstocks
- Alta Media
- Doming Stickers
- Fabric Ink Materials
- Fabric Stabilizers
- Glass Etching Cream
- Heat Transfer
- Mint Media
- Rhinestones
- Silkscreen Sheets
- Sketch Pens
- Specialty Media
- Vinyl

## HOW-TOS
- Hand Tools
- Silhouette Machines
- Project How-Tos

## TROUBLESHOOTING
- Silhouette Machine
- Cutting
- Cutting Mat
- Software
- Library
- Silhouette Library
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>GLOSSARY</td>
<td>343</td>
</tr>
<tr>
<td>SILHOUETTE STUDIO® SHORTCUTS</td>
<td>349</td>
</tr>
<tr>
<td>INDEX</td>
<td>351</td>
</tr>
</tbody>
</table>
Chapter One

The Silhouette Family

The Silhouette family currently includes three different cutting machines: the Silhouette CAMEO®, the Silhouette Curio™, and the Silhouette Portrait®. It also includes an innovative stamping system, the Silhouette Mint™, and Silhouette’s 3D printer, the Silhouette Alta®. Each machine performs unique and precise functions, and each machine is tailored to fit specific jobs.
The Silhouette CAMEO® is the ultimate DIY machine. It uses a small blade to cut over 100 materials, including paper, cardstock, vinyl, and fabric up to 12 inches wide. The Cameo has the ability to register and cut printed materials and is PixScan™ compatible. What does this mean for you? It is our machine that has the largest cutting space and is most versatile in the materials it can cut.

The Silhouette CAMEO® 3 has all of the same capabilities as the previous Cameo versions along with some added features. This Cameo features a dual carriage so you can use two tools at once, and it features Bluetooth technology. To top it all off, the Cameo 3 is one of two machines that is compatible with Silhouette’s AutoBlade, which is a self-adjusting blade.

Since the two versions of the Cameo are both relevant and still very similar, we will talk about both of them and call out the differences when it is applicable. Also note that the Portrait and Cameo are very similar machines and some of their information overlaps. View the video
Chapter One: The Silhouette Family

FEATURES OF YOUR SILHOUETTE CAMEO®
The Silhouette CAMEO® is your standard in electronic cutting. Like a home printer, it plugs into your PC or Mac® and a power outlet. Use Silhouette Studio® software on your computer to design and create projects to send to your Cameo. And now that the Cameo has a dual carriage, you can do more than ever. Read on to see more specifics on Cameo’s features and start brainstorming those projects!

FULL-COLOR LCD TOUCH SCREEN
The full-color LCD touch screen builds on the Cameos of the past and is even more user-friendly. With the touch screen, you can load your media and access your machine settings. The Cameo 3 is our first machine to feature sounds to help you navigate through the screens. It also provides mini tutorials to help you if you get stuck or have questions about using your machine. Just click the settings icon in the corner of the screen and choose “Tutorial.”

STORAGE COMPARTMENTS
The Cameo 2 storage compartment is located on the left side of the machine. It is a great place to store extra blades or your crosscutter.

The Cameo 3 has multiple storage compartments. With your lid open, there are places to keep extra blades on the left. On the top rack, you can keep blades, tools, or pens, and the pull-out drawer at the bottom opens for more storage.

### Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Cameo 2</th>
<th>Cameo 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full-color LCD touch screen</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Storage compartments</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Adjustable rollers</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Saving to and cutting from a USB device</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Crosscutter</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Dual carriage</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Bluetooth®</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Increased clearance</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Barcode scanning</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Ink stippling</td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>
Chapter One: The Silhouette Family

**Crosscutter**

If you are using a long piece of media, the crosscutter can be very helpful. It is basically a paper-cutter on the back of your machine. The crosscutter lets you separate your finished cut job from the remaining media in one quick stroke. With the crosscutter track attached directly to the back, you will get a perfectly straight edge every time. Then, when you use the remaining media for a different project, your Cameo will load the nice, even edge very easily. If you use rolls of vinyl, the crosscutter will be very helpful. See page 278 for detailed instructions.

**Adjustable Rollers**

By adjusting the white rollers on the main roller shaft, the Silhouette CAMEO® can cut the following media sizes: A4, letter, 12”, 13” (12 in. material on the cutting mat). The spring rollers have been designed for a strong yet gentle way to hold project materials in place.

**Saving to and Cutting from a USB Device**

With the Cameo, you can save from your computer to a USB device and then cut directly from your Silhouette without needing a computer (see page 282).

**Dual Carriage**

Like Curio, the Cameo 3 features a dual carriage. Are you like us and are a little bit EXCITED about the project possibilities? The tools are marked with little red circle on the left and a blue circle on the right. Insert your tools (such as an AutoBlade and a sketch pen) into the corresponding tool holders assigned in your Send panel. Watch two different tools work in one cut job!

The AutoBlade is only functional in the left-hand tool holder in the Cameo 3.

Cameo 3 has a slightly different way to insert tools. Instead of twisting a lever, gently pull out the end of the tool slot. Insert your tool and push the extended piece back in. Make sure it clicks
into place so your tool is held securely in place. See page 273 for detailed instructions.

**BLUETOOTH®**

Cameo 3 is Bluetooth® compatible and allows wireless communication. The Silhouette CAMEO® “Bluetooth® Edition” includes a pre-installed adapter. For all other Cameo editions, Bluetooth® is enabled, but you will need to install a Bluetooth® adapter. The Bluetooth® adapter resides in the bottom of the machine in a compartment accessible with a basic screwdriver.

Using Bluetooth® technology, your Cameo can receive cut jobs by devices other than your computer. This also means your Cameo will be able to receive cut jobs without being attached to your computer. Use Bluetooth® to get some of those pesky cords out of the way!

**INK STIPPLING**

The Cameo 3 can stipple using a marker or felt-tip pen. Stippling is the process of making a design using a series of dots. You can turn any design from the Silhouette Design Store or any photo into a stipple design.

**BARCODE SCANNING**

The Cameo 3 is able to read barcodes produced in the Registration Marks panel of the Silhouette Studio® software. Accessed through Business Edition, you can use the barcode scanning feature to print a barcode and registration marks onto Print & Cut pages. Then, load your printed page into your Cameo 3 and the optic scanner will read the barcode and access the file, cutting your design without needing the file open on your screen.

**INCREASED CLEARANCE**

The Cameo 3 has an increased clearance level compared to the Cameo 2. This allows you to cut thicker materials like foam using the Deep-cut Blade.
Silhouette Portrait 2

The Portrait is essentially a miniature version of the Cameo. The biggest difference is that it has a smaller cutting area at 8 inches wide, but it can cut all of the same material as the Cameo. At 16.35 inches and only 3.5 pounds, it can go anywhere with you. Pack up your Portrait and your laptop, and you can craft and design anywhere you want. This machine also has the ability to register and cut printed materials, is PixScan™ and Bluetooth® compatible, comes with an AutoBlade, and has a 2 mm clearance to cut deeper materials with the deep-cut blade. With your Portrait, the possibilities are endless. [View the video.]

PRODUCT SPECIFICATIONS

- 16.25 in. x 5.6 in. x 4.5 in.
- 3.5 lbs.
- MAX CUTTING AREA
  - 8 in. x 12 in. (mat)
  - 8 in x 10 ft. (roll)
- MAX MEDIA THICKNESS
  - 2 mm
- MAX CUTTING FORCE
  - 210 gf
FEATURES OF YOUR SILHOUETTE PORTRAIT® 2
The standout features of the Silhouette Portrait™ are the smaller size and the smaller price tag. The Silhouette will make all the cuts you want in your machine, just on a slightly smaller scale.

LOADING YOUR MEDIA AND MAKING A CUT
Loading the blade or tool into the Portrait 2 is slightly different from loading the blade or tool into the original Portrait. Instead of twisting a lever, gently pull out the end of the tool slot, insert your tool, and while pushing down on the tool, push the extended piece back in. Make sure the piece clicks when you push it back in so that the tool is held securely in place. See the How-tos section (page 273) for more detailed instructions.

Both versions of the Portrait retain all of the precision cutting abilities from the Cameo and can cut rolled media as long as 10 feet at a time. They also feature a simple loading method. See the How-to page (starting on page 275) for more details on how to load your machine and make a cut.

NOTE: The Portrait does not have adjustable rollers like the Cameo, so do not try to mess with them or move them. The Portrait rollers stay put.
Silhouette Curio

Curio is the most specialized Silhouette machine because it gives you access to different types of media as well as giving you more effect options (like embossing or etching). Because of its higher clearance level than both the Cameo and the Portrait, Curio can handle thicker media such as wood, metal, and chipboard. And while Curio is also a cutting machine like the Portrait and the Cameo, its emphasis is on embellishments and detail. The dual carriage means that you can perform two functions in one cut job, such as a score and emboss or a multicolored sketch.

View the video.
FEATURES OF YOUR SILHOUETTE CURIO™

Curio is the only machine that can unlock etching, debossing, embossing, and metal stippling in the powerful Silhouette Studio® design software.

INCREASED CLEARANCE LEVEL

In order to accommodate more possibilities and more media, Curio has literally raised the bar. By creating more space between the bar and the mat, you can transfer your designs directly to new types of media. Your Curio can accept up to 5 mm, including wood, metal, and canvas. And Curio does this without sacrificing the same quality cuts that make the Portrait and the Cameo so effective.

PRECISE LOADING

One of Curio’s greatest strengths is its loading mechanism. Because the base is solid, Curio loads the same every single time. This means that you can interrupt a cut job, pull out the base to examine your project, load it right back in, and resume cutting. This is especially useful when layering colors for multicolored sketches. Your design placement on the screen is exactly where it will be on the base, every time.

CURIO’S PLATFORMS, MATS, AND BASE

The Curio can accommodate a wide range of materials by adding or removing platforms. The Curio comes with four platforms marked with either a “1” or a “2.” For common material types, the Silhouette Studio® Send panel will indicate which combination of platforms you should use. For example, a platform setting of “3” would require both a #1 platform and a #2 platform since 1+2=3.

DUAL CARRIAGE

You can put two tools into the Curio at the same time! The first carrier is denoted by a red circle, and the second carrier is denoted by a blue circle.
The Curio knows to do the action associated with the red circle first and the blue circle second. You can toggle between tools by clicking “Tool 1” and “Tool 2” in the Send panel.

**UNLOCKING CURIO TOOLS IN SILHOUETTE STUDIO®**
Remember that Curio’s specialty icons in Silhouette Studio® can be used ONLY with the Curio and not our other machines. If you disconnect Curio, you will have access to those tools until you plug in another machine. The tools will deactivate if the software recognizes that a Cameo or Portrait has been plugged in because neither machine has the capability to perform these unique Curio features.

**ETCHING WITH CURIO**
Curio’s 5 mm clearance level means you can use materials that you can’t with other Silhouette machines, like metal. With this feature, new crafting options are available. The Stippling & Etching tool is meant to accommodate these possibilities. You can etch designs for home decor, personalize pet tags, create custom jewelry, and much more. For instructions on how to etch, see page 299.

**EMBOSSING AND DEBOSSING**
With your Curio, you can emboss, deboss, Score & Emboss, and Print & Emboss. You can use Silhouette Fine or Wide embossing tools to get unique and detailed raised lines on a variety of surfaces. For more information on these, see page 119-120.

For detailed instructions on how to emboss, see page 290.

**STIPPLING WITH CURIO**
Stippling is a way of creating a drawing through the use of dots instead of a continuous line. Curio performs this effect with the Stippling & Etching tool on thin metals or with a felt-tip pen or marker on paper.
Curio uses the stippling tool and the embossing mat to create the stipple effect. The stipple tool has a narrow metal tip that allows the machine to create small indents in the media using a quick up and down motion.

In Silhouette Studio®, the Stipple feature allows you to convert any design from the Design Store or your own design into a stippled project. By playing with settings like Spacing or Scale factor, you can change the look of the stipple effect. You can control the number of dots, the spacing of dots, and even the pattern. For instructions on how to stipple, see page 295.

SKETCHING WITH CURIO

Sketching with Curio is amazing because you can use two colors at once in the dual carriage. Plus, you can unload your design and load it again perfectly to draw more or with additional colors because Curio uses a solid base that loads the same every single time.

For instructions on how to sketch with the dual carriage, see page 281.
The Silhouette Alta® is Silhouette’s first 3D printer. In the process of 3D printing, a digital model is created and sliced, which is where the Silhouette 3D™ software breaks down how the machine is going to print each layer of the model. When the model is sliced, the software sends the information to the Alta, and the machine will print one thin layer of melted filament at a time until the model is printed. When the filament has cooled, the printing process is complete.

The Alta comes preassembled, precalibrated, and ready to plug and play right out of the box, so you can start printing objects immediately. You can print designs that you create in Silhouette 3D™, that you purchase from the Design Store, or that you acquire from third-party sources (provided they are in an .STL or .OBJ file format).

[View the video.]

**PRODUCT SPECIFICATIONS**
9.875 in. x 9 in. x 18.75 in.
9.7 lbs.

**FILAMENT TYPE**
1.75 mm
Non-proprietary
PLA filament

**LAYER THICKNESS**
From 0.05 mm to 0.5 mm

**PRINT VOLUME**
124 mm x 124 mm x 130 mm
FEATURES OF YOUR SILHOUETTE ALTA®

The Silhouette Alta® is Silhouette’s first 3D printer. Along with the Silhouette 3D™ software, you can create and print 3D objects using a plastic material called filament. The machine takes the model created in Silhouette 3D™, warms up the filament to melt it, and extrudes the filament layer by layer.

The most unique thing about Silhouette’s 3D printer is that it comes assembled and calibrated, meaning you don’t have to wait before you start playing with it. With most 3D printers on the market, you have to put them together yourselves.

FILAMENT

The medium that you will use to 3D print your object is called PLA (polylactic acid) filament. While Silhouette sells filament in a selection of colors (black, white, red, pink, yellow, green, and blue), most PLA filament that is 1.75 mm in diameter is compatible with the Silhouette Alta®.

NOTE: You may have to adjust your print settings as the default print settings in Silhouette 3D™ are optimized specifically for the Silhouette filament.

3D PRINTING

The Silhouette Alta® has a maximum print volume of 124 mm by 124 mm by 130 mm (4.88 inches by 4.88 inches by 5.11 inches), and its layer resolution ranges from 0.05 mm to 0.5 mm (or about 0.002 inches to 0.02 inches), so it can print small, and the smaller the resolution, the better your print quality will be.

While the Silhouette 3D™ software has three preset printing options, you do have the ability to change many of the settings in order achieve the best quality print for your needs. Some of the things you can change include the temperature of the filament, the layer height (also known as the print resolution), the infill density, whether or not supports are needed, the printing speed, and more.
The Mint is the most innovative machine we have at Silhouette. It differs from other members of the Silhouette family because it is not a cutting machine. The Mint is a custom stamp maker, and it will change the way you stamp. In four easy steps and less than two minutes, you can have a completely original, custom-made stamp. It is as easy as designing it, Minting it, inking it, and stamping it. Once it’s inked, your stamp is good for 50+ stamps (but it often lasts a lot longer).

The Mint is small and takes up roughly the same amount of desk space as your smartphone. But don’t let its size fool you. The Mint is powerful enough to create stamps sized anywhere from the size of a postage stamp to the size of an index card. And because you apply the ink directly to the stamp, you precisely control what color goes where when making multicolored stamps. View the video.
FEATURES OF YOUR SILHOUETTE MINT™
With the Silhouette Mint™, you can make custom stamps quickly and easily. You can turn any design or photo into a full-color, reusable stamp.

MINT INKS
The Mint is different than a traditional stamp that requires an ink pad. In fact, you’re not using a pad at all. The Silhouette Mint™ uses 5 ml bottles of ink applied directly to your stamp. The stamp will then absorb the ink, enabling it to stamp approximately 50 images before the stamp dries up. After that, just add a few more drops of ink and you’re ready to go again. Each 5 ml ink bottle has enough ink for hundreds of projects and thousands of stamps.

THERMAL PRINTING
The Mint uses thermal printing to create 3D reliefs of your design, making even the most intricate details visible. You can turn almost any design in the Design Store into a custom stamp. It even works with photos, too! To see how to create a stamp, turn to page 300.
You have your Silhouette in hand and you are ready to get designing, creating, and making. But before we turn you loose on the creative world, there are a few things that we want to cover. This crash course will walk you through everything from unpacking your Silhouette to making a basic cut. In subsequent chapters, we will elaborate on everything we talk about in here, but this is a short and sweet Silhouette rundown. Are you ready?

Chapter Two

Quick Start Guide

What You Need to Get Started

You have your Silhouette in hand and you are ready to get designing, creating, and making. But before we turn you loose on the creative world, there are a few things that we want to cover. This crash course will walk you through everything from unpacking your Silhouette to making a basic cut. In subsequent chapters, we will elaborate on everything we talk about in here, but this is a short and sweet Silhouette rundown. Are you ready?

Designing with Silhouette Studio®

Creating Your Own Design
Using a Design from the Store

Cutting Your Design

Loading Media Into Your Silhouette Cutting Machines
Loading Your Silhouette
Sending Your Design to Your Silhouette
Making a Basic Cut with Your Silhouette
What You Need to Get Started

So you have your machine? You only need a few more things to get creating! Your machine comes with everything you need to get going, minus a material to cut. You will need a blade and a mat, but both of these are included with your machine.

Some other important things to have are basic Silhouette tools like a scraper and a hook. Depending on the material you use, you will use them more or less, but they are helpful to weed and to clear extra material off your mat. If you are using vinyl, you will need transfer paper or transfer tape. If you are using heat transfer, you will need an iron. If you are using fabric, you will need a fabric stabilizer.

Then, it’s the fun part. You get to decide what you are actually going to DO with your machine. This will lead to what material you will need. Pick an easy project to get started with and go from there.

Okay, so you have an idea in mind. You have a vision of what you want to do. What now? Our biggest recommendation is to start using your machine as soon as possible. Don’t be intimidated. It is easier than you think! Using this handbook, you can learn the basics
in no time. Then, once you get familiar with that, dive into the more advanced features. Here at Silhouette, we want you to love your machine as much as we do. So, if you prefer to find and purchase designs and cut them right out, do it! If you want to hand-design intricate files, do that! Our software is built for every type of user, so start exploring all the possibilities!

UNPACKING YOUR SILHOUETTE FROM THE BOX

We pack our Silhouette machines securely to protect them during transit. Our number one packaging goal is that your machine makes it safely to your arms. In order to achieve this, we secure all moving parts of the Silhouette machine. It’s important to make sure that you’ve removed all packaging, otherwise your machine won’t work properly. Check all the nooks and crannies of your machine to remove any plastic or foam. The quick instruction manual provided in the box will detail where any tape and foam may be.

INSTALLING SILHOUETTE SOFTWARE

This handbook was written for Silhouette Studio® Software Version 4. V4 will look a little different to those of you used to working with V3, but it still has all of the same capabilities. One of the changes between the two is the expanding the Cut Settings into an easier-to-use Send panel. V4 has made selecting your media and sending your design to your Silhouette easier than ever.

There are two ways you can install Silhouette Studio® on your computer:

- Downloading it at silhouetteamerica.com/software.
- Using the installation CD included in the box.

Download the software file or, if included with your machine, insert the installation CD into your computer’s drive and follow the prompts on your screen. Make sure when you install the Silhouette software, your computer’s operating system supports the program you are downloading. If your computer’s operating system does not meet the minimal requirements for installation, the Silhouette software will not install.

New versions of Silhouette Studio® are released periodically. There are also three paid editions of Silhouette Studio® available for purchase—Designer Edition, Designer Edition Plus, and Business Edition. Turn to page 33 to learn more about which edition of the software is right for you.

Software updates and the most recent version of Silhouette Studio® are always available online.

Don’t confuse a software edition with a version of software. When we talk about an edition of Silhouette Studio® software, we are talking about the four different levels of Silhouette Studio® that are available—Basic Edition, Designer Edition, Designer Edition Plus, and Business Edition. Each edition adds features to the previous editions, giving you more tools and effects to work with.

Different versions of the Silhouette Studio® editions are released periodically. New software versions are released to keep the program up-to-date.
UPDATING YOUR SILHOUETTE SOFTWARE
If you used the installation CD to install your Silhouette software, you may need to update to the newest version. There are two ways for you to update your software.

- Online at silhouetteamerica.com.
- Automatically in Silhouette Studio®.

If you are updating your software online, at the top of the website there is a blue button that says “Update Software.” Silhouette Studio® will prompt you when a new update is released. The software automatically checks for program updates every week, but you can change these settings if you would like.

CONNECTING YOUR SILHOUETTE TO YOUR COMPUTER
Make sure to install Silhouette Studio® on your computer before you connect your Silhouette. This will make the connection process easier.

Each Silhouette comes with preselected, free designs. When you have your software installed and your Silhouette connected, these designs will download to the Library.

Once your Silhouette is connected to your computer and your software is installed, you are almost ready to design. All you need is a Silhouette account. For help on setting up an account, see page 129.

Designing with Silhouette Studio
Our Silhouette software is designed to be easy to use for both design beginners and design experts. If you’ve used any drawing program (even the most basic ones like Microsoft Paint) the layout in Silhouette Studio® and Mint Studio™ will be familiar to you.

In Basic Edition, there are four basic locations for your toolbars. To the left are your drawing tools, above are general document tools, above and to the left are your navigation tabs, and to the right are your studio tools.

There are a few ways to design in Silhouette Studio®. You can create your own designs using the drawing tools. You can purchase a ready-made design from the Silhouette Design Store. Or, you can do a little of each and take designs from the design store and edit them to make them your own.

Open Silhouette Studio®. You’ll see that a large part of the program is taken up by a gray and white window. This is your workspace. Think of
it like an artist’s canvas. This is where you will create all your designs.

In Silhouette Studio®, the initial set-up for the page will depend on the Silhouette you have connected to your computer. We are using a Silhouette CAMEO® for this overview, so the default setting is a 12 in. x 12 in. page mounted on the Cameo mat. You can change the page settings for different sized projects. To learn how, turn to page 69.

**CREATING YOUR OWN DESIGN**

The drawing tools are located to the left of your workspace. Try them out! Experiment with a few. Using the drawing tools, you can create both simple and complex designs. Try the Text tool to use any font you have installed on your computer.

1. Click on the Store tab.

2. Search for something you like and select your design. We suggest something simple for your first project. Place it in your cart. Checkout.

3. After you have purchased a design, it will download into the Library under “Recent Downloads.” Double-click the design. The design will open in your workspace.

4. Most designs will be red cut lines when you add them to your workspace. You can fill the shapes with color, scale them, rearrange them, and a million other things. Or, you can leave them just as they are.

Here is the design we chose to cut out first. We aren’t going to worry about changing anything major. All we are going to do is click on the design, move it to the top left-hand corner by dragging it with your mouse, and make it a little bigger by pulling on the corners.

**USING A DESIGN FROM THE STORE**

There is a navigation toolbar at the top has four tabs: Design, Store, Library, and Send.
LOADING MEDIA INTO YOUR SILEHOUETTE CUTTING MACHINES

One of the best things about Silhouette cutting machines is that they can cut so many different types of media. This versatility allows your creativity to run wild with cardstock, vinyl, canvas, and much more.

If you should or should not not use your cutting mat will depend on what material you are using. Lined material does not require you to use a cutting mat. In this quick overview, we'll show you how to make a cut using a Cameo on adhesive-backed cardstock without a cutting mat.

LOADING YOUR SILEHOUETTE

1. Turn on your Silhouette. The power button is located on the right side of the machine.

2. Lift the lid of your Silhouette. Inside you will see a metal bar with two rollers. Your media (or mat) will go under this bar.

3. Line up the left edge of your media with the blue line on the Silhouette CAMEO®'s deck. (Note that on a Portrait, the line is raised with an arrow pointing to it instead of blue.) Make sure the top of the media is a straight line.

4. Choose the Load or “Load media” button on your LCD screen. (For a Portrait, the “Load media” is the bottom button.)

5. Your Silhouette will automatically load your media. You are ready to cut.

SENDING YOUR DESIGN TO YOUR SILEHOUETTE

Now that we’ve unpacked, connected, designed, and loaded all necessary parts, let’s move on to the best part—making a cut. When we talk about making a cut in this handbook, it doesn’t always mean we’re talking about actually cutting through a piece of media. We use the word cut to describe the Silhouette’s carriage making a pass over the media. Passes made with sketch pens or Curio tools are also referred to as cuts.

Brand new cutting mats are sometimes too sticky for thinner media, like copy paper. If you are using a new mat, try seasoning it first by rubbing it against your pants or even on the floor. This will stop your media from over-sticking.
Chapter Two: Quick Start Guide

Cutting Your Design

1. Make sure your Silhouette is turned on and ready with your media loaded. If you’re not sure how to do this, look at the previous sections for a quick overview.

2. In Silhouette Studio®, click on the Send tab.

3. Under “Material” select your material, which is in this case “Cardstock (Adhesive-Backed).”

4. Silhouette Studio® will give you recommended cut settings. The only setting you will have to manually adjust is your ratchet blade.

5. Using the ratchet socket on your Silhouette, twist the little red line to match the recommended number in the software. If you are using an AutoBlade in your Cameo 3 or Portrait 2, you can skip this step.

6. Insert the ratchet blade into the carriage (the Tool 1 holder on Curio and the Cameo 3, farthest left) and twist or push the knob to secure the blade in place.

7. In Silhouette Studio®, click “Send.”

8. Your Silhouette will begin the cut job.

You made a cut! That’s all there is to it. Design something, load your media, and send your design to your machine. We hope your mind is racing with all the possibilities.

The next chapter is detailed instructions of every function in Silhouette Studio®. Now that you know how easy it is to use your machine, it’s time to dive into the software. Silhouette Studio® is powerful and is designed to help you easily create your custom projects.

See Chapter Nine for a more detailed set of instructions on how to make a basic cut, including how to adjust your rollers and blade.
In this chapter, we will go through each icon in Silhouette Studio®. If you want to know how to use a particular feature, turn to that page first. Many explanations use more than one feature and there are links between the two.

Within Silhouette Studio® if you hover your mouse over an icon a text box will appear with the icon’s function.
GETTING STARTED
Which Silhouette Studio® Edition is Right for You?

Are you new to Silhouette?
Yes → Are you familiar with design programs?
No → Silhouette Studio® Basic Edition

No →

Yes →

Do you want to import SVG or PDF files?
No →

Yes →

Do you need more control over your designs than what Basic Edition gives you?
No →

Yes →

Do you want to use rhinestones or embroidery files?
No →

Silhouette Studio® Designer Edition

Yes →

Will your projects need tiling, nesting, or multiple cutting machines at once?
No →

Silhouette Studio® Designer Edition Plus

Yes →

Silhouette Studio® Business Edition

Click on the edition you are interested in to learn more about it.
WORK AREA OVERVIEW
1. Document Tools
2. Quick Access Toolbar
3. Drawing Tools
4. Document Tabs
5. Holding Area (Gray)
6. Active Cut Area
7. Navigation Tabs
8. Silhouette Studio® Tools
9. Panels
10. Preferences and Themes

CUTTING/DRAWING AREA
There are two different sections in your workspace: the white design page or cutting area and the gray holding area. Images and designs can be placed on both the gray holding area and the cutting space, but only designs or images within the active cut area (bound inside the red box on the white page) will be sent to your Silhouette. The gray area can be used to place your extra work.

DOCUMENT TABS
Your document tabs are located at the top of your workspace. When you open a new document while you already have a document open, a new tab will open. The document tab highlighted in white shows which document is open in your workspace. The other open documents are shown with greyed-out tabs.
Your document tabs allow you to move easily back and forth between multiple documents and let you know at a glance what projects you currently have open. When you save a file, the document tab automatically updates to the file name.

**KEYBOARD SHORTCUTS**
Silhouette Studio® has built-in keyboard shortcuts to make designing more efficient. You can see a compiled list of these shortcuts on page 349, or you can find them in a blue outlined box near each function.

**PANELS**
Silhouette Studio® design icons open their own panels. Panels open on the right-hand side of the screen when you click a design icon. The first panel you open will be at the top. Any panels you open after the first will replace the panel currently open as long as it is in the default position. If you move the panel from the default location, you can open a new panel and it will snap to the default location. Using this method, you can have as many panels open as you want, and you can move them anywhere in your design screen.
COLLAPSING PANELS: Panels can be collapsed by clicking the white arrow on the left-hand side of the panel. Collapse, move, and rearrange the panels to set up your screen exactly as you like.

When you close panels, the ones underneath will jump up to fill their place.

STICKY PANELS: Panels are sticky, meaning they snap to the top of the design area or to each other. But panels don’t need to stick to each other. You can move groups of panels or individual panels anywhere on your screen. Depending on your project, you might want lots of panels open to make adjustments using a wide variety of tools, or you might only want a single panel open at a time.

PANELS HOUSING MULTIPLE ICONS: Some panels are single icon panels, such as PixScan™ or Offset. Other panels consist of a group of related icons. These icons are available within the panel via separate tabs. For example, the Transform panel includes the Align, Scale, Rotate, Move, and, if you have Designer Edition, Shear icons.

PANEL MODE: You can customize the panel mode in the Preferences panel. Under Defaults, you can choose how you want your panels to open.

- Single Panel Mode: Only one panel can be open at a time. If you have a panel open and you click another icon, that new panel will open in place of the panel that was previously open.

- Flexible Panel Mode: Default. Similar to Single Panel Mode, Flexible will seemingly not allow you to have multiple panels open at once. But, if you move a panel from the default location, it will remain open when you click another panel icon. If you leave the panel in the default location and click another icon, the new panel will open in its place.

- Multiple Panel Mode: All new panels will open no matter how many panels are already open.
## SILHOUETTE STUDIO® EDITION COMPARISONS

Do you need help deciding what edition of Silhouette Studio® is right for you? Take a look at this comparison chart to make sure you get the software edition that meets all your needs.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Designs and Send to Silhouette</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Basic Design and Text Tools</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Manipulation Tools: Move, Rotate, Scale, Align, Replicate</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Modification Tools: Weld, Divide, Crop, Subtract</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Cut by Line or Fill Color</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Font Access (for font files on your computer)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Import JPG, BMP, PNG files</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Trace</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Image Effects (b/w, tint, color saturation)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Print &amp; Cut</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>PixScan™</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Silhouette Library Storage</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Object on Path</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Sticky Notes</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Pop-up Creator (Basic)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Color Fonts</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Print Bleed</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Commercial Font Indicator</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Import SVG, PDF files</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Layers (Including Cut by Layer)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rulers/Guides</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Nesting</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Shadow Tool</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Eraser Set Tools</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Knife Set Tools</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Eyedropper Tool</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Shear</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Sketch Effect</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

*Continued on next page*
### Features

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Trace by Color</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Magnet Trace</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rhinestone Conversion</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Glyph Support</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Font Management</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Basic Warp</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Pop-up Creator (Advanced)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Ability to Import Custom Patterns</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Lasso Selection</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Warp Templates</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Advanced Rhinestone Features</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Import Embroidery Files (PES, DST, EXP, JEF, and XXX)</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Warp (Conical, Perspective)</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FlexiShapes</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Puzzle Generator</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import Ai/CDR/EPS Files</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Weed Line Feature</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multi-cutter Support</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Matrix Copy Feature</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Media Layout View</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Automatic Nesting</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tiling</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Barcode</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multiple Undo/Redo</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export SVG, PDF, JPG</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Handwritten Font Creation</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital Font Creation</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edition Toggle</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Navigation Tabs

There are four tabs along the top right-hand side:

**DESIGN**
This design area is your workspace to create projects. This area houses the toolbars, the white design page, and the gray holding area. When you are in the Library, the Silhouette Design Store, or the Send menu, click the Design tab to return to your design page.

**STORE**
When you are connected to the internet, the Store tab takes you to the Silhouette Design Store where you can browse and purchase designs. For more information on the Store, see page 129.

**KEYBOARD SHORTCUT:** Show Design Area
Windows, press Ctrl + Shift + D
Mac®, press Cmd + Shirt + D

**KEYBOARD SHORTCUT:** Show Design Store
Windows, press Ctrl + Alt + S
Mac®, press Cmd + Alt + S
LIBRARY
You can access your stored designs from the Library tab. Sort and organize your designs any way you’d like by adding folders and subfolders. Designs can be stored on your computer or in the Silhouette Library. For more information, see page 139.

KEYBOARD SHORTCUT: Show Library
Windows, press Ctrl + Alt + L
Mac®, press Cmd + Alt + L

SEND
The Send tab allows you to adjust the cut settings for your designs and send them to your Silhouette. This menu works similar to a Send to Print menu in other programs. For more information, turn to page 142 for detailed instructions about cutting with your Silhouette.

KEYBOARD SHORTCUT: Show Send Panel
Windows, press Ctrl + F2
Mac®, press Cmd + fn + F2
Document Tools

NEW DOCUMENT
Silhouette Studio® automatically creates a new document each time you open the program. If you want to open another new document, use the New Document icon or go to File New Project Wizard. A menu appears where you can choose which type of project you want to create. Clicking on “Blank Document” will open a plain document where you can create any type of project. Clicking on an icon such as “Print & Cut” will ready your document for that particular type of project, such as automatically adding registration marks to your design page.

KEYBOARD SHORTCUT: New Document
Windows, press Ctrl + N
Mac®, press Cmd + N

OPEN
To open existing files, you may either use the “Open” option from the File menu or select the Open icon. Navigate to and click on the file you want. Through the Open feature, Silhouette Studio® Basic Edition has the ability to open the following cutting-type files:

- STUDIO (Silhouette Studio® files)
- GSD/GST (Graphtec “ROBO Master” program files)
- DXF (Silhouette Studio® supports only the Arc, Circle, Ellipse, Line, DWPolyline, Spline, and Text DXF features.)

You can also use the Open feature to access files that aren’t supported file types, but can be imported for printing or tracing.

Compatible file types may be also accessed by dragging the saved file from your computer directly into your workspace or copying and pasting into your Design screen.

A list of recently used documents are also available under File > Open Recent.

KEYBOARD SHORTCUT: Open Document
Windows, press Ctrl + O
Mac®, press Cmd + O

When you open Silhouette Studio®, a Recovered Document Panel will open on the right-hand side of the screen with any documents you created but didn’t save when the program closed.

SAVE
After you have created a design, don’t forget to Save! If you have not saved your document, Silhouette Studio® will prompt you to save your changes when you close a document or the program. Silhouette Studio® has an autosave recovery that will automatically save a copy of your work. This autosaved copy will be available the next time you open the software, but you will want to save your work as you go.
**SAVE:** Save creates a STUDIO file and you can save it to any location on your computer.

**SAVE AS:** This option creates a new file from your current document and saves it to any specified location on your computer.

**SAVE TO HARD DRIVE:** This saves your design to your computer.

**SAVE TO LIBRARY:** This option will save your file into the Library tab in Silhouette Studio®. You can choose which folder to save the files within your library.

**SAVE TO SD:** This feature is only compatible with the Silhouette SD and the original Cameo. This formats images to a GSP file that can be read directly by your Silhouette.

**SAVE SELECTION:** This option found in the File menu will save a STUDIO file of only the actively selected images from your document. It is saved to any specified location on your computer and can be backed up to a removable or external memory device as desired.

**KEYBOARD SHORTCUT:** Save or Save As
Windows, press Ctrl + S or Ctrl + Shift + S
Mac®, press Cmd + S or Ctrl + Shift + S

**MERGE**
You can use Merge from the File menu to open any file into the same workspace you are using rather than opening a file into a new document workspace in another tab.

But, if you look at the top, it is labeled Merge. Choose the file you want to open INTO the file you already have open on your desktop.

In this case, the file with the clothes line is already open in Silhouette Studio®. Choose the file you want to merge into your existing file, such as the file with the laundry phrase. The Merge function will put everything from the file you selected right on top of the file you currently have open. The laundry phrase will open right on top of the clothesline in the document already open. All of the objects will stay in their relative positions, including things that are off of the workspace in the gray area. This is great if you don’t want to copy and paste everything when consolidating designs. Now you are free to arrange everything and finish designing your document.
PRINT

The Print icon will send your design page to your printer. To clarify, your Silhouette machine is not a printer. If you design an awesome project full of color, shadows, or gradients and send it to your Silhouette, you will only get lines cut out of the material you loaded into your machine.

Your machine does not print. But, you can send designs with registration marks to your home printer from Silhouette Studio®. Then, you can load the printed sheet into your Silhouette machine. Your machine will use its optic scanner to read the marks and cut the cut lines specified in your design file.

Your machine does not read a piece of printed paper and know how to cut around shapes. You must define the cut lines in the software. Your machine uses an optic scanner to read registration marks, and it uses these marks to orient where the page is on the mat. Then it will cut the lines designated in the software according to its calibrations.

**KEYBOARD SHORTCUT:** Print
Windows, press Ctrl + P
Mac®, press Cmd + P

**CUT LINES:** Regular cut lines are the most basic and common type of designs in Silhouette Studio®. When you open a cut design from the Design Store or when you start to design on your own, the default settings will be red cut lines.

While these don’t look as good as your finished project will, these simple lines are all your Silhouette needs to cut. You can open a design from the Design Store, move it around the page and use the corner handles to resize it, and then send it to cut. If you don’t want to spend time in Silhouette Studio® customizing your design, you don’t have to! Send the design to your machine, cut your material, and get right to assembling your project.

**CUT LINES FILLED WITH COLOR:** Filling shapes with color or changing the color of cut lines does not affect how they will cut when you send your design to your Silhouette. This design has brown lines and a brown fill applied. But, when you send this to your machine, it will cut exactly the same way as the design above with red cut lines and no fill. If you add registration marks and print this design with your printer, it will print the brown lines and fill. You can then cut it with your Silhouette.
Note that the text on the bear is not filled with white. It is simply the design page showing through because the image is a compound path.

**WHAT IS A COMPOUND PATH?** A compound path is one way that two shapes can interact with each other. Instead of the letters lying flat on top of the bear, they are acting like a cookie cutter and slicing through the shape below them. In terms of cutting, it doesn’t matter if objects are compound paths or simply layered on top of each other. But when filling with color and printing, compound paths are very important. For more information, see page 53.

When we give examples in this chapter, the shapes will most often be filled with color. This is simply so you can more easily see what is happening on the design screen, not necessarily because the design is intended for print.

**PRINT & CUT:** Print & Cut designs are made specifically to print to your home printer and then cut with your Silhouette. They have red cut lines included around the outside of the printed area.

If you send this tree to cut without printing it first, the only thing that would cut is the red outlining cut line. You need to print it first, and then cut it out.

So, just remember that your machine does not print. Don’t be disappointed when your adorable design doesn’t print and cut out of your machine simultaneously. Your machine was designed with an easy Print & Cut feature to pair your home printer and your machine. See page 303 for detailed instructions on making Print & Cut designs.

**CUT, COPY, AND PASTE**

Cut, Copy, and Paste are the basic tools for copying selected images, pasting them, or cutting them from view. Images copied or cut will sit in your computer’s memory on a virtual clipboard. You may only have one object on this clipboard at a time.

This means if you copy one image and then copy another, only the most recent image will be waiting on the clipboard to be pasted. You can access these from the top toolbar, in the Edit menu, or by right-clicking on an image.

Pasting copied images will place the copy directly in front and slightly to the right of your original image so you can easily see and find your copy. Paste in Front pastes a copy of an image directly on top of itself. This is found in the Edit menu or by right-clicking and selecting “Paste in Front.”

Shown on the next page is a lace border. It is filled with a dark blue color and has dark blue lines. We need four copies of the border to make a square shape and create a frame. (1) Select the border and copy it. (2) Then paste three copies into your workspace, making a total of four borders. The copies will paste in a slightly overlapping diagonal line on top of your original image.
(3) Select each piece and move it slightly apart from the others so you can see what you are doing. Notice how one shape overlaps onto the gray space. That’s okay! Use all the space you need. Just remember not to let it overlap outside the red cut border when you are ready to send your design to cut.

Now that there are four copies, we need to rotate the borders to make the frame. Flip the top border vertically by right-clicking and selecting “Flip Vertically.” Or, go to the Rotate panel and rotate 180°.

Next, click one of the side borders. In the Rotate panel, rotate one of the borders 90° and the other one 270°. Start placing your borders together.

**SILHOUETTE PRO TIP:** Line up the circles on the edges to get the design straight. Then select all four pieces and weld them together so the frame is a single shape. For more on Rotating, see page 106.

When you have it completed, you can use your border square as frame for a photo or a design. You made a design from a single object! Copying and pasting are essential tools for designing your own projects.

**KEYBOARD SHORTCUT:** Cut
Windows, press Ctrl + X
Mac®, press CMD + X

**KEYBOARD SHORTCUT:** Copy
Windows, press Ctrl + C
Mac®, press CMD + C

**KEYBOARD SHORTCUT:** Paste
Windows, press Ctrl + V
Mac®, press CMD + V

**UNDO AND REDO**
Any action you do, including simply moving an image, may be undone. To back up to your previous action, click the Undo icon. There is an unlimited number of actions you may go back to with the Undo feature, including going back to when you first opened your new workspace. In other words, you can’t ruin your design. Try something out and if you don’t like it, Undo! This is great for experimenting with different fill colors, resizing, and effects. Once you close your file, the function resets. You won’t be able to open a
document tomorrow and undo something you did today.

**Undo** is crucial for welding as there is not an “unweld” function. The only way to unweld something is to undo. (For more on welding, see page 52).

If you welded the borders above together “inside out,” don’t worry. Try out your new best friend Undo! Click the Undo icon as many times as you need to get your design back to where you can put the borders back together correctly. And if you accidentally undo too far, click “Redo” and it will redo your action.

**KEYBOARD SHORTCUT:** To Undo an Action  
Windows, press Ctrl + Z  
Mac®, press Cmd + Z

**KEYBOARD SHORTCUT:** To Redo an Action  
Windows, press Ctrl + Shift + Z  
Mac®, press Cmd + Shift + Z

**KEYBOARD SHORTCUT:** Select All Tool  
Windows, press Ctrl + A  
Mac®, press Cmd + A

**KEYBOARD SHORTCUT:** Deselect All Tool  
Windows, press Ctrl + Shift + A  
Mac®, press Cmd + Shift + A
ZOOM TOOLS
When you view your workspace, you may wish to zoom in or zoom out to either get a closer look at smaller images or see your entire design. There are a variety of zoom options you can utilize. Also, it is helpful to know the zoom shortcuts so you can zoom in and out quickly and easily.

**ZOOM OUT:** This tool zooms out from your view for a broader perspective so you can see the objects that are in the gray holding space. Objects outside of your page will not be sent to your Silhouette, so the gray holding area is great place to put your extra work.

**DRAG OVER A SHAPE TO ZOOM:** This tool allows you to zoom to specific areas of your workspace by drawing a box around the area you wish to zoom into.

**ZOOM IN:** This tool zooms into your workspace wherever your mouse is positioned for a closer view. You can see the small details of an object while zoomed in. It is really helpful if you are editing small parts.

**KEYBOARD SHORTCUT:** Drag Over a Shape Zoom Windows/Mac®, press Z and drag a box around the area you what to see closer.

**ZOOM IN AND OUT USING MOUSE:** After clicking on this tool, your mouse will appear as the Drag Zoom symbol. Click and hold down your mouse to zoom in or out to any selected scale.
**PAN USING MOUSE:** This function doesn’t actually zoom at all—it pans your work area. You can move your design screen in any direction using the Pan tool. Click the Pan Using Mouse icon. Then, click and hold your mouse on your design screen. Now you can move your entire screen anywhere you want. This can be really helpful if you are zoomed in close and need to move from one part of your design to another.

**KEYBOARD SHORTCUT:** Pan Tool
Windows/Mac®, press Spacebar and move the design screen.

**FIT TO WINDOW:** Clicking the Fit to Window icon will immediately fit the full defined workspace (the white page and the dark gray cut mat) to the center of your screen. When you are zoomed far in or out, Fit to Window is a good option to get your design back into the center of your page.

**KEYBOARD SHORTCUT:** Fit to Window
Windows, press Ctrl + 1
Mac®, press Cmd + 1

---

**Quick Access Toolbar**

Tools that do not open in panels open in the Quick Access Toolbar located at the top left-hand side of the Design screen. Editing and Drawing tools such as Point Editing, Eraser, and Knife open here.

**SINGLE SHAPE**
When you have a single shape selected, the Quick Access Toolbar will open with drop down options for Fill Color, Line Color, Line Style and Thickness, Scale, Move, Grouping, Arrangement, Weld, Offset, Duplicate, and Delete options.

**MULTIPLE SHAPES**
When you have multiple shapes selected, the Quick Access Toolbar will open with the same options as a single shape along with Align options.
Access Fill, Line, Scale, Move, and Align options here or in their respective panels through icons on the right-hand side.

Group/Ungroup, Bring to Front/Send to Back, Duplicate, and Delete are only accessible from this toolbar or by right-clicking an object in the design screen and selecting from the dropdown menu.

Weld and Offset are accessible from this toolbar, by right-clicking an object in the design screen and selecting from the dropdown menu, or by the Modify panel for Weld or the Offset panel for Offset.

**TEXT**

If you have text included as part of your design, the Quick Access Toolbar will open with Text options such as font, size, bold/italics/underline, justification, direction, and kerning. Fill and Line options will also open.

**GROUPING/UNGROUPING**

Any lines or objects can be grouped together so they are fixed in their relative positions, even when you move them. You can group things temporarily just to move them and then ungroup them. Or, you can group things and keep them grouped indefinitely.

The berry bush is an example of a single line. The image seems to have many parts, but it is one line with a single starting point and ending point. There isn’t anything to group or ungroup. When you fill it with color, the entire shape fills. You can move the image and it all stays together because it is one single shape.

This adorable monster design has lots of parts, and it opens all grouped together. You can move the objects around as a single image, but you cannot click on individual parts. So, you have to ungroup it to start to rearrange and fill in the color. To ungroup, select the object and either click the Ungroup icon or right-click and select “Ungroup.” Once ungrouped, there will be individual selection boxes around each new ungrouped object.
Start with filling each object with color. This will make it easier to see which parts go where. Make sure you fill the white shapes with white or they will retain their clear fill.

Group the eyes together. Each eye is made of three separate circles. Place the white circle on the orange, and then the black on top of the white. Select all six shapes and then group.

**SILHOUETTE PRO TIP:** If you want each circle to be exactly centered, simply center them with each other using the Align Tool (page 103.)

**IS THE WRONG OBJECT IN FRONT?** Right-click and select “Bring to Front.” See page 52.

Now that you have your eyes grouped, you can move them as one object instead of six. It is so much easier than trying to move each circle individually.

Group the body together so you can move it as one piece. Place the orange body on top of the purple body and select them both. Group them.

Group the teeth onto the red mouth. Place all the monster pieces on top of each other and group the entire design. Now you can move the monster
ARRANGE OBJECTS

Many of your designs will have parts that overlap each other. The order of which image is in front and which is in back can be arranged any way you want. You can use the icons or right-click your design to pull up the arrange options.

**BRING TO FRONT:** This takes your selected image and moves it in front of all other overlapping images.

**SEND TO BACK:** This takes your selected image and moves it behind all other overlapping images. In the left image, the yellow shape is in the front. We need the gray one in front to see the stripes. Right-click the yellow one and “Send to Back.” (Or right-click the gray one and “Bring to Front.”)

---

**WHAT IS THE DIFFERENCE BETWEEN GROUPING AND WELDING?** Grouping takes two or more shapes and attaches them together. They will appear as one shape, and you can move them as one shape. But, you can always ungroup them and they will then return to their separate shapes. When you group things, each shape retains its individual properties like color.

When you weld shapes, they join together to create one continuous shape. The new shape will have all the properties of only one of the original shapes. Once you weld something, there is not an unweld feature. You can undo your action with the Undo feature, but once you close the file, you cannot open it up and Undo a welded object. For more on Welding, see page 52.

---

**KEYBOARD SHORTCUT:**

Windows, press Ctrl + Shift + ]
Mac®, press Cmd + Shift + ]
BRING FORWARD/SEND BACKWARD: “Bring Forward” and “Send Backward” send the selected image only one layer forward or backward. If you have more than two objects layered, this is essential. This tree has a part where three shapes overlap. There is the salmon pink circle, the teal cloud shape, and the brown branch. (1) Initially, the pink shape is on top of the other two. We want the pink one to overlap the branch, but we want the teal shape to be the top shape. (2) Select the pink one and “Send Backward.” (3) If you send it all the way back, the branches will be on top. (4) Send it just one layer back.

KEYBOARD SHORTCUT: Bring Forward
Windows, press Ctrl + ]
Mac®, press Cmd + ]

KEYBOARD SHORTCUT: Send Backward
Windows, press Ctrl + [
Mac®, press Cmd + [

WELDING
You can select objects that overlap and weld them into one object. This way, when you cut your material, you will not have lines cutting through overlapping shapes. This is especially helpful for text that has overlapping letters.

Select all of the overlapping images or letters you want to weld together and click the Weld icon. That’s it! The important thing to remember is that this is not seen as text anymore; it is an image. You cannot type additional letters into this. You also cannot unweld something. You can undo the action, but you can not go back to something you welded yesterday and unweld it.

SILHOUETTE PRO TIP: If you want, make a copy of your design and put it in your gray holding area. Then, if you do not like your welding later on, you can delete the welded image and use the unwelded image from the side of the page.

Welding isn't just for letters and fonts. Objects can be welded, too. Weld objects together to create new shapes, easier to cut shapes, or
even to create borders. Take a single design like this elephant. Make three copies. Select two of the copies and right-click “Flip Horizontally.” Arrange the elephants’ trunk to trunk and tail to tail, making sure they slightly overlap each other. Select all four elephants and weld. Now when this cuts out, it will cut as one elephant border, not four separate elephants.

OFFSET: Offset is located in the Quick Access Toolbar, by right-clicking an object, or at the right in Silhouette Studio® design tools. Offset creates a slightly larger or slightly smaller outline of your selected shape. For more on using offsets, see page 115.

Offsets can be applied to shapes, text, and designs. Apply an offset to a simple design, like this sun, to make your own unique creation!

KEYBOARD SHORTCUT: To Weld
Windows, press Ctrl + Shift + W
Mac®, press Cmd + Shift + W

NOTE: Your machine will cut the middle shape and the shape filled with black in exactly the same way. Compound paths only affect how you view the design on your screen.

COMPOUND PATHS: The concept of compound paths is important in order to understand why certain features are applied differently to seemingly identical situations. Compound paths are a collection of two or more objects where lines are embedded or cut into the image. A compound path may appear the same as a grouped set of lines, but they will look very different when they are filled with color.

OFFSETS AND COMPOUND PATHS
Use offset and compound paths together to create a frame. Draw a square. Make an offset with corner edges. Select both of the squares and right-click. Select “Make Compound Path.”

How can you tell if your shape is now a compound path instead of two rectangles? You can move the two rectangles as one shape and you can fill the space between the two with color.
NOTE: Compound paths do not have an icon in the Quick Access Toolbar, but they are essential to understand when designing. They can be accessed by right-clicking or through the Modify icon in the Silhouette Studio® design tools.

The sun pattern below is an image from the Design Store that has many different parts. It is originally a non-compound image, so when you open it from your Library and fill it with color, it will not look like you might want it to. Everything will fill with black because there isn’t any negative space in the design, even though it looks like the little circles should punch through. Though grouped together, all the shapes and lines are just individual pieces lying on top of each other, so they are all filled with the black fill color.

We want to use a compound path to make the circles punch through the design. Ungroup the entire image. Then select all the triangles that make up the sun at the bottom. Group those shapes together. Change the fill color of that group to yellow.

Now, select all the objects that make up the half circle and right-click, “Make Compound Path.”

This punches the circles through the image instead of simply lying on top. Now the circles will show through to the white of the design page. It is important to note:

- Compound paths do not have an icon in the Quick Access Toolbar, but they are essential to understand when designing. They can be accessed by right-clicking or through the Modify icon in the Silhouette Studio® design tools.
- Compound paths do not affect how the design will cut, only how it will print or how it looks on your design screen.
- Using a compound path on text changes the text into individual, editable pieces. Releasing the compound path does not change the pieces back into text.
Take the yellow sun and place it on top of the half circle. Group the design. Change all the line colors to clear so you can see what it will look like if you want to print it.

Do you want to add a lot of different colors to this design? The best way to do this is by ungrouping, not by making it a compound path. To see an in-depth tutorial on ungrouping, see page 49. But, for a quick tutorial, take the original design and ungroup it. Then pull apart the pieces and fill them with color. You can group together pieces that go together, like each set of circles that make up an arch. After you fill everything with color, layer them on top of each other and group.

**KEYBOARD SHORTCUT:** Make Compound Path
Windows, press Ctrl + E  
Mac®, press Cmd + E

**KEYBOARD SHORTCUT:** Release Compound Path
Windows, press Ctrl + Shift + E  
Mac®, press Cmd + Shift + E

**DUPLICATE**
When you select an object or group of objects and click the Duplicate icon, it will make a copy of what you have selected and place just slightly off-center of the original. You can move the copy and manipulate it.

1. Open a design or object that you want to duplicate.
2. Select the cute heart and leaves from the watering can and duplicate the design.
3. Right-click and flip the design horizontally (see page 107).
4. Place the image into a text design. Using this method, you can make corresponding designs.

**KEYBOARD SHORTCUT:** Duplicate
Windows, press Ctrl + D  
Mac®, press Cmd + D
DELETE
Delete will take anything you have selected and delete it. You can also do this by selecting something and pressing Backspace or Delete on your keyboard.

You can delete parts of designs to customize them. On this watering can, delete some of the water spout holes so you only have to worry about adhering three tiny black dots instead of six. No one will even notice and you made it a little easier on yourself!

Drawing Tools

SELECTION
The plain arrow is your standard selection mouse. Use it to drag your images around your screen, resize objects, and click on different parts of your design.

KEYBOARD SHORTCUT: Selection Tool
Windows/Mac®, press V

POINT EDITING
To enter the Point Editing Mode, either double-click a selected image or use the Edit Points tool which will open in the Quick Access Toolbar. This allows you to edit any points of your image. Only single ungrouped line selections may be point edited. To exit Point Editing Mode, click on a blank part of your screen or return to the regular selection mode by clicking on the Select tool.

In Point Editing Mode, the selected point will be displayed in white while all other points will be dark gray. The selected line associated with the selected point will be emphasized as a bolded red line. Additional lines that have blue points are handles to adjust curved lines.

When you enter Point Editing Mode, selected images will change from displaying the resizing and rotating control handles around the image to showing the points, or nodes, of the image. Points on lines are where the line may take a new direction or change from being straight to being curved.

We have a fairly simple banner here. Each banner shape has only seven points (not counting the letter points), so it will be easy to change it up.
Chapter Three: Silhouette Studio®

Setup and Design

MOVE/ADJUST POINTS: Move a point by hovering your mouse over any point on the line. When you are over a point that can be adjusted, the cursor will adjust to show you may click and grab the point to move it. With curved lines, you may similarly grab the blue points and drag them around the screen to adjust the curve of the associated line segment. On the banner, select the middle point of upside down “v” shape. Pull it straight down. Now it is a “v.” We didn’t add or subtract any points. We just moved one point down.

KEYBOARD SHORTCUT: Edit Points
Windows/Mac®, double-click your shape or press A

I CAN NOT MAKE THE POINTS APPEAR! If you are trying to enter Point Editing Mode and the functions are greyed out, or if you double-click your design and nothing happens, you will either need to ungroup your design or make it a compound path.

MOVE/ADJUST POINTS: Move a point by hovering your mouse over any point on the line. When you are over a point that can be adjusted, the cursor will adjust to show you may click and grab the point to move it. With curved lines, you may similarly grab the blue points and drag them around the screen to adjust the curve of the associated line segment. On the banner, select the middle point of upside down “v” shape. Pull it straight down. Now it is a “v.” We didn’t add or subtract any points. We just moved one point down.

ADD POINTS: Add a point by hovering over a spot on a line where there are currently no points. Once you are over a line where a point may be dropped, the cursor will adjust to show that you can click to drop a point onto the line. On the banner, pull the bottom middle point that makes the upside-down “v” down to make a flat line. Then, add a point on either side of that point so there are three points on the line. Drag the two side points up slightly, leaving the middle point where it is. This will give you a zigzag edge on the bottom of your banner. How easy was that? You only had to add three points to change the entire shape.

DELETE POINT: Any point can be deleted by right-clicking on the selected point and selecting the Delete Point icon. Deleting a point will cause the closest points on either side of the deleted point to join and create a new connecting line. This tool is different from deleting an image and is only intended to delete individual points. On the “L” banner that was adjusted above, select the middle point at the bottom of the “v” at the bottom. Click the Delete Point icon. It deletes the point and connects the two points on either side of the deleted one, making a straight line between the two.

Do you want to delete or modify many points at once? On a PC, hold Shift and use your mouse to draw a selection box around the points you want. On a Mac, hold Shift + Alt and use your mouse to draw a selection box. Once you have multiple points selected, you can use any of functions in the panel.
**BREAK PATH:** You can break the path of any line by using the Break Path tool or by right-clicking on a point and selecting “Break Path.” Breaking a path will create two new points from the original point. A broken path or two unconnected end points can be rejoined by dragging one red end point onto the opposite red end point.

1. Break the path at the bottom of the wing.

2. The bright red dot shows that the path is broken. The wing loses its fill color because the path is broken and it is no longer a closed object. Make two points from the one red point.

3. Pull them both upwards into the wing and then reconnect them. The wing will fill with color again.

4. Now the wing has a little more feather-like dimension.

**CORNER:** The Corner tool allows a selected point to be adjusted to create a sharp corner. Add a point at each of the corners. With the new point selected, click “Corner.” Drag the point upward to make the banner a right angle.
**SMOOTH:** You can use the Smooth tool to adjust a selected point to make a smooth transition point at the selected intersecting point.

**MAKE FLAT:** The Make Flat option will adjust the selected line (the line emphasized in bold red that is associated with whichever currently selected point) to a flat, straight line.

**MAKE CURVE:** Make Curve adjusts the selected line (the line emphasized in bold red that is associated with whichever currently selected point) to a curved line. On the banner, select one of the top corner points. Then, select “Make a Curve.” It will curve between the two points on either side of the point you selected. You can adjust it by rotating the little bar that appears on your object.

**SIMPLIFY:** This bird has far more points than the banners, so it is a little harder to edit. Click the wing. See how many points there are on the wing alone? Some images contain a very large number of points. The Simplify tool automatically re-adjusts the image’s points and simplifies the image to its smallest number of points without changing the shape of the image.

**POINT EDITING WORDS:** If you are interested in making word art, all you need to do is point edit your text. Start by typing a word in a fairly basic font in all caps. You want your letters to be pretty close to the same size. Draw an oval shape above your text. The oval should be approximately the same length as your word.

In order to curve the text to the shape, you need to ungroup your text. This will change the text to individual shapes. Start in the middle and select a letter. Stretch the top endpoints up to the oval. Don’t mess with the bottom points; those need to stay where they are so you have an even base line.
Some letters are easier to stretch than others. For some of the more difficult ones, like the “E”s, you might have to adjust a few of the surrounding corner points, as well.

Point Editing text is different than text to a path. If you want to leave your letters mostly unchanged and simply curve them to a path, see page 97.

Another way to point edit words is the place the text inside of the oval. You will need to adjust both the top and the bottom of the letters to fit within the oval.

Just like in the previous example, select the points at the top of the letter and drag them to the oval line. Then select the points at the bottom of the letter and drag them to the bottom of the shape.

When you have adjusted all of the letters, delete the oval.

Once you have adjusted all of the letters, remove the oval. You made your own unique word art!
**DRAWING LINE TOOLS**

| LINE: | The Line Tool creates straight lines. Holding down Shift on your keyboard while drawing will force a straight vertical, horizontal, or 45° diagonal line from the starting point. |

Type your text in a font you like. Add two vertical lines to the right-hand side. Copy the two lines and paste them to the left. Using only simple lines, you personalized your design.

Weed Lines: Add weed lines manually by using the line tool. Weed lines are lines placed in the negative space of your design. These lines make it easier to weed vinyl and heat transfer. If you are cutting vinyl, you can add lines to your design between your words or shapes. Then, when you are pulling out the negative space of your vinyl, it can break in sections instead of trying to weed your entire design at once. It is so easy and it will save your sanity. Use the Line feature to draw lines in open spaces, making sure not to touch any parts of your design with the lines. You can add as many or as few as you want. This will make weeding vinyl so much easier.


**POLYGON: | The Polygon Tool creates a shape out of multiple straight lines. A point is created with each mouse click. Lines will be drawn until you close the image by aligning the ending point with the starting point or by double-clicking. Holding down the Shift key on your keyboard while drawing will force a straight vertical, horizontal, or 45° diagonal line from the starting point or last point dropped.**

**CURVED SHAPE: | The Curved Shape Tool creates a shape from multiple curved lines. A point is created upon each mouse click. Lines will continue to be drawn until you close the image by aligning the ending point with the starting point or by double-clicking.**
**KEYBOARD SHORTCUT:** Curved Shape Tool  
Windows/Mac®, press C

**SILHOUETTE PRO TIP:** You can Point Edit these objects after you draw them to fine-tune their shape. For more on Point Editing, see page 56.

**ARC:** The arc tool makes smooth, arcing lines. Adjust the angle and the line style to use the feature in a variety of different ways.

**KEYBOARD SHORTCUT:** Arc Tool  
Windows/Mac®, press Shift + A

**SHAPE TOOLS**  
Silhouette Studio® provides you with a set of basic drawing tools you can use to create shapes.

**RECTANGLE:** The Rectangle Tool creates squares or rectangles. Holding down Shift on your keyboard while drawing will create a square, while holding down Alt on your keyboard will make the initial cursor point as the exact center of your object. Use rectangles to create boxes, cards, tiles, patterns, etc.

**KEYBOARD SHORTCUT:** Rectangle Tool  
Windows/Mac®, press R

See what you can do with basic rectangles and the Shear tool on page 159.

**ROUNDED RECTANGLE:** The Rounded Rectangle Tool creates a square or rectangle with rounded corners. Holding down Shift on your keyboard while drawing will create a rounded square, while holding down Alt on your keyboard will make the initial cursor point as the exact center of your object. When you select your rounded rectangle, you will find two red control points on the rectangle’s upper left-hand corner. You can drag these individually to adjust the curves of the rectangle, or you may select both simultaneously by holding down Shift on your keyboard and dragging all of the control points at once. Use the Knife tool to slice a rounded square to make a fun design.
**FREEHAND TOOLS**

**REGULAR FREEHAND TOOL:** The Freehand Tool creates a continuous free-form line. Lines drawn with this tool will continue until the mouse is released or the image is closed by aligning the end point with the start point. Use it for anything, from closing open images to adding text embellishments to make spiky letters, like shown below.

**ED Papercut Font | by Emily Dyer**
Design ID: 56803

**ED Papercut Font | by Emily Dyer**
Design ID: 56803

**KEYBOARD SHORTCUT:** Regular Freehand Tool
Windows/Mac®, press Shift + F

**POLYGON:** Polygons have a slider bar in the middle where you can adjust how many sides you want the shape to have. Hold Alt while drawing a polygon to have it snap to one of its sides. After you draw a polygon, you need to “Convert To Path” so you don’t keep changing the number of sides when you try to adjust your shape.

**KEYBOARD SHORTCUT:** Ellipse Tool
Windows/Mac®, press E

**SMOOTH FREEHAND TOOL:** The Smooth Freehand Tool creates a smooth, continuous free-form line. Lines drawn with this tool will have smooth transitions, no sharp angles, and will continue until you release the mouse, or the image is closed by aligning the end point with the start point.

**KEYBOARD SHORTCUT:** Regular Freehand Tool
Windows/Mac®, press Shift + F
Make your own butterfly in four simple steps:

1. Use the Smooth Freehand to make a wing shape.

2. Mirror the wing to the right. Move each wing in a little so they overlap slightly.

3. Weld the two wings together.

4. Fill your butterfly with color and add an oval body using the Rounded Rectangle tool.

Finally draw a circle for the center and that’s it! You custom made your own flower.

The light pink flower was made with the Curved Shape Tool. The coral one was made with the Polygon Tool. The purple flower was made with the Ellipse tool, and the gray one was made with the Smooth Freehand Tool.

Start experimenting! Draw shapes, weld them together, layer shapes on top, and even point edit the shapes to minutely adjust the design. The possibilities are endless!

SO, WHAT CAN YOU DO WITH SHAPES?: There are so many designs you can make with basic shapes. Get creative!

This flower is made entirely of shapes. First, use the Polygon feature. Draw a triangle. Then go to Replicate. Rotate a single copy of the triangle. Weld the two together. Draw a rectangle for the stem and draw a Curved Shape for the leaf.
Chapter Three: Silhouette Studio®

Setup and Design

First, set up your design on your page. After you have your design ready, add your text. Using the little circle in the bottom left-hand side of the text box, drag the text onto your path, making it curve.

Before you turn your text into an object, use your sticky note feature! Click the Sticky Note icon. In the note, type which font you used.

Now, you can turn your text into an object, and you don’t need to worry about remembering what font you used in case you want to use or edit the same design again. You can also add any other important info, such as whether you purchased a commercial license for the design, any sizing notes to yourself, and so on.

The best part about sticky notes is that they won’t ever cut, even when they are overlapping your cut area. Add as many notes as you want and adjust them or move them to the most convenient place. When you don’t need a note anymore, just click outside it to make sure the text cursor isn’t in the note anymore, right-click, and select Delete.

KEYBOARD SHORTCUT: Text Tool
Windows/Mac®, press T and then click your design screen to open a text box.

STICKY NOTES
Click the Sticky Note icon to place a note on your screen. This note can be placed anywhere on your page. It will be saved into your actual design file so that you can record any important info onto the note. Then, you can close the file and open it again at a later time, and your note will still be right there.

If you have ever turned your text into an object, you can see how this feature will be so useful! Once your text is an object, you can no longer see what properties your text had. So if you weld your text or turn it into an object, you won’t be able to see what font you used. It can be hard to find the same font you want to use again, so to save some time, write yourself a note!
When you want to go back to your design and add additional light bulbs with text in the same font, it is easy. Instead of scrolling through your Font Library and trying to remember which font you used, just read your note. Your future self will be glad you wrote it down!

**ERASERS**

Erase any part of any image using the Eraser tool. Before you erase something, check to see if you can ungroup the image. Often, when you ungroup a design, you can select and delete pieces you thought you would need to erase. If you can’t ungroup or if you want to delete lines that are part of a shape, the eraser is a good option.

Using the eraser to manipulate an image is easy. Select your shape. We are going to be editing a fruity drink design. It has a little citrus slice on the side of the glass.

We want to delete the citrus slice to make this fruity drink into a milkshake. The citrus touches the glass in three places. Select the eraser tool. If you want to adjust your eraser settings, they are located in the Quick Access Toolbar. You can adjust the size and shape of the eraser along with making it either a solid or outline.

It can be helpful to fill your image with color when you are erasing so you can see the lines better. Drag the eraser along the top of the glass to erase part of the citrus. Then drag the eraser at the other two places where the citrus and the glass touch. Select the discarded fruit pieces and delete them.

Change the fill color from pink to brown and you are done. Milkshake! Take it a step further and erase the straw. Now you have a plain glass full of whatever you want. Maybe witch’s brew?

See how easy it is to customize anything? If you have a specific idea and can’t find the perfect design, you can manipulate shapes and create it yourself.
Here is an adorable heart word art. It is perfect as is, but we want to show you how you can use your eraser tool to customize any design.

1. Select the eraser and start dragging it over the lines you want to erase.

2. We want to erase all the extra lines so the design only says “love.”

3. Once you have the lines erased, select the “e.”

4. Using the green circle at the top, rotate the letter slightly so it lines up with the other letters. Adjust it a little closer to the others and you are done. Love!

**KEYBOARD SHORTCUT:** Eraser Tool
Windows/Mac®, press Shift + E

---

**KNIFE TOOL**
You can cut, slice, and segment images using the Knife tool. This tool delivers a straight-line cut to separate parts of images. It creates two, new separate shapes.

Say you are going to put this mandala on a notebook cover. But, you only want to put part of it on the front. The other part is going to wrap around and be on the back cover. Use the knife tool to cut a vertical line slightly off-center. That’s all you need to do! Place the larger piece on the front and the smaller on the back.

**CREATE DESIGNS:** Here is another example. First, draw a circle. Then make an offset and turn the two circles into a compound path (see page 53 for detailed instructions). Next, use the knife tool. Cut two horizontal lines across the circle so you have two little cut pieces that you can pull out of your design. Delete the pieces.

**SILHOUETTE PRO TIP:** Press Shift for a straight cut either horizontally, vertically, or 45° diagonally.
Use the polygon tool to draw a triangle. Make a copy of the triangle and flip it horizontally. Place each triangle at the end of either line. Group all of the pieces of your custom-made arrow design.

Another way to use the knife is to slice through letters or shapes to create stripes or half-and-half colored shapes. Type out your text. Then, use the knife tool to slice horizontal lines through your text, making stripes. Hold down the Shift key while you slice so your lines are straight. Slice enough rows to fill your shape. Then, start at the top and select the little pieces making up the top row. Fill them with a different color. Skip a line and do the same on the next. You made striped text!

Use the knife to do more than just slice. Fill this antelope design with black. Use the straight knife to make lots of small straight cuts. Then, select the small shapes you created from the cuts and fill them with various greyscale colors. Think of the awesome geometric projects you can create.

**WHAT IS THE DIFFERENCE BETWEEN THE KNIFE AND ERASER?** The Knife and Eraser do similar things, but the Eraser deletes parts of an image. The Knife only separates parts, and then you can delete or keep the segments.

**KEYBOARD SHORTCUT:** Knife Tool
Windows/Mac®, press K

**Silhouette Studio Tools**

The section along the right-hand side of the screen provides a range of tools including filling images, altering lines, adjusting text attributes, adjusting and replicating images, adjusting page and cutting conditions, and more.

When one of these tools is clicked on, it will open in its own corresponding tool panel.
PAGE PANEL

PAGE SIZE
This is where you can choose your page and your cutting mat. Choose the cutting mat corresponding to the machine you will be using to cut. It is important for your page settings to match your physical page and mat so your machine knows where to cut.

When a new document is opened, the default document size will always open in a standard letter size (8.5 in. x 11 in.) for the Portrait, 12 in. x 12 in. size for the Cameo, and 8.5 in. x 6 in. for Curio. You can change the size of your page, the size of your mat, and even if you want to see the mat or borders. Everyone has different preferences of how they like to view their screens, so experiment and find what works best for you.

You can alter the width and length of your document. There are preset sizes you can select, or you can manually set measurements for any custom page size. Within custom page sizes, you can adjust the width up to a maximum 8.5 in. for the Portrait and Curio or a 12 in. width for the Cameo. The minimum recommended width for a custom size is 3 in. The height may be adjusted up to any measurement you want, but the maximum recommended height is 40 in. While you can select longer material ranges, lengths exceeding 40 in. have the possibility of becoming misaligned on the Silhouette machine’s rollers. The minimum recommended height for a custom size is also 3 in.

If you are cutting on a small piece of material, you want to make sure your design fits on the piece so you don’t cut off onto your mat. Measure the dimensions of your piece of material. Then, change your page size under “Custom” to match the material. When you place the design on your mat, align the material to the grid lines, matching the image in the software. This will ensure you cut your design right onto the material.
Using the same mailbox design from before, resize your mailbox to be almost 15 in. long. It is too long for a standard Cameo 12 in. by 12 in. page size and cutting mat. Pick the 12 in. by 24 in. page size and cutting mat option. If you want to cut a design wider than the 12 in. cutting area, see the Tiling feature on page 187.

**KEYBOARD SHORTCUT:** Page Panel
Windows, press Ctrl + F1
Mac®, press Cmd + FN + F1

**ORIENTATION:** You can view your document in landscape or portrait orientation. Landscape is the default orientation when you open a new document. When a document is in landscape orientation, it will be sent to the Silhouette with the upper left-hand corner of the screen coinciding with the upper right-hand side of your material. When a document is in portrait orientation, it will be sent to the Silhouette with the upper right-hand corner of the screen matching the upper-right hand side of your material.

**CUTTING MAT:** Choose your cutting mat depending on the mat you are actually going to be cutting on. Mats come in different sizes for different machines, so make sure to choose the one you have. Your machine comes with a standard mat size, but you can buy a longer one to cut larger projects. When the cutting mat is shown, you can move the slider bar to “Reveal” the cutting mat and see exactly where your images will be cut on your mat. As you slide the bar to the right or increase the percentage number, the white page workspace will become more transparent and show the cutting mat beneath. A setting of 100%, or having this bar slid all the way to the right, will allow you to see the cutting mat and your white workspace will be entirely transparent.

What’s the difference between revealing the cutting mat and showing the grid? When you reveal the cutting mat, the little numbers in the grid boxes will show. It will look just the same as your mat. If you are sick of counting boxes to line up your media, this is for you! For more Grid options, see page 72.

**ROTATE VIEW:** You can rotate how you are viewing your page. While the Page Orientation will dictate the way your cutting job is being sent to the Silhouette to cut, the “Rotate View” option will simply rotate your workspace on the screen for a different perspective.
PRINT BLEED: Have you ever been annoyed when you’ve gone to cut a Print & Cut file and found that there was some unwanted white space around the object? If so, this feature is for you. It’s possible that your printer may not print to the cut lines as shown in Silhouette Studio®. A print bleed extends the printing area of a design to just outside the cut line to help prevent unwanted white space on the outside of your design once it is cut.

To turn on print bleed, go to the Page Setup panel. At the bottom of the panel, you’ll see the Print Bleed section. Make sure the box is checked and adjust your bleed radius if needed. Most people find only a small amount of print bleed is necessary to make their images to cut out looking fantastic every time.

PRINT AND CUT BORDERS: The red line around your workspace is your Cut Border. Images outside of this red cutting area will not be cut. The dark gray line on the cutting mat is your Print Border. This is your printer’s print margin area and is only applicable if you are making a Print & Cut.

KEYBOARD SHORTCUT: Show Print Border
Windows, press Ctrl + Shift + P
Mac®, press Cmd + Shift + P

KEYBOARD SHORTCUT: Show Cut Border
Windows, press Ctrl + Shift + L
Mac®, press Cmd + Shift + L
GRID

Turn the grid on or off to measure and place your design on your page. This can be really useful when you are cutting your design out of multiple colors on your page at the same time. You can turn the grid on by either right-clicking on your workspace and clicking “Show Grid,” pressing G on your keyboard, or by going to the Grid panel.

KEYBOARD SHORTCUT: Turn Grid On and Off
Windows/Mac®, press G

SILHOUETTE PRO TIP: If you want to show grid lines, but you want the little numbers counting the inches, you need to go to the Page panel and reveal the cutting mat. See page 69 for more details.

For more grid options like guides, rulers, and crosshairs see Designer Edition on page 153.

SQUARE OR ISOMETRIC: There are two options on viewing your grid: Square or Isometric. Square is the regular grid with horizontal and vertical lines. Isometric is a grid with diagonal lines that you can use to view 3D objects.

SPACING AND DIVISIONS: In the Grid panel you can turn the grid on and off, adjust the grid spacing to any desired measurement, and select the number of divisions in the grid. If you change spacing to 1 in., your grid will resemble your cutting mat.

OPTIONS: “Show Grid” will make the grid appear or disappear. It may be useful to have your grid showing at times during your designing process, but it might be distracting in others. Knowing how to easily turn it on and off can be helpful when you are working in your design page.

The “Snap to Grid” option forces the image to conform to grid’s measurement and divisions. This may be especially helpful when drawing images to force them to conform to specific desired measurements.

COLOR: Your grid’s color can also be adjusted so your grid can either be more in the background with a muter color or very obvious with a bright one.
REGISTRATION MARKS

Registration marks are only required when you are doing a Print & Cut. It adds little black marks to three corners of your page and hash lines along the top.

Your Silhouette can read printed jobs with registration marks sent from Silhouette Studio® to cut the lines defined in your workspace. In other words, you are able to print an image to your regular home printer and then feed the printed sheet into the Silhouette and cut out the printed image. Awesome, right?

The Cameo, Portrait, and Curio have optic scanners to read marks printed by Silhouette Studio®. These marks are called registration marks. Black marks will print around the border of your workspace and will be read by the optic scanner prior to cutting so that your Silhouette can triangulate where these marks are located and know exactly where the cut lines are defined. Registration marks are only needed when you are doing Print & Cut jobs.

Click the Registration Marks icon. Under “Style,” choose “Type 1” or “Type 2” registration makes. “Type 1” is for the Cameo, Portrait, and Curio. “Type 2” is for the Original Cameo and SD.

You can make the marks smaller or larger, but we recommend you keep them to the default settings so your machine can easily find them. You will note that the marks have a hash mark fill around them. Print information cannot be contained in the hash mark fill for the optic scanner to operate properly. Only the three black marks, not the hash lines, will print on your page.

SILHOUETTE PRO TIP: Don’t let your design touch the hash lines of the registration marks or it will mess with the optic scanner.

CUTTING PRINTED IMAGES: With the registration marks displayed, you are ready to do a Print & Cut job. Again, this does not mean that the Silhouette will scan and cut around any print information. Also, your Silhouette is not a printer and it can’t print your design. The Silhouette is simply using the registration marks to know where your cut lines are defined around your printed image. Your image must have cut lines around your printed image defined in the software.

KEYBOARD SHORTCUT: Registration Marks
Windows/Mac®, press M

When your job is ready, print your page to your home printer. Once you have printed your design, it is important not to make any further adjustments to your document in Silhouette Studio®. If you move or adjust any objects, the location of your printed information will be altered and you will need to reprint your design.
Chapter Three: Silhouette Studio®

Set up and Design

PIXSCAN™ PANEL

PixScan™ technology allows you to cut precisely around any printed image or position cut lines on a specific place on your material using a camera or scanner. The PixScan™ feature cuts according to an image’s actual size, whether it be to provide a contour cut around the image, to nest images into an oddly shaped material precisely, or to replicate a pattern at its original size.

The PixScan™ feature requires the use of a PixScan™ mat, which is sold separately.

Nest material? Yes! Take a pic of the scrap you want to use. Use your PixScan™ mat to upload the image to your software. Then see exactly where you can fit designs within the scrap. Fit your project perfectly!

What does this mean? When you use a PixScan™ mat, you can take a picture, upload it, import it to the software, trace it, and cut it out. First, take a picture of the object on your mat. For optimal results when photographing or scanning the PixScan™ mat, make sure that:

- You don’t zoom in at all.
- Your lighting is even.
- Your entire mat is clearly visible in the image.
- Your PixScan™ mat is flat.
- Your cut media is contained within the cut border.

Silhouette Studio® allows you to fill any image with fill colors, gradients, and patterns. This allows you to create your own Print & Cuts from regular cut files or from scratch.

Place your printed sheet onto a cutting mat. Align your registration marks the same way displayed on your screen with the black box in the left-hand corner. Then, load the mat with the printed page into your Silhouette.

In the Page panel, adjust all of your settings and then click “Start.” As long as your marks are displayed on your design page, your machine will know to automatically detect them. The Silhouette’s optic scanner will locate the marks. Once all marks are successfully detected, your Silhouette will start cutting the defined lines around your printed image.

These planner stickers are a basic Print & Cut job on sticker paper. In this case, your printer will see the left side to print out. Your Silhouette will only see the right side to cut.
CALIBRATING YOUR CAMERA: You only have to calibrate your camera once. The calibration profile will be available for all future projects.

1. Click the PixScan™ icon.
2. Select the “Import from File” option.
3. Click “Camera Calibration.”
4. Click “Show Calibration Test Card,” choose your printer size, and print the page.
5. Take a picture of the printed calibration page from a bird’s-eye view, ensuring that the calibration dots fill the entire image. Do not put the page onto the PixScan™ mat. The image should only include the dots. Save your image to your computer.
6. Click the plus (+) icon under the Camera Calibration section of the PixScan™ panel. A window will pop up. Select your calibration image and click “Open.”

Your PixScan™ calibration is ready for your camera. You only have to do this once per camera.

SCAN TO SOFTWARE: Silhouette Studio® offers a direct scan feature where the software can access a connected scanner to import images directly into the software program. Click on the Scanner tab. Select your scanner from the Source drop-down list. Make sure your scanner is powered on and your PixScan™ mat has been placed on the scanner bed. Click the “Import PixScan Image from Scanner” button. Your image will scan directly into the software.

UPLOADING YOUR IMAGE: Do you do your own hand-lettering? Do your kids make adorable drawings you want to save? Creating cut lines for original designs is just one of the awesome ways to use the PixScan™ feature. Place your design onto the PixScan™ mat. This is a cute little phrase one of us here at Silhouette hand-lettered. We want to use PixScan™ to trace the design, add cut lines, and precisely cut it out. Take a picture with your camera or smartphone and upload the image to your computer. Or, scan your mat as described in the previous section.

After you have your image on your computer, click the PixScan™ icon. Select “Import from File” or “Import from Scanner.” A window will pop up for you to navigate to and select your image. Click
“Open” after you have selected your image. Once your PixScan™ image is loaded, you are ready to create or place cut lines.

**TRACING YOUR DESIGN:** Open the Trace icon. Drag the trace box around your entire design. Adjust the filters and thresholds so the yellow color completely covers your design. This will give you clean, crisp lines. Click “Trace.”

Check out those perfect cut lines! Now all you have to do is load your PixSan™ mat into your Silhouette and send your design to cut. It will exactly cut around your lines.

**ADDING CUT LINES, NOT TRACE LINES:** You can also add cut lines to your design rather than or in addition to tracing. Here we took the same design and, instead of tracing, we added fun frames around the design.

**FILL PANEL**

**FILL OPTIONS:** A closed image is a design where the starting point and the ending point of a line connect. Basically, any shape you open from the Design Store or create is a closed image. You can add different fill properties to these images. If the path is broken on a closed image, the fill attributes will immediately disappear.

Closed images will default to be displayed as no fill with red cut lines, but you can choose a color, gradient, or pattern to fill your object. All three options can be accessed from the Fill icon.

The hash line selection will always represent “clear.” The clear hash is standard fill tool in all three sections.

Here is a chameleon without any fill applied. This is how most designs look when you first open them in Silhouette Studio®. It has red cut lines.

**SILHOUETTE PRO TIP:** In the Page panel, rotate your page view so you can see your design right-side up.

PixScan™ is also perfect for cutting out your freshly minted stamps.

**CUTTING:** Once you have your lines set, load your PixScan™ mat into your Silhouette. Send your design to your machine like a regular Print & Cut. Your machine will automatically read the registration marks on the mat and begin cutting your project.
and a clear fill. Keep in mind, filling an image does not affect how it will cut when you send it to your machine.

**FILL COLOR**

You may only think to fill your object with color when you are doing a Print & Cut, but the fill tools are useful for far more than that! Use fills to visualize your project so you don’t cut your design and hate the way your colors look together. Use fills to mock up your design. Trust us, everything you design will look so much better filled with color than just red cut lines on a white page.

Open a cut file. Click on your object to select it. Then, go to the Fill panel and select a pink shade from the basic color option squares. Note that the shape has the red cut lines around the outside. Fill color does NOT change line color.

To see the fill options better, we are going to change the line color to clear. Make sure to fill your design before you change the line color or you won’t be able to see your image on your screen!

**SILHOUETTE PRO TIP:** Do the red lines bug you? Want to get rid of them? Once your shape is filled, change the line color to clear or to the same color as your fill color. For more on line color, see page 85.

**ADVANCED OPTIONS:** You can make any custom color in the Advanced options. Either select one visually from the spectrum or type in the RGB (Red Green Blue), HSL (Hue Saturation Lightness), or HEX value of your desired color. You can also use a color from the basic options as a starting point to pick your new color.
Fill color is an invaluable tool when you have complex designs. It will help you visualize what your design will look like as a finished project. Also, it can help you keep together objects that are the same color and will be cut from the same piece of colored material.

This tree is a more complex example that we are going to fill with multiple colors. Right-click your image and select “Ungroup.” Otherwise, if you fill your image when it is grouped, all of the parts will fill with the one color. Fill each object with a color. Then, layer the shapes to make a tree.

Remember, fill color does not affect line color. If you only adjust your fill color, your line color will stay the automatic red of default cut lines. If you are creating a Print & Cut, don’t worry about the red lines. They won’t show up on your printed project unless the line thickness has been increased. In the Line Color panel, you can select clear, change your lines to black, or change the lines on each object to match its fill color. See Line Color on page 85 for more tips.

Another reason fill color is so useful is because you can cut by fill color. See page 151 for more information.

**SILHOUETTE PRO TIP:** You can fill objects while they are separated or while they are layered.
design and reusing colors throughout. Simply select an object and use the eyedropper from the Advanced Fill panel to click an object already filled, and it will fill with the same color.

Don’t underestimate the color picker tool, though. It is powerful! Say you want to match a color palette of an image. Silhouette Studio® can do it! First, simply copy the image and open it or paste it into Silhouette Studio®. The object we are using is this adorable Ready Set Make right from the Silhouette Design Store. The colors are so perfect! We could try to match or find our own by trial and error in the Advanced Fill Options, but this is an easier way.

Select the object you want to fill first. In our case, it is the “W.” Open the Fill Color panel and select the eyedropper. Hover over the image you imported. See the small box with the color sample that appears? This will show you a swatch of the color. Once you have the color you want in the box, click right where you are. That’s it! The “W” or line color becomes that exact shade of turquoise.

Now all you need to do is select the color picker tool again and repeat with the rest of the letters.

Line Color also has a color picker tool. When you select a color with the eyedropper, it will save the color temporarily in both the Fill Color eyedropper and in the Line Color eyedropper. Have both windows open at once. After you have selected the fill color, choose that same color for your line color without having to use the color picker tool twice.
FILL GRADIENT
Similar to filling images with solid colors, you can also fill any closed line image with a gradient. To apply gradient fill options, select your image. Then select any of the Basic Menu gradient options.

SILHOUETTE PRO TIP: You will want to select a clear line color for your design so you can really see the gradient. For more on Line Color, see page 85.

In the Basic Options, pick one of the many ready-made gradients and apply it to your object. When you first apply a gradient, it will always be horizontal.

Above, the gradient on the left is the original gradient from the previous example. Simply pull the slider bars to adjust the colors and make a new gradient. This gradient uses the same four stops as the previous one, just at different places in the gradient.

You may change colors in the range by clicking on the color arrow bars on the gradient creator tool. Once the color bar is selected, you can select any new color from the Select Color tools directly below. You can add new bars at any interval between the top and bottom colors by simply clicking. Or, you can slide any color bars in between the top and bottom gradient color bars to create additional gradient stops. Here we added a few more stops in our gradient, including purple.

ADVANCED OPTIONS: The Advanced Options menu allows you to create your own custom gradient fills based off of the last gradient fill you selected. Gradient fills have a minimum of two colors, with one color at the left and one color at the right. The gradient will create a range between the two selected colors.

Advanced Options is where you can do all of your customization. You can adjust one of the Basic Options by moving the slider bars or by adding new stops into the gradient. To add a stop, simply click in the gradient.
It's easy to make your own custom gradient. Start with any gradient from the basic options. The gradient can be one you want to modify just a bit, or you can completely change all of it. Pick a left color and a right color. Then start adjusting and adding your own colors in between.

Adjust the transparency of a gradient to put it behind another design. Drag the Transparency option bar or type in the desired percentage where 0% is solid and 100% is completely clear.

This coffee mug in the background has two gradients: a red to pink gradient for the hearts and a gray to white gradient for the cup. Both are rotated 90° so they are vertical instead of horizontal gradients. Adjust the transparency to 50% and place text over the gradient design.

What are you waiting for? Start making gradients part of your own Print & Cut designs!

If you have an image that has lots of different parts, each individual shape will be its own gradient. If you want your entire image to have one gradient, select the image and right-click “Make Compound Path.” Make sure to do this BEFORE you fill it with the gradient. If you fill your shape with a gradient and then make it a compound path, it won’t work the same way.
Chapter Three: Silhouette Studio®

Setup and Design

FILL PATTERN

The final fill option is Fill Pattern. To apply pattern fills, select your closed line image and select any of the pattern options. The software comes with some included patterns or you can purchase patterns in the Design Store.

TRANSPARENCY: You can also adjust the transparency of a pattern by manually dragging the Transparency option bar or by typing in the desired percentage of how transparent you want the pattern to be, where 0% is solid and 100% is completely clear. Here the pattern is adjusted to 50% transparency.

MIRROR PATTERN: Some patterns are the same no matter how you rotate, mirror, or adjust them. But others have distinctive sides or directions. For patterns like this, you can Mirror the pattern.

ASPECT RATIO: Aspect Ratio controls the width to height ratio of your pattern on the screen. Choose if you want to see your pattern head-on or at an angle.

ROTATE PATTERN: Under Rotate Pattern, you can twist the pattern in any of the four standard directions, or choose your own custom rotate.

ADVANCED OPTIONS: Under Advanced Options, you can manipulate your pattern. You have complete control over how your pattern fits into your shape.
**SCALE PATTERN:** In addition, you have the ability to scale the pattern’s size to alter the pattern itself as it fills the selected shape. Do this by either manually dragging the Scale Pattern bar or entering a new percentage value of how much larger or smaller you may wish to make the filled pattern. Here is the original pattern scaled to 70%.

![Pattern Image]

**PAN PATTERN:** When you have a pattern that has unique parts (not just all polka dots or something), you can use the Pan Pattern option to move the pattern to reveal the part you want. Here are three flowers filled with the same pattern. The pattern is scaled the same for all three. The first flower reveals three white flowers within it. The second one shows two birds. The third one shows the pink flower. Move your pattern around until your design shows which part of the pattern you like.

![Flower Images]

Want to try using multiple patterns to create designs? Open a flower design. Copy the flower a few times. Start resizing and rearranging the flowers into a design you want. Then start filling shapes with your patterns. Adjust the scale of each pattern so some of the shapes have a zoomed-in close, bold pattern and some have a more subtle background pattern. You can Print & Cut the entire design, or you can separate the pieces, Print & Cut the pieces, and layer the final project.

**CREATE A PATTERN FROM AN IMAGE:** You can create patterns from your own images. That’s right! A photo can be a pattern.

Go to File > Library > Import to Library. Navigate to the image you would like to use and select it. The image will appear in the “User Designs” folder in the Library. If you double-click the image, it will open in the design screen. Or, other ways to do this is to simply drag an image from your computer into your design screen or use the Open icon to open the image into your screen.

Once your image is in your document, open the shape you want to fill with the image. Layer the shape on top of the image. Then, use the Crop tool in the Modify panel. The Crop tool will fill the shape with the pattern and crop the rest of the image away.
Chapter Three: Silhouette Studio®

S I L H O U E T T E  P R O  T I P :  I n  D e s i g n e r  E d i t i o n ,  y o u  c a n  d r a g  t h e  p a t t e r n  f r o m  y o u r  U s e r  D e s i g n  f o l d e r  t o  y o u r  P a t t e r n  f o l d e r  i n  y o u r  L i b r a r y .  T h e n  t h e  p a t t e r n  w i l l  a p p e a r  i n  y o u r  P a t t e r n  p a n e l  w h e n  y o u  a r e  i n  t h e  D e s i g n  s c r e e n .

When you use Crop to fill a shape with an image, Silhouette Studio® will treat the image like a pattern. You will be able to adjust all the settings in the Advanced Pattern options. But, it won’t be a pattern in your Library. So, if you are only going to use an image once and you don’t want it appearing in your patterns in the future, this is a good option. See page 156 for another example of how to turn a photo into a pattern.

LINE STYLE PANEL

Under the Line icon there are two options: Line Style and Line Color.

LINE STYLE

We are going to make our own super-easy design. (1) Start by making a circle using the Ellipse Tool. Fill it with black. (2) Next, make an offset using the Offset Tool. (3) Now make an offset of the offset. Select the two offsets. (4) Make a compound path between the two by right-clicking and selecting “Make Compound Path.” Fill the compound path with black. (5) Type text, fill it with white, and place it in the center of the design. (6) Now, make one last offset around your design. This line is the line we are going to adjust. Go to Line Style. Select a dotted line option. Play with changing the line thickness and choosing different line options.

There are three options to choose how the line looks at the edges. The End Cap Style option will only adjust lines that have open ends. Flat or Square provide varying sharper flat edges at the line tip whereas Rounded provides a smoother rounded edge to the line tip. (a) is “Corner” with “Flat,” (b) is “Rounded” with “Rounded,” and (c) is “Bevelled” with “Square.”
Position only matters if you are using thick lines. You can choose to put the shape outline in front of or behind the shape. You can adjust the line thickness all you want on your screen. But, if you are going to cut or sketch the design, the line will only cut as thick as the blade or your sketch pen actually is. So even though you see these cute little circles, your machine is only going to cut a single point as thick as your blade.

This method works if you are going to print your design. But if you are going to cut it out, you will need to do a little bit more. You can either see the Rhinestone section and use rhinestones to create circles around your design, use the Trace feature to trace the dots to give the circles cut lines, or use the Object to Path feature to create a ring of dots.

**PERFORATED LINES:** One of the really cool features of the Line panel is the ability to make perforated lines. This is essential for anything you need to cut, tear, or fold. Design a card. Then, select the solid fold line and change the line to a dashed line. This will give you a perforated edge, and you will get a perfectly straight fold every time!

This will give you a perforated edge, and you will get a perfectly straight fold every time!

**LINE COLOR**

While lines will default to be displayed in red, you can change lines to any color. Altering line colors does not affect their properties or how they cut. Changing line colors is helpful because you can more easily view different images or image parts, see lines in whichever color you prefer, or adjust image parts specifically with printing in mind for Print & Cut jobs.

Start with a design that requires more than one color, like this globe. Select the design from your library and double-click to open it in your design screen. And all that opens are red cut lines. What happened to the cute colors? You might be surprised that this doesn’t look like the image in the Design Store.

Unless it is a design specifically made for Print & Cuts, designs will usually just be shapes displayed with red cut lines. This can make it really hard to visualize what it will look like when you cut it out. Here is where line color is so useful.

Right-click and ungroup your design. Select the first object you want to change. In the Line Color panel, select the color for the selection, like blue
for the circle. Now you have a circle with blue lines. Select line colors for the base and the land.

**ADVANCED OPTIONS:** We did not match the colors as the original. But, if you like how the original looks, you can match it easily in Advanced Options.

This is a great place to stop if you are cutting out a fairly basic shape like this. You can see which shapes to cut out of which color paper (or whatever your material may be). In the Send panel, you can select by Line Color to cut one color at a time. To see more, see page 146.

You can either drag the target on the color spectrum to visually match the color you are looking for, type in the RGB (Red Green Blue), HSL (Hue Saturation Lightness), or HEX value of your desired color or use the eyedropper tool. (See page 78 on how to use the eyedropper to match colors). Adjust things until you get a color you like. Then, match the fill color to the line color with the eyedropper tool in the Fill panel.

Or, you can build your design by putting it on top of each other. Line color and fill color go hand in hand. If you want to further visualize your design or turn it into a Print & Cut, just fill your shapes with the same color as their line color. Use the color eyedropper tool to get the exact color.
TRACE PANEL

TRACE

The Trace feature traces imported images and creates cut lines that your machine can see. We cannot guarantee the quality of images not created by our company nor support any third-party images not offered through the Silhouette Design Store. Silhouette Studio® should not be used to trace licensed or copyrighted images which you do not specifically own.

Once you have opened an external image that you own, you need to add trace lines to it. Simply placing an image in the software won’t create cut lines. Open the Trace panel and then click “Select Trace Area.” This allows you to draw a box around the intended area of your image. You can adjust this area or move it once it is drawn.

SELECT BY COLOR PANEL

If you want to select only objects that are the same color, click the Select by Color icon located along the right-hand side of the screen.

Make sure your shapes are ungrouped. Select the lime green color. It will select the two lime green tags, one from each suitcase. This is useful if you want to change the color of these green shapes or if you want to move them and cut them from the same material. You can select by Line Color or Fill Color.

SILHOUETTE PRO TIP: For Print & Cut images you create, it can be nice to have the line color be black for everything. It gives it a nice outline.
The trace area selection provides a preview of the original image with a yellow area overlay. This yellow area is where the trace area will be applied. Adjusting the trace filters provides a more refined or more liberal application of the traced effect in the trace area. You are going to have to play around a bit to find the settings that will successfully trace your image.

**Threshold** - This determines how broadly the trace filter is applied to your image beginning with the darkest colors for low settings.

**Despeckle Threshold** - This helps eliminate noise in your trace. If you have extra small spots traced that you don’t want to traced, adjust this threshold.

**High Pass Filter** - This allows the trace lines to begin from the outside of your image and work towards the inside of the image as the filter setting is raised. If you do not wish to create a frame outline for your image, turn this option off.

**Low Pass Filter** - This allows the trace lines to begin at the center of your image and then work outwards as the filter setting is adjusted up.

Some things are easier than others to trace. If something has a simple or blank background and has defined lines, it will be easier to trace. These sunglasses are really simple. Paste the image into your design area. Under the Trace panel, select your trace area. Adjust the filters and thresholds so yellow covers the entire design. Click “Trace.” Pull the original off to the side.

Besides simple images, you can also trace photos and patterns. This pattern is from the Design Store. Go to your Library and under the Patterns folder, double-click your selected one. The pattern will open in your design area. Select the trace area. You don’t need to trace all of it; just select a piece. Adjust the filters and thresholds to get clean lines.

Select “Trace.” Move the trace lines off of the original image. Fill in the traced lines with a color.

If you want to access each shape instead of the outline of the shapes, right-click and “Release Compound Path.” Move the top shape off to the side. The individual shapes are underneath. You can move, delete, rearrange, and fill them to create your design.
**TRACE STYLE:** There are three trace styles: Trace, Trace Outer Edge, Trace and Detach. Trace is your standard trace. Trace Outer Edge makes cut lines around the outside of your shape. If you are using PixScan™ to scan in a shape and cut it out, this is an excellent option. Trace and Detach removes the traced part from your original image. It is the only feature that impacts the original image.

(1) Drag the trace area over your design. 
(2) Adjust the filters and thresholds to cover most of the dark areas. (3) Then click “Trace.” You will get a shape with lots of crazy red lines. It’s okay! This is what you want. (4) Change your line color and fill color to black.

You can create an offset for your image so you can cut it out. Simply apply an offset. Then, move the traced image to the side. Your offset probably won’t be perfect. Right-click and “Release Compound Path.” Now you can delete all of the shapes in the middle. Point edit the outline if needed to make the offset work for your image. Place the offset back around the original image.

**TRACING A PHOTO:** Here is a photo of a cute puppy. He is on a plain white background. When you are tracing a photo, try to pick one that has a plain, simple, or empty background. It will make it easier. But if you do have a background, think about using Magnet Trace to crop out the background before you trace.
Do you want to take it a step further? To get more detail, you can trace your traced image. Then, layer the two on top of each other and group them. This is a completely optional step, but it can add more detail.

**IMAGE EFFECTS PANEL**

There are many ways you can change the look of your Print & Cut image. This “Thank You” card looks awesome. It has lots of colors, which works great to show you all the ways you can change the look of this one image. The original card has yellows, blues, some purple, and muted red.

**GREY SHADE**

If you move the slider to about 50, it adds gray to the colors and mutes them a little, but they still retain some of their original hue. You can move the gray scale all the way to 100 to make all the color disappear (like pictured). Now you have a black and white image.

**COLORIZE**

Colorize is one of the coolest features ever. It can change the card in a million different way. Change the percentage and watch the colors change from blues and oranges to greens and purples to pinks and greens (like pictured at 30%).
CONTRAST, BRIGHTNESS, AND SATURATION
These all start at zero. You can adjust all of them or just one or two at a time. Use these to make your image bolder or more subtle.

INVERT
Invert flips your colors. If your background was white before, this will give you a black background. It gives your image a cool, glow-in-the-dark look.

GAMMA
Gamma starts at 50. Slide to lesser numbers for richer, more intense color (like pictured). Slide it to higher numbers for lighter, more washed-out colors.

SEPIA
This gives your image a brownish, monochromatic look. If you only adjust the strength a little, it can mute your colors without making them completely disappear into browns.
Chapter Three: Silhouette Studio®

**Setup and Design**

Silhouette Studio® can use any font installed on your computer, and you do not need to install these fonts into the program. Silhouette Studio® will simply access all installed font files and display them for you as you create your desired text. The Design Store has thousands of fonts made specifically for cutting. Check them out!

To use your fonts, click the Text tool located at the left-hand side of the screen. Clicking the left-hand icon will allow you to place a text cursor onto your workspace and begin typing directly onto the screen. Clicking on the right-hand text icon will allow you to edit your text. When you start to type text, the default font is Arial. Change your text to a fun font and fill it with color to see it better.

**TINT**

Tint gives you three options: red, green, and blue. Adjusting one or more of these will give you drastically different looks. The card is featured with a 70% red tint. It makes it have more pastel, red and pink based colors.

**TEXT PANEL**

The first section of the Text panel will display your currently selected font and size. Use the top search bar to search for any specific font by typing in the font name. Underneath that, the panel will display your “Frequently Used” and

**TEXT STYLE**

Silhouette Studio® can use any font installed on your computer, and you do not need to install these fonts into the program. Silhouette Studio® will simply access all installed font files and display them for you as you create your desired text. The Design Store has thousands of fonts made specifically for cutting. Check them out!

To use your fonts, click the Text tool located at the left-hand side of the screen. Clicking the left-hand icon will allow you to place a text cursor onto your workspace and begin typing directly onto the screen. Clicking on the right-hand text icon will allow you to edit your text. When you start to type text, the default font is Arial. Change your text to a fun font and fill it with color to see it better.

**MIX AND MATCH**

Now that you know how all of the effects work, mix them together and make your design your own. You can get a design that looks drastically different from the one you started with.

The first section of the Text panel will display your currently selected font and size. Use the top search bar to search for any specific font by typing in the font name. Underneath that, the panel will display your “Frequently Used” and
“Recently Used” fonts. This is awesome because there always seems to be at least one font that works well for just about any project. Now, you can find it easily right at the top of the text panel. Under that panel, every font you have bought or installed on your computer is listed in alphabetical order. Beneath the font list are Bold, Italic, or Underline options if they are available for that specific font.

**SILHOUETTE PRO TIP:** See how to italicize any font on page 159. To bold a text that doesn’t have a Bold feature, you can make a slight offset. And to underline text that doesn’t have an Underline feature, just draw a line using the Line tool.

**KEYBOARD SHORTCUT:** Text Tool Windows/Mac®, press T and then click your design screen to open a text box.

You may change fonts while in the Text Editing Mode and you can even use different fonts within the same text box. Apply a different font in the same text box by highlighting the desired letters and selecting the new font. If you are not in Text Editing Mode, new fonts may still be applied to selected text, but adjustments will change the font for the entire selected text box. If you are making a complicated design with multiple sizes or fonts, we recommend placing each word or phrase in its own text box so you can easily and minutely adjust your text.

**WHAT IS TEXT EDITING MODE?** Text Editing Mode is when your text is selected and you are able to type into the box in the screen. You can tell you are in this mode by the teal bar on the right-hand side of your text and bright green lines around the entire text box. When you have the text box selected without the teal slider bar appearing, the text is acting like any other object you can select and move. To enter Text Editing Mode, double-click the text.

**COMMERCIAL FONTS INDICATOR:** If you’ve ever purchased a commercial license for a font you’ve downloaded through the Silhouette Design Store, you’ll find the commercial license is indicated by a dollar sign icon next to the font in the text style tool. This helps you easily know which fonts are available to use for projects you sell.

**COLOR FONTS:** Color fonts, also known as OpenType-SVGs (scalable vector graphics), are somewhat new on the graphic design scene. Most fonts on your computer are simple fonts, meaning they do not contain things like textures, images, or multiple colors.
Traditionally, to get a font with much more graphic detail, you would have to use an SVG design. Because of this, you wouldn’t be able easily change letters because an SVG, at its core, is an image, so it is not easily editable.

Then click on the design space to place the cursor and type your desired text. It’s that easy!

Because color fonts are more graphic, they are more suited to be printed rather than cut; however, they can be cut just like any other font in Silhouette Studio® can be. So when you find a color font you love, download it and open it in the Silhouette software to see what amazing things you can do with it!

**TEXT SIZE:** The general size of your text will default to 72 point size. This refers to the font’s printed font size. Though fonts will vary because they are programmed by a variety of sources, this will generally equate to roughly a one inch height (or 25 mm). Enter any custom number by manually typing into the size box. Also, once your text is typed, you can select it like any other object and resize it by dragging the corners or using the Scale tool.

Common equivalent measurements include:

18 pt = 0.25 in. (6 mm)  
48 pt = 0.66 in. (17 mm)

24 pt = 0.33 in. (8 mm)  
144 pt = 2 in. (50 mm)

36 pt = 0.5 in. (13 mm)  
288 pt = 4 in. (100 mm)

These measurements are approximations and will vary from font to font. So, if you want a specific measurement, you should resize your text to your desired size in your design.

But color fonts change all of that and make using more complicated font designs really easy. Color fonts can show more graphic elements and can therefore be much more dynamic, and you can use them like any font in Silhouette Studio®.

To use a color font in Silhouette Studio®, install the font on your computer, just as you would with any other third-party font. There are many third-party color fonts available that are free if you are using them for personal purposes.

**NOTE:** When you go to download the color font and look at the font preview, you may not see the graphic, texture, or color components. This is normal. After you install the font and use it in Silhouette Studio® Business Edition or other design software programs that accept color fonts, you’ll be able to see the font in its entirety.

Open Silhouette Studio® and select the Text tool on the left-hand side. Go to the toolbar on top of the page or the Text panel on the right side of the page and select the color font you downloaded.
JUSTIFICATION: Text will automatically be Left justified. You can change it to Center, Right, or Full. Text must wrap onto at least two lines for this to make much of a difference. (A) is right-justified and (B) is left-justified.

SILHOUETTE PRO TIP: If you want your text to go from down to up, rotate it 180° in the Transform panel under the Rotate tab. To see more on Rotate, go to page 106

It is pretty simple to write text that’s not horizontal text on its side, but actually headed down. The teal slider bar on the right hand side of your text is the magic tool. Slide the bar to the left until it is one letter wide. It will force all the letters onto their own line. If you have a wider letter, like the “m,” it might force some of your smaller letters to the same line. Easy fix. Simply go to the line with two letters, in this case the “i” and “l,” and press a hard enter between the two. Then change the justification to center. Adjust your line spacing until your letters look good. Vertical text!

HORIZONTAL/VERTICAL TEXT: There are a few ways to change your text from standard left to right. The easiest way is to change the direction in the menu from horizontal to vertical. This will rotate your text 90° to the right. You can keep typing and your text will be flipped on its side, typing downward.

If you are working with a complicated design, or if you want complete control over your design, it can be useful to put each word or line in its own text box. That way you can adjust each specific box. Each of these words in this word art is in its own text box so you can easily apply different fonts, directions, and sizes.
**CHARACTER SPACING:** You can adjust letters from their normally programmed spacing to either bring them closer together or push them farther apart with the “Character Spacing” option.

Spacing will always start at 100% indicating spacing between characters is normal. As the number is lowered or the bar is slid to the left, the letters will come closer together. As the number is raised or the bar is slid to the right, letters will become spaced farther apart.

**LINE SPACING:** If your text has multiple lines, you can increase or decrease the Line Spacing to adjust the distance between lines of text.

Spacing will always start at 100% indicating spacing of lines are normally distanced. As the number is lowered or the bar is slid to the left, text lines will come closer together. As the number is raised or the bar is slid to the right, lines will become spaced farther apart.

(1) The “Mr. & Mrs.” text is in one text box. The text is left justified by default. (2) Change it to center justification. (3) Then, change to 80% line spacing. Experiment with your font! There are so many fonts and they are all so different so play around to find the look you like.

**SILHOUETTE PRO TIP:** Spacing is super helpful if you want to weld your text. To see more on welding, go to page 52. But, for a quick tutorial, adjust the spacing on your text so the letters overlap a little bit. Right-click and select “Weld.” Now your text is no longer “text.” It is an image. You can still drag the corners to resize, but you can’t type into it like a text box anymore. Your Silhouette won’t cut into overlapping letters.
WHAT IS “KERNING”? Kerning is the feature you can turn on or off at the bottom of the Text panel. Kerning adjusts the spacing between letters in your font so they look and fit better together. Letter combinations like “AW” will often look better kerned. It will delete the extra space between the two and make the letters fit with each other better.

CREATING STENCIL LETTERS: Any font can easily be made into a stencil font. There is not an automated way to do it, but you can do a super easy work-around to manually connect the inner parts of letters to the outside to create a bridge for stencil creations.

Type your letter. Then, draw a small box using the Rectangle tool that connects the inside portion of the letter to the outside. Select the letter and the small rectangle together. Go to the Modify tools. Select the Subtract option. Done! This option is best if you are a bit of a perfectionist and want all of your letters to have the same rectangle size cut out.

Or, you can use the knife or eraser tool to freehand your cut. This is a quicker option if you only have a letter or two you need to adjust.

SKETCH FONTS: Some fonts, like this one below, are made specifically for sketching. This font has lines that are very thin. If you try to cut it with your machine, it won’t work very well. Some fonts designed for cutting can be turned into sketch fonts by applying an internal offset. See page 116 on how to turn a cut font into a sketch font. Alternately, sketch fonts can be turned into cut fonts by applying a slight offset. For more on offset, see page 115.

TEXT TO PATH: When you are in Text Editing Mode, you can see a control point located on the left-hand side of the text box. It is a little gray and white circle with arrows. This control point may be dragged to rest directly on any line path. For example, you can create an oval with the Ellipse tool and then drag your text onto this line to get curved text.

As you apply text to a path like this, you will see a vertical bar to the left of the text. This opens a new control bar which can be used to adjust the placement of your text relative to the line making a path. This means that it may be placed on, above, in line with, or below the path.

The object used as a path will turn gray. This indicates that this image is now turned off for cutting purposes.
Draw a shape. Double-click your text. See the green box with the little compass? Drag the compass down to your line. Your text will snap to it and shape itself around the line of the shape. Drag the text around to find where it fits best. It can go on the inside or outside of the line. You might have to adjust your text spacing to make your letters fit well together on a path, especially if it tightly curves.

It is easy to take lines of text and turn them into shapes or words. Type your text and size it so it is very small. Copy and paste it over and over in the same text box. Then drag your text to the object you want to create. Adjust the spacing until it looks good. Convert it to a path, and then you can delete your shape.

You can convert your text to a path if you want to extensively manipulate it or if you want to delete the object you used to convert it to path in the first place. Once you have dragged your text to your shape, right-click and “Convert to Path.” If you try to mirror it without making it a path first, the text can get confused and flip to the bottom of the circle.
**MONOGRAM TEXT:** There are many different ways to add monograms to your design. Knowing the different types will make it easier to find what you are looking for.

**Monogram Font:** Some fonts are actual monogram fonts, meaning you use the keyboard to type the letters you want. Usually, uppercase letters are the left-hand side, lowercase letters are for the middle, and numbers and symbols make up the right-hand side. The Design Store has a variety of monogram fonts to choose from. Check your font for specific instructions.

**Monogram Letters:** Some monograms are single letter sets. This means you can combine multiple letter sets just like the previous example, or you can leave the letters all the same to emphasize the single letter. This is not text and the letters will act like objects in Silhouette Studio®.

**Monogram Letter Sets:** One of the most popular ways to make monograms is to select the individual letters from a monogram letter set. A letter set comes with the left, middle, and right monogram letters for a certain chunk of the alphabet. Select the letters you want, ungroup them, and arrange them into your monogram sequence. Make sure you know which letters come with the pack when you are browsing so you end up with all the letters you need.
**Split Monogram:** Another type of monogram is a split monogram. This is a letter or design that has a space for you to add text. Use whatever font you want to type text into the empty split part.

**Monogram Shape:** There hundreds of different monogram shapes in the Design Store. The thumbnail might display letters in the shape, but be aware that these shapes will not include the monogram letters. Use a monogram letter set or font to add letters into the monogram. Or, be creative and use a regular font to add monogram letters. Type your text, ungroup the letters so they are objects, and point edit them to fit your shape. See page 56 for an example of point editing text.
Click into your text box. You know you are ready to insert a glyph when the green box appears around your text. All you have to do is simply click the glyph you want, and it will be inserted into your text box.

At the bottom of the Glyph panel, there is a spot for recently used glyphs. Also, you can adjust the size the glyphs are displayed in the panel so you can see them more easily.

**SPELL CHECK**

Nothing can ruin a design more than finishing your project and realizing you misspelled something. Luckily, Silhouette Studio® has a spell check feature. The little blue line under your word will flag any misspelled words.

You can access the Spelling panel by either right-clicking on the word or clicking the Spell Check icon in the Text panel. The software will provide a list with recommended results at the top. If you see the word you want, you can click it from the list. Otherwise, you can select the “Spelling” option underneath these words.

In the Spelling panel, there will be a potentially larger listing of suggestions. From here, select your corrected word and click “Replace.” You can also click “Previous” or “Next” to toggle between additional problem words that may have been found.

**SILHOUETTE PRO TIP:** Sick of the little blue line on a word you know is correct (like a name)? Add the word to the dictionary or turn the feature off.

You can check and see which characters are included in every font installed on your computer. This is really useful because lots of fonts have additional characters with accent marks, even if they don’t advertise additional glyphs. Some fonts even come with bonus characters. The cake is a character in the font, not an added image.
**TRANSFORM PANEL**

Under the Transform icon, you will find:
1. Align
2. Scale
3. Rotate
4. Move

In the above example, the text stays the same while the flower left aligns with the text, scales larger, rotates clockwise, and moves.

**KEYBOARD SHORTCUT:** Spell Check Tool
Windows, press F7
Mac®, press fn + F7
ALIGN

The Align tool is a powerful way to make your designs look professional. Eyeballing works to some degree, but align is a failsafe way to get perfect projects. Plus, it takes no time! It can be used on simple things like two text boxes or on complex designs like the oven on the next page.

These two words are in separate text boxes, one on each side of the arrow. If they were in the same text box, you could use the text tools to align them. Select the two words. The objects create the bounding borders. It has nothing to do with where they are on the page, only their relation to each other. If you horizontally center align the words, they will center themselves with each other. Since we didn’t include the arrow in our aligning, the software will ignore it.

WHAT IS A BOUNDING BORDER? A bounding border (or box) is the space between two or more objects that the software will use as the edges of the design. It will use these to align your shapes. The software will take the far left-side of the left shape, the far right-side of the right shape, the top of the top shape, and the bottom of the bottom shape. This invisible square is the space Silhouette Studio® uses to align things. So if you “align center,” it is center aligning your objects within this bounding box. The placement on the page only comes to play when choose “Center to Page.”

CENTER: The first icon centers the objects to the page. The second centers two or more objects so they are exactly centered with each other.

HORIZONTAL: This aligns two or more objects so they are aligned together to the left edge/center point/right edge of the shared bounding box while maintaining their respective distances in regard to being above or below each other.

VERTICAL: This aligns two or more objects so they are aligned together on the top/center/bottom edge of the shared bounding box while maintaining their respective distances in regard to being next to each other.

The align options work with two or more shapes, but the spacing options need at least three shapes.

SPACE HORIZONTAL/VERTICAL: When three or more objects are selected, this takes all the shapes and spaces them horizontally or vertically so that they are all equidistant from each other horizontally or vertically.
Here are four snowflakes in a horizontal line. We want them aligned and spaced evenly.

First, vertically align center. Now the snowflakes are centered from the farthest top and farthest bottom. But, they are not spaced evenly. So select all of them and click Space Horizontally.

This puts equal space between each snowflake with the edges of the far left and far right snowflake acting as the bounding borders.

**ALIGNING A COMPLICATED DESIGN:** The software is much more powerful than the snowflake example. Here is a bit trickier, more in-depth example. This oven has many small parts. Start by ungrouping the design and filling each shape with color so you can see it better when you are putting it together. We changed the line color to black so everything would have a nice, defined edge. We used three colors: light gray, dark gray, and mint green.

Start with the drawer. Select the three skinny lines and group them with each other. Now move the grouped lines on top of the dark gray rectangle. Select the lines and the rectangle and click “Center.” The lines move to the center and look perfect. Now group the lines with the rectangle so you have one shape that won’t get bumped out of place.

Place the drawer shape on your oven. This time we don't want to just “Center” because the drawer isn't in the middle of the oven. We want it centered between left and right, but not top and bottom. So, select both objects and click Horizontal Center. The drawer will stay where you placed it vertically, but it will move left or right to center onto the oven shape. Now group these two.
Some of the smaller pieces layer on top of bigger pieces. Place them where they should go and group the corresponding pieces together. Where you can, ALIGN! Place the smaller circles on top of the larger ones and “Center.” It makes it so easy!

As with the oven drawer, place the handle on the oven and Horizontal Center. Do the same for the dials, screen, line, and handle. Once you have them all perfect, group everything on the oven.

Here is where we are going to do some tricky aligning. We want the two knobs to be equidistant from the screen and aligned in relation to each other. If we just align them left or right, they will both move to the same side. That is the same with top or bottom aligning. If we space them horizontally, they will go to the far left and right sides of the oven. That is not what we want. So here is a little workaround. (1) Draw a rectangle sized to where you want the edges of the knobs to be. (2) Select both circles and the rectangle. Align Vertical Center. Now, Space Horizontally. (3) Select the rectangle and delete it, since it was just to help us align. Group the circles. Now move the circles to the oven. Click Align Horizontal Center. Then group ALL the parts. Perfect! You have a precisely aligned oven!

**SCALE**

You can custom-size any object. It is important to note that while you may adjust images to any size, the quality of cuts made may vary, especially when cutting smaller designs on thicker materials like cardstock.

You can view the measurements of your image when it’s selected by the numbers on the edges of the selection box. There are also control points on the selection box for resizing images manually. To resize manually, simply click on any of these tiny boxes and drag your mouse in the desired direction to make your shape larger or smaller. The corner control points will proportionately resize the image and maintain the relative height and width, while the side control points will stretch your image in the direction your mouse is dragged.

A card is an example of something that you might need precise dimensions. The Scale panel is more accurate than manually resizing an object. This has really small pieces when it’s scaled down. Slow down your cutting speed in the Send panel so your material does not rip.
The Scale options will resize any selected image by a percentage of its current size. Any number under 100% will make your image smaller and any number over 100% will make your image larger. For example, selecting to resize an image to 50% of the current size will make the image half as large while selecting to resize an image to 200% of the current size will make the image twice as large. You can apply a custom percentage.

“Specify Dimensions” allows you to resize a selected image to any specific measurement. To size your image proportionately, click the lock icon on the right-hand side. If you are resizing a design with more than one piece, make sure you select ALL of the pieces in the design before you resize it. You can either group the design and then resize, or simply select all the pieces at once.

If you want your design to be a specific size, you need to remember which pieces are the base and which pieces will be layered on top. In this design, the polka dot sail on the side and the scalloped border at the bottom will be layered on top of the boat. So, if you want your design to be 6 in. wide, you will need to measure the design without the polka dot sail to the side. Not sure how to do this? Turn on your grid and manually size the boat (ignoring the sail on the side or scallop at the bottom). Or, place the polka dot sail on top of the other sail and the border on the edge of the boat. Group your design. Now you can size it like it is one object and specify exact dimension in the Transform panel under the Scale tab.

Maybe you want to resize just one part of your design. Either specify the dimensions for only the one selected object or use the pull circles on the corners and edges of an object. The flag was pulled longer and not to scale with the rest of the design.
The Rotate menu options will also provide additional rotation options for more exact or specific rotation options.

**ROTATE TO:** These options will rotate the selected image to the selected angle based on the image’s original fixed 0° point.

**CUSTOM ROTATE TO:** This option will allow you to either manually slide a degree measurement bar or enter a specific degree measurement to rotate the selected image based on the image’s original fixed 0° point.

**ROTATE BY:** These options will rotate the selected image by the selected common angle from the image’s current angle.

**CUSTOM ROTATE BY:** This option will allow you to either manually slide a degree measurement bar or enter a specific degree measurement to rotate the selected image from the image’s current angle.

To rotate an object to right angles, hold Shift while you are rotating the object with your mouse. It will snap to right angles.

**FLIP:** Flip is not an icon or option under Rotate, but it is a useful tool to know. “Flip Horizontally” is the best option to use when you need to mirror your design when cutting media like heat transfer. It will keep your design where you placed it on your page, just flipped. In the Replicate panel, the “Mirror Left” or “Mirror Right” will copy your design and place it to the right or left, while the flip function will keep your design in the more or less same position and flip it without making a copy.

**SILHOUETTE PRO TIP:** If you are cutting small letters or designs out of a material that is not adhesive, you can cut letters out backwards (or flipped) so that you can apply adhesive onto the backs of the letters after they have been cut, but before they are removed from the cutting mat. By placing adhesive onto the back of the letters, you can simply pull them off the cutting mat and place them onto your project.

To flip your design, right-click your image and choose “Flip Horizontally” or “Flip Vertically.”

Sometimes, your design will be more or less symmetrical and it won’t matter that much if your design is flipped or not. But, if you are using heat transfer and cutting words, make sure to flip your design! You don’t want backwards words on your project!
MOVE
You can move and position images by selecting and dragging them around the screen with your mouse. You can also move an image by selecting it and then pressing the arrow keys on your computer keyboard. But, if you want a more precise way to move an object, use the Move panel.

MOVE BY: The Move By directional arrows will move images just a little bit in whichever direction you select. Choose how far you want your image to move in the Width box.

MOVE TO: Move To will move your image a specific measurement. You can choose where to base the measurement from (top, middle, right, etc.) on the little square on the left-hand side.

Turn on the grid (by either right-clicking your workspace and selecting “Show Grid,” pressing G on the keyboard, or opening the Grid panel) to see what is happening better when you are moving objects.

SILHOUETTE PRO TIP: The Grid settings on the ski image are adjusted to one inch so it looks like the cutting mat. But, if you want to see an actual cutting mat, turn on “Show Cutting Mat” in the Design Page Settings. See page 69.

SNAP TO GRID: Sometimes, when you move your shape with the arrow keys, it might seem like it jumps an entire inch instead of scooting a tiny amount. This is a simple setting to adjust.

For example, take a look at this dinosaur design. It is made of two separate pieces: the darker bottom one and the lighter top one.

Once you have them filled with color, layer the lighter piece onto the darker one. Simply select it with your mouse and drag it on top. To get it perfectly layered, zoom in close and use your
arrows to minutely move the lighter shape to sit exactly where you want on top of the darker one.

---

Is your shape moving too far with a single arrow tap as shown above from image (1) to (2)? This indicated you have a setting turned on called “Snap to Grid.” In the Page panel under Spacing, there is a box to “Snap to Grid.” Even if your grid is turned off, if you have that box checked, your shapes will try to line up with the grid lines. If you turn your grid on by checking the box or pressing G, you can see the lines your shape is trying snap to. Simply uncheck the “Snap to Grid” box to move your shape in as small of increments as you want.

---

**REPLICATE PANEL**

**DUPLICATE**

This makes an identical copy to the left/right or above/below the original.

**KEYBOARD SHORTCUT:** Duplicate Object

Windows, press Ctrl + ←↑→↓←

Mac®, press Cmd + ←↑→↓←

The arrow press will be the direction the duplicate will be placed.

**ROWS AND COLUMNS:** This duplicates the number of copies to the right or below as closely as possible to maximize your cutting area.

---

Stamp 1 by Silhouette

*Design ID: 56767*
**FILL PAGE:** This copies and replicates your selected object and fills the cutting area with as many copies possible. The software won't rotate your objects to fit them on the page. If you want to fit more on the page and don't mind if your objects are rotated, see the Designer Edition Nesting option on page 161.

**MIRROR:** This mirrors your design to the left/right or above/below the original. Mirroring is a good option when cutting heat transfer. But, if you want your object to stay in the same position without replicating, we recommend you flip horizontally. For more, see page 107.

**KEYBOARD SHORTCUT:** Fill Page  
Windows, press Ctrl + Shift + F  
Mac®, press Cmd + Shift + F

**ROUNATE COPIES:** You can choose to rotate one, two, three, or five copies of an object. This adds copies of your object on top of your original, but rotated. It can be very useful when making geometric designs or flowers.

1. Open a petal design or draw your own.  
2. Click the rotate three or five copies icon.  
3. Select all of the petals together. Right-click and select “Weld.” Now you have a custom-made flower. Draw a circle and fill it with a color. Then place the circle on top of the flower as the middle. You’ve made your own flower!

**KEYBOARD SHORTCUT:** Mirror Object  
Windows/Mac®, press Alt + Shift + ←↑→↓←  
The arrow press will be the direction the object is mirrored.

If you want to rotate an object without making a copy, see the Rotate function on page 106.
NUMBER OF COPIES
Replicate can come in handy if you are creating your own patterns or designs. (1) Draw a square. (2) Make four copies right and four copies down. You have a perfectly spaced square pattern. (3) Fill the squares with color. (4) Add an offset for a border and text to the front.

You can also use the combined Right/Down feature to set custom X and Y offsets to make diagonal copies.

OBJECT ON PATH
(1) Begin by opening or creating by the object you want to put to a path and the shape of the path. In this case, we have a flower as the object and a rounded square as the path. Make sure that your object is quite a bit smaller than the path to get the best results. Select your flower and click “Show Grab Handle.” A small circular handle will appear in the center of your object.

(2) Similar to Text to Path, drag this little handle onto the path with which you want your object to interact. If you don’t want to replicate your object, you can end here. (3) You can put as many objects onto the single path as you would like.

(4) But, if you would like to replicate the object to cover the entire path, simply select the object and drag it along the path. It will populate the entire path, creating a flower frame. Play with the drag handle to space the flowers closer together or farther apart. In the object menu, adjust the angles, start position, and more.

SILHOUETTE PRO TIP: Make copies by selecting your shape, pressing and holding Alt, and dragging copies away from the original.

If you click “Release Copies” it will release your objects and they will no longer be on the path.
MODIFY PANEL

The modify panel has a variety of options to change how overlapping objects interact with each other.

WELD: When you weld two objects, they will both take the color and properties of the bigger object. If you want them to both have their respective properties and colors, you should group the two objects instead of welding them. For more on grouping, see page 49.

Weld is in the Modify panel, but you can also access it by right-clicking an image. Welding takes two or more selected overlapping images and joins them together into one single continuous image. Welding is particularly useful when cutting objects that touch so the cut lines don’t overlap and cut into each other.

If you weld the cupcake with the pink frosting on the brown bottom, you will get one solid pink cupcake shape. To see more on welding, see page 52.
If you type a word and your letters overlap, you will want to weld the word before you cut it. If not, your Silhouette will cut each individual letter, even if it cuts into another letter. This is also helpful if you are working with tricky material like vinyl. When welded, instead of having seven individual letters, you have one continuous image.

**There is an auto-weld feature in the Send panel. See page 147.**

**DIVIDE:** Divide creates individual objects from the intersections of your selected images. When you draw a rectangle over the tile and then Divide, it creates tiny individual shapes from the tile that you can move and edit. When you divide the cupcake, it makes three shapes.

**SUBTRACT:** Subtract removes all of the overlapping parts of images that are in front of other images. Only the back image will remain with the overlapping parts removed.

**SUBTRACT ALL:** Subtract All removes any portion of an image that is hidden behind another image. We have three cupcakes here, and each have two parts. So, in total we have six parts. If you select all six of them and Subtract All, everything your eye cannot see will be deleted. Only the parts showing in the front will be left. This can be helpful if you are trying to conserve materials or if you want to layer materials without adding bulk.

Subtract can be your best friend if you are layering something like heat transfer. Type the word “cupcake.” Then make a copy of your text and place it on the side. Layer your “cupcake” text on top of the cupcake. Select both the text and the cupcake and select “Subtract.” This will make a path in the frosting where the words cut through. Now you have perfect way to make
CROP: Crop removes all areas that are not shared by at least two shapes when overlapping. It can be similar to intersect.

INTERSECT: Intersect will leave only the overlapping part, or intersecting part, of the selected images. If you only intersect two things, it can work like crop. But if you intersect three or more things, it will only keep the parts that overlap with all of the selected shapes.

Draw a circle and a square. Place both on your tile. Intersect will only keep the small triangle where all three objects overlap.

MAKE/RELEASE COMPOUND PATH:
The tile is already a compound path. When filling the original shape, some parts filled with black and some parts remained white, acting as a window to the white design screen background. The compound path acts like a cookie cutter on your shape. It punches the little shapes through the shape. But, if we release the compound path, the little shapes won’t punch through. They will simply lay on top of the black square.

Compound paths don’t affect how your machine sees the lines or how it cuts them. It only affects how shapes fill with color and how you view them on your screen. For more in-depth info on compound paths, see page 43.

Some shapes from the Design Store will need to be made into compound paths from the very beginning. To see an example of this, go to page 43.
DETACH LINES: When images are filled or have thick lines, you can detach the lines and move the outline to create two separate images. One image will have only the lines and one will have only the filled effects.

Clicking the offset action button provides a starting point. You can fine tune the offset effect to be as wide or as skinny as you’d like with the slider bar or by typing in a specific measurement.

Once your offset looks how you want, click “Apply.”

Here are a bunch of flowers filled with deep red. Make a simple offset. Change the fill color of the offset from clear to orange. Now those red flowers really POP!

If you are working with a delicate material, you might find a design you love, but it has thin and delicate lines. Long and thin lines can be frustrating to work with when paired with certain materials. Here is where you can use an offset. Select your design and apply just a small offset, like 0.05 in. Delete the inner, original design. Now the lines aren’t as thin so it is easier to work with, but it still is the same adorable design.

OFFSET PANEL

Offset is a very useful tool. Once you get the hang of it, you will want to use it all of the time. The Offset option will outline images with cut lines, giving the image a shadowed mat effect underneath it. It can also be used to create contoured inner lines for images.

To apply an offset, select your image. Then go to the Offset panel or right-click your image and select “Offset.” You can choose to either have your offset image have a sharper corner appearance, or have a softer, more bubbly, round appearance.
Make an internal offset on already thinner text to custom-make a sketch font.

OFFSETS AND COMPOUND PATHS: You can use the offset feature to change a simple shape into an outline. Select your shape and make an offset. Select both of the shapes, in this case circles, and right-click “Make Compound Path.” Now when you fill with color, it won't fill the entire circle. It will fill the space between the two circles, giving you a nice outline.

Any shape or text can be made into a pop-up. Pop-ups work best with designs that are thicker so that the pop-up has a solid base.

Start by designing your pop-up. This adorable tea cup is actually three colored teacups layered on each other. To create the pop-up, we just want to use the base shape. We will cut out the other two shapes normally and layer them on top when the pop-up is finished. If you are making a Print & Cut into a pop-up, group your shapes. The pop-up feature will see your grouped shapes as one shape.

Select the dark pink base shape. Go to the Pop-up Panel and select “Convert Selected Shapes to Pop-up.”

This teacup pop-up is going to be in a card, so use the Rectangle Tool to draw a card around your teacup. This is important so you can adjust your pop-up to the size of the card.

Once you have your rectangle, center your pop-up shape within the right and left sides. The long perforated line toward the bottom of your pop-up shape will be the fold of your card, so you will want this line in the middle of your rectangle. Pull
the red lines on either side of the perforated line to adjust the fold line to the width of your card.

The Base Width adjusts how much of the bottom of the design is connected to the page. The Minimum Strut Width adjusts the number and size of pop-up connections. The Dash Pitch adjusts the width of perforation on the fold lines. Play around with adjusting these settings until you find the ones that work the best for your card.

Once you have pulled the fold line to the edges of your card, you are ready to cut. Send the pop-up design to your Silhouette.

After it has cut, carefully fold the design on the perforated lines. Cut out the other layers of your cup and attach them to the front. Add text to the bottom of the card, and that’s it! You made your own unique pop-up card.

Designer Edition offers you more control with your pop-up designs. You can adjust the size and number of tabs as well as have multiple drag handles to create objects with different pop-out distances.

Stippling is the process of marking a material’s surface with numerous small dots to make a pattern. Curio and the Cameo 3 create stipple points by either converting lines into stipple points or by converting imported print images into stipple patterns. To use the Stipple option with your Curio, you must use either a Stipple Tool or a felt tip pen. If you use your Cameo 3, you can only use a felt tip pen.

Stipple edge will only apply a stipple to the outside cut lines. Often, you will want to add a stipple edge in conjunction with a stipple fill so you can clearly see the shape you are stippling.

Selecting one of the Stipple Fill types (patterns or shapes) will fill the selected line image with your desired pattern or shape. Only one option can be selected at a time. The following settings can be adjusted:
STIPPLE TRACE

The Stipple Trace section lets you convert imported images (such as JPG and PNG) into stipple patterns. (1) Open an external image you own, like the pineapple. (2) Click “Select Stipple Area.” This allows you to draw a box around the intended area of your image in order to create a stipple pattern. Once you draw your box, this selected area may be adjusted or moved like any other object. This box provides a preview of the original image with a black-dotted image showing how the intended stipple points will be created layered on top of it.

Now, adjust your Stipple Options. Some stipples will need fine tuning to get your desired look.

Try a few different ones to find something you like. (3) Then, click “Create Stipple” to create your pattern.

- Grid Spacing: Zooms the selected stipple in or out.
- Stipple Spacing: Controls stipple point spacing to either be closer together or spaced farther apart.
- Scale Factor: Scales the points.
- Angle: Controls the angle of the stipple fill.
- Offset: Controls how close to or far from the edge of the filled shape the Stipple Fill will appear.

The Stipple Size option adjusts the display size of the stipple points on your screen. This does not control the actual resulting size of the created stipple point. This is for display purposes only.

When the “Print Stipple” option is checked, your image can be sent to a printer to simply print your stippled design.

- Grid Spacing: Specifies the distance between rows and columns of the square grid where the stipple points are positioned. Lower values provide a finer grid.

- Invert: The invert check box will have the contra-positive image traced.

- Density: Generally, lighter regions of the drawing will be populated with fewer stipple points and darker regions are more densely populated. The darkness of any region is magnified by adjusting the Density setting.

- Refinement: Stipples are rendered at the points of a small invisible square grid, the spacing of which is defined by “Grid Spacing.” Some Stipple Style options allow this to be adjusted so that the stipple points appear at half, third, or quarter grid squares. Higher values provide a more randomized display of stipple points which may have a more natural or less blocky appearance.

- Stipple Style: Various stipple styles and settings can be adjusted to provide altering stipple effects.

- Scale Factor: Scales the points.
- Angle: Controls the angle of the stipple fill.
- Offset: Controls how close to or far from the edge of the filled shape the Stipple Fill will appear.
**EMBOSS PANEL**

**EMBOSS/DEBOSS**

Some features found in Silhouette Studio® are only intended to be used with a Silhouette Curio™. Curio alone provides these select options that other Silhouette machines cannot.

At the top of the Embossing menu, you will find an option to select either “Deboss” or “Emboss.” These options apply to the entire document and are not object-specific.

- When you select “Deboss,” your design will be processed as it is viewed on screen. The action of the embossing tool pressing down onto your material will create a recessed relief of the image, or Deboss effect.

- When you select “Emboss,” you will continue to see your design as is, but your job will be flipped horizontally when processed so that the entire page is mirrored. The action of the embossing tool pressing down in a mirror image will allow the material to be flipped over after the job is completed to display a raised image, or Emboss effect.

To apply an embossing effect, select your image and then select the effect. The mountains on the left are filled with “Parallel Lines” while the ones on the right are filled with “Concentric.” Play around with the options to find the one you like for your design.

- Spacing controls how compact or spread out the applied Effect will appear.

- Angle controls the applied angle of the selected Effect.

- The Spacing and Angle options are dynamic and will automatically adjust when images are resized or adjusted. However, if you wish to set these options to be static after they are created to your liking, click “Release Emboss.”

**SCORE & EMBOSS**

This feature is intended for use with Silhouette brand “Score & Emboss Paper.”

The Score & Emboss option is a special action that will first score around the edges of your image with a blade, and then will press inside of the score line with an embossing tool. The resulting effect provides a more dramatic deboss relief or raised emboss effect.
To Score & Emboss your image, begin by selecting the Embossing Tool type in the Score & Emboss tab. Selecting the “Fine” embossing tool will provide a more pronounced emboss/deboss effect and will place the emboss line closer to the score line. Selecting the “Wide” embossing tool will provide a softer emboss/deboss effect and will place the emboss line farther from the score line.

By default, the image will only be embossed a single time close to the score line. The “Passes” option allows you to add an additional number of impressions made inside of the score line. “Fill” fills your image entirely by a series of emboss lines. Once you have all settings adjusted, select the image and click “Apply Score & Emboss Lines.”

The action to “Apply Score & Emboss Lines” will automatically set up your job to be scored and then embossed.

Notice that the red score line and the blue emboss line are more or less on top of each other.

PRINT & EMBOSS

The Print & Emboss option is similar to a regular Print & Cut which uses registration marks to provide proper alignment to cut around a printed image. Print & Emboss jobs allow you to print an image and then press down onto the opposite side of the printed surface with an embossing tool. This produces a printed image that is embossed, providing a dramatic and detailed effect. The embossing lines can either be the outline edges or filled in according to the Emboss/Deboss options in the Emboss/Deboss tab.

Begin by placing your print design into your design screen. Create embossing lines around or within your image.

The flourish on the left is the original Print & Cut. The image on the right contains the concentric embossing lines. Layer your embossing lines on top of your design. Make sure you have both your print lines and your embossing lines ready before you send your design to your printer. If you leave your embossing lines to the default red lines, Silhouette Studio® will not send them to be printed.

Now go to the “Print & Emboss” section in the Emboss tool panel. Three steps will appear to help guide you through the process. Make sure
you have added registration marks to your design. Click the “Print” button under Step 1. This will send your design to your printer with the printed registration marks. The red emboss lines will not be printed.

Now, under Step 3, click “Emboss.” Make sure you have your cut settings set up so your embossing tool is selected.

As your machine embosses, the back of the page will be indented along the embossing lines. This raised emboss effect will be visible when you look at the design from the front.

SILHOUETTE PRO TIP: It is recommended to allow ample time for ink to dry prior to placing it face down onto the embossing mat because some ink may transfer onto the embossing mat. It is normal and will not negatively affect your future mat use, but it can be avoided if you wait for your print to dry.

Preferences

You can adjust a number of preferences in the Preference menu at the lower right hand side of your screen. Knowing the different preferences can help you with your design projects.

KEYBOARD SHORTCUT: Show Preferences
Windows, press Ctrl + K
Mac®, press Cmd + K

If something isn’t working exactly how you want, like your knife tool seems to follow you around after you have made your cut, check here to adjust your settings.
GENERAL

LANGUAGE: Silhouette Studio® offers 25 different languages in which to view the software. So find the one you are most comfortable with and get designing!

CHECK FOR UPDATES: We recommend you check for updates to the software regularly. While it is not required to update your software, the updates are usually to fix bugs or add additional features. Some machines need at least a certain version of our software to run.

DEFAULT SAVE LOCATION: Where you save your .STUDIO files is completely up to you. There are two options for the default save location: Hard Disk or Library. Hard Disk will lead you to save your file onto your computer. Library will save your file into your Library tab in Silhouette Studio®. Setting one as your default does not mean you can’t save to the other version whenever you want.

UNIT OF MEASUREMENT: Silhouette Studio® defaults to inches, but it is easy to change! Select millimeters, centimeters, meters, or feet to help you size your design. You can change it for individual projects, like using feet instead of inches if you are doing a much larger project than usual.

SHOW DIMENSIONS: You can click to show or hide dimensions. When you select an object, numbers will run along the bottom and left-hand side measuring the size. Turn it off if it bothers you or keep it on to size your designs with ease.

PRINT RESOLUTION: Choose the dpi that works best for your printer.

DEFAULTS

PAGE ORIENTATION: You can choose if you want landscape or portrait as your default page setup. But, if you want to change it project by project, use the Page panel.

DEFAULT FILL STYLE: Outline only is the default for Fill Style. This means when you draw a shape or type text, the lines are red and the fill is clear. You can change it to Solid Fill if you prefer. This will fill any shape created with a blue fill and dark gray lines. You can change line and fill color for any object after it is created.
**ALWAYS DISPLAY MAT:** Check to display or to hide the cutting mat permanently.

**CUT TO EDGE OF PAGE:** Check or uncheck “cut to edge of page” to choose if your machine will cut to the very edge of the material or leave a sliver of extra space on the edges.

**REGISTRATION MARKS:** Registration marks are defaulted to off, but if you are regularly doing Print & Cuts, go ahead and turn them on! Remember, when you are in the Design Screen, you can turn registration marks off and on by pressing “M.”

**CENTER OF ROTATION:** Center of rotation is the point that your object rotates around. This is a good feature to know how to turn off and on. If it drives you crazy, turn it off by pressing “O” or here in Preferences.

**SET OF THREE ORNATE BORDERS**

| by Emily Dyer |
| Set of Three Ornate Borders | Design ID: 56142 |

**OVAL FLOURISH FRAME**

| by Sophie Gallo |
| Oval Flourish Frame | Design ID: 152125 |

**SET OF THREE ORNATE BORDERS**

| by Emily Dyer |
| Set of Three Ornate Borders | Design ID: 56142 |

**SET OF THREE ORNATE BORDERS**

| by Emily Dyer |
| Set of Three Ornate Borders | Design ID: 56142 |

**PANEL MODE:**

- **Single Panel Mode:** Only one panel can be open at a time. If you have a panel open and you click another icon, that panel will open in place of the panel that was previously open.

- **Flexible Panel Mode:** Default. Similar to Single Panel Mode, Flexible will seemingly not allow you to have multiple panels open at once. But, if you move a panel from the default location, it will remain open when you click another panel icon. If you leave the panel in the default location and click another icon, the new panel will open in its place.

- **Multiple Panel Mode:** All new panels will open no matter how many panels are already open.

**SILHOUETTE DEVICE CONNECTIONS:** If you have more than one Silhouette machine, you can choose if the software auto-releases or keeps the connections.
**DISPLAY**

**ANTIALIASING:** This smooths jagged edges on curved lines and diagonals. The higher the sample, the smoother the image is.

**CURRENT THEME AND BACKGROUND COLOR:** There are three themes to choose in Silhouette Studio®. You can cycle through the themes by clicking the rotating arrows icon next to the Preferences icon.

**BUTTON SIZE:** Adjust the button size to smaller or larger, depending on your viewing preferences.

**ANIMATION:** Adjust the animation to be faster or slower, depending on your viewing preferences. When it is faster, if you undo something, it does it instantly. When it is slower, you will be able to see the shapes move and rotate during the undo process.

**CURVE QUALITY:** This involves the pixilation on curved lines. It has nothing to do with the cut quality. It is only for display purposes.

**IMPORT**

**IMPORT:** All of the import options allow you to decide how you want your imported GSD, SVG, or DXF file to appear. You can choose where on the page to open your file, whether or not to convert white lines to black, and if you want to join lines into polylines. Adjust the settings to find what import options work best for you.

**TOOLS**

**ACTION AFTER TOOL USE:** This section of preferences is so useful to know! This is all personal choice, so find what works best for you. Choose if you want to continue using a tool when you select it and manually choose the selection tool after you are finished, or if you want to use the tool once and then automatically return to the selection tool. For example, if you “choose select” after creating a shape, you will draw one circle and then your mouse will return to the selection tool. If you have “continue drawing shapes” selected, you can draw circle after circle until you manually select the selection tool.

**SELECTION TOOLS:**

**When Drag Selecting:** Drag Selecting is when you select objects by holding down your mouse and drawing a selection box around the shapes you want. You can choose if you want the marching ants selection box to select any shape the box touches, or only the shapes the box includes. This is a very useful preference to know because it is a tool you will use very often.
**Chapter Three: Silhouette Studio®**

**Setup and Design**

**When Many Shapes Selected:** You can choose to make single or multiple bounding boxes when you select multiple shapes. If you choose single, all the shapes you select will be grouped in one box. The dimensions on the side will measure for all the shapes together. If you choose multiple, it will show each shape in its own box showing its own dimensions.

The set of paddles on the top has only one bounding box, while the one on the bottom has multiple bounding boxes.

**When Right-clicking Subsequent Shapes:** When you have a shape selected, and you right-click a DIFFERENT shape, you can either choose to have the new shape become selected and the right-click window open or the original shape remain selected and open the right-click window for that shape. In this example, the gold shape is selected first and remains selected in the left example. In the right one, “new shape becomes selected” is checked and the teal shape becomes selected after the right-click.

**EDITING TOOLS:**

**Show Bezier Control Handles for:** When you are in point editing mode, you can adjust how you view points on a curve. Default is to only see the bezier toggle lines when you have a individual point selected. If you select “All points,” you can see all the toggle lines at once.

---

**Select only encompassed shapes**

**Owl | by Ty Pilcher**

Design ID: 34590

**Paddles | by Nic Squirrell**

Design ID: 149939

**Banners | by Teresa Collins**

Design ID: 119513
When you view the two options in the Cut panel, “convert thick lines to polygons” is option “a,” giving you a two shapes. “Maintain thick lines as lines” will give you just one shape, option “b.”

This feature works the same using Subtract, Subtract All, and Eraser.

### ADVANCED

**RESET LIBRARY:** This will remove everything from your library and reset it back to the original installation settings.

**RESTORE PRE-LOADED DESIGNS:** You should only need to adjust this setting if the designs your machine came with disappear.

**SET LIBRARY PERMISSIONS:** You should only need to adjust this setting if there is a problem with your Library and it appears blank, even though you have purchased or created designs.

**RESTORE FACTORY DEFAULTS:** You can restore the default settings at any time.

**OPENGL SETTINGS:** Here you can adjust select display issues.

**HTTP SOCKETS:** Depending on your internet connection speed, this option may be adjusted to a higher number of sockets to increase the download speed when purchasing images from the Silhouette Design Store.
**PACKET SIZE:** The amount of information being sent to your Silhouette. The default is 1,000. But, if you are frequently sending intricate designs, you can lower the packet size. It won't change any cutting aspects of your machine, just the rate of information being sent. This can prevent your machine from becoming overwhelmed.

**PROXY SETTINGS:** Use this for proxy connection setups.

**USE IME:** This allows you to type non-western characters.

**SOFTWARE OVERCUT:** Beginning and ending cut points minutely overlap each other, ensuring they connect to produce a clean cut.

**INCLUDE CUT DATA:** This includes cut settings in the saved file and is necessary when cutting from a USB.

### Theme

Clicking on the Arrow circle icon located at the bottom right will cycle through a pre-selected list of color themes for the software’s overall appearance.

**THAT’S IT!** You have made it through every single icon in Silhouette Studio®! Now it's time to start designing your projects. Browse the Design Store and find things you like. Inspiration is all around you.

1. Text
2. Print & Cuts
3. Cards
4. 3D Shapes
5. Banners
6. Phrases
7. Cut Files
8. Sketches
9. Print & Frame
10. Ready, Set, Make
11. Monograms
12. Rhinestones
Chapter Three: Silhouette Studio®

Setup and Design

5. Party Banners | by Loni Harris
   Design ID: 43088

9. Abstract Watermelon Print and Frame | by Silhouette
   Design ID: 99609

   Design ID: 125138

10. Floral Napkin Ring | by Silhouette
    Design ID: 1330

7. Sea Shell | by American Crafts
   Design ID: 19298

11. Flamingo Monogram | by Sophie Gallo
    Design ID: 88271

8. Cool Elephant Sketch | by Cali Arroyo
   Design ID: 44557

12. Monogram Ring Font | by Rivka Wilkins
    Design ID: 79852

   Rhinestone Umbrella | by Silhouette
   Design ID: 23797
Welcome to the Design Store! We have thousands of designs that are waiting for you to turn into projects. You can download images using any major credit card, through PayPal®, through download cards, or by using subscription credits. Once you purchase the design, you can use it as many times as you want without having to connect to the internet to access your designs. This means that designing in Silhouette Studio® eliminates lag time between performing an action and having it happen on your design screen. And if your computer crashes or some other accident happens, don’t worry! Any design you download from the Silhouette Design Store is recoverable. Plus, you can access your designs from multiple devices. View the video.

ACCESSING THE DESIGN STORE

The Design Store is accessible through Silhouette Studio® using the Store tab or online at silhouettedesignstore.com. You can browse, shop, and purchase right from the comfort of your home 24 hours a day, 7 days a week.
CREATING A SILHOUETTE ACCOUNT

1. Click the Store tab while in Silhouette Studio® or navigate to silhouetteamerica.com from your internet browser.

2. Click the “Sign In” link at the top of the screen.

3. You will be taken to the Sign In screen. Underneath the “Sign In” button, there is a prompt that reads, “Don’t have an account? Sign up FREE.” Click “Sign up Free.”

4. On the next screen you will be prompted for your name, your email, a password, and your current country of residence.

5. Click “Sign Up.”

An email will be sent to you from support@silhouetteamerica.com asking you to validate your email address. Click on the link included in the email to activate your account. Once you have validated your email address, you are ready to use your account.

MANAGING YOUR SILHOUETTE ACCOUNT

Once logged in to your account, you will find your profile thumbnail in the upper right-hand corner with your credit amount (if any). When you hover over this corner, a drop-down menu will appear with several options for you to select, including account options. Here you can see when any of your subscriptions expire and manage your Library devices (or devices linked to your Silhouette Library).

If you click on your profile thumbnail or on “Account Settings” in the drop-down menu, you will see the following options:

- **Change My Account Info/Preferences:** You can update your email and password.

- **My Designs:** You can see all of the designs you have purchased.

- **My Download History:** You can view a copy of all the orders you have placed. If there was a break in connection during the download process, you may also opt to recover a specific order.

- **My Purchased Design Licenses:** You can look at all of the designs you have purchased a commercial license for.

**NOTE:** Are you missing a confirmation email? Check your spam or junk folders to make sure that the email hasn’t been caught by your filters. If this is the case, make sure you change your filter settings to allow messages from support@silhouetteamerica.com and no-reply@silhouetteamerica.com.
Recover All Downloaded Designs: You can recover any and all previously downloaded content if you are seeking to load the software onto a new computer if your computer has crashed or you are replacing your computer.

Add a Download Card to My Balance: You can enter a download card code to apply to your account.

Redeem a Promotional Download Card: You can redeem a promotional download card that was included in a starter kit.

Manage My Credit Cards: You can manage your credit card information on file.

Manage Library Devices: You can see your current devices active with Silhouette Library. Up to five devices are accessible with the Library.

Subscription management tools are also available on this page.

Navigating the Design Store

The Design Store is available from within the Silhouette software and at silhouettedesignstore.com. Navigating the Design Store is the same in both.

Along the top of the website is the Design Store menu. You can use it to see what’s new, view our artists, browse all available designs, and navigate to other specific parts of the Design Store (like Free Designs and Ready, Set, Make).

NOTE: Ready, Set, Make is a section in the Design Store where you can find dozens of ready-made projects with instructions to help you create the featured project. When you purchase a project from Ready, Set, Make, you get all of the included designs at a discounted price.

Are you browsing the Design Store and see something that you love, but you aren’t going to buy it right now? Add it to your Wishlist by clicking the heart icon below the design, and we will keep track of it for you. Come back whenever you like and purchase those must-have designs.

FREE DESIGN OF THE WEEK

Get out your planners and circle every Tuesday! Each week on Tuesday a new Free Design of the Week is released. You can also view other free designs by clicking “Free Designs” in the navigation menu at the bottom of the page. The free shapes will be added to your shopping cart with a value of $0.00.
READY, SET, MAKE
We have dozens of sets of ready-made design bundles, complete with written instructions to help you create the perfect project. When you buy designs in a Ready, Set, Make package, you get all of the designs at a discounted price. You can make the project with the instructions included, or you can use the project as inspiration and make your own.

SALES, PROMOTIONS, AND OTHER DOWNLOAD CARDS
Everybody loves a sale! Sales usually coincide with holidays like Halloween or Valentine’s Day and other promotional events. Sales and all other promotions will be advertised on the Design Store main page, in Silhouette newsletters, and in your notification center. Follow us on social media to see sales easily.

BUNDLES
Bundles are groups of designs that you can buy at a discounted rate. Each bundle has a theme that goes along with the season, and Silhouette changes up the bundles regularly, so make sure you keep checking back to see what new bundles will catch your eye!

DAILY DEALS, WEEKLY STEALS, AND LAST-CHANCE DESIGNS
Hello bargain, shoppers! With Daily Deals and Weekly Steals, there are new discounts every day. Daily Deals are changed every 24 hours and are marked down 30% (40% on Fridays) while Weekly Steals reset every Tuesday and are half price. You’ll have to check each day to see what’s on sale!

One of the deals that you can take advantage of at the Design Store are Last-Chance Designs. These are designs that are going to be leaving the Design Store soon, but Silhouette is going to give you one more chance to get them before they are gone for good. The best part is these designs are up to 75% off!
Chapter Three: Silhouette Studio®

Store and Library

Design Types Available in the Design Store

Some designs are specifically created for a certain type of project. The little symbol near the price of the design will specify what type of design the shape is. Knowing the difference between designs is important because you might buy a super cute design thinking it is a Print & Cut. Then, when you open it in Silhouette Studio®, you’ll be disappointed when it is just red cut lines and not the cute colors you expected. Play around and try some of each!

**Design Types**

- **3D**
- **Font**
- **Print & Cut**
- **Printable Patterns**
- **Rhinestone**
- **Sketch**

**Cut file:** Most designs in the Design Store are cut files that communicate with your Silhouette cutting machine, letting it know where and what to cut.

**Printable patterns:** You can fill an object or shape with any pattern. Printable patterns can be used with your home printer the same way as Print & Cuts. For more information, see page 156.

**3D Print:** The 3D Print designs are specifically created to be printed with the Silhouette Alta® and a plastic material called PLA filament.

**3D:** A 3D cut file lets you take two-dimensional material (like cardstock or chipboard) and create a 3D object, like a box or an ornament. 3D cut files require some assembly depending on the complexity of the design.

**Printable Patterns:**

- **Wild & Free** by Rivka Wilkins
  Design ID: 76452
  $0.99

- **Tropical Leaf Pendant** by Silhouette
  Design ID: 269301
  $2.99

- **Suit and Tie Box** by StudioIlustrado
  Design ID: 125060
  $2.99

- **Printable Patterns:**
  Design ID: 29090
  $0.79

The prices of the examples on this page may be different than actual price. To see actual pricing go to silhouettedesignstore.com.
**DESIGN TYPES**

- **3D**
- **Font**
- **Print & Cut**
- **Rhinestone**
- **Sketch**

**Font:** Fonts allow you to type text with your keyboard into your design area. Fonts work with almost any text or symbol, letting you create the look you want with your unique text.

**Premium Fonts:** Premium Fonts are just like regular fonts except they come with more glyphs (extra characters or letters and symbols with extra flourishes). Some Premium Fonts even come with a few different fonts or even dingbats.

**Print & Cut:** A Print & Cut is a type of cut file that uses your personal printer to print designs and then uses your Silhouette to cut out the designs. For more information, see page 303.

**Sketch:** Cut files that are designed specifically to use with drawing tools, like Silhouette Sketch Pens, are called sketch files. Unlike the other cut files in the Design Store, sketch files are meant to be sketched and not cut.

**Rhinestone:** Rhinestone files are different from others because they should not be resized. They are made the correct size to fit individual rhinestones. Use Rhinestone cut files to add a bit of glam or sparkle to any project.

---

The prices of the examples on this page may be different than their actual price. To see actual pricing go to silhouettedesignstore.com.
Buying and Downloading Content

You can either purchase content by buying a subscription or by paying à la carte for each design.

A paid subscription is perfect if you download lots of designs each month. With each subscription, you get a certain amount of credits each month. Unspent credits at the end of the month rollover and are available for up to 60 days. Subscription credits can be used to buy any design, even those that are on sale or in the clearance section. Subscriptions are available in various tiers and various lengths. And when you pay for a deluxe or a premium subscription, you can download designs at a 25% to 50% discount if your monthly credits run out.

When you pay à la carte, you pay for each design separately. This is great if you purchase a few designs at a time.

Subscriptions to the Silhouette Design Store

Most designs in the store are $0.99 and fonts are $2.99. If you download more than a handful of shapes each month, Design Store subscriptions can provide significant savings over the pay-as-you-go service. For example, a basic subscription of $119.88/year will give you $25.00 worth of designs each month! Subscriptions credits can be used to buy any design, even ones on sale or in the clearance section. They are also available in various tiers and are valid toward a one-year subscription.

There are several account options offered: Basic, Deluxe, Premium, Diamond, and Custom.

Using the Custom option, we have 20 different subscription levels.

Specific pricing and credit allotment amounts for each subscription level may be found by accessing the Silhouette Design Store and clicking “My Subscription.” All subscriptions are offered in 3 month, 6 month, or 1 year periods (consecutive months). You are offered the option of paying month-to-month or paying for their entire term (consecutive monthly period) up front during the sign-up process.

Subscriptions credits are allotted according to the date the subscription is started and the credits
are valid for a period of 60 days from the date of allotment. You can review current and pending subscription credits with their allotment and expiration dates at any time by clicking on the credit amount listed on your account.

Subscription credits are only valid during the term of a current active subscription. If you have unused subscription credits and your subscription ends, you may opt to renew or sign up for a new subscription within 30 days of your previous subscription ending. Any remaining unused credit would then be re-activated and be usable on your account within this 30-day period.

**USING YOUR TRIAL SUBSCRIPTION CARD**

The trial subscription card entitles you to a Basic Subscription to the Silhouette Design Store for one month. If your Silhouette machine came with a trial subscription card, you may use it to purchase designs from the Design Store.

1. Open the Design Store in an online web browser or in Silhouette Studio® and sign in to your Silhouette Account.
2. Hover over your name and click “My Account” in the dropdown menu that appears.
3. Click “Redeem a Promotional Download Code.”
4. Type the code found on the back of your trial subscription card and click “Apply Card.”

Your available subscription credits can be viewed in the upper right-hand corner of the screen below the search bar. Once your trial has been activated, the card is no longer needed and can be discarded. Regular download cards cannot be used to pay for subscription fees. If download cards have been applied to an account, credit will remain valid on the account and can be used once all subscription credit has been exhausted at any given point or reserved until after the subscription has ended.

**BUYING À LA CARTE**

You don’t need a subscription to buy designs. It will save you money if you get more than a handful of designs a month, but you can buy any design, any time.

**CREDIT BOOSTS**

You already know that a Design Store subscription can offer huge savings for anyone who downloads frequently. For the more casual downloader, we offer Credit Boosts. A Credit Boost is a great way to load up on Design Store credit and save money at the same time. The more you buy, the more you save — up to 50%! Boost credits never expire so you can use them whenever you’d like.
DOWNLOADING DESIGN DIRECTLY FROM THE STORE

1. Add as many designs and fonts to your cart as you like. Make sure you check out the Free Designs tab and see if any of the designs qualify as free if you purchase another design. If they’re free, why not?

2. Click the cart icon in the corner of the screen or “Checkout” on a design that has already been added to your cart.

3. While in your cart, simply click “Checkout.” If you have a balance on your account from a download card or subscription credit, the total charges will be taken from your balance automatically. You will be prompted to either provide credit card information or add a download card code to your account.

4. Once you are ready, enter your password to authorize your purchase. Upon entering your password to confirm the purchase, the design will appear in your Library.

You can keep browsing through the Design Store, or you can go to your Library to access your brand-new designs. Once your images are all downloaded, drag them from the Recent Download folder and sort them into your desired library folders. Downloaded images will remain in this Recent Downloads folder until sorted.

You will note that while all purchased images are stored in your Library, purchased fonts will also be in the “Fonts” section. You may then either access these fonts purchased by double-clicking on a font from the Library, which will bring you to your workspace with a text cursor ready to place to type, or by accessing your fonts through the Text tool in the Design screen. Similarly, any patterns purchased will automatically download into your Patterns folder and can be accessed through the Fill icon.

OBTAINING A COMMERCIAL LICENSE FOR DESIGNS

Designs offered through the Silhouette Design Store are protected by copyright and are owned by Silhouette or its licensors. All digital designs are available for personal use. Some digital designs are available for commercial use, also. Commercial use is defined as using the digital design in any physical project, product, artwork, etc., that is intended for resale or commercial use. Under no circumstances are you allowed to resell or distribute the files associated with digital designs offered by Silhouette.

You must purchase a commercial license for a design if you plan to use the design to create products that you will sell or if you will be using the design for other commercial purposes (including advertising). Silhouette offers commercial licenses for over 100,000 designs in the Silhouette Design Store.

If a commercial license is unavailable for a design, that design is limited to personal use only. The commercial license fee covers only the specific image in question being purchased at that rate. The royalty-free license fee is a flat one-time payment per image based on the number of units you will produce for resale.
You can, of course, use your Silhouette to produce original projects for the purpose of selling, as long as it is not a replication of an image offered by our company or its licensors.

To obtain a commercial license:

1. Open the Design Store in your software or in your browser.

2. Select the image for which you want to purchase a commercial license.

3. In the dropdown menu next to the design, select the number of designs you want.

4. Click “Add to cart” and continue on with purchase as normal.

Your purchase of the commercial license option grants you the legal permission to proceed to use the design. Use of a design in a commercial venture without purchasing a commercial license is strictly prohibited.

**NOTE:** If you purchase a commercial license for a specific design, you are authorized to use that design for commercial purpose as many times as you desire. It doesn’t matter if you are using the design 50 times in scrapbook kits, 500 times for vinyl wall art, or 5,000 stickers. The commercial license gives you the right to use the design commercially an unlimited number of times.

**DOWNLOADING CONTENT PURCHASED FROM THE WEBSITE**

Sometimes you might purchase content directly from the website instead of through your Silhouette software. When you access the Silhouette Design Store outside of Silhouette Studio®, your order will not automatically download to the Library. We will cache your designs until you manually download the designs to your software. This feature is especially helpful if you are purchasing designs on a different computer than the one you usually use with your Silhouette. But, if you want to avoid any hassle, set up your Silhouette Library account. Then, anything you download will be accessible from all of your devices by simply syncing your account.

To download content purchased from the website:

1. Open Silhouette Studio®.

2. Go to the dropdown menu and select “File > Download Pending Orders....”

3. Enter your Silhouette user account information.

4. Click “Check for Downloads.”

5. Select the order you want to download and click “Start Downloading.”

Downloading your order from the website to your Silhouette software does not count against any recovery attempts on your account.
Library

If you haven’t purchased any designs yet, that’s okay! Each Silhouette comes with unique free designs from the Design Store. Your Silhouette will download these designs automatically when you first connect your machine to your computer.

ORGANIZING THE LIBRARY

1. Click the Library tab.

2. Click “All Files” in the top-left panel of the Library to view all the designs you’ve acquired.

3. Click the Designs folder icon with a plus on it to expand the folder and view its contents. By default, this folder will contain two additional folders: “Recent Downloads” and “User Designs.”

4. Click “Recent Downloads.” This folder is the default destination for all downloaded content, including any free designs that came with your Silhouette machine.

5. Create a file by right-clicking the folder you want to add a subfolder to and select “New Folder.”

6. You will be prompted to name the folder. Folders can’t be moved once they’ve been placed, so make sure you have the proper folder selected when you’re creating subfolders. Subfolders can be deleted.

All of your designs are automatically backed up in your Silhouette Library. This means that if you log in to your Silhouette account from a different computer or device, you will still have access to all your designs. However, you may only download your designs to five different devices.

Once your designs are organized the way you like, finding them is a snap. You can also use the toolbar at the top to search your designs.

USING DESIGNS FROM THE LIBRARY

1. Select a design from the Library.

2. Double-click the design to place it in your workspace.

3. Manipulate and transform the design using the tools in Silhouette Studio®.
Double-clicking your design will automatically close the Library and place the design in your workspace. You can reopen your Library by clicking the Library tab.

If you plan on placing several designs on the design space at one time, you can use the Library split screen to help ease your workflow a little bit. When you are in the Design tab, go to the toolbar on the left-hand side and look almost all the way to the bottom. You’ll notice that there is the word “Library” with an arrow pointing to the right. To do a split screen that shows your Library and the Design area, click on that icon.

You can adjust the split area by hovering over the middle bar with your mouse and then clicking and dragging the bar to move to the left or right.

When you no longer wish to see the split screen, you can go to the toolbar on the design screen and click on the same Library icon (with the arrow now pointing to the left) again to hide the Library screen.

NOTE: This is one of the really awesome designs that has fill colors already in the cut file. How great is that? You can still manipulate them however you want, but it can be a great starting point, especially for a design like this that has a lot of pieces.

In the Silhouette Library, there is unlimited storage available for any designs you have downloaded from the Silhouette Design Store. You will have 1GB of space to save your own custom content. Club Silhouette Members receive 5GB of storage for custom content.

Once you have your Silhouette Library set up for your account, all of the designs you download from the Design Store will automatically download into your “Recent Downloads” folder. And because the Silhouette Library is backed up, you can also recover any purchased designs.
Club Silhouette

Club Silhouette is the exclusive club for all things Silhouette, making it easier for you to do it yourself and do it your way. Here’s what you get when you sign up:

- Free shipping on all orders over $50.00
- Free blade (or Mint Stamp Kit) and mat (or Mint Stamp Sheet) right to your door 3 times per year
- 10% standing discount at silhouetteamerica.com
- 10 exclusive Club Silhouette digital designs each month
- 5 GB of Silhouette Library storage
- Earn Club Silhouette Points for every $10.00 you spend

For more info, see silhouetteamerica.com/club-silhouette.
Sending a Project

SEND TAB

The Send panel is very similar to Cut Settings of the past. The Send panel was designed to streamline the cutting process and make it even easier.

The Send panel moves in chronological order. Start at the top and work your way down. Once you have adjusted all of your settings, you can click “Send” and watch your machine perfectly cut out your project.

The Send screen has two parts: the panel on the right-hand side and the screen displaying your design on the left. When you enter the Send tab, cut lines in your design will become thicker and bolder so that you can see exactly what your Silhouette is going to cut.

ACTION BY

The top option in the panel defines how you will be cutting with your machine. You can either use Simple, a standard cut, or you can choose to cut by specific attributes like Line Color or Fill Color (or Layer if you have Designer Edition). First, we are going to show you how to use the Simple option. Turn to pages 151, and 167 to learn how to cut by Line Color, Fill Color, and Layer.

SIMPLE: Simple is for basic cuts. This is what you will use for any project when you are cutting the entire design out of a single material. In the Simple cut mode, all lines are scheduled to cut at the same time.

If you are using a CAMEO 3 or Curio, you will have options for two tools. All of your lines will be sent in one cut job, but you can use two different tools with the red tool cutting first and the blue tool cutting second.

KEYBOARD SHORTCUT: Open Send Tab Panel
Windows press, Ctrl + F2
Mac® press, Cmd + Fn + F2
No Cut: If you don’t want something on your page to cut, select it in your design area and click “No Cut.” The red cut lines will disappear, and the cuts won’t be sent to your machine. Or you can pull the shape off to side and place it in the gray holding area while you are on the Design screen. Any items outside of the red cut border on your page in the Design screen will not be sent to your machine.

Cut Edge: With the autoweld feature activated, overlapping shapes of the same color will be welded together. If you haven’t already welded your overlapping shapes together on the Design screen, use the Cut Edge option.

MATERIAL, ACTION, AND TOOL
The second step is to choose your material, action, and tool. These options are located to the right of the No Cut/Cut/Cut Edge options.

SELECT MATERIAL: The first option is the Material drop-down menu. Here is a list of common materials that you can cut with your Silhouette as well as all of the Silhouette specialty materials. Find the material you are using from the list, and select it.

In this case, we have selected the “Cardstock, Adhesive-Backed.” If the material you are using isn’t there, click the plus icon at the bottom of the drop-down menu. You will have the option to name the material and define the cut settings.

Cut: This is the regular cut option. Click this if you want all of your lines to cut exactly as they appear. If your lines are solid, your machine will cut solid lines. If you have perforated lines in your design, it will cut perforated lines.
SILHOUETTE PRO TIP: Did you know you can use more than one color of material at a time on your cutting mat? Place each piece (use those scraps!) on a different section of the mat. Turn on your grid. With the grid turned on, you are able to see exactly where your machine is going to cut and you can position your material to that exact spot. You can also rotate objects to fit your material better. Just remember to rotate, not mirror or flip.

Blade Setting Recommendation: The software and your actual Silhouette machine will not know the level to which you have set your blade. The software will give a recommendation of what blade setting you should use for the material you selected. The recommended settings are tried and tested and will most often work. But you can adjust your blade to any settings needed for your particular material.

Speed: The speed is measured in centimeters per second x 10. In other words, the Silhouette can cut from 10 centimeters per second up to 100 centimeters per second. To achieve the best results, slower speeds are recommended for thicker materials or designs that are more intricate.

Force: Force is measured by approximately 7 grams of force per setting and has 33 levels. In other words, the Silhouette can cut from 7 grams of force up to 231 grams force. Thicker materials will likely require higher force levels.

Passes: The number for this setting makes your Silhouette cut through all lines in your cutting area multiple times. This can be necessary when you are cutting thicker materials so that you get cleaner cuts. It is also useful to get a more pronounced emboss or deboss. Some materials automatically include two passes as part of their recommended settings. If your cut isn’t coming out very clean and you are using a thicker material, like cardstock, try setting the number of passes to two.

If you want to edit the material defaults, choose a material and adjust the settings. Then, click the “Save As” button in the Action Settings bar. Choose a name and save these specific settings if they are ones you would like to use again.

SELECT ACTION: In the next drop-down menu, choose your Action.

The Action options are Cut, Score, Sketch, Emboss, and Stipple. The tool options correspond to whichever action you choose.

SELECT TOOL: In the last drop-down menu, choose your tool.

The Tool options correspond to whichever action you chose.

ACTION SETTINGS: The summary gives you an overview of your settings before making the cut.
you want to edit the settings for just the one particular project you are cutting, don’t make edits here! Make them in the Action Settings tab and then cut your design, but don’t save the changes.

**SILHOUETTE DEVICE**

The final step in the Send tab is sending your design to your Silhouette machine. You should do this only when you have completed adjusting all of your cut settings.

---

**SILHOUETTE PRO TIP:** A Test Cut does not have to be in the upper left-hand corner. Use the arrows to move your blade to any position on the material. Test cuts can be done anywhere that is best for your project.

---

**Test Cut:** When you are cutting a new material type you have not previously cut, whether it be a predefined media-type setting or a new User Defined media type you are trying to find the correct settings for, it is good idea to perform a Test Cut. This is to make sure your cut settings are correct for your material, and that you will be able to get a clean, quality cut for your design. You can access the Test Cut options in the summary.

To perform a Test Cut, click the blue Blade Position Arrows to move your blade so it is resting over your loaded material in the Silhouette unit. Once your blade is where you want to make a small cut, click “Test.” Your Silhouette will cut a small square with an embedded triangle. Use this to gauge your cut settings and determine if something needs to be adjusted. You may continue to make further test cuts until you find the settings that work for your material.

If you are comfortable cutting, you are ready to click “Send.” If you would like a guideline to send your project, click the Learn icon on the bottom left. When you click this, a slide show of steps will appear to remind you all of the things you must do before you make a cut. Click through the slide show to review all the steps.

Before you cut, make sure you have:

- Chosen your material from the Material drop-down list.
- Adjusted any desired cut settings in the Action Settings.
Inserted your blade or tool into your machine and adjusted it according to the recommended settings in the Action Settings.

If using a CAMEO, adjusted your rollers to fit your material or mat.

Loaded your material if it has its own backing or loaded your material placed on a cutting mat. If you are using Curio, make sure you have properly loaded your base into your machine.

When you are ready, click “Send.” This will send your cut job to your Silhouette.

**EDIT MATERIALS:** The Edit Materials window can be accessed by clicking More (the three little dots) on the bottom right. This allows you to make changes to the default cut settings. Any changes you make here will be permanently applied to this particular material. If you want to edit the cut settings for a single project, you can in the Action summary.

Speed, Force, Passes, and the ratchet blade settings can all be changed in the Action summary and in this Edit Materials menu. Track Enhancing and Line Segment Overcut can only be changed in this menu.

**Track Enhancing:** The Track Enhancing feature will roll your material into your Silhouette and back out several times to create a track where the rollers can grip the material. This is to make sure the material stays on track during the cutting process. Track Enhancing should only be used if it is already preselected for your material type or if you are having issues with a specific material type slipping during cutting. Most materials don’t require this feature.

**Line Segment Overcut:** Selecting the “Off” option will have all lines cut normally. Selecting the “On” option will have all straight corners cut with a slight overcut. This option is beneficial for providing cleaner cutting results for thicker or denser material types (such as chipboard) and cutting smaller block fonts or sharp edged images on various material types, including vinyl. The option will have no effect on rounded edges. It is only effective for images containing sharp edges.

Feel free to play around and find the best settings for your material. To see whether your settings are going to effectively cut your material, the best thing to do is try a Test Cut.

**LINE COLOR, FILL COLOR, OR LAYER:** You have the option to break up your project into multiple cutting stages. This is especially handy if your project is designed to be cut in several colors or if your project will be sketched and then cut (or some other combination of tools). You can schedule cuts by Line Color, Fill Color, or Layer. (Layer cuts are available in the Designer Edition only).
By Line Color: All of the line colors present in your project will be visible in the Action tab. Based on line color, you can arrange a cutting order.

By Fill Color: All of the fill colors present in your project will be visible in the Action tab. Based on fill color, you can arrange a cutting order.

By Layer (Designer Edition Only): All of the layers present in your project are visible in the Action tab. Based on the layers you’ve created, you can arrange a cutting order.

ACTION TABLE: The action table shows and allows you to edit every detail of the cut settings for individual lines in your design.

Remember, the blade setting is the only setting you have to manually adjust. To see how to adjust the blade, see page 273. The other settings are adjusted here in the software.

1. **TOOL NO.:** Clicking on the left-hand RED circle will have the selected row performed by the left-hand tool, and clicking on the right-hand BLUE circle will have the selected row performed by the right-hand tool.

2. **CUT LINES:** Cut lines can be turned on or off individually. They can also be sorted to cut in a designated order. You can turn cut lines on or off by checking or unchecking the box next to the cut color or layer.

3. **TURNING AUTOWELD ON OR OFF:** You can turn autoweld on or off by clicking the autoweld box. With autoweld activated, overlapping shapes of the same color or layer will be welded together.

4. **ARRANGING CUTTING ORDER:** To arrange the order that different colors or layers are cut, simply click and drag the desired color or layer to a higher or lower position in the cutting order. The top line cuts first.

5. **MATERIAL:** Choose your material according to the material you will actually be cutting for your project.

6. **ACTION:** The Action options are Cut, Score, Sketch, Emboss, and Stipple. Different actions will dictate the different tools you can select.

7. **TOOL:** Tool options include the blades, embossing tools, stipple tools, and sketch pens.

8. **ADDING PAUSES:** Pauses are especially helpful in sketch projects where it is necessary to change pens or blades.
between colors. To schedule a pause after a color or layer is finished, right-click the color or layer and select “Add Pause.” It will add a pause after the layer you selected.

**ADVANCED SETTINGS**

The Advanced Settings window can be accessed by clicking on the Settings icon on the bottom right. The Advanced menu offers several options for specialized cutting with your Silhouette. It is found to the far right of the Send icon.

**Cut Order Sorting:** This series of options allows you to control the cutting order of your job. “No Sort” will simply cut your images according to their layout. “Maximize Speed” will set the cutting order to cut the job as quickly as possible. “Minimize Roller Movement” will cut the job with the least amount of back and forth roller movement possible. This can aid in cutting more delicate materials. “Sort Interior Contours” controls whether the interiors of images will be cut first (checked) or whether the interior is simply cut in line with all other portions of the image during the cutting process (unchecked).

**Feed Options:** “Return to Origin” will simply return your material back to its original starting point after the job is completed. “Feed” will continue to feed your material forward beyond the point of origin.

**Layer Sorting:** “No Sort” will cut your layers in the order they are listed. “Group Layers by Condition” will sort your layers and group layers that share the same conditions together. It will cut these layers in succession. Lines of a particular color are considered a layer.
Making a Basic Cut

1. Create your design. Make sure it is sized and positioned on the page exactly how you want it. Then, click the Send tab.

2. Choose your material from the drop-down list.

3. Choose “Cut” for your Action and choose which blade you are using.

4. Choose “Cut” for your cut lines. This just means it will cut your lines exactly as they appear on the screen.

5. If you are using the AutoBlade with the CAMEO 3 or Portrait 2, you do not need to manually adjust the blade settings. If you are using any other blade, look at the number highlighted on the blade image. Take the blade you will be using and manually adjust the blade to that number by placing the tip in the ratchet socket and twisting. Load the blade.

6. The Learn icon has a slide show of images at the top. Click through and follow the instructions, such as checking or adjusting your ratchet blade, loading the blade, placing the material on the mat, moving the rollers, and loading the mat. When all of the above settings are adjusted correctly, you are ready to cut.

7. Click Send.
**Cutting with Multiple Tools**

1. Create your design. Make sure it is sized and positioned on the page exactly how you want it. Ungroup the image so that you can assign certain lines to certain tools. Then click the Send tab.

2. You can use Action by: Simple for multiple tools.

3. Choose your material from the drop-down list for both Tool 1 and Tool 2.

4. Choose which action to correspond with which tool. In this case, the red is sketch and the blue is cut. This is also how you would perform Curio functions like Score and Emboss.

5. On the page showing your design on the left-hand side, select the lines you want to be assigned to red Tool 1. When they are selected, click the “Sketch” option. Repeat with the lines you want to assign to the blue Tool 2 but this time with “Cut.” The lines will turn red and blue so that you can see which lines you assigned to which tools.

6. Check your summary for both tools. Adjust your blade to the recommended blade setting.

7. If you want, view the slide show checklist to see the instructions for adjusting the blade, loading the blade, loading the sketch pen, placing the material on the mat, moving the rollers, and loading the mat.

8. When all of the above settings are adjusted correctly, click “Send.” Your Silhouette will start sketching and then cutting.
Cutting by **Line Color or Fill Color**

Create your design. Make sure it is sized and positioned on the page exactly how you want it. When cutting by Line or Fill Color, you don’t even have to separate your overlapping objects to cut your design one piece at a time. But if you want to visualize what your machine is actually going to cut, you can separate the parts of your image. Then you can reposition the parts to better fit your media. When you are ready, open the Send tab.
1. Choose your Action. Choose either Line or Fill, depending on which you want to cut from.

2. The table allows you choose which color to cut. Check On/Off to activate cut lines. Here, only objects with red lines will cut because it is the only box checked.

We want to cut one color at a time. There are two ways to do this. One is that you can deselect all of the colors except the one you want to cut first. Send that color, in this case red, to your Silhouette. Once it is cut, unload your material and remove it from the mat. Then place the material in your next color, like orange, on the mat. Select that color, orange, and deselect the others. Cut that color. Repeat until all of your colors are cut.

Or, you can keep all the colors checked, right-click a color, and click “Add Pause.” This will put a pause after the color you selected. During this pause, you can unload your media, take it off the mat, and place your media in the next color on your mat. Then you can click “Resume” and continue cutting your job until the next pause.

3. Check your cut settings. Adjust them as needed. When you are ready to cut, click “Send.”
Upgrades

There are three software upgrades available: Designer Edition, Designer Edition Plus, and Business Edition. As you upgrade your software, you get the features from each of the lower versions. Software upgrades never expire and will update when you update your software.

Designer Edition

Silhouette Studio® Designer Edition unlocks a number of features. If you are familiar with designing in other software programs, or if you are becoming more comfortable with designing in Silhouette Studio®, you need Designer Edition! Rulers, guide lines, Sketch functions, and Nesting are just a few of the features included in this software upgrade. Believe us, you don’t want to miss out. And remember, as you upgrade your software, you get the features from each of the lower versions. Software upgrades never expire and will update when you update your software.

FILE COMPATIBILITY

The additional file types Designer Edition supports are SVG and PDF.

RULERS AND CROSSHAIRS

You can turn your rulers on and off by accessing View > Show Rulers, the Grid menu in the Page panel, or by pressing Ctrl + R. Rulers will appear on the top and right hand side of your screen. The dark gray rectangle in your ruler shows where your design measures on the page.

KEYBOARD SHORTCUT: Show/Hide Ruler
Windows, press Ctrl + R
Mac®, press Cmd + R

Crosshairs can also be accessed from View > Show Crosshairs, the Grid menu in the Page panel, or by pressing Ctrl + H. Crosshairs are the small black lines in all four directions. Using them in conjunction with your rulers can help you measure and align objects in your design space.

KEYBOARD SHORTCUT: Show/Hide Crosshairs
Windows, press Ctrl + H
Mac®, N/A
FREEHAND LASSO TOOL
The Freehand Lasso tool works as an alternate selection tool. You can use it to select multiple items in a group, and it works great if you’re trying to select an odd shape or section of a design without selecting anything else. Here’s how you can use this tool:

Open your chosen design in Silhouette Studio®. Select the design by clicking on it. Ungroup the design by clicking the ungroup icon located on the quick-access toolbar or by right-clicking and selecting “Ungroup.” Repeat this step until the elements you wish to select are no longer grouped with the main design.

Select the Freehand Lasso tool icon, located on the left side of the screen. Click and drag the mouse to draw around the object or objects you wish to select. When you complete the lasso section, the pieces that were within the lasso are now selected.

While the pieces are still selected, group them together by clicking the Group icon or by right-clicking and selecting “Group.” Then continue to create your design.

GUIDES
You can pull blue guides from your top and right-hand side rulers onto your page. You can show or hide them in the Grid menu. Guides can be useful in aligning and designing.

CENTER OF ROTATION
Center of rotation is the point that stays in place while your object rotates around it. By default, the point is in the center of your object, but you can adjust it to be anywhere. Select your object and click on the small crosshair icon in the middle. Drag the crosshair icon to a new point of rotation.
Now when you rotate your object with the little green circle, it will move around that point.

**KEYBOARD SHORTCUT:** Center Rotation On/Off
Windows/Mac®, press O

**WAIT! WHY IS THAT THERE?** Does the little compass get in your way when you are trying to quickly select and move things around? It is defaulted to “off” so if it somehow gets turned on, go to Preferences > Defaults > Center of Rotation and turn it off again.

**KNIVES**
At first, you may not know what to do with the extra knife features included in Designer Edition, but once you mess around with them, you will see how awesome they are. You can use all of the features not only cut parts off, but to create.

If your shape isn’t filled, it is important to choose solid or outline. Solid will make your design into separate pieces when you cut. Outline will only make a cut where the knife intersects the cut lines.

Draw a black rectangle and fill it. Then, select the “Dovetail” knife and slice it down the middle of your rectangle. Drag the top slice up to create some space. Place text in the middle of the two knife cuts, and you have a super cute, super easy design made with a rectangle!

**WHAT IS AUTO APPLY?** Auto Apply can be turned on or off by checking or checking the box in the Quick Access Toolbar. While it is on, your knife will cut through your object as soon as you draw your line. If it is off, you can adjust your knife cut using slider bars, adjustment circles, or adjust it like any other line. Once you have your line fine-tuned, click “Apply Selected Knife.”

**TRANSFER PROPERTIES**
Properties can be transferred from one shape to another by selecting the shape you want to transfer properties to, selecting the Transfer Properties icon (also known as the Eyedropper), and clicking on the shape you want to imitate. It copies everything, including fonts, patterns, and gradients.

**KEYBOARD SHORTCUT:** Transfer Properties Tool
Windows/Mac®, Select item + Ctrl click another item you want the properties from.
Here, the pink fill of the lamp is a custom color in the Advanced Fill panel. Click on the top of the lamp, which is an unfilled shape. Then click the eyedropper. Next, using the eyedropper, click the image with the properties you want to copy. In this case, it’s the base of the lamp. Your selected shape, the lamp top, will update to the custom pink fill and the black heavy line. You can also transfer font. The “Z” is typed in the default font. When you transfer the properties from the “K” to the “Z,” it will transfer font, text size, line color, and fill color.

Transfer Properties also works for images. Open or drag a photo into your workspace. Type out a word and weld the letters together to make it a shape. When you have your word highlighted, simply click on your photo with the Transfer Properties eyedropper. There you have it! Your word will fill with the photo. Silhouette Studio® will treat the photo fill like a pattern. You can scale and pan it in the Advanced Patterns menu.

To see another way to fill text or an object with a photo, see page 83.
Here we filled text will different photos. To fill text, simply write out your word in a blocky font. Then release the compound path and ungroup the letters so you can remove any middle circles. Load your photos into your Library, making them into patterns. Fill each letter, which is now just a shape, with one of the photos.

TRACE BY COLOR
Sometimes, using the standard trace feature isn’t the best option. We don’t want to just trace of the outside edge of this watermelon image. We want to trace each individual part so we can cut it out of paper and layer the pieces on top of each other.

Start by using Trace by Color. Click “Trace by Color” and then click a color in the watermelon, like the green rind. It will trace only the green parts. After you trace the shape, you can change the line and fill color. Continue with the black and red parts of the melon.

There is a box to check or uncheck called “Trace all areas with same color.” When you have this checked, it will select all shapes of that color, like all of the black seeds. When it is unchecked, it will only select the particular area of the color you have selected, like a single black seed.

SILHOUETTE PRO TIP: Want to make your photos black and white? Under the Effects icon, change “Greyscale” to 100%. It is an easy way to edit your photos in the software.
When you close the beginning and end points, the outer part around the image you traced will be cropped out. That is why you made a copy and placed it to the side. Make another copy of the melon on the side and begin magnet tracing the next dark red shape on the copied melon. When you finish that one, make another copy of the original and trace shape three. Finally, use the last watermelon original image and trace the last shape. Place the four shapes together, spaced like they were on the melon.

Now, change the line and fill color of the magnet traced shapes to whatever you want. Layer your design and you are done! Cut each group out of its own color and layer your traced watermelon.

SILHOUETTE PRO TIP: The red shape traces around the seeds of the melon. Since we are layering the seeds on top of the red layer when we are putting together our project, we don't need the seeds cut out of the red. To fix this, select the shape, right-click, and select “Release Compound Path.” Move the seeds to the side and delete them. You are left with a nice, clean half-circle.

MAGNET TRACE
When you try to trace the darker red shapes in the previous watermelon with the Trace by Color feature, it will only trace the same red half circle. The colors are too similar and the software can't differentiate between the two. If you want the shapes in your melon, use Magnet Trace!

All you need to do is make a copy of your watermelon and place it on the side. Select “Magnet Trace” and click the outline of one of the darker red shapes. A bright green line will cling to the outside of shape you clicked. Move your mouse along the shape and click another point. If you click your points closer together, you will have a more precise trace. Also, if you adjust the selection tool wider and smaller, you can adjust the accuracy of your points.

When you get to a black seed that overlaps the part you are tracing, drag over it until your green magnet line finds the dark red one and starts clinging to it again.

Under Magnet Trace, you can adjust how big or small you want the size of your magnet to be. You can also do this while you are tracing by holding Alt and moving the roller on your mouse up and down.
**SHADOW**

You can add and adjust a shadow by clicking the Shadow icon in the Effects panel. In the Shadow menu, you can adjust the shadow offset, color, and transparency.

You can use shadows to add color and dimension to your projects. They work great for Print & Cuts.

**IS A SHADOW JUST AN OFFSET?**

Offsets and shadows have different effects. A shadow is the exact size of your shape. It is layered below the original, but slightly to the side. An offset is smaller or larger than the original image. You can use offset to create a shadow (by moving it slightly) but you cannot use shadow to create an offset. For more on Offset, see page 53.

**SHEAR**

Use Shear under the Transform panel to skew your design vertically or horizontally. You can select from preset amounts or specify a custom shear.

Take these vertical plants. Select the one on the left and shear it -15° horizontally. Select the one on the right and shear it 15° horizontally. Move them together and you made a bouquet.

Or, instead of printing, you can cut the shadow. If you click “Release Shadow,” it will basically ungroup the shadow from the object. You can move them apart and cut each out of a different color, and layer them back together on your project.
CUSTOM SHEAR: You can custom shear with the shear handles, too. Check the “Show Shear Handles” box to make the little boxes on the edges of the object appear. Pull them and adjust them how you’d like. You have the option to unshear anything you don’t like by clicking “O.”

ITALICIZE TEXT: You know what is another great thing you can do with shear? Italicize text. It’s so easy! Type your text in whatever font you want and then horizontally shear.

![Dream text](image)

French Fry Font | by Dresden Carrie  
Design ID: 156526

ITALICIZE TEXT: You know what is another great thing you can do with shear? Italicize text. It’s so easy! Type your text in whatever font you want and then horizontally shear.

SILHOUETTE PRO TIP: Use the Shear tool to make any text italicized, the Line tool to make any text underlined, and the Offset tool to make any text bolded.

MAKING DESIGNS WITH SHEAR: Shear is great to use when making your own designs.

(1) Draw a rectangle.

(2) Select a 30° vertical shear.

(3) Mirror the rectangle to the right. Move each rectangle towards the center a tiny bit so they slightly overlap. Then weld them together so you have a “v.”

(4) Make a copy or two of the “v” underneath the original.

(5) Mirror the “v” shapes to the right. Move each “v” towards the other a small amount and weld the two together. Make a few copies of your welded shape and place them below the original. You made your own chevron pattern!
You can use Shear to create more advanced designs, as well. (1) Draw a circle and a rectangle with the same widths. Overlap the two. Then point edit the rectangle, and add a point so there is a triangle at the end. (2) Weld the two shapes. Add a vertical line down the center. Draw two rectangles on either side of the line.

(3) Select the entire design and horizontal shear 30°. Some of the objects will need to be realigned a bit after shearing. (4) Add a few additional horizontal lines. Fill the shapes with color and group everything. You made your own feather with basic shapes and shearing!

**DESIGN PAGE NESTING**

To minimize the space required to cut a certain design, you can use the Nesting feature. You can choose to use your entire media surface to nest your shapes, or you can create a specific area for them to nest into.

Here is a simple nesting example. There are twelve leaves on this page. Click the Design Page Nesting icon and adjust how many rotations you will allow and how much padding you want between each object. Click “Nest.” Look how much material you saved! Now you can fit even more leaves on the page if you’d like.

This little winter village scene is made up of lots of different shapes. We have four of these house designs on our page for a Print & Cut. If they are grouped, you can nest them and they will all stay together. If they are not grouped when you nest them, they will separate and each individual shape will be nested. You can adjust how many rotations you will allow and how much padding you want between each design.

**ROTATIONS, PADDING, AND ALIGN:** You can adjust how many rotations you will allow the software to make to your objects. If you don’t need your shapes positioned specific way, you can bump up the rotations to a higher number. This won’t flip or mirror your designs; it will only rotate them.

Padding adjusts how much space you have between objects. It will then nest them as close as possible, but with as much space between objects as you have specified.
Align will nest according to your specifications but it will also try to keep shapes aligned with other shapes as much as possible.

**SET SHAPE AS BOUNDARY:** You can also select a shape as your nesting boundary. Draw a rectangle or other shape that matches the shape of your media and nest your design to fit to that specific shape.

After making any necessary adjustments, click “Nest” and the shapes will nest together to maximize space. If you have selected more shapes than will fit in the nesting area, the software will determine which shapes fit best in the defined area. In this case, the software couldn’t fit one heart key.

You have to be a little tricky, but it is worth it. Open the house design from the example on the previous page. On that page, these houses were for a Print & Cut. But this time, we are going to cut each piece out of paper and piece all of the parts together.

Fill the page with as many house designs as you want. Then, click the Select By Color icon. Choose a color, in this case navy, and drag all of the shapes of the selected color off to the side of the screen into the gray holding area. Group all the objects of like color together so you don’t lose any of the little objects.

Do the same for all of the colors in your design, selecting them one color at a time and moving them off the screen and grouping them.

**USING NESTING WITH SELECT BY COLOR:** Do you want to cut out your design from a few different colors and layer the pieces? If you want to cut each color object out of its own color of material, such as the navy shapes out of navy cardstock, use the Nesting tool! Here is one way nesting can be incredibly useful.
Once you have all of your corresponding colors grouped together, select one color and move it back onto the design page. Now, ungroup that color. Remember, the grouping was just so we could move it from the page to the side and back without losing any of the little parts. You cannot nest your objects if they are grouped together, so ungrouping is important.

Go to the Nesting panel. Select all of the shapes of one color on your page and click “Nest.” Now all of your navy shapes are nested together! Load your navy material and cut out all of your nested navy shapes. Move the navy shapes off, move another color on, and nest that color. This is so much easier and more efficient than trying to manually pick out all of the navy blue shapes and fitting them together. Nesting will save you time and material.

**SKETCH**
Create your own sketch designs by clicking the Sketch icon. It will pull up the Sketch panel where you can adjust the sketch edge, fill type, and fill effect.

Some files are made specifically for sketch pens. They generally won’t work well as cut files because of their stray lines. In the Design Store, sketch files are marked with a specific sketch symbol. See page 134.
**EDGE SKETCH/SHADOW OFFSET:** You can choose an edge or fill your sketch with different options.

**RELEASE SKETCH:** Release Sketch is a powerful tool to help you to customize your design even further. Select your image that have been filled with a sketch option. Then select “Release Sketch.” It won’t look like anything has happened until you enter Point Editing mode. You can see the gray points are the design points (like your regular point edit points) and the red points are the sketch points. You can adjust the sketch fill by manipulating the red dots.

This heart is filled with the diagonal line option. Delete half of the sketch lines. Think of the possibilities. You can minutely adjust the sketch fill to perfectly fit your design.

**ADVANCED SKETCH MENU**

The Advanced Sketch menu gives you most of the same options as the basic sketch menu, but with more options to customize your sketch design.

**FILE TYPES: CUT VS. SKETCH** Some files are sketch specific. Some files are cut specific. You can turn a cut file into a sketch file. Sketch files can’t really be turned into cut files because of their skinny lines, but you can try to apply an offset to make them into cut files if you wish.

File (A) is marked with the sketch icon in the Design Store. You can tell it is a sketch file because of the single lines on the legs and neck. Those lines aren’t meant to be cut.

File (B) is a regular cut file. Notice how all the parts like the legs and the neck are a little thicker so they won’t rip when you cut them with your Silhouette.

You may not have the best results when you try to turn a sketch file into a cut file (unless you first create an offset and cut that), but you can easily turn a cut file turned to sketch file. Just open your cut file and go to the Sketch panel. Select the
option you want and that’s it! This giraffe is the cut file sketched.

**CUT FILES TO PRINT & CUT IMAGES:** A cut file can be turned into a Print & Cut by filling it with color. Take your cut file and ungroup it. Fill each part with the color you want and reassemble your design. Add registration marks and you’ve made a unique Print & Cut. For more, see page 44.

**PRINT & CUTS INTO SKETCH IMAGES:** Turning a Print & Cut into a sketch file only takes a few steps. Open your Print & Cut file. Then, trace it. (If you need a refresher on using the Trace tool, see page 87.) Once you have it traced, go to the Sketch menu and turn your traced image into a sketch file. This is an option for any image you have, whether it be a photo or an image. Silhouette Studio® should not be used to trace images that are copyrighted or not yours.

**CREATING CUTTING FRAMES FOR SKETCH IMAGES:**
You may want to sketch a design and then cut it out. With a few easy steps, you can convert sketch images to have an accompanying frame. Open your sketch image and select it. Go to the Offset tool. Create an Offset for the sketch image so a frame is created. That’s it!

Once you have this outer frame, go to the Send panel. Select the outer frame. Click the “No Cut” option (this will have the outer frame line ignored). Proceed to send the inside job to be sketched with a sketch pen. When it is done sketching, do not touch the material or make any adjustments. Remove the sketch pen from the Silhouette and place a blade in the tool holder. Go back to the Send panel. Turn the outer frame line to “Cut” and the sketch image to “No Cut.” Proceed to cut the outer frame around the sketched image.
RHINESTONES

If you love rhinestones, great! If you aren’t so sure, the Rhinestone feature is more useful than you might think. In the Design Store, some designs are rhinestone specific. Or, you can also turn any design into a rhinestone design or add rhinestones to a design.

First, we have a simple balloon cut file. Fill it with color so you can see your rhinestones better.

You can use “Freehand” to add individual rhinestones to your design. “Release Rhinestones” turns each rhinestone into an individual circle that you can move or delete. If you want to release rhinestones in a rhinestone specific design, you might need to ungroup it first.

At the bottom of the Rhinestone menu is a total rhinestone count. It tracks how many rhinestones of each size you use in your design.

ADD CIRCLES USING RHINESTONE FEATURE: Here is a tricky Silhouette Pro Tip. Use the rhinestone tool to add circles, not rhinestones, to your design. First, draw a circle. Then add an edge of rhinestones. Space and size them how you would like. Fill them with color. Then, add this circle of circles to your design. In this case, place a letter inside of the circle. The circles will cut out as individual circles that you don’t have to use as a rhinestone template. You can use this for a Print & Cut or you can cut it out!

On the left, “Fill Interior Linear” positions rhinestones in a grid-like formation. On the right, “Fill Interior Radial” positions rhinestones on edge of the path and on concentric contours in the interior.
LAYERS
When you import a project with layers created in another program, you can access those layers in the Layers panel. Or, you can add layers to any design in Silhouette Studio®. You can use the +/- keys to add or remove layers in the panel.

We have four layers here: the text, the light cloud, the dark cloud, and the sun. Rename each object or layer to keep track of each object easier. Check the eye on the far left to see or hide your layer. Lock your layer in the second box to restrict changes.

Even if you hide layers, Silhouette Studio® will see the cut lines and send them as part of your cut job. In Send, you can adjust this and can cut by layer, just as you can cut by line color or cut by fill color.

CUTTING BY LAYER
1. Create your design. Make sure it is sized and positioned on the page exactly how you want it and that your layers are properly set up. Then, click the Send tab.

If you hide the text layer, only the sun and the clouds will show.
2. Choose “Layer” for your Action By.

3. The table allows you choose which layer to cut. Check On/Off to activate cut lines. We want to cut one layer at a time. There are two ways to do this. One way is that you can deselect all of the layers except the one you want to cut first. Send that layer to your Silhouette. Once it is cut, unload your material and remove it from the mat. Then, place the material for your next layer onto the mat. Select that layer and deselect the other. Continue until all of your layers are cut.

Or you can keep all the layers checked, right-click a layer, and click “Add Pause.” This will put a pause after the layer you selected. During this pause, you can unload your media, take it off the mat, and place your media for the next layer on your mat. Then you can click “Resume” and continue cutting your job until the next pause happens.

4. Select a layer. Choose your material from the drop-down list.

5. Select “Cut” as your action and choose the tool you are using.

6. Make sure you have adjusted your ratchet blade, loaded the blade, placed the material on the mat, moved the rollers, and loaded the mat. When all of the above settings are adjusted correctly, click “Send.” Your Silhouette will start cutting.

WARP
Are you ready to go crazy making your own word art? The Warp feature gives you ultimate control, allowing you to precisely adjust your text. Start by typing a word by using the Text tool.

PARTY TIME!
After you have your text ready, go to the Warp panel. All you have to do is click “Warp Selected Shapes.” A green box will appear around your design with a grid overlay. The default grid has three divisions, one column, and one row.
Adjusting these features will give you even more control to warp.

All you need to do now is to start playing around. Pull the orange control handles on the corners to pull the edges of your design one way or another. Pull the red or blue control handles in the middle of the design to adjust the inside. If you want to make sure both sides are adjusted equally, turn on your grid in the design screen. This will let you see where you are pulling the control handles so that you can do matching warps on both sides.

NOTE: In previous versions of Silhouette Studio®, you weren’t able to edit the text once you used the Warp tool on it. But with Silhouette Studio® version 4.2 and later, you can now edit the text and it will remain in its warped shape. Simply double-click twice on the text box. The cursor will pop up, and you can change any of the text you need to.

Warp can be used for more than making word art. Any object can be warped.

For example, take this rose on the front of a card. It fits on the front of the card, but there is some white space. If we resize the flower, it still won’t fill the space exactly. This is where warp is a valuable tool.

Select the flower. Using the warp controls, drag the points up, down and out to adjust your shape to fit the space. Some shapes may look distorted when warped, so try to choose a shape that will still look natural.

After you are done warping, adjust the transparency of the flower to 50% in the Fill panel. Place some “get well soon!” text on top, and that’s it. You just created your own unique card.

WARP TEMPLATES
If you’re looking for a more uniform way to warp your text, then you’ll want to know more about The Warp Templates feature. You can click on a template, and it automatically applies that warp shape to your text.
Start by typing your text using the Text tool. Then click to open the Warp panel and click the Warp Templates icon. You’ll see a few different template options. Make sure your text is selected, and then click on a template you wish to apply. You can click through the templates to change the shape and you can change what the warp looks like by moving the points within the template.

If you’ve made too many changes, you can click “Restore Original Shape” to make your template go back to the default settings. You can also click “Release Warp” if you decide you don’t want to use a template at all anymore.

If you find that you made a mistake with your text, you can easily edit the text by double-clicking twice on the text box. The cursor will pop up, and you can change any of the text you need to. The warp settings will remain on the text box unless you decide to release it.
**Designer Edition Plus**

Silhouette Studio® Designer Edition Plus unlocks the Flexishapes, Conical Warp, Advanced Rhinestones, and Puzzle Generator tools as well as the ability to open embroidery files. Plus, it includes all of the features included in Designer Edition.

**EMBROIDERY FILES**

**APPLIQUÉ EMBROIDERY:** Designer Edition Plus gives you the ability to import appliqué embroidery files into Silhouette Studio®. If your embroidery file has a placement stitch layer, you can cut out the appliqué shapes using your Silhouette.

You can import the following embroidery formats with Designer Edition Plus:

- PES (Brother, Babylock, Deco, Singer)
- DST (Tajima, Barudan, Toyota)
- EXP (Stellar, Melco)
- JEF (Janome)
- XXX (Singer)

Open your file in the Silhouette Studio®. Delete the extra embroidery shapes so only the placement stitch line remains. Now you can send your shape to cut in your Silhouette. Remember to use a fabric blade and fabric stabilizer when you are cutting fabric with your machine.

**SKETCHING WITH EMBROIDERY FILES:** You can convert embroidery designs to sketch artwork using Silhouette sketch pens. Open your file in Silhouette Studio®. Assign each layer a color. Send the image to your Silhouette with each colored layer corresponding to a colored sketch pen.

**FLEXISHAPES**

If you’re the type of person who loves to tinker with existing shapes, the Flexishapes feature is for you. It allows you to take the base of a shape and customize certain aspects of it to create an entirely new shape.

Take this zigzag shape for example. There are a few ways you can change it to make it more of the shape you want.
Notice the little slider bar within the shape. This indicates how many points will be included in the zigzag. You can slide the bar to the right to add more points and slide the bar to the left to take away points.

The red points are there so you can adjust the thickness of the shape, the height of the total shape, and how close together the points in the shape are. The white points adjust the length and stretch or compress your design.

The best way to get into Flexishapes is to start playing around and seeing the possibilities. So pick a shape, start customizing it, and see what fun designs you can create!

**PUZZLE GENERATOR**

The Puzzle Generator is an easy-to-use tool that allows you to customize and create your own puzzles. It’s great for either your own photos, for patterns, or for Print & Cut designs you find at the Silhouette Design Store.

Start by choosing your design. Remove any excess cut lines that are both inside the design and around the border. Because we are also going to print this design, we’ve added registration marks and made sure our design is within those marks.

Next, click on the puzzle piece icon to open the Puzzle panel. There are a few ways to generate a puzzle. The easiest way is to make sure your design is selected and then click “Puzzle Selected Shape” in the Puzzle panel. But you can also click “Select Puzzle Area” and then click and drag over the design area you would like to turn into a puzzle.

**NOTE:** We have adjusted the line thickness of the puzzle here for the sole purpose of showing the puzzle lines in greater detail. If you do this, Silhouette Studio® will print those red lines as part of the design, so we recommend leaving your line thickness setting at 0 so that the lines don’t print.
The software will insert the puzzle overlay. You can easily change the number of rows and columns as well as any other puzzle settings. Changing the number of rows or columns increases or decreases the size of the puzzle pieces, so you can make the puzzle as simple or as complicated as you want. Checking the Curvature box means that the edges of the puzzle pieces will have more of a curved edge to them. If the Curvature box is checked, you can also change how much of a curve should be present as well as how much the edges of the puzzle pieces ripple. The Wobble setting changes how off-center the interlocking parts of the puzzle pieces are.

This feature makes whipping up your own puzzle so easy. Start playing around with the settings and see what settings you prefer for your own puzzle!

**ADVANCED RHINESTONES**

The top part of Advanced Rhinestones is your rhinestone library. It has rhinestones in different colors and three standard sizes: 20ss, 16ss, and 10ss. The best part is that the actual rhinestone image appears in your design instead of little colored circles. It can make it easier to create a mock up of your design.

If you work with rhinestones at all, you need Designer Edition Plus! It has so many features you can use to customize your design.

**USER RHINESTONES:** You also have the option of adding your own rhinestones. You can upload images of rhinestones using your PixScan™ mat, you can draw your own shape, or you can use a design.

Once you have your shape drawn or have placed the image of your custom rhinestone on the page, select the image. Then, click “Add Selected Shape to Rhinestone Library.” This will add your shape to a section called “User Rhinestones” underneath the stock rhinestones already loaded.
in your software. The rhinestone shape will remain in your library so you can use it for future projects. You can adjust the width and height to exactly match any rhinestone you are using.

The size of circular rhinestones is defined in “ss,” but it can be changed to “mm” or “in.” in your Preferences. You can resize your custom rhinestones by clicking on the slider bars under your Rhinestone Library.

Use your unique rhinestone shapes for more than just rhinestones. You could cut this star design out of any material.

**PLACING RHINESTONES AS OUTLINES OR FILLS:**
You can create outlines or fills using either a single rhinestone style or a multiple rhinestone pattern. First, select your image. Next, under Draw Rhinestones select “Single.” Then, select which rhinestone you want for your design.

There are three adjustment options: Angle, Spacing, and Angle Offset. Angle Offset allows you to adjust the angle at which rhinestones are placed. This is helpful if you want rectangular rhinestones to sit on your lines a specific way.

- **Standard:** Rhinestones are oriented in a uniform direction.
- **Center:** Rhinestones are oriented to point toward the center of the boundary shape.
- **Perpendicular:** Rhinestones are oriented perpendicular to the contour upon which they sit.
You can even adjust rhinestone specific designs. All you need to do is open the design, right-click and select “Ungroup.” Then change what you’d like in Advanced Rhinestones, such as deleting the top circle and adding a heart rhinestone as the cupcake topper. Then regroup everything so you can move it around as a single design.

**MULTIPLE RHINESTONES:** The Multiple Rhinestone Mode functions similarly to Single Rhinestone Mode, except you can use a multiple rhinestone pattern to fill or outline your design.

When in Multiple Rhinestones mode, you can make a pattern of rhinestones. To make a pattern, click on the rhinestone you want and drag it down to the space under “Multiple.” Go back to your rhinestone library and click the next rhinestone you want and drag it next to the first one. You can drag down as many rhinestones as you want to create your pattern. Each rhinestone will automatically be placed at the end of the pattern, but by clicking and dragging, you can rearrange them to make it look how you want.

**PLACING INDIVIDUAL RHINESTONES:** To place individual rhinestones in your design, select the rhinestone you want. Then, select “Single Click.” Place rhinestones by clicking into your design screen. Otherwise, there are two options to place rhinestones in your design: single and multiple.

Single provides a rhinestone cursor in the drawing area which places the currently selected rhinestone from the Rhinestone Library onto the page. This is a quick way to place a repeated rhinestone.

When you are in Multiple mode, the Rhinestone Cursor rotates through the sequence of Rhinestones defined in your list under multiple. This allows you to quickly place sequences of different rhinestone types.

Placing the Rhinestone Cursor above a rhinestone that has already been placed in the design area and then clicking causes that rhinestone to be replaced by a new one, positioning the new rhinestone at the same center.

**USING RHINESTONES WITH CUT FILES:** Open this regular phrase cut file and ungroup the design. The sprays of circles on either side are still grouped together. This is helpful. We are going to use the circles as a template to place the rhinestones. Using the Single Click function, choose the rhinestone or rhinestone pattern you want and begin placing rhinestones over the circles. Don’t worry if they don’t match up
exactly. The circles are just acting as a template. Once you have your rhinestones all placed, select one of the circles that is poking out from behind the rhinestones. Pull all the circles out and delete them. Aren’t you glad they are grouped so you don’t have to select each individual circle? Now you have an awesome blinged-out design.

Use the Replace Rhinestones feature to swap out some of the rhinestones for larger rhinestones. Select the rhinestone you want and click the rhinestone you want to replace.
CONICAL WARP

Have you ever tried to wrap a design around a round object and it just doesn’t quite work perfectly? Maybe your straight lines don’t match up? Conical warp is here to help you, and the best part is that the software does all the work for you! All you need to have is your round object and a ruler.

Start by creating your design. You can make this design by creating two long lines (which are actually just really skinny rectangles) with the rectangle tool. Add some text in the middle. Then, open the watercolor hearts. Ungroup the hearts, move, and resize them to fit around your text. Group everything and you are ready to warp!

Conical Warp is the second tab in the Warp panel. The main part of the panel shows a cylinder. To get an accurate warp, measure the object on which you will place your design. In this case, we are going to put the “Charlie” design onto a pencil cup.

Measure the top of your object from side to side. Put that measurement in the first input box. Next, measure the bottom of your object from side to side. Place this number in the second box.

The third length to measure is from top to bottom. Put this into the third input box.

The cylinder in the box is now an accurate representation of your object.

It might not seem like the warp has really changed the design that much. That’s because it hasn’t! It only adjusts your shape a tiny bit so it will look straight on your finished project. But, if you compare the two designs, you can see that the warped design is slightly bowed.
Business Edition

Silhouette Studio® Business Edition was created with small businesses in mind. If you are cutting multiples of the same project or if you are cutting very large projects, Business Edition is an awesome investment. With automatic weed lines and multi-cutter use, Business Edition was designed to save you time. It includes all of the features offered in Designer Edition and Designer Edition Plus so Business Edition helps you get the very most out of your machine.

MULTI-CUTTER SUPPORT

Business Edition provides multi-cutter support. This means that when using the Business Edition, you can send cut jobs to multiple Silhouette cutting units at the same time. Time Saver!

Go to the Send tab. First set up your cut settings in the Material and Action tabs just like you would with any other cut job. Once you get to the Send tab, select the Silhouette unit to which you would like to send your cut job. Press “Start.”

You can use this feature to cut the same job or different jobs depending on which document tab is actively displayed when you enter the Send panel. That means you can send project number one to one machine, and while it is still cutting you can switch tabs on your design screen and send project number two to your second machine.

You can name your Silhouette machines so you know which machine you are sending which job to if you have multiples of the same machine. To rename a connected Silhouette, simply click on the Silhouette model name in the Send panel. Once you click on the model name, you can type in any name for the specific Silhouette unit. The name will be retained whenever you use the computer that was used to create the name.

AI/EPS/CDR FILE COMPATIBILITY

Business Edition provides the ability to open Ai, EPS, and CDR files which have been created from other major vector imaging software programs (such as Adobe Illustrator® or CorelDraw®).

You can either select to cut by layer and simply enable the desired layers, or opt to cut by line color and either enable the “no color” line to be cut or re-color your lines as desired using the Line Color tool.
Alternately, you can opt to use the Silhouette Connect™ program to cut these files from their native software programs.

**WHAT IS SILHOUETTE CONNECT™?**
Silhouette Connect™ is a plug-in available for those of you who want to cut directly from Adobe Illustrator® or CorelDraw®. Once the plug-in is purchased and installed, you can send your design to your Silhouette directly from your design program without ever opening Silhouette Studio®.

**EXPORT SVG, PDF, AND JPEG FILES**
Business Edition gives you the ability to export SVG, PDF, and JPEG files. These files can be used or edited in design software programs that do not support the STUDIO file type.

**EDITION TOGGLE**
One of the benefits of having Silhouette Studio® Business Edition is that you can utilize all of Silhouette’s amazing features. But if you are generating a tutorial or are trying to teach someone who has a different version of the software, things can get a bit confusing. Silhouette’s edition toggle helps make viewing other software versions much easier.

To access the edition toggle, go to the Help menu. Then go to “View In” and select the edition of the software you wish to view.

There is also an option for you to hide your email address when you are working in the software. This is helpful when you are producing tutorials and want to protect your privacy.

**MULTIPLE UNDO/REDO**
If you are anything like us, you can spend quite a bit of time designing things in Silhouette Studio®. Some designs require more time than others. The more time you spend clicking around in Silhouette Studio®, the more actions you make.

You can see every single action you have taken. Click the Multiple Undo/Redo icon on the top of the design screen next to the regular Undo and Redo icons. The Multiple Undo panel will open.

When we first started this design, we typed out the “sisters” text. Then we started working on designing the girls. These paper pieced girls are made of quite a few shapes each. Between arranging them and adding line and fill colors, we made 269 actions.

Now, we want to add some additional text in the original font. But we welded the text when we first started this project and we might not remember which font it was. And, we didn’t leave ourselves a helpful sticky note with the text name. The good news is you are not out of luck!
Start by making a copy of your design. Just to be safe, open a new document and place your design in there. When you undo everything, it will undo all of your hard work!

Look in the Multiple Undo panel and go back as far as you need to. Find where you typed your text and changed the font, but go back to before you welded the text. Once you find that spot, click the action. Silhouette Studio® will undo EVERY action you took to get to that spot. You can watch it reverse every action you did.

Now you can see your text and check which font it is in. Knowing that, we can continue designing!

This was a drastic example of multiple undo, but you could use it for almost anything. If you start designing something and you don’t like it, simply use the multiple undo function instead of clicking Ctrl + Z a million times.

FONT CREATION
Creating your own font is a great way to customize any project, and you can easily do that with the Font Creator tool in Silhouette Studio®. There are two different ways you can make your own font: handwritten or digital.

HANDWRITTEN FONT CREATION
Preserve the handwriting of your loved ones or create a special font for a new project by adding a new handwritten font to your computer.

First go to the font creation tool located on the toolbar on the right. Click “Show Font Creator Sheet” and print it to your home printer.
Chapter Three: Silhouette Studio®

Upgrades

Fill in the letters and symbols on the sheet and take care to make the glyphs nice and dark. **You must fill in the specified letter or symbol in its corresponding box.** If you don’t, when you go to type with the font, the assigned letters or symbols may be misplaced, and you may not know which glyphs correspond to which keyboard keys.

Now you must upload your font sheet. There are two ways you can do this.

**SCAN SHEET:**
To upload your Font Creations Sheet using a scanner, start by going to the Font Creation panel and selecting “Scan.” Then choose your scanner from the drop-down menu. When you are ready, insert your Font Creation Sheet into the scanner.

Finally, go back to the Font Creation panel and click “Start Scan.”

**TAKE PHOTO OF SHEET:**
In the Font Creation panel, select “Photo.” At the bottom of the panel, there is a drop-down menu where you can select your calibration source. Try selecting “Auto” first. If you find that you are having a calibration issue, you must first calibrate your camera. You can do this by following the tutorial under the PixScan™ section page 75. You only have to calibrate your camera once. Then make sure the calibration photo for the camera is selected from the drop-down menu in the Font Calibration panel.

Then take a photo of your sheet.

Next, download the photo to your computer. Then in Silhouette Studio®, click “Import Photo” and find your photo and click “Open.”

When your new font is imported, you’ll see thumbnails of each of the glyphs in the Font Creation panel. Make sure you give your font a name. (Double-click on the font name to change it from the default name.) Then choose one of
three different save options, which we will go over in a later section.

To add or edit a glyph, click on the box and then click “Edit Glyph.” This will open up a new window where you can digitally draw the selected glyph.

You’ll see five different dashed lines. The top line and the bottom line are your cutoff lines—make sure you don’t extend your glyphs over these lines. If you do, the glyphs may not show up in their entirety when you type your font. The other lines are standard lettering lines and can be used as guidelines to determine how you would like to design each glyph.

1. Ascender Line
2. Cap Height Line
3. X-height Line
4. Baseline
5. Descender Line

DIGITAL FONT CREATION
To create a font digitally, start by going to the Font Creation panel. Click on the second tab at the top of the panel that looks like a cursive uppercase E. Next, click on the + sign in the Font Creation section. This gives you all of the blank glyph templates you need for your font.
Once you are finished, select “Save Glyph” in the Font Creation panel. You’ll see a thumbnail of your glyph show up in the panel. Repeat with all of glyphs.

When you’ve added all of the glyphs for your font, you’ll see all of the thumbnails in the Font Creation panel. Make sure you give your font a name. (Double-click on the font name to change it from the default name.) Then choose one of three different save options.

**SAVE OPTIONS**

- **Test Run**: Choosing this option allows you to view what your font will look like in Silhouette Studio® without permanently installing the font in your software or on your computer. This option is the one you’ll want to use if you still want to make changes to the glyphs but want to view what your font currently looks like.

- **Save Final Version and Install**: If you’ve made all the changes you are going to make to your font and are ready to install it, choose this option. A window will pop up and prompt you to save the font to your computer. Once that is done, you can use the font in other software programs, not just Silhouette Studio®.

- **Save Final Version without Installing**: This option allows you to save the font as you have created it, but it won’t be installed on your computer to use in other software programs. However, you will be able to access the font file if you wish to install it on your computer later.

After you’ve chosen a save option for your new font, you can start using it. Simply go to the Text panel and search for the name of the font. Then use your font just as you would use any font in Silhouette Studio®.

**AUTOMATED WEED LINE FEATURE**

The Business Edition Weed Settings feature allows you to automatically creates weed lines within open line paths for easier weeding. This is great for materials like vinyl and heat transfer. You can make a surrounding weed line border as well as internal weed lines inside the design’s open spaces (such as between letters). You can make your own weed lines with the Line Tool, but why not have the software do it for you?

The following options are available in the Weed Settings panel:

- **Show Weed Border** - This creates an automated weed border around the entire cut job.
- **Padding** - This adjusts the padding dimension to add or remove spacing between the border and the weed border.
All weed borders and internal weed lines are automated and adjusted on-the-fly as you make changes to the placement or sizing of objects on your workspace. All weed borders and lines are displayed in blue on your Design Page and red on your Media Layout page.

Open your design and select “Show Weed Border.” It will add a blue box around your design.

There are four types of Weed Lines: Horizontal, Vertical, H/V (Horizontal/Vertical), and Recursive. The best thing to do is a click on a few to find what works best for your project. For this design, Horizontal works well. Vertical doesn’t work very well because there is hardly any space to put straight lines up-and-down. H/V doesn’t work well because Vertical doesn’t work well. If you are looking to add a lot of weed lines, Recursive works great. It added lines between every letter.

Once you click the Business icon, you can check or uncheck the “Processing Active” box to show or hide the Media Layout View. This side-by-side view capability provides you access to further Business Edition features like Matrix Copy options, Media Layout Nesting, and Tiling. Check “Processing Active” to turn the dual view on and off.

You can adjust the Media Layout page just like you adjust your design page in the Page panel. Your Page settings and Media Layout Settings don’t need to match each other. For example, on your design page, you can have “Cutting Mat: None” selected and in your Media Layout Settings, you can have a cutting mat showing. Pages can also be different sizes, like if you just
Adjust the rows and columns to choose your number of copies. This has two rows and three columns. But, part of the third column is out of the cutting area. We need to do some further adjusting to get more shapes to fit. If you click “Limit to Media,” the software will take the numbers for the rows and columns you entered and remove any that don’t fit on your media size. This removed the two right-hand copies, leaving us with four instead of six.

**KEYBOARD SHORTCUT:** Media Layout

Windows, press Ctrl + Shift + V  
Mac®, press Cmd + Shift V

**MATRIX COPY FEATURE**  
Matrix Copy lets you create a matrix of multiple copies of the same design. These are replicated while your cut job is processing, but it doesn’t actually alter or effect your original design. This is available only while in the Media Layout mode.

While the original design retains its original design layout, the Copy panel replicates your design to cut multiple copies. Choose how many copies you want and how much space you want between them.

**SILHOUETTE PRO TIP:** Turn on “Nesting Active” under the Nesting Icon. It will automatically nest your designs as it makes rows and columns. Here we have our same design of three columns and two rows. With “Nesting Active” selected, it easily fits six designs on the page. Add two more rows and you can get another full page of your design. For more on Nesting see the next section.

**MEDIA LAYOUT NESTING**  
Automated Nesting mode automatically nests your objects within the Media Layout View to provide efficient use of your material. But, unlike Nesting in Designer Edition, the original images’ positioning stays the same in the Design View, allowing you to continue editing and refining the design.
Checking “Nesting Active” turns the nesting feature on or off. Nesting can be combined with other Business Edition features, such as Tiling or Matrix Copy. For an example of this, see above.

The following options are available in the Nesting panel:

- **Maintain Groups** - This will keep any grouped images in their original grouping rather than nesting each individual object.

- **Rotations** - This will allow or restrict the level of angles you allow the images to rotate. For example, a Rotations setting of “0” will hold the images exactly in their original angle of rotation whereas a Rotations setting of “2” will allow rotations of 0° and 180° turns for the images. As the Rotations setting is raised, the number of possible rotation angles for each image increases. While the highest setting may make the most effective use of space, there may be instances where the angle of images is important to your project.

- **Padding** - This controls the minimum distance between two shapes after they have been nested.

- **Interlock Shapes** - This will nest concave shapes together in more efficient ways and attempt to interlock them to save more space on your media.

- **Maintain Grain** - When enabled, this leaves images unrotated or rotates by 180°. This is useful when you are using specialty media that has a grain to ensure the grain runs in the same direction for all images.

- **Align** - If your images are rotated to an irregular angle in the Design View, the Align option will snap the image upright to compensate prior to determining the best angle to nest the shape into.

- **Whole Words** - This will keep letters in words created with the Text tool together as words, instead of nesting each individual letter. It will nest the words together.
TILING

The Tiling feature provides you an amazing method to cut a large project from a series of smaller tiles. After the cutting process is completed, you will assemble the tiles to create the large-scale design. The Tiling feature is available only in the Media Layout mode.

The Cameo has the maximum cutting width of all Silhouette machines at 12 in. So, if you want to cut something larger than this, you have two options. You can manually slice your material into smaller pieces using the Knife Tool, or you can use the Tiling feature which will automatically segment the job into a series of smaller jobs. Let Business Edition do the work for you! After your pieces are cut out, you will assemble them to create your final project.

While your original design will retain its original design layout, the Tiling option will rearrange the design to be cut in a series of multiple panels. It will add cut lines to the places that are getting spliced. You have options to adjust just about everything, including how many tiles you want, where you want your pieces sliced, and how much overlap you want between the pieces.

Our design here is a simple example of tiling a single shape into two pieces. We adjusted the grid so it would slice it into two pieces that are each under 12 in. wide so they can be cut with the Cameo.

SILHOUETTE PRO TIP: Under the Overlap feature, there is a Margin bar. Add some overlap! How much easier will it be to piece your design together when you have a little bit of wiggle room?

The bike was a simple example of tiling. But did you know that you can cut something MUCH larger than this? How about a 55 in. US map to apply to your wall? With Business Edition, cutting something huge is a snap. Open your design in Silhouette Studio® and size it in the Scale panel. Change your Page Settings so your page is larger than your design.
Make sure you have your correct page size in the Media Layout Settings. Click “Tiling Active.” A grid will appear over your design. Fifteen tiles! Don’t worry; Business Edition can handle it. You have full control to minutely adjust the grid. Don’t forget to add a little overlap if you want to give yourself a little wiggle room when you rebuild.

When you’re ready to cut, the bottom part of the panel labeled “Tiling” gives you options to cut which tiles. You can cut them all at once, or you can choose a few tiles at a time.

You can also choose which tiles to cut by clicking or unclicking the tiles in your design screen.

**SILHOUETTE PRO TIP:** Keep “Show Dimensions” checked to see how big each tiled area is and to make sure it will fit on the page you are cutting on.
Silhouette 3D™, sometimes referred to as S3D, is the software program specifically designed to work with the Silhouette Alta® 3D printer. This software is very unique because it allows you to create and view 3D objects and then print the objects with your printer using a plastic material called filament.

You can create your own designs, use designs from the Silhouette Design Store, or even use other third-party designs. These designs can then be prepared through the Silhouette 3D™ software, which you will use to send the design to the Alta 3D printer.
WORK AREA OVERVIEW

1. Document Tools
2. Quick-access Toolbar
3. Drawing Tools
4. Document Tabs
5. Holding Area (Gray)
6. Design/Print Area
7. View Cube
8. Navigation Tabs
9. Library Panel
**Document Tools**

**NEW PROJECT**
When you open Silhouette 3D™, a new project is automatically created. But when you’re working in Silhouette 3D™ and want to open a new project without closing and reopening the software, you can use the New option from the File menu, select the New Project icon on the toolbar, or use the keyboard shortcut.

**KEYBOARD SHORTCUT:** New Project
Windows, press Ctrl + N
Mac®, press Cmd + N

**OPEN**
To open existing files, you either use the Open option from the File menu, select the Open icon, or use the keyboard shortcut.

**KEYBOARD SHORTCUT:** Open Document
Windows, press Ctrl + O
Mac®, press Cmd + O

You will then be prompted to navigate to the location where your desired file is located. Through the Open feature, the Silhouette 3D™ software has the ability to open .S3D, .STL, and .OBJ print files.

**SAVE**
If you’d like to save any changes to your design, you can select the Save option from the File menu, click the Save icon, or use the keyboard shortcut.

**KEYBOARD SHORTCUT:** Save Project
Windows, press Ctrl + S
Mac®, press Cmd + S

**CUT, COPY, AND PASTE**
Cut, Copy, and Paste are the basic tools for copying selected designs, pasting them, or cutting them from view. Designs copied or cut will sit in your computer’s memory on a virtual clipboard. You may only have one object on this clipboard at a time.

This means if you copy one design and then copy another, only the most recent design will be waiting on the clipboard to be pasted. You can access these from the top toolbar, in the Edit menu, or by right-clicking on an object.

**KEYBOARD SHORTCUT:** Cut
Windows, press Ctrl + X
Mac®, press Cmd + X

**KEYBOARD SHORTCUT:** Copy
Windows, press Ctrl + C
Mac®, press Cmd + C

**KEYBOARD SHORTCUT:** Paste
Windows, press Ctrl + V
Mac®, press Cmd + V

**UNDO AND REDO**
Any action you do, including simply moving an image, may be undone. To back up to your previous action, click the Undo icon. There is an unlimited number of actions you may go back to with the Undo feature, including going back to when you first opened your new workspace. In other words, you can’t ruin your design. Try something out and if you don’t like it, click Undo! Once you close your file, the function resets; you won’t be able to open a document tomorrow and undo something you did today.
Chapter Four: Silhouette 3D™

KEYBOARD SHORTCUT: To Undo an Action  
Windows, press Ctrl + Z  
Mac®, press Cmd + Z

KEYBOARD SHORTCUT: To Redo an Action  
Windows, press Ctrl + Shift + Z  
Mac®, press Cmd + Shift + Z

OBJECT VIEW TOOLS
The View Tools are for changing how you view an object in Silhouette 3D™.

SELECT ALL AND DESELECT ALL  
To select all the objects in your design area, click the Select All icon. To deselect all of the objects that are currently selected, click the Deselect All icon, or use the keyboard shortcut.

KEYBOARD SHORTCUT: Select All Objects  
Windows, press Ctrl + A  
Mac®, press Cmd + A

KEYBOARD SHORTCUT: Deselect All Objects  
Windows, press Ctrl + Shift + A  
Mac®, press Cmd + Shift + A

WIREFRAME  
Click the Wireframe icon to show the wireframe view of the objects on your design space. To go back to the solid view of objects, click the Wireframe icon again.

CUBE  
Click and drag the cube to adjust the camera view to see all angles of your object.

ORTHOGRAPHIC AND PERSPECTIVE VIEWS  
The orthographic view is a 2D representation of the 3D shape at any given angle. The perspective view shows the point of view that is an approximate representation of the shape as you would see it once built in your machine.

PAGE VIEW TOOLS
The Page View Tools are to help you adjust the page so that you can see your objects better.

ZOOM IN AND ZOOM OUT  
Clicking the Zoom In and Zoom Out icons changes how close the camera view is to an object or the design space in Silhouette 3D™.

ZOOM TO SELECTION  
This tool allows you to zoom to specific areas of your workspace by drawing a box around the area you wish to zoom in to.

PAN USING MOUSE  
Use this tool to pan around your work area. To use it, click the icon and then click and hold the mouse on your design screen. While you are still holding the click, move your mouse around. Doing this will adjust what parts of the screen you see.

CENTER VIEW  
When you click the Center View icon, your design space will center in the window and zoom in or out depending on how close you currently are to the design.

DESIGN/PRINT AREA  
There are two different sections in your workspace: the design space, or the printing area, and the gray holding area. Images and designs can be placed on both the gray holding area and
the printing space. However, any designs that are in either the white design space or the gray holding area will be designated as prints when you go to the 3D Print tab.

To group objects together, select two or more objects (this can be done by clicking and dragging your mouse to create a selection area with your objects inside OR by holding down the Shift key on your keyboard while you click the parts you wish to include). Once everything is selected, click on the Group icon or right-click on your selection and click “Group.”

To ungroup parts of grouped objects, click on the object to select it. Then click the Ungroup icon or right-click the selection and click “Ungroup.”

**Quick-access Toolbar**

The quick-access toolbar has what are called the object tools. You will see this toolbar only when you have an objected selected.

**COLOR SELECTION**

Change the color of the shapes or text in Silhouette 3D™ by making sure the shape or text is selected and then clicking on the square below the New Project option on the Document toolbar.

**ROTATE**

Objects may be rotated to any desired angle using the tools we’ve previously mentioned. To quickly rotate the object in 90-degree increments, use these arrows located on the quick-access toolbar.

**GROUP AND UNGROUP**

Any two sets of designs can be grouped together so they are fixed in their relative positions, even if moved, by using the Group option. Most designs that contain more than one object can be ungrouped so that parts of the design may be treated independently.

**DUPLICATE**

The Duplicate option performs the same action as copying and pasting the selected object but does so without the need of utilizing your clipboard and is a one-click operation. This toolbar icon is located at the top of the software screen and can alternately be located in the Edit menu or by right-clicking on a selected object.

**DELETE**

Selected images may be deleted from your workspace by clicking on the Delete icon located at the top of the software screen, by accessing the Edit menu and selecting Delete, right-clicking
a selected image and choosing the Delete option, or by simply pressing the Backspace or Delete key on your computer keyboard.

**LEVEL TO BED**
You can bring your design level with the print bed by clicking on this icon.

**CENTER TO BED**
You can center objects in the middle of the print bed by clicking this icon when a design is selected.

**OBJECT MANIPULATION**
Instead of changing aspects of the object by hand, you can use the drop-down menu to select and change an object’s dimensions, rotation, and scale.

When you have an object in your design space, you have the ability to check or change its dimension, rotation, and scale. Make sure the object is selected, and then go to the toolbar above the design space. You’ll see a drop-down menu where you can select “Dimensions,” “Rotation,” or “Scale.”

**DIMENSIONS:** You can change the size of an object by changing the width, height, and depth of an object.

**ROTATION:** You can change the x, y, or z axes to rotate your shape in a specific position. The x-axis is the horizontal axis, the y-axis is the vertical axis, and the z-axis is the depth axis.

**SCALE:** You can change the scale (or the proportionate size) of an object by adjusting the width, height, or depth.

**ASPECT RATIO LOCK:** With the dimension and scale options, you have the ability to lock in the ratio aspects by clicking on the lock icon. This means that when you make a change, the software will change the other measurements to keep the object proportionate.

**NOTE:** The aspect ratio lock and unlock only works for the Dimension and Scale options.

---

**Document Tabs**

Each new project or opened project will provide you with a new document tab in the top left-hand corner of your screen.

The tab will be labeled as “Untitled” until you save your file with a name. If you open a file that already had a name, the file’s name will be displayed. The white tab will always be the active document while other opened inactive documents will be gray. You may click on any inactive tab to make it the active workspace and toggle between open documents. Clicking on the “x” in the document tab will close any open workspace.

To save your file and give your current file a name, go to File > Save, click on the Save icon, , or use the keyboard shortcut.

**KEYBOARD SHORTCUT:** Save or Save As
Windows, press Ctrl + S or Ctrl + Shift + S
Mac®, press Cmd + S or Ctrl + Shift + S
Drawing Tools

CREATE SHAPE TOOL

- CONE
- SPHERE
- CUBE
- FRUSTUM OF CONE
- CYLINDER
- TORUS
- DOME
- TUBE
- PYRAMID
- WEDGE

When you click on a shape, a 3D version of that shape will show up in the middle of the design space.

TEXT TOOL

When you click on the text tool, a window will pop up where you can insert your text. To create 3D text, type your text and click “OK.” The text will show up in the print area.

You can manipulate the shapes or the text by selecting the object. You’ll see a box around the object with white squares around the edges of the box and arrows pointing in different directions.

Resize an object by clicking and dragging any of the white squares in the corner. You can squish or stretch the object by clicking and dragging one of the middle squares (that are either next to the corner squares or at the top of the box in the very middle).

Rotate an object by using the black arrows. To do this, move your mouse over one of the black arrows. The black arrows will then turn to red to indicate what you are selecting. Then click and drag your object in the direction you want it to go.

Navigation Tabs

There are three tabs along the top right-hand side above the Library panel: Design, 3D Print, and Store.

The Design tab is what comes up when you first open Silhouette 3D™, and it’s the screen you’ll use when you want to create a 3D object to print. It consists of the design space (the circle space that represents the Silhouette Alta® print platform) and the gray space outside of the design space.

To change the font, make sure the text is selected and go to the upper-left corner above the design space. Click the drop-down menu to select a new font. You can select any font available on your computer.
The 3D Print tab is where you will modify any print or machine settings and send your design to the Alta. Silhouette 3D™ will prepare the design (through a process called slicing) for printing according to your print settings and give you an estimate of the print time and the amount of filament needed.

The Store tab is what you will click when you want to go to the Silhouette Design Store. When you click it, a browser window will open up and take you to the Design Store. From there, you can browse all kinds of designs that you can print.

Design Tab

LIBRARY

The Silhouette Library contains all of the content you purchase from the Silhouette Design Store. To go to your library in Silhouette 3D™, go to the panel on the right-hand side of the screen and sign in using your Silhouette credentials.

After you sign in, you’ll see a few folders. The majority of your designs are going to be in the Library folder, so double-click on the Library folder to start.
You’ll see a folder of 3D designs as well as any other library folders you may have created on your Silhouette account.

Double-click on the folder to view the designs, and when you find a design you want to open, double-click it or click and drag the design onto your workspace.

You may find it convenient to customize your library with new folders to sort your designs however you wish. To add a new folder, right-click in the Library panel and select “New Folder.” Then name your folder as desired. You can right-click to rename or delete your folder. If deleting a folder, be sure to move any designs you want to keep into a different folder. If you delete a folder with designs you still want, you will have to resync your account to re-add the designs in your Silhouette software.

As your library continues to grow with additional content, it may be easier for you to search for designs by keyword if you know the keyword of a specific design you are searching for. Go to the search bar at the top of the Library panel, click on the search icon (it looks like a magnifying glass), and type in your keyword to search through your designs. As you type, results that are relevant to what you have typed will start to populate within the Library panel.

2D DESIGN IMPORT OPTIONS
When you open a 2D Design from your Library in Silhouette 3D™, you’ll see a box with several options you can select that will determine how your design is imported. We’ll go through each of these options with the same design to show you how the software changes the 2D design into a 3D design.
**EXTRUSION**
The extrusion option simply adds some thickness to the design to make it 3D and printable.

**COOKIE CUTTER**
When you click the cookie cutter option, the center of the design is removed but the outline remains and is extended.

**JEWELRY BOX**
Selecting the jewelry box option will turn the outline of your design into a box with a lid that fits on top.

**STENCIL BOX**
Much like the jewelry box option, the stencil box option will create a box with a lid, but instead of using the outline, it uses the inset of the shape, so the heart is slightly smaller.

**STENCIL**
The stencil option is the opposite of the extrusion option, meaning that it creates a square and cuts out the design from the middle so that you have a stencil instead.

**WAX PENDANT**
The wax pendant option is similar to the extrusion option. The only difference is that it adds a little bit of a ridge to the outline of the design.
SNAPKITS
Build custom objects with predesigned pieces called Snapkits. Start by going to the Snapkit folder in the 3D Design folder and choosing a base piece. Then select an accessory piece. When you move that piece around, you’ll see that there is a colored dot on the accessory as well as a colored dot on the base piece that corresponds with where you can snap the accessory into place.

With some accessories, like this duck, you may be able to use multiple accessories. However, you may not use more than one accessory if the accessories snap in the same place. For instance we cannot use two hat accessories on this duck; we can pick only one.

Text can also be used as a Snapkit piece for things like tags or keychains. Type the text you want to use and place the tag design on the design area. Then click and drag the text and put it on the design. There will be a red line showing where to connect the center of the text with the center of the design. When the text snaps to the design, it will automatically go on top of the design.
HOW TO IMPORT THIRD-PARTY DESIGNS
The Silhouette 3D™ software is able to open .STL and .OBJ files in a ready-to-print format in addition to .S3D files. This means that you can import designs from any third-party sources into Silhouette 3D™ as long as the designs are in a compatible format. From there, you’ll then be able to print the design.

NOTE: When importing designs that are not your own, it’s important to remember that you must comply with the appropriate product licenses that are listed when you download the design file.

When larger designs created outside of Silhouette 3D™ are imported into the software, a window will pop up and ask you if you’d like to decrease the size of the object to fit the print bed. If you click “Yes,” the software will autoscale the design to a smaller size. If you click “No,” the object will be imported at its original size. You will still have a chance to decrease the size of the object manually.

TO IMPORT FILES, FOLLOW THESE STEPS:
1. Open Silhouette 3D™ and click on the Open folder icon (it looks like a folder) in the upper left-hand corner or click File and select “Open.”
2. Locate the files you wish to open.
3. Click on the files you wish to open. To select multiple files, hold down the Control or Command key and click on all the files you want to import.
4. Decide whether you want to have the software scale the design automatically. The software will automatically detect whether the design will be too big to print.
5. Proceed to alter the designs or change the print settings as needed.

NOTE: Often when you download designs from a third-party source, the designs come in a zipped folder. In order to successfully import the designs into Silhouette 3D™, you must first extract the files before you attempt to open them in the Silhouette software.
FREE DESIGNS
Each Alta 3D printer comes with 25 free designs that you can print. You can choose from a selection of cookie cutters, boxes, stencils, Snapkits and more!

TO ACCESS THESE FREE DESIGNS

1. Make sure you have completed the setup process by registering your machine (and creating a Silhouette account, if applicable).

2. Next, make sure the Silhouette 3D™ software is open.

3. Sign in to your Silhouette account on the right-hand side of the screen.

4. First click on the Library folder. Next click on the folder that is labeled “Free with Machine.” Then click on the folder labeled “Alta.”

As long as you’ve successfully registered your Silhouette Alta® on the setup page (silhouetteamerica.com/setup), you should find the free designs to print with your 3D printer.

3D Print Tab

After you are done making any adjustments to your design, save any changes and click the 3D Print tab. Silhouette 3D™ automatically constructs a 3D model according to the default settings, and you’ll be able to see how the printer will construct and print your shape. Click the Play button at the bottom of the page to see the different layers the printer will print.

You can toggle through the layers that will be printed and decide which designs you want to keep and print. Keep in mind that each print must remain within the active print area (bound inside the red circle on the white area). Any parts of the design outside of this area will not be printed.

In the upper right-hand corner, there is a box that shows you the status of the Silhouette Alta® as well as an estimate of the total printing time and the amount of filament needed. This is also where you will go to change your Print Quality Settings.

PRINT QUALITY SETTINGS
Silhouette 3D™ already has three preselected print settings for you: draft, standard, and high quality. What setting you choose depends on what kind of print you are making. If you are making something that you are just testing and don’t need it to look particularly great or hold up for a long time, you’ll probably want to select the draft print settings. If you are making something that needs to look nicer, select the high-quality settings.
You have the ability to create your own print profiles for your own specific projects, and you can change any settings that are preset in the software. The necessary settings will depend on what you are making and what you want to use it for. There are many additional resources online to help you decide what adjustments to make. To create a new profile, click on the gear icon next to the drop-down list of print-quality profiles. Choose an existing profile to start off and make whatever changes you need. When you’re done making changes, click “Save Settings,” and then you can name your new profile.

For more information on each print setting, please view either the Silhouette Alta® or the Silhouette 3D™ user manual.

**SLICING YOUR DESIGN**

After you have adjusted your print settings, Silhouette 3D™ will automatically slice your design. This just means that the software will break down your shape into layers it needs to print. Don’t be alarmed if you don’t see the exact shape that you originally had on your design page; when slicing your design, it adds in the brim and layer as well as supports, if you added them.

If you have multiple designs on the Design page that aren’t grouped together, Silhouette 3D™ will separate each object and put it in its own print job. A print job won’t print unless it is selected on the bar at the bottom of the screen. The software will print only one object at a time. If you wish to print multiple objects at the same time, you must group them together when you are in the Design tab.

**NOTE:** Printing multiple objects at one time is not recommended. Your Alta 3D printer prints by LAYER not by OBJECT, so if you print multiple designs at once, it may affect your print quality and cause the filament to become stringy between each object.
Chapter Four: Silhouette 3D™

The Silhouette Design Store is a great resource for premade designs. To access the Silhouette Design Store, you can click the Store tab in Silhouette 3D™, which will open the Design Store in a browser window for you. You can alternately navigate to silhouettedesignstore.com outside of the software through any web browser.

SEARCHING FOR 3D DESIGNS

To search for 3D designs, go to the 3D section on the menu bar. You’ll see a drop-down menu to select either 3D Paper Crafting or 3D Printing. The 3D Paper Crafting section has designs that are meant to be used with paper, so you’ll want to go to the 3D printing section.

PRINTING OBJECTS

When you’ve finished adjusting your print settings, it’s time to print your object. Make sure you connect your Alta printer to your computer and plug the Alta into a power outlet. Then turn the Alta on.

In the print settings box in the upper right-hand corner of the screen, make sure your Alta is selected as the printer.

If needed, go through the filament loading process by clicking on the filament icon that looks like a spool of filament. Place the Alta platform with the Alta platform tape face up inside the plastic case. Next click Print in Silhouette 3D™, and your object will proceed to print.

When you move your mouse over the 3D Print section, you’ll see new options populate to the right: S3D, Snapkits, and SEE ALL 3D PRINTING. Click on S3D. This will bring up all of the Silhouette 3D designs that are available for purchase.
SEARCHING FOR 2D DESIGNS

Silhouette 3D™ has the ability to turn 2D designs into 3D designs. Not every 2D design is going to convert into a good 3D design, so you’ll have to experiment and see what designs work best. Generally, you want to use designs that have all of its pieces connect or that can be connected once you open the design in your software. Anything that has thin lines, intricate details, multiple layers or lots of text may be harder to print.

For more information about how to convert 2D designs into 3D designs, go to the 2D Import Options section in this chapter.

PURCHASING DESIGNS

When you click on a design, a box will pop up that will tell you more about the design and give you the option to add the design to your cart or add it to your wishlist if you want to come back to the design later.

Any designs you purchase will automatically be added to the Silhouette Library in the Recent Downloads folder.

Preferences

You have the option of changing a few of your software preferences. To do so, go to Edit > Preferences. A window will pop up, and you’ll have the option of changing the language and the unit of measurement as well as what to do when you open an object that is larger than your print bed. In this window, you can specify how often, if ever, the software will automatically check for updates. You can also choose to have the software send Performance Improvement data, to Silhouette’s software team. Doing this will help Silhouette know what needs to be improved.

After you add all of the designs you wish to purchase to your cart, click the cart icon in the upper right-hand corner of the screen. You’ll see a list of all of the designs currently in your cart. From here, you can remove any designs you no longer wish to purchase, view the total cost, and checkout to purchase your designs to use in most of the Silhouette software offerings.
Silhouette ModelMaker™ is a completely separate software from Silhouette Studio®. It is a program intended for users to design, cut, and assemble 3D shapes. First, users will create 3D shapes in the program. Then, these shapes can be cut as 2D images with a Silhouette machine and assembled into 3D shapes.
**Silhouette ModelMaker**

Silhouette ModelMaker™ is an easy-to-use educational software tool for creating 3D shapes and converting them into 2D images that can be cut out and assembled. This software is perfect for classrooms but can also be used in a home environment to create a variety of 3D paper crafting applications. Providing STEM (science, technology, engineering, and math) subject teaching and learning opportunities, ModelMaker™ is simple enough for elementary-age curriculum yet robust enough to transition to those in high school and beyond.

Models designed in the software’s 3D environment are converted instantly into nets (unfolded, segmented versions of the 3D shapes) that are designed to be cut out with a Silhouette cutting machine, such as the Silhouette CAMEO® or Silhouette Portrait®. Build a rocket ship, design a mock-up for a company product or create an entire model city. The possibilities are endless!

**WORK AREA OVERVIEW**

1. Document Tools
2. Shapes
3. Quick Shapes
4. View Tools (Edit Window)
5. Edit Window
6. Quick-access Toolbar
7. Output Window
8. View Tools (Output Window)
9. Window Control Buttons
Document Tools

NEW DOCUMENT
Each time you open Silhouette ModelMaker™, a new document is created. But if you wish to open a new document, click on the New Document icon or go to File > New. But be aware that opening a new document will cause you to lose what you are currently working on, so you may wish to save any work you have done before you attempt to open a new document.

OPEN
You have the option to open existing Silhouette ModelMaker files. Click on the Open icon or click on File > Open. Search for the file you wish to open.

SAVE
To save any models you have created, simply go to the top of the screen and click the Save icon or go to File > Save or File > Save As and save the file anywhere on your computer.

PRINT
If you wish to add color, patterns, or other designs to your shapes, you will need to add registration marks (or black marks printed around the border of your nets) and print out the net using your home printer. You then have the option of cutting out the net precisely with your Silhouette cutting machine. The machine will use its optic scanner to scan the registration marks and cut out the printed cut lines specified in ModelMaker™.

CUT (WITH MACHINE)
After you’ve created your shape (and printed the shape net, if desired), place your material on the Silhouette machine’s cutting mat and load the cutting mat into your cutting machine. When you are ready, click on the cut icon that is in the upper right-hand corner.

COPY, PASTE, AND CUT
The cut, copy, and paste tools are the basic tools you’ll use when you want to copy and paste selected images or cut them from view. Images copied or cut will sit in your computer’s memory on a virtual clipboard. You may have only one object on this clipboard at a time. In other words, only the most recent image that you copy or cut will remain on your clipboard for your computer to retrieve.

When you paste a copied shape onto the edit workspace, the image will appear slightly to the right of the shape you just copied.

NOTE: Here are two cut icons that do two different things. The icon that looks like a page with cutting machine is the icon to use when you send the job to your Silhouette machine. The icon with the scissors is the cut function that is used along with the copy and paste functions, and clicking on this icon while a shape is selected will remove the shape from the workspace.

UNDO AND REDO
Any action you perform in ModelMaker™, whether it’s adjusting a shape or changing a shape’s color, can be undone. To undo an action, you can either click on the arrow icon that circles around to the left or press Ctrl + Z or Cmd + Z on your computer’s keyboard. You can use this action as many times as you need, and even undo all of your actions up until the point when you opened your document.
If you find that you have done one too many undo actions, there is also a redo action where you can redo any steps you may have accidentally undone. Simply click the arrow icon that circles around to the right or press Ctrl + Shift + Z or Cmd + Shift + Z on your computer’s keyboard.

**SELECT (SHAPE)**

If you wish to select a shape and move it around the Edit space, click the arrow icon located along the top toolbar. Then select your shape to move it around in the space or to edit any of the shape’s points.

**SELECT (SIDE)**

If you wish to select just one side of a shape (say to color the side a different color or to add a pattern to one side of your shape), click on the select icon that looks like an arrow pointing to an irregular shape. Then click on the side of the shape you wish to select.

**ROTATE**

To rotate a shape with where it currently stands on the edit space, click on the rotate icon (an arrow going counterclockwise). Then click on the shape. You’ll see a white bar go through the shape and arrows circling around the bar. This means that it is ready to rotate. To change the position of the shape, click the mouse, hold the click, and drag the green squares in the direction you wish to rotate the shape. When the shape is rotated how you’d like, release the click.

**NOTE:** That this option rotates the shape itself instead of the camera view.

You can also right-click the shape and select Rotate. This will bring up the green rotation points, but it will also bring up a box and give you the option of rotating on a specific access and choosing a specific degree rotation.

It’s important to note that the net outputs are not affected by the rotation of shapes.

**GRID**

Clicking on the grid icon will make the grid in the editing space either disappear or reappear. If you click the down arrow next to the grid, a box will pop up that will give you the option of changing the grid setup, which may be helpful for you as you try to create small or detailed designs.

**ModelMaker Setup**

The main screen of ModelMaker is divided into two parts: the Edit window and the output window. These are separated by a divide bar that can be dragged to either side to adjust the relative sizes.
EDIT WINDOW
3D shapes are drawn and edited in the Edit window. This is similar to drawing 2D vectors in 2D design software, but the ModelMaker software shows a representation of what the 3D image will look like in a 3D space when it is assembled.

In the Edit window, you’ll see the left corner view of your area. This is the default view. You can change this view by clicking on the camera icons or any other icons located in the Edit Window Controls.

NOTE: You may not be seeing all of the camera angles available right away. If you go to File > Preferences > Toolbars, you can add any additional viewing angles or any other additional shapes and settings to your toolbar that you wish.

OUTPUT WINDOW
ModelMaker is creating representations of 3D images, but there has to be a conversion step to break down the 3D design into flat pieces so that it can be Print & Cut on a 2D surface first. This is where the Output window comes in. It will display what’s called a net, which is the flat model, and the outline of the shape as well as the tabs that will be added to the shape to make the assembly easier. You can think of it as a print preview to show you how your shapes will appear on the printout.

View
The default window setup is to split both the Edit window and the Output window. With the Window Control Buttons, you can choose to see only the Edit window or only the Output window instead of seeing both windows simultaneously.

Shape Creation
Silhouette ModelMaker™ uses 3D shapes to design models on the screen. Using the shapes on the Shape Toolbar on the right-hand side of the Edit window, you can draw new shapes. You can manipulate a single shape or you can combine shapes together to make a more complex 3D model. Some of the shapes have a drop-down menu that reveals other variants of the shape that can be selected to draw.

Remember that you can unlock more shapes by going to File > Preferences > Toolbars, scrolling down to the shapes section, and clicking the box next to the shape to display the shape on your toolbar.
The beauty of the ModelMaker™ software is that you don't have to just draw single shapes; you can draw and stack multiple shapes on top of each other to create a more complex 3D model.

This model of a Saturn V Rocket was drawn using mainly cylinder shapes with images placed onto them. The command module and the engines were drawn using the frustum of cone shape.

**SHAPE TOOLS**
Shapes can be created in three ways: Select a shape tool and draw it with the mouse. Drag a library shape onto the screen. Use the shape wizard and type in dimensions.

**SILHOUETTE PRO TIP:** When learning how to use ModelMaker, it is best to keep the shapes quite small, no bigger than two inches in depth, width, and height. This way, it is much easier to see what is happening, and the net shape will fit on a single page.

**HOW TO DRAW SHAPES WITH THE MOUSE:**

**CUBOID**
Select the cuboid tool. Click on the screen to set a corner point of the base. Then drag the mouse to draw out the base, and click to set the base. Drag the mouse again, upwards or downwards, to give the cuboid height, or its third dimension. Click to finish.

**WEDGE**
Select the wedge tool. Click on the screen to set a corner point of its base. Then drag the mouse to draw out the base and click to set it. Drag the mouse again, upwards or downwards, to give the wedge height. Click to finish. When the wedge is selected, as shown in the illustration, two red control handles are displayed on top of the wedge. Use these handles to adjust the pitch of the sides of the shape.

**CYLINDER**
Select the cylinder tool. Click on the screen to start drawing its base. Drag the mouse to draw out the base, and then click to set the base. Drag the mouse again, upwards or downwards, to give the cylinder height. Click to finish.

**FRUSTUM OF A CONE**
Select the frustum of a cone tool. Click on the screen to start drawing its base. Drag the mouse to draw the base, and click to set the base. Drag the mouse upwards to give the shape height, and click to set the height. Then drag the mouse again to set the diameter of the top face. Click to finish.
CONE
Select the cone tool. Click on the screen to start drawing its base. Drag the mouse to draw out the base diameter, and click to set the base. Then drag the mouse upwards to give the cone height, which is its third dimension. Click to finish.

SPHERE
Select the sphere tool and click on the screen to start drawing. Drag the mouse to draw out its diameter. Click to finish.

*REGULAR PRISM
Select the regular prism tool. Click on the screen to start drawing its base. Drag the mouse to draw out the base, and click to set it. Then drag the mouse upwards to give the prism height. Click to finish. Use the drop-down menu on the prism tool to choose the number of sides to the end faces.

*FRUSTUM OF A PYRAMID
Select the frustum of a pyramid tool. Click on the screen to start drawing the base. Drag the mouse to draw out the base, and click to set it. Then drag the mouse upwards to give the pyramid height. Click to finish. When the frustum of a pyramid is selected, two red control handles are displayed on top of the wedge. Use these handles to adjust the pitch of the sides of the shape. Use the drop-down menu on the pyramid tool to choose the number of sides to the top and base.

*PYRAMID
Select the pyramid tool. Click on the screen to start drawing its base. Drag the mouse to draw out the base, and click to set it. Then drag the mouse upwards to give the pyramid height. Click to finish. Use the drop-down menu on the pyramid tool to choose the number of sides to the top and base.

*TRANSITION
Select the transition tool. Click on the screen to start drawing its base. Drag the mouse to draw out the base, and click to set it. Drag the mouse upwards to give the transition piece height. Click to finish.

A drop-down menu for the transition tool provides options to create a transition shape with different end faces. For example, choose to draw a shape with a square face at one end and a pentagonal base at the other end.

IRREGULAR PRISM
Select the irregular prism tool. Click on the screen to set a corner point of the base. Drag the mouse to draw out the base, and click to set it. Then drag the mouse upwards to give the cuboid height. At this point, the prism looks like a cuboid shape.

ModelMaker then animates the shape to position its end face square on to the viewer, ready for editing. Use the mouse to add points to the shape by clicking on the white perimeter line. Move points with the mouse to create the desired shape, like a staircase. Click the FINISH button in the pop-up toolbar.

ROTATIONAL
Select the rotational tool. Click on the screen to start drawing its base. Drag the mouse to draw out the diameter and click to set it. Drag the mouse upwards to give the shape height. Click to finish.

At this point, the shape looks like a cylinder. ModelMaker then animates the shape to position

*Shapes with drop-down menu
This option is great if you want to play with the dimensions of your shape as you build it. Simply select your shape, click where you would like to place it on the edit workspace, and play with the shapes’ dimensions by moving the mouse, and then click to finish the shape.
its side view square on to the viewer, ready for editing. Use the mouse to add points to the shape by clicking on the white perimeter line. Move points with the mouse to create the desired shape, like a wine glass. Click the FINISH button in the pop-up toolbar.

**TORUS**
Select the torus tool. Click on the screen to start drawing. Drag the mouse to draw out the diameter. Click to finish. When the torus is selected, as shown in the illustration, two red control handles are displayed on inner radius of the shape. Use these handles to adjust the diameter of the cross section of the torus.

**PLATONIC SOLID**
Select the platonic shape tool. Click on the screen to start drawing the default shape, a dodecahedron. Drag the mouse to draw out its diameter. Click to finish.

Use the drop-down menu on the platonic shape tool to choose the number from any of the five platonic solids to draw: dodecahedron, tetrahedron, hexahedron, octahedron, or icosahedron.

**HOW TO DRAG A SHAPE ONTO THE SCREEN:**
Click on the QuickShapes icon, located on the left-hand side near the bottom of the toolbar. (This icon looks like a cuboid shape within a folder.) A panel will pop open on the left-hand side that shows the basic shapes as well as a folder containing the street models that you can use. Once you’ve found a shape you want to use, click on the shape in the panel and drag the shape to the editing space. This option is great if you’re looking to place completed shapes on the editing space quickly.

**HOW TO USE THE CREATE SHAPE ASSISTANT:**
Select the icon located at the very bottom of the toolbar on the left-hand side to open the Create Shape Assistant. Select the shape you wish to create. The Shape Assistant will ask you to input the dimensions of the shape and ask you to input the position where you wish to place the shape on the editing space. This option is great if you know the exact dimensions you want your shape to be or if you want to place your shape on a precise spot in the editing workspace.

**COLORING SHAPES**
The default color of the shape will be blue, but you can change the color if you wish. Make sure the shape is selected and click the color icon (four squares with different colors) located at the bottom of the toolbar on the left-hand side. Then select your color of choice. A color panel will pop up on the left-hand side of the Edit window and give you swatches of colors to choose from.

At the top of the panel, you can select what the color panel shows: the color palette, the texture palette, and the true color palette. The color palette show basic swatches of popular colors. The texture palette allows you to select a pattern or a texture, and it has a drop-down menu showing themes of patterns you may wish to choose from. You can import your own textures or patterns (individually or grouped in a folder) if you so choose by selecting the box with the arrow pointing to the right. (This box is located on the right side of the drop-down menu.) Or you can go to the true color palette to choose any color or shade on the color spectrum.

*Shapes with drop-down menu
This option is great if you want to play with the dimensions of your shape as you build it. Simply select your shape, click where you would like to place it on the edit workspace, and play with the shapes’ dimensions by moving the mouse, and then click to finish the shape.
Chapter Five: ModelMaker™

Quick-access Toolbar

These tools pop up only when you have selected an object or multiple objects and help you to arrange your shapes within the edit space.

**GROUPING**

When multiple shapes are selected (either with the Select All object tool or holding down the Shift key on your keyboard and clicking on the shapes you wish to select), you can group them together so that they shapes move as a single shape.

**UNGROUPING**

To ungroup a shape you previously grouped together, make sure to select the shape and then click the Ungroup icon.

**IMPORTING IMAGES**

You can import the following formats in the ModelMaker software: STL, SVG, JPEG, PNG, BMP. While you cannot import STUDIO files saved in Silhouette Studio®, you can save your design as an SVG, a JPEG, or a PNG file and place the file in Silhouette ModelMaker™. In Silhouette Studio®, go to File > Save As and select the file type you wish to save the file as.

To import a design in ModelMaker™, create the shape you wish to apply your image to and open the folder where the design you wish to open is located. Click and drag the image onto the face of the shape.
SELECT ALL AND DESSELECT ALL
The select all tool is a handy tool that allows you to select all of the shapes on your edit page at once, so it is a much better alternative to clicking every single shape separately. When you want to deselect the shapes, you can either click the deselect icon or click on the edit space that's outside of the selected shapes.

DUPLICATE, NEW POSITION
Clicking the duplicate option will duplicate your shape exactly and place it to the right of the original shape. You can then move it around anywhere within the edit window.

DELETE
When you click on this while a shape is selected, you’ll remove the shape from the edit workspace.

EDIT PATH SHAPES
If you select a shape that has points you can edit to change the shape, you can edit its paths by clicking on the edit path shapes icon. Doing this will take you to the side view of the shape so that you can add, arrange, or remove any of the points of that shape. When you are done, make sure to click “Finish” in the little pop-up window to that you can go back to the regular edit space.
LOCK AND UNLOCK

If you wish for a shape to stay in an exact spot while you are working in the edit workspace, you can select the shape and then click on the lock icon, which looks like a key. This will gray out the shape and prevent you from moving it or editing it. When you are ready to move or edit the shape, click the unlock icon.

NOTE: Clicking the Unlock icon will simultaneously unlock all of the shapes that are currently locked, so it’s best to make sure you’re not going to need to change something before you lock it into place.

SET TO WORLD AXES AND SET TO SHAPE AXES

When you rotate a shape, you have the ability to change which axis you want to move the shape along. The default setting allows you to move shapes along the shape axes, which can vary depending on your angles of the shape and don’t necessarily coincide with the X, Y, or Z axes.

However, you do have the option of moving a shape along only the world axes, or the X, Y, and Z axes. These axes are constant in your edit workspace and will not change. It does this by drawing a bounding box around the shape with the axes of the box parallel to the axes of the workspace.

To move the shape along the axes, click the translate handles, or the blue handles, in the squares and drag the box until the shape is in the desired position.
Viewing and Zooming

There are a variety of viewing and zooming tools to aid in the creation of shapes. Because you are working with 3D shapes on a 2D software program, the viewing and zooming tools are necessary in helping you view all sides of the 3D shape you are creating.

**CAMERA**

Because ModelMaker™ attempts to show you what your shape is going to look like when it’s assembled, it’s helpful to have the ability to view your shapes from all angles so that you can adjust it as needed.

You can use the camera icons to change the camera view of your edit workspace. The default view is the left corner view, but you can change the camera to tilted front view, front view, right view, top view, and inside view.

Remember that you can go to File > Preferences > Toolbars and check the boxes in the camera section to add more camera angles to your toolbar.

**VIEW**

While the camera views offer a great starting point for your view, they don’t allow you precise control of your view. This is where the view arrows come in handy. You can rotate your view using the arrow icons, and these icons allow you to change view horizontally, vertically, or a combination of both.

**SOLID OR WIREFRAME VIEWS**

You have the option of viewing your shapes as solid shapes or wireframes. The wireframe shapes are essentially just outlines and are helpful if you’re working with a lot of shapes and need to get an idea of how the shape is going to work in the area you want to put it in.

Using the wireframe view will not affect the output of your net shape. While your edit workspace may show a wireframe shape, the net shape will still translate as solid in the output window.
Net Settings

The nets that show up in the output window the unfolded and flattened versions of the 3D shapes you have in the edit window. To create your shape, you’ll print the design, if applicable, and cut the net with your Silhouette cutting machine.

Changing the shape in the edit window—whether it’s changing the size, color, or points of the shape—will change the shape in the output window as well.

The nets are automatically placed in the output window, but you can do a few things to make the best use of your page space.

**ROTATE:** When you select a net in the output window, you’ll see lines in the corner that show where your net is grouped as well as a green circle, which helps you to rotate the net. When you hover your mouse over the green circle, your mouse will turn into a black arrow circle. That is your indicator that the net is ready to rotate. Simply click and drag your mouse in a direction, and your net will rotate according to that direction.

**AUTO-ARRANGE NETS:** If you have multiple nets on a page, you may notice that some of the nets are overlapping or that the page that hold the nets is really cluttered. If you get to that point, you can click on the Auto-arrange Nets icon, and the ModelMaker™ software will automatically spread out the nets and arrange them so that they fit nicely on the page.
**CHANGE PERMUTATION:** With some nets, you have the ability to change how the shape is unfolded. This can be helpful when you're trying to fit multiple nets on one page. The assembled shape will be the same, no matter which permutation you choose.

![Change Permutation Example]

**SEPARATE NET:** When you first create a 3D shape, the net, and any of its pieces, are automatically grouped together. But sometimes it’s necessary to separate the pieces in order to make the best use of the page space. To separate a net, select it, right-click, and select “Separate Net.” Each piece will remain selected, so you’ll want to click off of the shape and then click the piece you wish to move around. With a little bit of finagling, you can fit many different pieces on one page.

![Separate Net Example]

With some separate nets, you’ll see some indicator dots to let you know where the separated piece needs to be placed.

To add or remove pages in the output window, you can use the arrows above and to the side of the nets.
PROJECTIONS

You have the option of viewing your object in a third-angle projection, which just means that you see views of your shape head on. ModelMaker™ defaults to the third-angle projection showing the top, front, and side views.

If you wish to change any of the sides you are viewing, you can right-click on your projection and then click on Properties. This will bring up a box with options you can change to change up your projection.

The symbol shown at the bottom of the page indicates that you’re seeing an orthographic view, or a view that shows an exact representation of the shape. Because you aren't looking at a 3D view, you’re just seeing certain views of the shape without any depth.
These projections are great if you’re interested in the engineering and architectural sides of the ModelMaker™ software, but the average user will probably want to stick to the Net view to Print & Cut shapes and models.

**Printing the Design**

ModelMaker™ has the ability to create what is called a Print & Cut design. This means that you can add a color, pattern, or some other type of design onto the surface of your shape using your home printer, and then the Silhouette cutting machine will perfectly cut out your printed net.

The first thing you’ll need to do is make sure you add registration marks to the page you are printing. This is a crucial step to take if you are wanting your Silhouette cutting machine to cut out the nets you have created. To do this, go to File > Fabrication > Use Registration Marks (Print and Cut).

You’ll notice in the output window that when you add registration marks, the print borders will decrease the amount of free space on your page. Make sure the net fits within the registration marks border that you will see on the page in the output window. If any of your designs print outside of the print border, your Print & Cut design may not print properly.

When you’ve arranged your nets to fit within the print borders, go to the toolbar in the upper left-hand corner and click the Print icon. Select the link that says “Click here.” A box will pop up prompting you to enter a name for your print job. This may be helpful, for example, in a classroom, where multiple computers may be using the same printer. Entering a name for the job will help everyone know whose printed page is whose. If you are not in a situation like that, you may skip the naming step as it is optional.

Another box will pop up and have you choose a printer as well as any other properties you wish to add. Once you’ve adjusted everything you wish to adjust, click OK to print your page.

Page numbers, as well as a name if you chose to add one, will print on the page to help you determine which page is which.
Cutting Shapes with a Silhouette Machine

Once you’ve created your shapes and have laid out the nets in the output window, prepare your Silhouette cutting machine. Make sure the machine is plugged into your computer and the wall outlet and turned on.

CUT WITH REGISTRATION MARKS
When you are ready to cut out the nets from the page you just printed, click the icon that looks like a Silhouette cutting machine. This is the cut icon. A box will pop up with instructions for what to do next. It will tell you to place the printed page onto the cutting mat and load the cutting mat into the cutting machine.

NOTE: Even if you printed a color or pattern onto your shape, the cut preview will not show that. It shows only the cut or score lines of the shape.

If you want to change any of the cut settings, click on the Settings link in the Status box of the Silhouette machine. You can choose to score or perforate the fold lines and change any of the other cut settings of your Silhouette machine. For most smooth cardstock, we use speed 5, thickness 30, and blade depth 3 for our cut settings, and for our score or perforate settings, we use thickness 10 and blade depth 1. The cut settings may vary based on machine or material.

When you’re done, click the X next to the Cut Settings in the white-colored section. This will close the Cut Settings window and take you back to the page where you can go to start your cut.

After that, you are ready to cut your page. Click the link that says “Continue” in order to start the cutting process.
The next thing you’ll want to do is indicate that you want your registration marks to be detected automatically. This is where your machine will use its optical eye to read the registration marks we added to the page.

After your machine has detected the registration marks, it will proceed to cut the outline of the shape and score or perforate fold lines according to the cut settings you input.

**CUT WITHOUT PRINTING A DESIGN**

Perhaps you are cutting from colored or patterned paper or don’t want anything on your shapes at all. In that case, you’ll skip directly to the cutting step.

Then go back to ModelMaker™ and click the Cut icon (the icon that is next to the printer that looks like a Silhouette machine).

If you want to change any of the cut settings, click on the Settings link in the Status box of the Silhouette machine. You can choose to score or perforate the fold lines and change any of the other cut settings of your Silhouette machine. For most smooth cardstock, we use speed 5, thickness 30, and blade depth 3 for our cut settings, and for our score or perforate settings, we use thickness 10 and blade depth 1. The cut settings may vary based on machine or material.
When you are ready, click the link that says “Cut” under the Loading the Silhouette instructions.

ASSEMBLING YOUR PROJECT
After you’ve finished cutting the net, you are ready to assemble it. Fold any perforated or scored lines. Line up any indicator dots if you separated your net shape into pieces. Glue the tabs into place to create the 3D shape.
While many of the functions in Mint Studio™ and Silhouette Studio® are similar, there are a few key ways that the Mint Studio™ software differs. As a result, we will focus exclusively on the functions that are unique to Mint Studio™. You do not need to know Silhouette Studio® to learn how to use Mint Studio™.

Page numbers are provided for the functions that are shared between the two softwares so you can find more in-depth explanations of the features if needed.
Designing with Mint Studio™

Mint Studio™ and Silhouette Studio® are two separate software programs engineered to work with the Silhouette Mint™ and the other Silhouette machines (the Cameo, the Portrait, and Curio), respectively. Even though each of the programs pair with different Silhouette machines, the two programs are very similar. But if you don’t know Silhouette Studio®, it is fine! You will learn Mint Studio™ in no time.

The initial page size when you open Mint Studio™ is 90 mm x 45 mm. The Design Page Settings are dependent on the size of your stamp. Mint Studio™ has seven different options for your page size which correlate to the seven different sizes of stamp sheets.

For dimension and features of the Silhouette Mint™, see page 23.
WORK AREA OVERVIEW
1. Document Tools
2. Drawing Tools
3. Library and Store
4. Stamp Tools
5. Mint Studio™ Tools
6. Options Panel
7. Preferences

SOFTWARE FILE FORMATS
The Mint Studio™ software uses a proprietary MINT file format, which consist of vector art for line and color/gradient fill type data. Mint Studio™ can open Silhouette Studio® files, but Silhouette Studio® cannot open Mint Studio™ files.

Mint Studio™ can open the following file formats:

- STUDIO
- STUDIO3
- TIFF
- JPG
- BMP
- PNG
- GIF

In addition to files that may be opened or imported, Mint Studio™ can also access any font installed on your computer.
**Document Tools**

**VIEWING AND ZOOMING**
When you view your workspace, you may either wish to zoom in to get a closer look at smaller images or zoom out to see your entire stamp.

- **ZOOM IN:** This tool will zoom into the center of your workspace for a closer view.

- **ZOOM OUT:** This tool will zoom out from your view for a more broad perspective.

- **SELECTION ZOOM:** This tool will allow you to zoom to specific areas of your workspace by drawing a box around the area you wish to zoom into.

- **DRAG ZOOM:** After clicking on this tool, your icon will appear as the Drag Zoom icon. You may then click and hold down your mouse to zoom in or out manually to any selected scale.

- **PAN USING MOUSE:** With the Pan Using Mouse icon selected, you can pan across your workspace. When you release your mouse, the Pan function will turn off. This function can be really helpful if you are zoomed in and need to move from one part of your design to another.

  Alternatively, you can hold the Spacebar and use your mouse to pan around your workspace.

**FIT TO PAGE:** Clicking the Fit to Page icon will immediately fit the full defined workspace to the center of your screen.

**OBJECT MENU**
Some of the software features don’t have icons along the top of the screen like they do in Silhouette Studio®. Instead, you can access these by going to the Object menu from the top toolbar.

**OBJECT MENU**

- **Move** and **Scale** automatically open their corresponding panels, allowing you to make edit specific preferences.

- **Mirror**, **Rotate**, and **Align** have additional menu options that allow you to perform specific actions.

  You can select an option directly from this menu (such as “Align Center-Middle”) or you can select the bottom “More Options” choice. This will open the familiar panel at the right-hand side.

**SILHOUETTE PRO TIP:** If you are looking for a tool you use in Silhouette Studio® but cannot find it in Mint Studio™, check the “Object” drop down menu.
Group, Ungroup, Make Compound Path, and Release Compound Path can only be selected if you have your object or objects selected on your design screen.

**Drawing Tools**

**SELECTION**
Your basic selection tool allows you to select shapes and move them around your workspace freely.

**POINT EDITING:** While there isn’t a Point Editing icon, you can still edit specific points on your object by double-clicking. Points will appear and the Point Editing panel will pull up on the right-hand side of your screen.

If you want to edit any of the shapes or frames you create, you will need to first “Convert to Path” (by right-clicking and selecting). Now you can point edit your shapes like any other object.

For an in-depth look at point editing, see page 56.

**TEXT**
To use your fonts, click on the text tool located on the left-hand side of the software screen or at the top middle. Clicking this will allow you to place a text cursor onto your workspace and begin typing directly onto the screen. See page 92 for a detailed description of all the different text functions.

Text in Mint Studio™ has the same features as text in Silhouette Studio®. You can justify, adjust character and line spacing, and convert text to a path.

**SHAPES**
You can create a variety of ready-made shapes using the Shape Tool. Some shapes can be adjusted further using the sliders within the shape.
**USING SHAPE SLIDERS:** This flower comes standard with seven petals. You can move the slider up or down to add more petals.

Using the red dots, you can further adjust the shapes. And, like any object in Silhouette Studio® or Mint Studio™, you can also use the green dot at the top to rotate the shape.

**FILL FRAMES WITH COLOR:** You can fill frames to make them into shapes. Simply change the fill properties at the bottom of the screen.

**FRAMES**
With the Frame Tool, you can create designs with a variety of ready-made frames. Some frames can be adjusted further using the sliders within the frame.

Here is a basic frame. Using the red dots, you can adjust the entire shape of your object. Using the slider bar in the center, you can add or subtract the number of curves on the outside of the frame.

**LINE TOOL**
The Line Tool creates single straight lines that you can create or edit designs with.

Below is a heart filled with a floral and paisley design. To add more dimension, click the Line Tool icon. You can add straight lines across the center of the flower or anywhere else you would like.

**SILHOUETTE PRO TIP:** Holding “Shift” while using the Line Tool creates a perfectly vertical, horizontal, or 45° line from your cursor.

**SMOOTH FREEHAND TOOL**
The Smooth Freehand Drawing Tool allows you to create smooth, continuous free-form lines. Lines drawn with this tool will have smooth transitions and no sharp angles, and they will continue until the mouse button is released.
or the image is closed by aligning the end point with the start point.

**ERASER TOOL**
Use the Eraser tool to easily and immediately remove inner lines or other unwanted objects from your design.

Below is the same heart from before. This time instead of adding lines, erase lines. If you delete quite a few of the lines, you can make the design simpler, which will make it easier to apply ink.

The “End Cap Style” option will only adjust lines that have open ends. “Flat” or “Square” provide varying sharper flat edges at the line tip where “Rounded” provides a smoother rounded edge to the line tip.

**Mint Studio Tools**

**LINE STYLE**
The Line Style panel gives you options to adjust the style of your line to be the default solid or various dashed lines. Lines will be printed to your stamp in the selected style.

Line thickness may be adjusted by either manually dragging the “Line Thickness” option bar or by typing in the desired point thickness.

The “Corner Style” option will adjust how lines appear at any of the image’s corner points. “Corner” is a sharp edge. “Rounded” is a smoother edge while “Bevelled” is angular.

The “Text” is located in the top toolbar and in the left-hand drawing bar. See page 92 for all things text.
“Fit to Stamp” will scale your design or image to fit the size of your stamp sheet. See page 235 for more details.

Once you connect your points into a complete shape, Mint Studio™ will crop out everything in the background. Don’t worry if you don’t have a perfect image. You can use Point Editing to make any adjustments to your cropped image.

**USING MAGNET TRACE:** Pick a starting point at the edge of your image. With the Magnet Trace Tool selected, click once to create an initial point. Guide the green line (the magnet) along the edge of the image and click again, creating another point.

The magnet will cling to the image, making it easy for you to guide the individual points to exactly where you want them to be.

Clicking multiple points closer together will give you a more precise crop around your intended area. Guide your magnet along the image and keep clicking.

**SILHOUETTE PRO TIP:** You can adjust your circle size while using Magnet Trace for more detailed precision.

**MAGNET TRACE:** In the Crop panel, there is a Magnet Trace feature. It will help you easily crop your image around curved and uneven lines.

**CROP TOOLS**
Use the Crop tool to cut or segment images. Within the Crop panel, you can select from ready-made templates or a variety of Knife tools.

The Crop tool has a section of knife tools. These work like the Knife Tool in Silhouette Studio®. See page 67.
**ADJUSTING MAGNET TRACE SETTINGS:** Adjust the magnet size selection circle by adjusting the slider or the up and down arrows under the Magnet Trace option, or by using the scroll feature on your mouse. The smaller the circle, the more precision you will have with placing your points.

A smaller magnet is good in curves, corners, and more detailed places while a bigger magnet is ideal for larger areas with more straight lines. The larger circle is better for placing points far apart on long flat surfaces.

To make an adjustment, double-click the image to enter Point Editing mode. Select the point or points that didn’t cling well to your image and drag the point closer to your intended image to adjust the Magnet Trace.

**CROPPED PORTION OF IMAGE:** With Magnet Trace, the cropped portion of your image isn’t really gone. It is still available in the background and you can adjust your cropped image to include more of the original.

Do this by double-clicking and entering the Point Editing mode. Pull the points out to reveal more of the original background you cropped out.

**CURVED TEXT**

Mint Studio™ has a selection of common text path shapes in the Curved Text panel. To use, first type your text and select a shape from the Curved Text menu.

You can also make your text to a path the same way you do in Silhouette Studio® by moving the compass on the right hand of the text box to the shape. For more on this method, see page 97.
**STAMP SETTINGS**

The size and orientation of your stamp design area can be selected in the Stamp Settings panel. You can view your stamp in landscape or portrait orientation.

Stamp sizes are always stated in millimeters and can be found printed on your stamp sheet. For example, the numbers ‘1560’ in the image below indicate that the stamp is 15 mm x 60 mm (or 60 mm x 15 mm) in size.

1. 60 mm x 15 mm
2. 30 mm x 30 mm
3. 15 mm x 15 mm
4. 45 mm x 45 mm

**STAMP FILTERS**

A variety of filters make it easy to apply a range of effects to your stamp. Some filters can be fine-tuned by using the slider bars within the filter menu. All filters can be inverted so the negative and positive space of the stamp is switched.

We have a design of three arrows. Different filters will dramatically affect how your stamp prints, how you apply ink, and how it will look stamped on your page.

**SILHOUETTE PRO TIP:** Multiple filters can be used on the same stamp, but only one filter can be applied to each selected shape.
SEND TO MINT

It is easy to send your design to your Mint. All you need to do is click on the little mint icon in the top right corner and “Send to Mint.” Make sure you have your Stamp Settings set up the way you want.

Once you enter the Send to Mint panel, your design will be flipped and you will be able to see your stamp how it will print. Click “Start Mint” and watch it go!

DON’T WORRY ABOUT MIRRORING YOUR STAMP!
Your stamp will automatically mirror when you send it to be printed.

Stamp Tools

These tools allow you to alter the visual elements of your stamp, such as color and outlines.

OUTLINE/FILL: Closed shapes can have a fill applied as well. You can apply an outline, fill, or both by selecting your design and choosing one of the icons below:

- **Outline** icon creates an empty outline around the selected shape. If using a filter, the outline will take on the properties of the selected filter. The outline can be adjusted in the Line Style menu.

- **Fill** icon fills your selected shape if it is a closed image. The fill will take on the properties of the selected filter (if applicable).

- **Fill Outline** icon combines the properties of both the Fill icon and Outline icon. Any filter used will be applied to both the fill and outline.
**PREVIEWING COLORS:** You can preview your stamp by applying a color or colors from the swatches along the bottom of the software. Multiple colors can be used on the same stamp, but only one color can be applied to each selected shape.

All of the swatches (except white) are for visual representation only and do not affect or alter how the stamp is actually printed.

**NOTE:** Any shape colored with the white swatch WILL NOT be printed on the final stamp.

**FIT TO STAMP**
You can scale your image to its maximum dimensions (based on stamp size) by clicking “Fit to Stamp” in the Scale panel or the Fit to Stamp icon located along the bottom of the software screen.

When you open a photo on your screen, it might be too big. Fix it with one click—“Fit to Stamp.” Now you can see your photo and adjust it more reasonably.
Chapter Seven

Accessories and Tools

Silhouette machine accessories and tools are specifically designed for use with your Silhouette. We offer a wide variety of blades (including Deep-cut, AutoBlade, and Fabric) as well as different types of mats and tools designed to make creating your projects easier. Will you be traveling with your Silhouette? Do you want a dust cover? Our travel and storage accessories are perfect for you.

BLADES AND CARRIAGE TOOLS

<table>
<thead>
<tr>
<th>Blade</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blades</td>
<td>238</td>
</tr>
<tr>
<td>Blade Adjustments and Numbers</td>
<td>239</td>
</tr>
<tr>
<td>Curio Tools</td>
<td>240</td>
</tr>
<tr>
<td>Pen Holder</td>
<td>240</td>
</tr>
</tbody>
</table>

TOOLS

<table>
<thead>
<tr>
<th>Tool</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hook</td>
<td>240</td>
</tr>
<tr>
<td>Scraper</td>
<td>241</td>
</tr>
<tr>
<td>Spatula</td>
<td>241</td>
</tr>
<tr>
<td>Pick-Me-Up®</td>
<td>241</td>
</tr>
<tr>
<td>Roll Feeder</td>
<td>241</td>
</tr>
</tbody>
</table>

MATS AND BASES

<table>
<thead>
<tr>
<th>Mat</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cutting Mat</td>
<td>242</td>
</tr>
<tr>
<td>Light Hold Cutting Mat</td>
<td>242</td>
</tr>
<tr>
<td>Cutting Mat for Stamp Material</td>
<td>242</td>
</tr>
<tr>
<td>PixScan™ Cutting Mat</td>
<td>242</td>
</tr>
<tr>
<td>Curio Embossing Mat</td>
<td>243</td>
</tr>
<tr>
<td>Curio Base</td>
<td>243</td>
</tr>
</tbody>
</table>

TRAVEL & STORAGE ACCESSORIES

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Silhouette CAMEO® Light Tote</td>
<td>243</td>
</tr>
<tr>
<td>Silhouette Dust Cover</td>
<td>244</td>
</tr>
<tr>
<td>Silhouette Portrait® Teal Tote</td>
<td>244</td>
</tr>
</tbody>
</table>

MISCELLANEOUS

<table>
<thead>
<tr>
<th>Item</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gift Cards</td>
<td>244</td>
</tr>
<tr>
<td>Silhouette Studio® License Keys</td>
<td>244</td>
</tr>
</tbody>
</table>
Blades and Carriage Tools

Tools perform the basic functions of your Silhouette, be it cutting, embossing, debossing, etching, or stippling. Certain tools can only be used with certain machines, so make sure that you check and see if your machine is compatible with the tool you are using.

Blade Types

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>RATCHET</th>
<th>FABRIC</th>
<th>PREMIUM</th>
<th>DEEP-CUT</th>
<th>AUTOBLADE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ratchet cap to adjust blade setting</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Self-adjusting</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Make thousands of cuts before replacing</td>
<td>✓</td>
<td>✓</td>
<td>3x the life of a ratchet</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Cut Depth</td>
<td>1 mm</td>
<td>1 mm</td>
<td>1 mm</td>
<td>2 mm</td>
<td>1 mm</td>
</tr>
<tr>
<td>Cameo 3 compatible</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Cameo compatible</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Curio compatible</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Portrait compatible</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

| Media types | Paper, heat transfer, cardstock, vinyl, etc. | Paper, heat transfer, cardstock, vinyl, etc. | Paper, heat transfer, cardstock, vinyl, etc. | Chipboard, foam and other thick media up to 2 mm | Paper, heat transfer, cardstock, vinyl, etc. |
BLADES
There are currently five blades available to use with your Silhouette: the Ratchet Blade, the Premium Blade, the Deep-cut Blade, the Fabric blade, and the AutoBlade. Each blade is standard size, meaning that you can (mostly) use the same blade in your Curio as you do in your Portrait or Cameo. The Deep-cut Blade should only be used in your Cameo 3 or Curio and the AutoBlade should only be used in your Cameo 3.

Silhouette blades are made of a sintered tungsten alloy that is extra sharp and durable. With the Silhouette blade you can cut, perforate, or even score your creative materials with professional precision.

Silhouette blades can last up to six months. The actual blade life will depend on how much you use your machine and the type of material you cut with your blade. Thicker materials will wear down the blade much more quickly. Frequency of use, overall line length for jobs performed, intricacy of patterns (where the blade turns more corners), and type of media being cut can all affect the length of your blade life. If you notice your blade isn’t making as clean as cuts as it once did, you might want to get a new one.

Your blade life is also affected by the density of the media you cut. The ratchet blade is not made to cut extremely thick media, like balsa wood or thick chipboard, and doing so may ruin or dull your blade.

On the other end of the scale, fibrous papers (like newspaper or recycled paper) can leave behind small particles that impair the blade’s cutting ability. This problem is easily solved by carefully twisting the tip off the end of the blade and blowing gently to remove any particles. If your blade continues to have issues cutting, it might be time to replace your blade.

AUTOBLADE: The Silhouette AutoBlade is only available for the Cameo 3 and can only be used in the left-hand tool holder. With the AutoBlade, you don’t have to manually adjust your ratchet setting! Simply let your machine do all the work for you. Silhouette Studio® will give you recommended cut settings, and you can adjust these in the software if you’d like. Then, when you send your design to your Silhouette, your machine will automatically adjust your AutoBlade to the blade setting you chose in the software. Sit back and watch your machine work its magic.

FABRIC BLADE: What is the difference between the ratchet blade and the fabric blade? Besides the color, nothing! They are color coded so you don’t cut fabric with your ratchet blade and vice versa. Just as you wouldn’t use your fabric scissors to cut paper, we recommended keeping one blade specifically for fabric to help both blades last longer.
BLADE ADJUSTMENTS AND NUMBERS

There are three different numbers associated with blades in Silhouette Studio®. To find the correct settings to produce a clean cut, there are three things to take into consideration: the blade level, force setting, and speed.

The blade level controls how far the blade is exposed in 0.1 mm increments. This accommodates for how thick the material is. For example, a blade level of 1 = .01 mm, a level of 2 = 0.2 mm, etc. If you have a material such as cardstock where the actual thickness is 0.3 mm, setting the blade to a higher exposure (such as 0.6 mm or a setting of 6) would mean you are exposing the blade beyond the actual depth of the material. This does not allow the blade to cut better. It just exposes more of the blade and extending beyond the actual thickness of the material can dull down the blade tip much more quickly (or in extreme cases break off the tip). This would then result in ragged cutting results. From that point on, you would then have to expose the blade to a higher level because a setting of 6 would actually be only exposed 0.3 mm since you had worn down the excess tip beyond the material’s thickness. So, we would discourage attempts to overexpose the blade to try and get a “better” cut.

The Force setting (Thickness in older versions) from the software controls how hard the blade is pressing down. This accommodates for how dense the material may be. For example, a sheet of paper that measures a 0.3 mm depth versus a sheet of denser cardstock that measures the same 0.3 mm depth would require the blade to be pushed down with different force levels.

If you feel that the material in question may be slightly deeper than the recommended blade setting recommendation, we would recommend that as you raise the blade level, you also lower the Force setting in the software so that the blade, if overexposed, is not still being pressed down with the hardest force possible and potentially harming the tip. You may then gradually increase the force according to further test results.

The key to successful cutting results is to find the blade setting and force setting combination where the Silhouette is still able to cut your material successfully. For example, if a specific material is able to be cut with a blade setting of 3 or 4, you should opt to go with the lower setting that is still allowing you to have a clean final cut. Likewise, if the Force setting works at 28, it would likely also work at 30. However, the lower setting should be selected to avoid overexerting the blade beyond what is necessary to achieve a clean successful cut.

The Silhouette Send panel also includes a Speed level to control the speed at which the job is cut. The speed is generally only necessary to adjust for specific materials that may require the blade to move at slower speeds around corners or intricate detailed parts of the image. Faster levels are available to expedite the overall cutting process. You may wish to slow down the Speed level if you are finding that certain parts of the design (especially corners) are not cutting as well, if the material is being lifted from the backing during the cutting process, or if the start/end point of an image is not matching up exactly.

You can read more about cutting on page 30.
Chapter Seven: Accessories and Tools

Tools

The Silhouette specialty tools, the hook, scraper, spatula, and Pick-Me-Up®, are available for sale separately or together in the Silhouette Tool Kit. The Silhouette Tool Kit also includes a ruler and a microfiber cloth.

CURIO TOOLS
The Stippling & Etching Tool and the Wide and Fine Embossing Tools can be used only with your Silhouette Curio™. The Stippling & Etching tool lets you create patterns or pictures with different shadings of small dots or by etching your design into a metal surface. The embossing tools create wide and fine channels for different embossed effects.

PEN HOLDER
Do you want to use a felt-tipped marker or a pencil instead of Silhouette Sketch Pens? You need the Pen Holder! Replace your Silhouette’s blade with a pen to sketch instead of cut. It’s easy to use, and it will hold a wide range of drawing instruments from a thinner standard pen to a thick felt-tip marker.

HOOK
The Hook tool is the most essential tool when doing vinyl and heat transfer projects. While the hook is used mainly for weeding, Silhouette users find many ways to use it for other projects, like poking out those stubborn pieces of cardstock from within a pattern or even pulling up the corner of Silhouette Sticker Paper.
Chapter Seven: Accessories and Tools

Tools

SCRAPER
With your Silhouette Scraper tool, you can clean your cutting mat by scraping off stubborn pieces, apply transfer tape to vinyl artwork, and eliminate air bubbles after you apply adhesive. Much like other Silhouette tools, you can find a variety of uses for the scraper tool. It’s always great to have on hand.

SPATULA
The Spatula tool will become your best bud. It is the perfect tool to lift delicate designs from the cutting mat without curling or tearing. The pointed tip makes it easy to get under cutout designs and work around the most intricate shapes. It won’t take long before this handy tool is a necessity for all your crafting projects.

PICK-ME-UP®
If you’re like us, you probably spend a lot of time chasing your smaller craft pieces around. This Pick-Me-Up® tool was created with that in mind. It has a tacky tip for picking up and placing small objects and a sharp tool to poke out hard-to-weed pieces. You don’t have to chase those bits and ends around your table top (or floor) anymore; the Pick-Me-Up® has you covered.

ROLL FEEDER
Do you find yourself juggling rolled vinyl or heat transfer while doing a project? You need a roll feeder! The roll feeder provides an easy and convenient way to place rolled material into your Silhouette. The feeder properly aligns your project to ensure that it loads straight. If you are sending large projects, a roll feeder will save you from babysitting your machine.
Mats and Bases

Here at Silhouette we’re all about that base—and mats too! Dive in and find out what kinds of options we have to make your material stick.

CUTTING MAT
Each Silhouette cutting machine comes with a cutting mat in the box. The mats have a special adhesive that sticks to thin and thick media, like paper, cardstock, fabric, and magnet paper. The adhesive is strong enough to hold most media and a “broken-in” mat will not rip thin paper. The cutting mat allows you to cut thin media like paper, and matching media to the grid lines on the mat and in Silhouette Studio® means you can position each cut exactly where you want it.

Cutting mats are sold in two dimensions for the Cameo (12 in. x 12 in. and 12 in. x 24 in.), one dimension for the Portrait (8 in. x 12 in.), and two dimensions for the Curio (8.5 in. x 6 in. and 8.5 in. x 12 in.).

LIGHT HOLD CUTTING MAT
The light hold cutting mat is designed to hold more delicate materials that require a lighter adhesive. It’s ideal for cutting thinner materials, including copy paper.

Light hold cutting mats are sold in two dimensions: one for the Cameo (12 in. x 12 in.) and one for the Portrait (8 in. x 12 in.).

CUTTING MAT FOR STAMP MATERIAL
This cutting mat is specifically designed for the Silhouette stamp material. It will help you create customized stamps with your Silhouette cutting machine. (Don’t get this mixed up with the Silhouette Mint™ stamping machine. This mat is to make custom stamps using your Cameo or Portrait.)

PIXSCAN™ CUTTING MAT
The PixScan™ cutting mat lets you unlock a whole new world of project possibilities. Available for the Cameo, Portrait, and Curio, the PixScan™ mat lets you cut precisely around a printed design or position cut lines in a specific location on your material.

Want to know how the PixScan™ mat works? See page 74.
Chapter Seven: Accessories and Tools

Travel & Storage Accessories

Silhouette machines are easy to travel with and store. Keep them safe with our selection of dust covers and totes. Personalize these with Silhouette creative materials and express your style.

CURIO EMBOSsing MAT

The Curio embossing mat is made with an adhesive cushioned surface that cradles the Wide and Fine Embossing Tool tips, allowing for unique embossed and debossed effects. The embossing mat comes in two sizes (8.5 in. x 6 in. for the small Curio base and 8.5 in. x 12 in. for the large Curio base).

CURIO BASE

Curio’s base allows you to feed thicker media through the machine that would otherwise be too large or too stiff to feed through your other Silhouette machines. Each Curio comes with an 8.5 in. x 6 in. base as well as 4 platforms (2 of each 1 mm and 2 mm platforms). For bigger projects, a larger base (8.5 in. x 12 in.) is also available.

SILHOUETTE CAMEO® LIGHT TOTE

The CAMEO Light Tote has minor padding to allow you to carry your machine, but the tote doesn't add a bunch of extra bulk. It is available in gray and fits the CAMEO 3.
Miscellaneous

GIFT CARDS
Silhouette offers two different gift cards. We have one gift card to the Silhouette America Online Shop and another to the Silhouette Design Store. Both cards can be purchased online at silhouetteamerica.com, but they are not interchangeable. You can’t use a Design Store gift card to buy product from the Online Shop, so make sure you buy the correct one!

SILHOUETTE STUDIO® LICENSE KEYS
You can buy software upgrades through the Silhouette America Online Shop. We’ll send a digital code to your email, and you’ll input that code into Silhouette Studio®. We have three editions you can upgrade to: Designer Edition, Designer Edition Plus, and Business Edition. Each edition includes all of the features from all of the lower editions.

See page 33 to see which version of Silhouette Studio® is right for you.

SILHOUETTE DUST COVER
The functional Silhouette dust cover fits snugly around your machine to keep it clean and protected. The CAMEO 3 dust cover is available in gray or pink. The Portrait dust cover is created in gray or red. The Curio dust cover is available in blue.

SILHOUETTE PORTRAIT® TEAL TOTE
The Portrait is designed for portability. The tote is perfect for carrying your Portrait, laptop, and accessories with you wherever you are going. This 18 in. x 7 in. x 12 in. teal tote will also accommodate the original Silhouette and Silhouette SD.
Chapter Eight

Creative Materials

Silhouette offers a line of creative materials to work specifically with your machines. These materials include different types of media that can be fed into your Silhouette machines, creative embellishments, and more. Each product contains a description of the product and, if applicable, recommended machine settings.

For color details or ordering, please visit our online store at silhouetteamerica.com or check with your favorite Silhouette retailer.

<table>
<thead>
<tr>
<th>ADHESIVE CARDSTOCKS</th>
<th>246</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALTA MEDIA</td>
<td>247</td>
</tr>
<tr>
<td>DOMING STICKERS</td>
<td>248</td>
</tr>
<tr>
<td>FABRIC INK MATERIALS</td>
<td>249</td>
</tr>
<tr>
<td>FABRIC STABILIZERS</td>
<td>250</td>
</tr>
<tr>
<td>GLASS ETCHING CREAM</td>
<td>251</td>
</tr>
<tr>
<td>HEAT TRANSFER</td>
<td>251</td>
</tr>
<tr>
<td>MINT MEDIA</td>
<td>254</td>
</tr>
<tr>
<td>RHINESTONES</td>
<td>255</td>
</tr>
<tr>
<td>SILKSCREEN SHEETS</td>
<td>256</td>
</tr>
<tr>
<td>SKETCH PENS</td>
<td>256</td>
</tr>
<tr>
<td>SPECIALTY MEDIA</td>
<td>257</td>
</tr>
<tr>
<td>VINYL</td>
<td>265</td>
</tr>
</tbody>
</table>
Adhesive Cardstocks

Adhesive Cardstock (Single-Sided) 246
Chalkboard Cardstock 246
Printable White Adhesive-Backed Cardstock 246

Silhouette adhesive cardstock makes it easier than ever to cut words and shapes in intricate detail, and you don’t even have to bother with glue. All of Silhouette’s adhesive cardstocks are coated in a tacky adhesive that allows you to skip the gluing process and go right to sticking. Adhesive cardstock is available in single sided, chalkboard, and printable, and comes in multiple colors.

ADHESIVE CARDSTOCK (SINGLE-SIDED)
This single-sided adhesive cardstock lets you attach cardstock without having to worry about attaching an adhesive manually. Use it for layered cards or banners or anything else you can think of. And, because this is a lined media, you don’t have to cut it with a mat.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 4, Speed 3, Force 29, Passes 1
Note: The Cameo can accommodate the 12 in. x 12 in. paper size without any trouble while you will need to cut it down to use with the Portrait or Curio.

CHALKBOARD CARDSTOCK
Chalkboard cardstock is available in a package of six 8.5 in x 11 in. sheets. It is adhesive backed so you apply it directly to your project without worrying about applying adhesives. Write with chalk on the black surface to create unique designs or use Silhouette Chalk with a pen holder to draw designs with your machine.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 4, Speed 3, Force 29, Passes 1

PRINTABLE WHITE ADHESIVE-BACKED CARDSTOCK
This smooth, white adhesive-backed cardstock is not textured, making it easier to feed through a printer. And the adhesive backing lets you move directly from the cut job to your project.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 4, Speed 3, Force 29, Passes 1
FILAMENT
Use Silhouette's filament with the Silhouette Alta® to create your very own 3D creations. When you load the filament, the machine will heat it up and print the object you created in Silhouette 3D™. Each reel includes 500 grams of 1.75 mm filament.

Machine: Alta

PLATFORM TAPE
The Alta Platform Tape is designed to fit right on top of the platform of the Silhouette Alta®. Not only does it protect the plastic platform piece and help it last longer, it also helps the first layer of your 3D printed design stick properly to platform so that you get a better print.

Machine: Alta
Doming stickers are stickers that have a clear epoxy resin over the top, so they create a cool 3D effect. These stickers are great for scrapbooks, journals, cards, and even notebooks. Simply Print & Cut the stickers and apply the epoxy resin over the top.

**EPOXY RESIN**
Silhouette's epoxy resin consists of two solutions. When you insert each solution into the syringe, the syringe mixes the two solutions to make the resin and allows you to apply it over a surface. After the allotted drying time, the solution will harden, giving you the 3D effect.

**LAMINATE SHEETS**
The laminate sheets are to be used with white sticker paper only when you want to apply the epoxy resin over the top. The laminate sheet prevents the colors from bleeding so that your stickers are nice and vibrant. Cut the sticker paper and the laminate sheet together. There are six 8.5 in. x 11 in. sheets included in a package.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Setting:** Increase the blade depth by 1
Fabric Ink Materials

<table>
<thead>
<tr>
<th>Material</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fabric Ink</td>
<td>249</td>
</tr>
<tr>
<td>Stencil Material Sheets (Adhesive/Non-adhesive)</td>
<td>249</td>
</tr>
<tr>
<td>Stencil Vinyl with Transfer Tape</td>
<td>249</td>
</tr>
</tbody>
</table>

Used together, Silhouette fabric inks and stencil vinyl make creating your personal designs a breeze. Cut your design out of stencil vinyl like you would when using regular vinyl. Use a sponge to apply the fabric ink and use heat to seal the deal.

**FABRIC INK**

Fabric ink and Silhouette stencil vinyl go hand-in-hand when you are applying custom designs to apparel and fabric. It is soft-drying ink that resists cracking and peeling. One 2 oz. bottle of ink is enough to create five to ten projects depending on size and intricacy. Mix your inks together to create custom colors. UV light-sensitive and glow-in-the-dark options are also available.

**STENCIL MATERIAL SHEETS (ADHESIVE/NON-ADHESIVE)**

Use stencil sheets with or without adhesive backing to make temporary stencils. You can use these in conjunction with Silhouette Fabric Ink to make your own “screen-printed” projects. Stencil Material is available in six 8.5 in. x 11 in. sheets.

**Machines:** Cameo, Portrait, or Curio

**Suggested Cut Settings:** Blade 3, Speed 2, Force 33, Passes 1

**STENCIL VINYL WITH TRANSFER TAPE**

Create a professional, screen-printed look on apparel and fabric with stencil vinyl and Silhouette fabric ink. Both stencil vinyl and transfer tape are see-through, making it simple to apply to clothing and fabric. The stencil vinyl applies with transfer tape the same way other types of vinyl are applied and is sold in a 9 in. x 36 in. roll.

**Machines:** Cameo, Portrait, or Curio

**Suggested Cut Settings:** Blade 2, Speed 8, Force 4, Passes 1
## Fabric Stabilizers

<table>
<thead>
<tr>
<th>Fabric Stabilizer</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean Cut Fusible Fabric Stabilizer</td>
<td>250</td>
</tr>
<tr>
<td>Cut &amp; Sew Fusible Fabric Stabilizer</td>
<td>250</td>
</tr>
<tr>
<td>Wash-away Fabric Stabilizer</td>
<td>250</td>
</tr>
</tbody>
</table>

Your Silhouette can cut fabric, but not without a fabric stabilizer. Use fabric stabilizer to stiffen your fabric so you feed it through your Silhouette on a cutting mat.

**Suggested Cut Settings:**
- Thick fabrics (like canvas), Blade 5, Speed 5, Force 33, Passes 1
- Thin fabrics (like cotton), Blade 3, Speed 5, Force 33, Passes 1

### CLEAN CUT FUSIBLE FABRIC STABILIZER
Silhouette Clean Cut Fusible Fabric Stabilizer has a thicker adhesive that irons onto fabric allowing you to cleanly cut designs with your Silhouette. This product is sold in rolls of 12 in. x 60 in. material.

**Machines:** Cameo, Portrait, or Curio

**Note:** The Cameo can accommodate the 12 in. x 12 in. size without any trouble while you will need to cut it down to use with the Portrait or Curio.

### CUT & SEW FUSIBLE FABRIC STABILIZER
Silhouette Cut & Sew Fusible Fabric Stabilizer has a thinner adhesive that irons onto fabric allowing you to cut patterns and designs with your Silhouette that are ready to be sewn or stitched. This product is sold in rolls of 12 in. x 60 in. material.

**Note:** The Cameo can accommodate the 12 in. x 12 in. size without any trouble while you will need to cut it down to use with the Portrait or Curio.

### WASH-AWAY FABRIC STABILIZER
This fabric stabilizer can be applied to material and then washed away after your material is cut. This product is sold in rolls of 12 in. x 60 in. material.

**Machines:** Cameo, Portrait, or Curio

**Note:** The Cameo can accommodate the 12 in. x 12 in. paper size without any trouble while you will need to cut it down to use with the Portrait or Curio.
**Glass Etching Cream**

Silhouette etching cream makes it easy to permanently etch your own designs and text onto glassware and mirrors. Simply cut a stencil using your Silhouette and apply Silhouette etching cream for permanent and beautifully etched glass. Each 2 oz. bottle of etching cream can last through multiple projects.

**Heat Transfer**

- Flocked Heat Transfer
- Glitter Heat Transfer
- Glow-in-the-Dark Heat Transfer
- Metallic Heat Transfer
- Printable Heat Transfer for Dark Fabrics
- Printable Heat Transfer for Light Fabrics
- Reflective Heat Transfer
- Smooth Heat Transfer

Heat transfer is one of the most popular materials to cut with your Silhouette! Using heat transfer, you can design and create custom-made apparel, home décor, and so much more.

**Flocked Heat Transfer**

Do you love velvety textures? Try using the Silhouette flocked heat transfer material. The material is manufactured with transfer tape already adhered so you can cut small and intricately detailed designs.

**Machines:** Cameo, Portrait, or Curio

**Suggested Cut Settings:** Blade 3, Speed 5, Force 33, Passes 1

**Note:** For large designs, we recommended the Cameo.
GLITTER HEAT TRANSFER
Glitter is the best way to add a little glam in your life. Try cutting intricately detailed designs with 12 in. x 3 ft. glitter heat transfer material, which is manufactured with transfer tape already adhered.

**Machines:** Cameo, Portrait, or Curio
**Suggested Cut Settings:** Blade 3, Speed 5, Force 33, Passes 1
**Note:** The Cameo can accommodate its 12 in. width.

GLOW-IN-THE-DARK HEAT TRANSFER
Do you have an awesome glow-in-the-dark idea? Try cutting intricate designs with the Silhouette glow-in-the-dark heat transfer material. This product is sold in rolls of 9 in. x 24 in.

**Machines:** Cameo, Portrait, or Curio
**Suggested Cut Settings:** Blade 2, Speed 8, Force 4, Passes 1

METALLIC HEAT TRANSFER
Add a cool edge to your projects with metallic heat transfer. This product is sold in single rolls of 12 in. x 36 in. and comes in silver, gold, pink, and mint green.

**Machines:** Cameo, Portrait, or Curio
**Suggested Cut Settings:** Blade 3, Speed 5, Force 33, Passes 1
**Note:** The Cameo can accommodate the 12 in. x 12 in. size without any trouble while you will need to cut it down to use with the Portrait or Curio.

PRINTABLE HEAT TRANSFER FOR DARK FABRICS
This material remains solid when ironed and is suitable for all colors of fabric. This product is sold in a package of 5 sheets of 8.5 in. x 11 in. material.

**Machines:** Cameo, Portrait, or Curio
**Suggested Cut Settings:** Blade 1, Speed 3, Force 8, Passes 1
PRINTABLE HEAT TRANSFER FOR LIGHT FABRICS
This material turns semi-transparent when ironed and should only be used on white or very light fabrics. This product is sold in a package of 5 sheets of 8.5 in. x 11 in. material.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 1, Speed 3, Force 2, Passes 1

REFLECTIVE HEAT TRANSFER
In need of a reflective shirt for your early morning runs? Try making your own with our reflective heat transfer material. This product is sold in one roll of 9 in. x 24 in. reflective heat transfer.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 1, Speed 6, Force 10, Passes 1

SMOOTH HEAT TRANSFER
Give your projects a subtle, shiny look with smooth heat transfer material. The material is manufactured with transfer tape already adhered, so you can cut detailed projects. This product is sold in over thirty colors including gold, silver, and neon.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 2, Speed 8, Force 4, Passes 1
Note: The Cameo can accommodate the 12 in. x 12 in. size without any trouble while you will need to cut it down to use with the Portrait or Curio.
Mint Stamp Sheet Set

Stamp sheet set is perfect for users who already own the bases from the stamp kit and only need more stamp sheets to keep creating new stamps.

**Machine:** Mint

**Contents:** 2 stamp sheets, 2 stamp mounts, and 2 labels.

---

Mint Ink

The Silhouette Mint uses 5 ml bottles of ink that you apply to your stamp. The stamp will then absorb the ink, enabling it to stamp approximately 50 images before the stamp dries up. After that, just add a few more drops of ink and you are ready to go again. This is enough ink for hundreds of projects and thousands of stamps.

**Machine:** Mint
### Rhinestones

<table>
<thead>
<tr>
<th>Item</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rhinestone Template</td>
<td>255</td>
</tr>
<tr>
<td>Rhinestone Transfer Tape</td>
<td>255</td>
</tr>
</tbody>
</table>

Silhouette rhinestones have a heat transfer backing and can easily be ironed onto clothes, cards, scrapbook pages, fabrics, and more. Rhinestones come in three standard sizes (10ss, 16ss, and 20ss) and twelve assorted colors—aqua, champagne, metallic, black, clear, pink, red, blue, green, yellow, amber, and orange.

#### RHINESTONE TEMPLATE

Use the 8.5 in. x 11 in. template kit with rhinestones to cut patterns, arrange rhinestones, and transfer the rhinestones to clothing, cards, and more.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 6, Speed 5, Force 33, Passes 2

#### RHINESTONE TRANSFER TAPE

Rhinestone transfer tape is not intended to be cut with your Silhouette. Rhinestone transfer tape makes it easy to transfer rhinestones from a backing board to your project.

**Contents:** Sold in packages of seven 8.5 in. x 11 in. sheets of transfer tape.
**Silkscreen Sheets**

Use the Silkscreen Sheets along with heat transfer and fabric ink to create your own custom silkscreen designs. You can use one silkscreen design over 100 times, which makes it perfect if you need to apply a lot of designs.

**Sketch Pens**

Sketch pens let you draw with your Silhouette. Sketch pens come in an assortment of colors including metallic, glitter, black and white, neon, and more.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Speed 10, Force 18  
**Note:** The Portrait and Cameo 2 can sketch single color designs. Curio and Cameo 3 can sketch multicolor designs without adding pauses.
Chipboard 257  
Cork 257  
Corrugated Paper – Adhesive 258  
Cotton Canvas – Printable 258  
Cotton Fabric – Printable 258  
Double-Sided Adhesive Sheets 258  
Duct Tape Sheets (Gray/White) 259  
Embossable Foil 259  
Faux Leather Paper 259  
Foil Transfer Sheets – Copper, Gold, and Silver 259  
Image Transfer Paper 260  
Kraft Paper – Printable/Adhesive 260  
Leatherette Sheets 260  
Magnet Paper 260  
Magnet Paper – Adhesive 261  
Metal Etching Sheets (Curio only) 261  
Metal Stippling Sheets (Curio only) 261  
Score & Emboss Paper (Curio only) 261  
Scratch-Off Sticker Sheets – Printable 262  
Scratch-Off Sticker Sheets (Silver or Gold) 262  
Shrink Plastic Sheets (White/Clear) 262  
Stamp Material 262  
Sticker Paper – Printable Clear, Glitter, Glow-in-the-Dark, and White 263  
Sticker Paper Foil – Printable Silver, Gold, and Rose Gold 263  
Temporary Tattoo Paper – Clear, White, Gold, and Silver 263  
Vellum 263  
Washi Sheets – Adhesive 264  
Window Cling (White/Clear) – Printable 264  
Wood Paper Sheets 264

Specialty Media helps you design creative effects on magnet paper, faux leather, sticker paper and so much more. Use Silhouette specialty media to create truly original products.

**CHIPBOARD**

Silhouette chipboard is great for adding dimension and rigidity to a variety of projects. Leave it undecorated to make boxes, tags, or cards or dress it up to add some colorful flair. It’s also perfect as backing to add structure and stiffness to a project. This product is sold in a package of 25 sheets of 12 in. x 12 in. chipboard.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 5, Speed 1, Force 33, Passes 2

**CORK**

Silhouette Cork sheets are thin enough to cut, but they still have the corkboard look. They have their own adhesive backing. The Cork material is available in eight 5 in. x 7 in. sheets.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 7, Speed 1, Force 20, Passes 1
Chapter Eight: Creative Materials

**CORRUGATED PAPER – ADHESIVE**
Create corrugated embellishments to add a dimensional, textured look and then adhere the design directly to your projects with its adhesive backing. This product is sold in a package of three sheets of 8.5 in. x 11 in. in either kraft or white adhesive corrugated paper.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 8, Speed 3, Force 33, Passes 1

---

**COTTON CANVAS – PRINTABLE**
Use printable cotton canvas with the Print & Cut feature to create personalized fabric adornments from your favorite photos and designs. Printable cotton canvas comes in 8.5 in. x 11 in. sheets in packs of eight.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 5, Speed 3, Force 33, Passes 2

---

**COTTON FABRIC – PRINTABLE**
Printable cotton fabric is a white fabric that has a built-in backing. Simply feed it through an inkjet printer and cut out the printed fabric with your Silhouette machine. The fabric backing can then be torn away, and you have a cutout, printed piece of fabric. This is sold in packages of eight 8.5 in. x 11 in. sheets.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 3, Speed 5, Force 33, Passes 1

---

**DOUBLE-SIDED ADHESIVE SHEETS**
With Double-sided Adhesive Sheets, you can create 3D effects. Adhere one side of the sheet to another piece of media. On the remaining adhesive side, you can use embossing powder, glitter, or flocking powder to create intricate designs that pop off the page.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 4, Speed 3, Force 33, Passes 2
### DUCT TAPE SHEETS (GRAY/WHITE)

Duct Tape Sheets are available in gray and white. You can use them as they are or you can print on their printable finish. Duct Tape Sheets are available in five 8.5 in. x 11 in. sheets.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 3, Speed 4, Force 20, Passes 1

### EMBOSSABLE FOIL

Emboss detailed designs into this foil using the Silhouette Curio™ and the embossing tool. This foil has an adhesive backing, so it’s great for making seals or stickers. This material is not intended to be cut with a Silhouette machine as it will quickly dull the Silhouette cutting blade. Each package comes with six sheets (three copper and three silver) that measure 7 in. x 5 in.

**Machines:** Curio  
**Suggested Emboss Settings:** Speed 5, Force 33, Passes 1

### FAUX LEATHER PAPER

Faux leather paper has fabric-like qualities and feels similar to leather, but it is actually paper. It can be sewn onto projects and washed. This product is sold in a package with one roll of 12 in. x 5 ft. faux leather paper.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 5, Speed 3, Force 33, Passes 2

### FOIL TRANSFER SHEETS – COPPER, GOLD, AND SILVER

Use Silhouette’s foil transfer sheets to add some metallic detail to your projects. Use the embossing tool to press your designs onto a surface, and that’s where your foil will be transferred. Included in each package are six 8.5 in. x 11 in. sheets.

**Machines:** Curio  
**Suggested Emboss Settings:** Speed 5, Force 33, Passes 1
IMAGE TRANSFER PAPER
The image transfer paper can be used to transfer images onto hard surfaces, like wood or concrete. It's a great option if you don't have the time or skill to paint on a hard surface because you can just print your design using your home printer and transfer it to your chosen surface. Each package includes two image transfer sheets and two adhesive sheets that measure 8.5 in. x 11 in.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 4, Speed 3, Force 30, Passes 1

KRAFT PAPER – PRINTABLE/ADHESIVE
Create labels and stickers with printable adhesive kraft paper. It has its own adhesive backing and looks great both printed and plain. This product is sold in packages of eight 8.5 in. x 11 in. sheets.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 3, Speed 3, Force 20, Passes 1

LEATHERETTE SHEETS
Leatherette sheets are actually vinyl, but they feel and look like leather. Use these to add a little edginess to your projects. They are sold in packs of three 8.5 in. x 11 in. sheets.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 6, Speed 3, Force 33, Passes 2

MAGNET PAPER
Add your own personality to your fridge magnets using the printable magnet paper. With the Silhouette Print & Cut feature, you can make all kinds of custom magnets from photos and other designs. This product is sold with four sheets of 8.5 in. x 11 in. printable magnet paper in each package.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 4, Speed 1, Force 30, Passes 1
Chapter Eight: Creative Materials

**MAGNET PAPER – ADHESIVE**
Use adhesive magnet paper to apply a magnetic backing to any shape. This product is sold in a package of four 8.5 in. x 11 in. adhesive magnet paper sheets.

*Machines:* Cameo, Portrait, or Curio
*Suggested Cut Settings:* Blade 6, Speed 1, Force 33, Passes 2

**METAL ETCHING SHEETS (CURIO ONLY)**
These anodized metal sheets are perfect for etching because the colored surface contrasts with the silvery aluminum underneath. This product is sold in packets of three: one sheet each of 5 in. x 7 in. black, gold, and pink metal.

*Machines:* Curio
*Suggested Cut Settings:* Speed 10, Force 18, Passes 1

**METAL STIPPLING SHEETS (CURIO ONLY)**
Use our 5 in. x 7 in. aluminum sheets to stipple any design with your Silhouette Curio™. This product is sold as six 5 in. x 7 in. aluminum stippling sheets in each package.

*Machines:* Curio
*Suggested Cut Settings:* Speed 10, Force 18, Passes 1

**SCORE & EMBOSSED PAPER (CURIO ONLY)**
Especially designed for the Silhouette Curio’s Score & Emboss feature, this specialty paper will make any emboss project look incredible. It is available in 10 sheets of 5 in. x 7 in.

*Machines:* Curio
*Suggested Cut Settings:* Blade 2, Speed 5, Force 20, Passes 1
*Suggested Emboss Settings:* Blade 2, Speed 5, Force 20, Passes 1
**SCRATCH-OFF STICKER SHEETS – PRINTABLE**

The 8.5 in. x 11 in. scratch-off sheets have an adhesive film with an opaque coating. Simply print the text that you want to be temporarily hidden, adhere a custom-printed scratch-off cutout over the printed area, and then scratch off the opaque area to reveal the message! This product is sold in packages of five sheets.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 2, Speed 7, Force 14, Passes 1

---

**SCRATCH-OFF STICKER SHEETS (SILVER OR GOLD)**

The 8.5 in. x 11 in. scratch-off sheets have an adhesive film with an opaque coating. Simply print the text that you want to be temporarily hidden, adhere a scratch-off cutout over the printed area, and then scratch off the opaque area to reveal the message! This product is sold in packages of five sheets.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 2, Speed 7, Force 14, Passes 1

---

**SHRINK PLASTIC SHEETS (WHITE/CLEAR)**

Are you ready to make adorable tiny things? Try shrink plastic. It has a surface that can be drawn on and then baked, making it smaller and thicker. This is great for creating jewelry-type projects. It comes in six 8.5 in. x 11 in. sheets.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 5, Speed 1, Force 33, Passes 2

---

**STAMP MATERIAL**

This stamp material lets you make personalized rubber stamps at home. The material is sold in packages of three sheets with 6 in. x 7.5 in. stamp material. Don’t confuse this with any of the Silhouette Mint™ products. This material is made to make stamps using the Cameo or Portrait and an ink pad.

**Machines:** Cameo or Portrait  
**Suggested Cut Settings:** Blade 9, Speed 1, Force 18, Passes 1  
**Note:** The accessory Stamp Cutting Mat is highly recommended as it will help with the precision of the machine.
Chapter Eight: Creative Materials

Specialty Media

TEMPORARY TATTOO PAPER – CLEAR, WHITE, GOLD, AND SILVER
Silhouette temporary tattoos apply easily with water, generally last a day or two, and can be removed with a washcloth and warm water. Simply print designs onto this unique paper with an inkjet printer. Then, with the included adhesive, use the Silhouette’s Print & Cut feature to cut around each printed design. The temporary tattoo paper is sold a package of two 8.5 in. x 11 in. sheets with the adhesive included.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 4, Speed 3, Force 25, Passes 1

VELLUM
Add a simple softness to your projects with Silhouette vellum paper. Vellum is sold in a package of six sheets of 8.5 in. x 11 in. This soft cotton make-up is particularly good for embossing and debossing effects.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 1, Speed 6, Force 19, Passes 1
Note: When cutting vellum to add an embellishment to a card or other project, the Cameo, Portrait, and Curio will all get the job done. If you are looking to emboss or deboss on vellum, Curio is the only machine that is compatible with these effects.

STICKER PAPER – PRINTABLE CLEAR, GLITTER, GLOW-IN-THE-DARK, AND WHITE
From mailing labels to gift tags, printable clear sticker paper can give all your projects a customized look. This product is sold in packs of eight 8.5 in. x 11 in. sheets of printable clear sticker paper and is also available in glow-in-the-dark.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 3, Speed 4, Force 33, Passes 2

STICKER PAPER FOIL – PRINTABLE SILVER, GOLD, AND ROSE GOLD
Printable sticker foil is a great way to add labels to jars, gifts, and cards. Just use it with the Print & Cut feature to customize your favorite designs. This product is sold in packages of eight sheets of 8.5 in. x 11 in. printable gold, silver, or rose gold foil.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 5, Speed 5, Force 33, Passes 1

TEMPORARY TATTOO PAPER – CLEAR, WHITE, GOLD, AND SILVER
Silhouette temporary tattoos apply easily with water, generally last a day or two, and can be removed with a washcloth and warm water. Simply print designs onto this unique paper with an inkjet printer. Then, with the included adhesive, use the Silhouette’s Print & Cut feature to cut around each printed design. The temporary tattoo paper is sold a package of two 8.5 in. x 11 in. sheets with the adhesive included.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 4, Speed 3, Force 25, Passes 1

VEllUM
Add a simple softness to your projects with Silhouette vellum paper. Vellum is sold in a package of six sheets of 8.5 in. x 11 in. This soft cotton make-up is particularly good for embossing and debossing effects.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 1, Speed 6, Force 19, Passes 1
Note: When cutting vellum to add an embellishment to a card or other project, the Cameo, Portrait, and Curio will all get the job done. If you are looking to emboss or deboss on vellum, Curio is the only machine that is compatible with these effects.
WASHI SHEETS – ADHESIVE
Mix and match different washi styles with Silhouette washi sheets. Each sheet has a different washi pattern to add a bright, fun look to your projects. This product is sold in a package of nine 4 in. x 12 in. adhesive washi sheets in nine different patterns.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 1, Speed 7, Force 17, Passes 1

WINDOW CLING (WHITE/CLEAR) – PRINTABLE
Printable white or clear window cling material is what you need to customize your next party or event. It has a white liner backing that allows you to Print & Cut your design. The window cling comes in three 8.5 in. x 11 in. sheets and with either a clear or white finish.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 2, Speed 8, Force 14, Passes 1

WOOD PAPER SHEETS
Add a natural look to your designs with Wood Paper Sheets. With three different wood colors in each pack, you can mix and match them to add adhesive-backed wood to a variety of projects. They are available in six (2 sheets each color) 5 in. x 7 in. sheets.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 3, Speed 4, Force 20, Passes 1
Vinyl

Black Chalkboard Vinyl 265
Carbon Fiber Vinyl 265
Frosted Vinyl 266
Glitter Vinyl 266
Glossy Adhesive Vinyl (Permanent) 266
Glow-in-the-dark Vinyl 266
Matte Adhesive Vinyl (Removable) 267
Metallic Vinyl 267
Oracal 651 Vinyl 267
Printable Vinyl 267
Reflective Vinyl 268
Textured Translucent Vinyl 268
Transfer Tape 268
Whiteboard Vinyl 268
Wood Vinyl 269

With vinyl you can apply precisely cut designs to almost any surface. Our vinyl is available in over twenty-five different colors, two sizes (9-inch and 12-inch widths), and comes in glossy permanent, matte removable, and various specialty finishes.

BLACK CHALKBOARD VINYL
Turn nearly any hard, dry surface into a chalkboard with the 12 in. x 4 ft. vinyl rolls. Write on your vinyl with chalk and create intricate designs using chalk and the pen holder.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 1, Speed 5, Force 10, Passes 1
Note: The 12 in. size fits best in the Cameo, but it can be cut down to fit the Portrait or Curio.

CARBON FIBER VINYL
One of the most unique vinyl types that Silhouette offers is the Carbon Fiber vinyl. While the vinyl is not really carbon fiber, it does provide a unique texture and has a strong adhesive, making it very durable for your projects. Each roll measures 9 in. x 6 ft.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 1, Speed 5, Force 10, Passes 1
Chapter Eight: Creative Materials

**FROSTED VINYL**
If you're looking to add a frosted look to your glass projects but don't want to go through the process of etching the glass yourself or don't want a permanent design, then the frosted vinyl is for you. Just cut your design out of this vinyl and add it to your surface. The frosted vinyl comes in a roll of 9 in. x 4 ft.

**Machines:** Cameo, Portrait, or Curio
**Suggested Cut Settings:** Blade 2, Speed 8, Force 14, Passes 1

**Note:** The preferred transfer tape is the Strong Hold Transfer Tape.

**GLITTER VINYL**
Glam up your projects with Silhouette's Glitter Vinyl. You can either add touches of sparkle here and there or go all out and add glitter to absolutely everything you want. Each roll measures 12 in. x 6 ft.

**Machines:** Cameo, Portrait, or Curio
**Suggested Cut Settings:** Blade 3, Speed 2, Force 33, Passes 1
**Note:** The preferred transfer tape is the Strong Hold Transfer Tape.

**GLOSSY ADHESIVE VINYL (PERMANENT)**
The glossy permanent vinyl has strong adhesive for indoor and outdoor use. It's gentle enough for most indoor walls, but resilient enough to withstand the sun and weather. This vinyl is not meant to be removed (compare with matte removable vinyl) and comes in 9 in. x 10 ft. and 12 in. x 6 ft. rolls.

**Machines:** Cameo, Portrait, or Curio
**Suggested Cut Settings:** Blade 1, Speed 5, Force 10, Passes 1
**Note:** The 12 in. works best for the Cameo and the 9 in. is perfectly suited for the Portrait. The Cameo rollers also can be adjusted to accommodate the 9 in. vinyl.

**GLOW-IN-THE-DARK VINYL**
Glow-in-the-dark vinyl is available in a 9 in. x 4 ft. rolls. Add fun glow-in-the-dark on any surface.

**Machines:** Cameo, Portrait, or Curio
**Suggested Cut Settings:** Blade 2, Speed 7, Force 10, Passes 1
**MATTE ADHESIVE VINYL (REMOVABLE)**
The removable matte adhesive vinyl is a self-adhesive, high-grade vinyl that is well equipped for a large array of outdoor and indoor applications, including decals, advertisements, quote walls, and outdoor decorations. This vinyl can be removed (as compared to permanent vinyl) and comes in 9 in. x 10 ft. and 12 in. x 6 ft. rolls.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 1, Speed 5, Force 10, Passes 1  
**Note:** The 12 in. works best for the Cameo and the 9 in. is perfectly suited for the Portrait. The Cameo rollers also can be adjusted to accommodate the 9 in. vinyl.

**METALLIC VINYL**
Give your projects a cool feel with Metallic Vinyl. With both gold and silver options, you can add metallic vinyl to a variety of projects. It is available in 9 in. x 10 ft. or 12 in. x 6 ft. rolls.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 1, Speed 5, Force 10, Passes 1  
**Note:** The 12 in. works best for the Cameo and the 9 in. is perfectly suited for the Portrait. The Cameo rollers also can be adjusted to accommodate the 9 in. vinyl.

**ORACAL 651 VINYL**
We’ve partnered with Oracal Americas to bring you the Oracal 651 premium vinyl. This glossy vinyl is gentle enough for most indoor walls but resilient enough to withstand the sun and outdoor weather. Each roll measures 12 in. x 4 ft.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 1, Speed 5, Force 10, Passes 1  
**Note:** The preferred transfer tape is the Oratape.

**PRINTABLE VINYL**
Use Printable Vinyl to customize any hard, dry surface. The vinyl is available in eight 8.5 in. by 11 in. white printable sheets.

**Machines:** Cameo, Portrait, or Curio  
**Suggested Cut Settings:** Blade 1, Speed 5, Force 20, Passes 1
Chapter Eight: Creative Materials

REFLECTIVE VINYL
Use the reflective vinyl to create a reflective surface on your projects. This specialty vinyl reflects light to show some contrast. It’s great for outdoor signs or for vehicles, like a bike, if you’re wanting to add an extra safety feature. Each roll comes with vinyl that measures 12 in. x 2 ft.

*Machines:* Cameo, Portrait, or Curio
*Suggested Cut Settings:* Blade 1, Speed 5, Force 10, Passes 1

TEXTURED TRANSLUCENT VINYL
Add some pizzazz to your projects by incorporating some of this textured translucent vinyl. It looks great over both clear and opaque surfaces and comes in six vibrant colors. Each roll measures 12 in. x 4 ft.

*Machines:* Cameo, Portrait, or Curio
*Suggested Cut Settings:* Blade 3, Speed 5, Force 29, Passes 1
*Note:* The preferred transfer tape is the Strong Hold Transfer Tape.

TRANSFER TAPE
Use transfer tape to align and transfer vinyl designs onto walls, windows, and other smooth surfaces. Silhouette has three kinds of transfer tape: regular hold, strong hold, and Oratape. Transfer tape is not meant to be cut with your Silhouette. Use the grid lines on the transfer tape to help you know specific lengths and sizes of the vinyl you are cutting. Transfer tape is sold in rolls of 9 in. x 10 ft. or 12 in. x 6 ft.

WHITEBOARD VINYL
Whiteboard Vinyl is specially treated so you can draw on it with whiteboard markers. It is available in a 12 in. x 4 ft. roll.

*Machines:* Cameo, Portrait, or Curio
*Note:* The 12 in. works best for the Cameo and the 9 in. is perfectly suited for the Portrait. The Cameo roll feeders also can be adjusted to accommodate the 9 in. vinyl.
*Suggested Cut Settings:* Blade 2, Speed 5, Force 33, Passes 1
WOOD VINYL
Give your projects a rustic feel by adding some wood vinyl. It looks like wood, but because it is vinyl, it gives you the flexibility to use it in so many places. It comes in three different colors, and each roll measures 9 in. x 6 ft.

Machines: Cameo, Portrait, or Curio
Suggested Cut Settings: Blade 1, Speed 5, Force 10, Passes 1
Chapter Nine
How-Tos

Have you ever wanted step-by-step instructions for everything Silhouette? From loading your machine to using creative materials like glass etching, we have detailed tutorials to show you exactly how to accomplish your projects.

<table>
<thead>
<tr>
<th>HAND TOOLS</th>
<th>271</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hook</td>
<td>271</td>
</tr>
<tr>
<td>Spatula</td>
<td>271</td>
</tr>
<tr>
<td>Scraper</td>
<td>271</td>
</tr>
<tr>
<td>Pick-me-up</td>
<td>272</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SILHOUETTE MACHINES</th>
<th>273</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjusting the Blade</td>
<td>273</td>
</tr>
<tr>
<td>Adjusting the Rollers</td>
<td>274</td>
</tr>
<tr>
<td>Loading Your Mat</td>
<td>275</td>
</tr>
<tr>
<td>Loading Silhouette Curio™</td>
<td>276</td>
</tr>
<tr>
<td>Cutting</td>
<td>277</td>
</tr>
<tr>
<td>Matless Cutting</td>
<td>278</td>
</tr>
<tr>
<td>Using a Crosscutter</td>
<td>279</td>
</tr>
<tr>
<td>Dual Carriage</td>
<td>280</td>
</tr>
<tr>
<td>Sketch Pens/Pen Holder</td>
<td>281</td>
</tr>
<tr>
<td>Saving to a USB Device</td>
<td>282</td>
</tr>
<tr>
<td>Cutting Directly from a USB</td>
<td>282</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PROJECT HOW-TOS</th>
<th>283</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adhesive Materials</td>
<td>283</td>
</tr>
<tr>
<td>Apply Platform Tape (Alta)</td>
<td>284</td>
</tr>
<tr>
<td>Calibrating the Silhouette Alta®</td>
<td>285</td>
</tr>
<tr>
<td>Cutting Fabric</td>
<td>287</td>
</tr>
<tr>
<td>Doming Stickers</td>
<td>288</td>
</tr>
<tr>
<td>Double Sided Adhesive and Glitter</td>
<td>289</td>
</tr>
<tr>
<td>Embossing/Debossing (Curio only)</td>
<td>290</td>
</tr>
<tr>
<td>Fabric Ink</td>
<td>292</td>
</tr>
<tr>
<td>Glass Etching</td>
<td>293</td>
</tr>
<tr>
<td>Heat Transfer</td>
<td>294</td>
</tr>
<tr>
<td>Ink Stippling/Metal Stippling</td>
<td>295</td>
</tr>
<tr>
<td>Loading Filament (Alta)</td>
<td>296</td>
</tr>
<tr>
<td>Making First Print (Alta)</td>
<td>298</td>
</tr>
<tr>
<td>Metal Etching (Curio only)</td>
<td>299</td>
</tr>
<tr>
<td>Minting a Stamp</td>
<td>300</td>
</tr>
<tr>
<td>PixScan™</td>
<td>302</td>
</tr>
<tr>
<td>Print &amp; Cut</td>
<td>303</td>
</tr>
<tr>
<td>Rhinestones</td>
<td>304</td>
</tr>
<tr>
<td>Shrink Plastic Sheets</td>
<td>306</td>
</tr>
<tr>
<td>Silkscreen Printing</td>
<td>307</td>
</tr>
<tr>
<td>Stamp Material</td>
<td>309</td>
</tr>
<tr>
<td>Vinyl</td>
<td>310</td>
</tr>
</tbody>
</table>
Hand Tools

HOOK
Use the Silhouette hook tool for weeding vinyl and heat transfer cutouts. Simply use the hooked end to remove unwanted pieces until only your design remains.

SPATULA
Use the Silhouette spatula tool to lift delicate designs from the cutting mat without curling or tearing. Slide the flat end under your cut-out design to loosen it from the cutting mat.

SCRAPER
1. Use the Silhouette scraper tool to apply transfer paper to vinyl projects by covering the cutout artwork with transfer paper and rubbing the scraper back and forth against the transfer paper until it is thoroughly bonded to the vinyl.

2. Use the scraper again to transfer the vinyl onto the project surface from the transfer paper.
**PICK-ME-UP®**

1. Remove the lid and twist top clockwise to expose sticky tack. Twist top counterclockwise to stop the flow of sticky tack.

2. Peel off old sticky tack as it loses its adhesive.

3. Use the sticky tip to pick up rhinestones or other small pieces.

4. Remove the wand and use it to help position pieces as needed or as a pick to pop smaller pieces out of your design.
ADJUSTING THE BLADE

Cameo 2, Curio, and Portrait

1. Remove the blade from the tool holder by twisting the knob counterclockwise and pulling out the blade.

2. The blade needs to be manually adjusted to the number indicated in the Send panel prior to cutting. Different materials will require different blade settings.

3. To adjust the blade setting, place the blade into the adjustment socket so the arrow on the socket lines up with the red line on the blade. A ratchet cap, which is included with each blade can be used also.

4. Turn the blade to the desired number.

5. Reinsert the blade into the tool holder.

6. Turn the knob clockwise so the blade locks into place.

Cameo 3

1. To remove the blade, pull gently on the tip of the tool holder. A small piece will extend, allowing you to pull your blade from the tool holder.

2. If you are using a ratchet blade, please see Steps 3 and 4 in the above section. Once your blade is adjusted, place it in the desired tool holder.

3. Gently push the extended piece back. Make sure it clicks into place.

The AutoBlade can only be used with the Cameo 3 and Portrait 2. The AutoBlade will automatically adjust according to your cut settings. In the Cameo 3 the AutoBlade must be put in the left-hand tool holder. Other blades can be used with your Cameo in either tool holder.
ADJUSTING THE ROLLERS

**Cameo 2**

1. Locate the release lever on the right side and turn it clockwise. When the lever is pointing up, the roller is locked in place. When the lever is pointing toward you, the roller bar is raised and the rollers are ready to be adjusted.

2. Grab the roller in one hand and hold the roller bar in the other. Twist the sliding roller so the pinchers are NOT in the notches.

3. Slide the roller to the desired media size and twist again to lock the pinchers into place. There are four grooves your roller can sit in: A4, letter, 12,” and 13.”

4. Once you have your roller adjusted, twist the release lever to the upright position to lock it in place.

**Cameo 3**

1. Locate the release lever on the right side and turn it clockwise. When the lever is pointing up, the roller is locked in place. When the lever is pointing toward you, the roller bar is raised and the rollers are ready to be adjusted.

2. Grasp the roller body and roller head and twist into the unlocked position.

3. Slide the roller to the desired position and twist to lock in place. Once you have your roller adjusted, return the release lever to the upright position to lock it in place.

**NOTE:** Only the Cameo has adjustable rollers.

Adjusting the white rollers on the main roller shaft, the Cameo can cut the following media sizes— A4, letter, 12,” 13” (for 12 in. media on the cutting mat).
LOADING YOUR MAT

1. Silhouette cutting mats are available in several sizes. Be sure that you select the mat you are using from the Page panel before beginning your project. We are using a Cameo 12 in. x 12 in. mat and letter sized paper.

2. Cutting mats are printed with a 1-inch grid pattern to help you position and align your material. Place your material on your mat to correspond with the display in Silhouette Studio® before cutting.

3. When loading a cutting mat into your Silhouette, align the mat with the white rollers. Make sure the arrow on the top of the mat is pointing into the machine.

4. Use the blue line on the left-hand side of your machine as a guide to align your mat. Select “Load Cut Mat” from the display. Your machine will roll your mat into the cutting area. You are ready to cut.

NOTE: Loading a mat only applies to the Cameo® and the Portrait. To see how to load your Curio, go to page 276. To see how to load your Mint, go to page 300.

To extend the life of your mat, always replace the cutting mat liner when not in use.
LOADING SILHOUETTE CURIO™

1. Turn on your Curio using the power button on the right side of the machine.

2. Adhere your media to your cutting mat. Use the mat’s grid to line it up straight.

3. Attach the correct number of platforms and your cutting mat to the hard base.

4. Use the snaps on both sides of the cutting space to hold the platform and cutting mat in place.

5. Locate the arrow at the top of the base. This tells you which way to load the base into your Curio.

6. Gently insert the base into your Curio.

7. Continue pushing until the small notches on the base are pushed farther in than the front of your machine.

8. Hit the load button on the right side of your Curio.

9. Curio will pull the base in place. You are ready to make a cut.

While Curio is included under the cutting machines umbrella, it had a different load feature than the rest of the cutting machines. Curio’s raised inner bar means that you can load thicker media for cutting and sketching, allowing you more creative possibilities.

The number of platforms you use with Curio depends on how thick your media is and what kind of cut you are making. When you connect Curio to your computer, Silhouette Studio® will tell you in the Send panel how many platforms you need.
Chapter Nine: How-Tos

CUTTING

1. In Silhouette Studio®, click on the Send tab in the upper right-hand corner. The Send window will open.

2. The first step is to select your material. Select the media type you are using from the drop-down list.

3. Pick which tool you are using, what lines to cut, and whether you want to cut by Fill Color, Line Color, or Layer (Designer Edition only).

4. Check that your blade is set to the recommended setting and loaded.

5. Load your material with a cutting mat. Click the Learn icon at the bottom of the Send panel to check you have everything ready to send. When the settings are the way you want, click “Send.”

6. Your Silhouette will begin the cut job.

   Once the Silhouette is done cutting, press the “Unload” button. Carefully peel away your cutout design. Peel the leftover paper/media off the cutting mat. Use a Silhouette scraper tool to scrape excess paper pieces from the mat. Replace the mat cover to keep it sticky.

For more on adjusting the software cut settings, see page 146.
MATLESS CUTTING

1. Open design in Silhouette Studio®. In the Page panel select “None” under the Cutting Mat section. You will see the cutting mat disappear from your design window.

2. Load your media into your machine. Make sure you select “Load Media” and not “Load Cut Mat.”

3. Choose your appropriate cut settings for your material. Send your design to your Silhouette. Unload your media.

Some material does not need to be cut with a mat. If a material has its own backing, you do not need to use a mat to cut it. You can, but it is not necessary.

NOTE: Matless cutting only applies to the Cameo and the Portrait.
USING A CROSSCUTTER

1. In Silhouette Studio®, open your design. Select “None” as the cutting mat in the Page Setup panel.

2. In the Send panel, go to the Advanced Settings. Select “Feed” from your feed options. Adjust the ending distance so that the material will feed through the back of the machine.

3. After your design has been cut from your material, select “Advance to crosscutter” from the LCD screen on your machine.

4. Line up the crosscutter on the track at the back of the machine. Make one quick pass for a straight, clean cut.

If you’re using a CAMEO 2 or 3, you have the ability to use the crosscutter, which comes in handy when you are cutting vinyl or heat transfer without a cutting mat.
**DUAL CARRIAGE**

1. Open your design in Silhouette Studio®. Make sure your design is ungrouped so certain lines may be assigned to certain tools.

2. Load your first tool into Tool 1 of the carriage holder (the holder farthest to the left).

3. Repeat for your second tool into Tool 2 on the right.

4. Place your material on your mat and load it.

5. Go to the Send panel. Choose your material. Assign which lines you want to cut with which tools. To do this, select the lines on your design page and then click either Tool 1 or Tool 2. Adjust your action to match the tool you loaded into your tool holder.

6. Send your design to your Silhouette. Unload your project when it has finished with both actions.

Dual carriage only applies to the Cameo 3 and Curio.
1. Open your design in Silhouette Studio®. If you are using Basic Edition, simply design your project with regular cut lines showing. If you are using Designer Edition or higher, you can use the Sketch Pen panel to customize your design.

2. Place your sketch pen in your tool holder on your machine. If you are using a machine with a dual carriage, you can use more than one sketch pen at a time. If so, assign the correct lines to the correct color. (For more info on using a dual carriage, see page 280).

3. In Silhouette Studio®, go to the Send panel and select “Cardstock” for your material type. Since you are sketching and not cutting the material, it doesn't really matter which material you choose.

4. Choose “Sketch” for your action and “Sketch Pen” for your tool.

5. Send your design. Remember, each line your sketch pen makes is a “cut,” so the sketching process may be a bit lengthy.

6. Remove your finished project. You are an artist without even trying!
Chapter Nine: How-Tos

Silhouette Machines

SAVING TO A USB DEVICE

1. Open your design in Silhouette Studio®. Make sure it is exactly as you want it to cut because you can’t adjust your file from the USB.

2. Insert a USB memory device into your computer. Go to File > Save option (or Ctrl + Shift + S) and save your design to the USB memory device. Remove the USB memory device from your computer.

CUTTING DIRECTLY FROM A USB

1. Turn on your Silhouette Cameo® and insert your USB memory device into the slot on the side of the machine.

2. Load your material into your Cameo.

3. After you load your material, a screen will appear. Choose the “Browse USB” option on the touchscreen to enter the USB device menu.

4. Choose “Select file” to browse to your desired image on the USB memory device.

5. Press “Select” when your desired file is highlighted.

6. Select “Cut Settings” to adjust force (thickness in older machines), speed, and other settings for media type. Click “Start.”
ADHESIVE MATERIALS

1. Open design in Silhouette Studio®.

2. Place the adhesive-backed material (in this case, chalkboard cardstock) on your cutting mat.

3. Load the cutting mat with the material into your Silhouette.

4. Select your media in the Material menu in the Send panel, manually adjust your blade accordingly, and proceed to cut out your design.

5. After your design is cut, remove the project from your Silhouette and carefully pick up the pieces of your design.

6. Apply the design to your project.

Many of our Adhesive Materials are also printable. If you are working with printable material see page 303.
Chapter Nine: How-Tos

Project How-Tos

APPLY PLATFORM TAPE (ALTA)

1. Start by taking off the liner half without the notch.

2. Line up the top half of the platform tape (with the liner still on) with the platform's notch.

3. Rub the bottom half of the tape in place. You can use your hand or the spatula tool, but the most important thing is to make sure there are no air bubbles or creases in the platform tape when it is applied to the platform.

4. Then remove the other half of the liner and rub the remaining tape in place.

5. Again, make sure there are no air bubbles or creases. If your platform tape is not lying completely flat against the platform, your 3D object won’t print properly.

6. After the tape is adhered, place the platform piece under the print nozzle with the tape side facing up. Make sure the notch of the platform lines up with the notch at the bottom of the machine.

For detailed instructions on how to load the filament in the Silhouette Alta®, go to page 296.
CALIBRATING THE SILHOUETTE ALTA®

Your machine already comes calibrated, so when you set it up, it should be ready to go. But should you run into an issue with your machine’s calibration, you must start the calibration process from Silhouette 3D™.

To do so, you can follow the instructions listed or view the Calibrating Your Silhouette Alta video.

1. In Silhouette 3D™, go to the 3D Print tab. Locate the box in the upper right corner and click the Calibration icon.

2. Make sure the Silhouette Alta® is powered on and connected to your computer. Then click “Next.”

3. Take a piece of copy paper. Cut it in half length-wise and place it on the print bed. Go back to the software and click “Start.”

4. Follow the onscreen steps. Hold the paper by the end as the machine moves the print head.

5. Attempt to move the paper after the machine lowers the print head (the machine will do this three times).

6. In the software, indicate the difficulty of moving the paper. For “Normal” points, you should feel a little bit of resistance. Then click “Next.”

7. If you indicated that the paper was “Easy” or “Hard” to move at any point, you’ll need to adjust the mechanism closest to the point.

NOTE: Don’t use a piece of paper that is folded up. If the paper is too thick, the calibration will be off.
8. Either tighten or loosen the screw using the hex key. For the “Easy” points, turn the hex key counterclockwise. For the “Hard” points, turn the hex key clockwise.

9. Once you’ve adjusted the screw, go back to the software and click “Test Again.”

10. When all your points have been adjusted and are “Normal,” click “Next” and then click “Finish.”
CUTTING FABRIC

1. Open design in Silhouette Studio®.
2. Cut a piece of fabric that is larger than your design. Cut a piece of fabric stabilizer that is the same size as your material.
3. Iron together the back side of the fabric with the rough side of the fabric stabilizer.
5. Put your fabric on your cutting mat with the right side of the fabric facing up.
6. In the Send panel, choose “Fabric” as your material type. Send your design to your Silhouette. Use a fabric blade to get the cleanest cut.
7. Unload your design and remove it from the mat.
8. If you used Fusible Fabric Stabilizer, you can now iron your cut fabric onto whatever surface you are working with. If you used Cut and Sew fabric stabilizer, your fabric is ready to sew. If you used Wash Away, wash your fabric with soap and water and then let it dry.

To cut fabric, you will need to apply some type of fabric stabilizer. Fabric is not rigid enough on its own to cut, even with a cutting mat. We offer three types of fabric stabilizers — clean cut, cut and sew, and wash away.

View the Video
DOMING STICKERS

1. Open or create a design in Silhouette Studio® and print it with registration marks turned on. Allow the ink to dry before proceeding.

2. **Apply a laminate sheet over the printed page if using white sticker paper.** Use a scraper tool to carefully smooth the laminate sheet as it is applied to prevent bubbles or creases.

3. Proceed to cut your project using the appropriate cut settings. (Keep in mind that you need to increase your blade depth by one if you applied a laminate sheet to your page.)

4. Weed away the excess material from around your designs, leaving just your cutout stickers on the sticker backing.

5. Set your sticker sheet on a flat surface.

6. Fill the A and B syringe chambers with equal amounts of the corresponding A and B epoxy resin solutions.

7. Attach the syringe tip and prime your syringe by squirting out a small amount of epoxy resin (about 1 inch in diameter) onto a scrap piece of paper. This ensures that your syringe will apply an equal mixture of the A and B solutions.

8. Slowly apply the epoxy resin onto the surface of your cutout design, starting from the outer edge and moving toward the inside of the design. Be careful not to over-apply the resin as the resin may overflow off the edge of your cutout design.

   Use the provided toothpicks to spread the resin for more complicated designs and also to remove excess air bubbles.

9. Allow the resin to set for 12 hours to fully cure and harden.
DOUBLE SIDED ADHESIVE AND GLITTER

1. Position a double-sided adhesive sheet onto your cutting mat with the white side up and feed it into the Silhouette.

2. Open the design in Silhouette Studio®. In the Send panel, select “Double-sided Adhesive” as your material. Adjust the blade as indicated (unless you use an AutoBlade) and click “Send.”

3. Remove your project from the cutting mat. Make sure that all excess internal pieces are weeded out.

4. Remove the yellow liner from the back of the design. Make sure not to remove any adhesive from the white liner.

5. Carefully place the design into position with the white liner facing up and press into place. Be careful, because double-sided adhesive forms a very strong bond and should only be used for permanent applications.

6. Remove the white liner, making sure that all the adhesive transfers cleanly.

7. Liberally apply glitter (or flocking powder) to cover the adhesive design.

8. Gently brush away excess material. You can brush the glitter right back into the jar.

9. The adhesive is very strong so use your glitter on a variety of projects.
EMBOSSING/DEBOSSING (CURIO ONLY)

1. Open the design in Silhouette Studio®. In the Page Setup panel, choose the correct page size and the embossing mat.

2. Adjust your design and add effects under the Embossing icon. If you don’t fill your design with an effect, it will only emboss or deboss the outline.

3. In the Send panel, select your embossing material. For this tutorial, we will use Silhouette embossable foil. So choose “Foil, Embossable” for the material “Emboss” as your action, and “Embossing Tool, Fine” as your tool.

4. Place 2 + 2 + embossing mat onto the Curio base. Place an embossable foil sheet on the embossing mat, and line up the foil sheet to the 2 arrows on the left-hand side of the mat.

5. Insert the embossing tool in the machine’s tool holder.

6. Load Curio base into the machine. To do so, locate the arrow at the top of the base. This tells you which way to load the base into the Curio. Insert the base into your Curio. Continue pushing until the small notches on the base are pushed past the front of your machine.

7. Hit the Load button on the right side of your Curio. The Curio will pull the base in place.

8. After you load the Curio base, you will see that Curio status will change to Ready. After checking all the settings, click Send. The machine will proceed to emboss the design.

9. Once the embossing is complete, press the Load/Unload button and unload the base from the Curio.
10. Carefully take the embossable foil off of the mat.

11. Cut along the outermost oval with your scissors. (To avoid dulling the Silhouette blade, it is not recommended that you cut this material with a Silhouette machine.)

12. Peel off the adhesive backing and place the embossed sticker on your project.

**SILHOUETTE PRO TIP:** If you are using the Score and Emboss feature, load your regular ratchet blade tool into Tool 1 (blue) and the embossing tool into Tool 2 (red). Some materials will work better with an increased number of passes so that the embossing is a little clearer.
FABRIC INK

1. Open your design in Silhouette Studio®. Remember that you are using this design as a template, so you might want to draw a rectangle or square around your design to make it easier to weed out the design and leave the negative space.

2. Feed the stencil vinyl directly into the Silhouette cutting machine. Make sure you go to the Page Setup panel in Silhouette Studio® and choose “None” as your mat option. You can also use a cutting mat to cut the stencil vinyl.

3. Under the Send panel, select “Vinyl, Glossy” as your material type. Adjust the blade if necessary, and click Send.

4. Weed the design (or remove the unneeded vinyl) to create the stencil. Remember not to remove the negative part of the design or the centers of any letters.

5. Apply transfer tape on the weeded stencil vinyl and remove it from its backing.

6. Place the vinyl on your project. Press down firmly and carefully remove the transfer tape.

7. Place a thick piece of cardstock under the material you are going to apply fabric ink to in order to prevent ink from bleeding through. Apply regular Silhouette fabric ink on the design. Use a paint brush or sponge to apply the fabric ink. When you are applying ink, be careful and not go over the stencil borders. Let the ink dry.

8. Remove the stencil vinyl.

9. Place a piece of cloth on the top of the fabric ink design and iron on top for a couple of seconds to set the ink.
GLASS ETCHING

1. Open design in Silhouette Studio®. Make sure you have plenty of room on the sides of your design to protect the surrounding glass. (If you don’t, you can place painters tape around the outside of the vinyl to prevent any etching cream from getting onto the glass.)

2. Load the stencil vinyl into your Silhouette. Select “Vinyl” from the Material drop-down menu in the Send panel, adjust the blade to the suggested settings, and click “Send.”

3. With the Silhouette hook tool, carefully remove the design from the vinyl, creating a stencil from the negative space. It can be tricky, but be sure you think “backwards” and remove the actual design.

4. Apply transfer tape over your design and use the scraper to remove any bubbles. Remove the vinyl backing. Make sure all the pieces of the stencil adhere to the transfer tape.

5. Apply the adhesive side of the vinyl to your clean, dry glass. Smooth the vinyl over the glass with the scraper tool, removing any bubbles.

6. Once you have the vinyl really secure, peel away the transfer tape. Make sure all the pieces of the stencil remain on the glass.

7. Using a cotton swab or the scraper tool, apply a thick and even layer of etching cream to the exposed glass. Let the cream set for 30 to 60 seconds. Wear protective gloves when working with glass etching cream and don’t get it in your eyes!

8. Carefully scrape the remaining cream back into the bottle. Wipe away any residual etching cream away with a paper towel and wash the glass thoroughly.

9. Peel the vinyl off the surface of the glass. Remove any fingerprints with glass cleaner.
HEAT TRANSFER

1. Open design in Silhouette Studio®.

2. Load your heat transfer into your Silhouette. Heat transfer is lined, so if your piece is large enough, there is no need to use your mat. But, if you have a smaller piece, place it on your cutting mat and load.

3. Before you send your design to your Silhouette, make sure to MIRROR IT. Don’t forget or all of your text will be backwards. The easiest way to do this is right-click your design and select “Flip Horizontally.”

4. Choose “Heat Transfer” in the material drop-down menu located in the Send panel and manually adjust your blade, if necessary, to the recommended settings shown. Send your design to your Silhouette.

5. Once your design is cut, unload it. Weed your design. That is, peel off the extra vinyl and leave your mirrored design on the clear backing.

6. After the design is weeded, place it on your desired surface. Use an iron (or a heat press) to adhere the vinyl. We recommend using a piece of light-weight fabric between the iron and the vinyl.

7. Peel off the transfer sheet.

8. That’s it! If you placed it on something you are going to wear, make sure to turn the garment inside out when you machine wash it.

For additional information on flipping or mirroring, see page 107 and 110.
INK STIPPLING/METAL STIPPLING

1. Open your design in Silhouette Studio®. In the Page panel, change your page to “Curio (emboss)” if you are using your Curio or whichever page settings match the material you are using with your Cameo 3.

2. Use “Select Stipple Trace” in the Stipple panel. Drag a box around the image, choose a stipple style, and apply.

3. For the material type choose “Metal Stippling Sheets.” Insert the Stippling & Etching tool or a pen into the tool holder. If using Curio, place material on the embossing mat and hold it down with material fasteners. Otherwise, place material on a cut mat. Load your material.

4. Choose “Stipple” for the action and “Stipple Tool” for the tool.

5. Click “Send.” Watch it stipple!

6. Remove your project.

NOTE: Metal stippling only applies to Curio. Ink Stippling can apply to Curio or the Cameo 3.
LOADING FILAMENT (ALTA)

1. Open Silhouette 3D™ and make sure your machine is powered on and connected.
2. Go to the 3D Print tab and locate the box in the upper right corner. Click on the Filament icon.
3. Click on “Load Filament” and then follow the onscreen steps.
4. Place the filament spool and then the filament on top of the Alta.
5. Keep a hold of the leading end to prevent the filament from tangling.
6. Feed the filament through the loop.
7. And then feed it through the filament tube.
8. Make sure you push the filament tube slightly back through the loop. In the software, click “Next.”
9. Insert the filament through the opening loading lever using light pressure until you feel it come to a stop.
10. Keep a hold of the filament and click “Load” in Silhouette 3D™. Once the filament begins to be pulled into the machine, you may let go.

11. The print head will then move down and expel a little bit of filament once the filament is warmed up in order to prime the print head.
MAKING FIRST PRINT (ALTA)

1. Connect the Silhouette Alta® to the power supply. Then connect the Alta to your computer with the included USB cable. Turn the machine on by pressing the power button.

2. Apply platform tape on the platform and place the platform under the print nozzle with the tape side facing up. Make sure the notch of the platform lines up with the notch at the bottom of the machine.

3. Open your 3D design in Silhouette 3D™. All downloaded 3D designs for the Alta can be found in your Library in the 3D Designs folder.

4. Go to the 3D Print tab, and choose your print quality settings.

5. Load the filament in your Alta 3D printer.

6. When you’re ready to start your 3D print, click Print. The machine will begin to print the design. Give the design a few minutes to cool.

7. Gently remove the design from the platform. Begin to break away the first layer to reveal your printed design.
METAL ETCHING (CURIO ONLY)

1. Open a design in Silhouette Studio®. Under the Page Setup panel, change your cutting mat to the Curio (emboss) 8.5 inches by 6 inches mat. Resize your page to 7 inches by 5 inches (the same size as the metal etching sheet).

2. Open the Emboss panel and select your design. In this example, we used the concentric fill with a spacing of 0.005 inches.

3. In the Send panel, choose your material type as “Metal Sheets, Etching” and change your action to “Etch” and your tool to “Etching Tool.”

4. Place 2 + 2 platforms + the embossing mat onto the Curio base (use the snaps on both sides of the etching space to hold the platform and embossing mat in place). Place a metal etching sheet on the embossing mat.

5. Insert the stippling and etching tool into the tool holder. Load the Curio base into the machine.

6. Hit the load button on the right side of your Curio. The Curio will pull the base in place.

7. After you have loaded the Curio base, you will see that the Curio status will change to Ready. After checking all of your settings, click Send. Your machine will proceed to etch.

8. Once the etching is complete, unload the base from the Curio. Removed the etched metal sheet and insert it into a frame.
MINTING A STAMP

1. Open your design in Mint Studio™ and resize it to the stamp size of your choosing.

2. By clicking “Send to Mint,” Mint Studio™ will automatically flip your image and prepare the file to be printed.

3. Unwrap your stamp sheet from its packaging. DO NOT remove the plastic layer covering the rubber.

4. Insert the stamp sheet through the back slot of the Mint arrow first. You will feel the stamp catch inside the machine.

5. In Mint Studio™, click “Start Mint” and watch the magic happen. Pull out your stamp once it has finished printing.

6. Assemble your block by sliding the top into place.

7. Remove the lid from the block. Pull off the brown protective sheet to reveal the adhesive mat.

8. Take your 3D relief in hand, peel off the plastic, and remove the cardboard surrounding it. There are perforated lines across the cardboard that help make removing the stamp easier.

9. The back of your 3D relief is coated with a sticky adhesive for easy application. Stick your stamp to the interchangeable base.
10. Apply Mint Ink directly to the stamp. The inner reservoir on the stamp will absorb the ink only where the stamp is printed. After the ink is applied, wait 5–7 minutes before stamping.

11. The first couple of times you use your stamp, the design will be blurry. The excess ink just needs to be stamped off. Use a scrap piece of paper and stamp repeatedly. When the excess ink blots off, your stamp will be crisp and clear.

12. Don’t forget to stamp the stamp label to put on your block so that you can tell which stamp is which.

13. You can stamp 50+ times with your custom stamp before the stamp needs to be reinked.
1. Place the photo or image you want to cut out on your PixScan™ mat. Press down so that your image is stuck securely to the mat. Take a picture using your smartphone or scan in your PixScan™ mat.

2. Click on the PixScan™ icon in the Silhouette Studio®. Select “Import from File” or “Import from Scanner.” A window will pop up for you to navigate to and select your image click “Open.”

3. Once you have your PixScan™ image loaded, you are ready to create or place your cut lines. Trace your image or manually add cut lines where you want your machine to cut. Delete any excess cut lines that you do not need.

4. Choose your cut settings according to the material on your mat.

5. Send your project to your Silhouette and watch the magic happen.

**TIP:** If you see a message that says you need a calibration profile, click “Show Calibration Test Card,” choose your printer size, and print the page. Take a picture of the printed calibration page from a bird’s-eye view and ensure that the calibration dots fill the entire image. Do not put the page onto the PixScan™ mat. The image should include only the dots. Save your image to your computer. Click the plus (+) icon under the Camera Calibration section of the PixScan™ panel. A window will pop up. Select your calibration image and click “Open.” After that, PixScan™ is calibrated for your camera. You only have to do this once per camera.
PRINT & CUT

1. Open your Print & Cut design in Silhouette Studio®. Make sure your workspace matches the size of paper you will be printing on.

2. Click on the Registration Mark icon located along the upper right-hand toolbar and select the style of registration marks. Type 1 is standard (which is what you will most likely use), and Type 2 is for older machine models.

3. You will note that there are now crosshatched areas on three corners of your workspace. Make sure that your design does not overlap into the crosshatched area, or your Silhouette will have trouble reading your registration marks.

4. Once your design is ready to go, print your job to your regular printer by clicking on the Print icon in Silhouette Studio®. Make sure you have loaded your material into your home printer correctly, whether it is cardstock or a specialty material. Here we are using printable foil.

5. Load your printed material into your Silhouette using a cutting mat. Select the appropriate material from media list of the Cut Settings panel and adjust your blade accordingly.

6. Click “Send” and your Silhouette will begin scanning the page for the printed registration marks. After the registration marks are found, the Silhouette will proceed to cut as usual.

7. Unload your material and complete your project.

A Print & Cut image has two parts: a design you will print with your home printer and corresponding cut lines you will cut with your Silhouette. Though the cut lines will show in Silhouette Studio®, they will not be printed.

In addition to regular printer paper and cardstock, there is a large selection of Silhouette materials that can be used with the Print & Cut feature, including printable heat transfer material, printable foil, printable sticker paper, printable magnet paper, printable tattoo paper, printable cotton canvas, and printable adhesive kraft paper.

View the Video.

SILHOUETTE PRO TIP: Are you using metallic materials for a Print & Cut? We suggest leaving the registration marks at the default settings and increasing the force to the max.

SILHOUETTE PRO TIP: If your machine fails to read your registration marks, you can choose to “retry manually” in the Send panel. Use the arrows to position the carriage above the marks and select “Register.” After the machine registers the mark, it will cut like usual.
RHINESTONES

1. Create your design in Silhouette Studio®.
2. Load your template material into your Silhouette. In the Send panel, choose “Rhinestone Template Material.” Cut out your design.
3. Peel the black material off of the white. It works best to do it quickly.
4. The black material is your template. Add it to your rhinestone backing board.
5. Pour your rhinestones onto your design.
6. Gently brush the rhinestones into the template holes. Use the Pick-Me-Up® tool to place individual rhinestones (see page 272).
7. Once you have all of your rhinestones positioned face-up in your template, cover the design with a piece of transfer tape. Press firmly to adhere all of the rhinestones.
8. Lift your rhinestones attached to the transfer tape and position them on your project.
9. Place a cloth over the design and iron your rhinestones into place. Your iron should be on the “wool” setting and you should hold it for 45-60 seconds.
10. Remove the cloth and the transfer tape.

Do not resize rhinestone designs. Each tiny circle will fit an individual rhinestone.

Depending on your version of Silhouette Studio®, you will have different rhinestone options. With Basic Edition, you will need to use a rhinestone design from the Design Store. With Designer Edition, you have options to create your own design using the Rhinestone icon. With Designer Edition Plus, you have access to Advanced Rhinestones, which opens up many more possibilities.

**SILHOUETTE PRO TIP:** Turn your project inside out (if you can) and iron the back side of your design. It will help your glue stick better.
SHRINK PLASTIC SHEETS

1. Open or create your designs in Silhouette Studio®. Resize them. Keep in mind that a baked piece will be approximately three times smaller than a printed one, as shown above.

2. Add a circle to each design for the jump rings to go through. If you are using shrink plastic for the first time, add a couple of extra designs that you can use as test items. Also, make sure to turn on the registration marks (found in the Page Setup panel).

3. Feed the shrink plastic sheet into your home printer. (Tip: For the best results, print your design using the low-quality printing settings to lighten the designs and prevent them from becoming too dark after they are baked.)

4. Place the printed sheet on your mat and feed it into your Silhouette machine.

5. In the Send panel, choose “Shrink Plastic” as your material type. After cutting the designs, remove the designs from the cutting mat.

6. Preheat the oven to 290–325° F (140–160° C). The baking process takes about 2 minutes. When you see that the plastic is small and flat, quickly remove the baking sheet from the oven, and immediately press the plastic down with a flat tool.

7. Remove the piece from the cookie sheet and repeat each process with each piece you have.
SILKSCREEN PRINTING

1. Assemble the frame by aligning the numbers in each corner and securing with the provided fasteners. Be sure that the frame insert groove faces out.

2. Make sure to mirror the design in Silhouette Studio® before cutting it.

3. Cut out your design from the heat transfer sheet. It is recommended that you center the design on the heat transfer sheet and ensure that your design measures 7.5 by 10.5 inches or smaller in order to fit the frame properly.

4. Weed away the design (not the negative space) from the heat transfer material in order to create your stencil.

5. With the heat transfer material glossy side down, place the silkscreen sheet on top and then iron for 20–30 seconds using the standard cotton setting.

6. Once cooled, remove the glossy heat transfer liner.

7. Cut a 2-by-2-inch square from each corner to allow the stencil to be secured in the frame.

8. With the silkscreen side facing down, place the frame on top of the completed stencil and secure it into place by folding the edges upward around the frame and securing with the frame inserts.

9. Place the frame with the silkscreen side facing down onto your fabric. NOTE: You should always practice on a spare piece of fabric before you commit to your final project to ensure proper technique and ink usage.
10. Apply a line of fabric ink horizontally above the stencil spanning the width of the design. For best results, be sure to use enough ink to avoid having to make multiple passes. Some practice may be required.

11. Using the squeegee tool, spread the ink down the stencil in a top-to-bottom direction using a smooth, uninterrupted motion. For best results, spread the ink in a single pass. If repeat passes are required, spread the ink in the same direction.

12. Lift the frame and the stencil off your fabric. Allow the fabric ink to dry and then set the ink by ironing. Rinse the stencil with water or wipe it with a damp cloth every 5-10 uses as needed in order to avoid clogs in the silkscreen. When finished, rinse the stencil and store it in a dry location for repeated use.
STAMP MATERIAL

1. Open design in Silhouette Studio®. Choose your page size and cutting mat to the Stamp defaults.

2. Remove the liner from the perforated cutting mat.

3. Remove the liner from the stamp material. Place the stamp material onto the mat and gently pat it into place until all air bubbles are pressed out. Do not stretch or spread the stamp material. Load the mat into your Silhouette.

4. Select “Stamp Material” from the Material drop-down menu in the Send panel. Adjust the blade to the recommended settings. Click “Send.”

5. After the Silhouette is done cutting, unload the mat.

6. Gently peel out the stamp. Don’t worry if the blade did not cut all the way through. The material will break away cleanly.

7. Arrange the stamp onto the Silhouette acrylic block that fits it most closely. Use the block’s grid for spacing and alignment.

8. Your stamp is ready to use. Press the stamp into the ink pad. (It’s normal to get ink on your acrylic block.)

9. When stamping, be sure to press straight down on a flat surface. When you’re done, wipe away excess ink with a tissue or paper towel. Rinse and dry stamps and blocks before storage.
VINYL

1. Open design in Silhouette Studio®. Select “Vinyl” in the Material tab in the Send panel.

2. Load the vinyl into your Silhouette. A cutting mat is not necessary. However, if your vinyl piece is smaller than what the rollers can adjust to you will need to use a cutting mat. Click “Start.”

3. After your image is cut, remove the vinyl from your Silhouette. Weed (peel away) the negative space, so all that remains on the vinyl backing is your design. Now to get it onto your project. See instructions below.

APPLYING VINYL WITH TRANSFER PAPER & THE HINGE METHOD

1. Start by cutting your design out of vinyl. Weed your design.

2. Cut a piece of transfer paper or tape big enough to cover your entire design.

3. Remove the backing from your transfer paper. Using a Silhouette scraper, apply the transfer paper to the vinyl. Press it down hard so it evenly adheres to the transfer paper.

4. Move your vinyl to your project and place it where you want. Place a piece of tape down the middle of your project. This will act as the “hinge.”

5. Gently pull up one side of your design. Remove the vinyl from the adhesive backing.

6. Use scissors to cut away the adhesive backing from that one side.
Chapter Nine: How-Tos

Project How-Tos

7. Press your vinyl onto the surface. Use a scraper to press out any bubbles.

8. Remove the tape from the middle.

9. Gently fold back the other side of your design.

10. Remove the adhesive backing from that side.

11. Press that side down onto your surface. Use a scraper to adhere it and press out bubbles.

12. Remove the transfer paper. Be careful to make sure all of the vinyl sticks to your surface.

13. You perfectly aligned your project.

SILHOUETTE PRO TIP: If you have a small design, you don't need to use the hinge method to apply your vinyl. Simply place your design on your project like a sticker and peel off the transfer paper.
We want you to love your Silhouette and we are happy to help you with any questions that you might have. Look through this FAQ to see if it can answer your questions.

Not finding your answer? Reach out to us.

Email support: support@silhouettamerica.com
MY SILHOUETTE MACHINE IS SO LOUD!
If your Silhouette makes noise while cutting, it is probably normal. Lift your Silhouette’s lid to make sure any tape that is connecting the motor to the side of the unit has been removed. If this was not previously removed, this would be the cause of the excessive noise. Remove the tape and power the Silhouette unit back on.

Otherwise, know that the Silhouette is unfortunately not a whisper-quiet unit. It’s a little noisy. The sounds are likely normal.

MY MACHINE STARTS CUTTING WHEN I TURN IT ON
If when your Silhouette is powered on, it immediately begins to go through cutting motions (starts to cut the same job repeatedly or the blade taps up and down rapidly) prior to you sending a cut job, another device is trying to communicate with your machine. The issue stops if the USB cord is removed, but is repeated without stopping if the unit is powered on and the USB cord is connected to the computer.

This indicates that there is another USB device (such as a printer) that is trying to communicate with the Silhouette.

Do the following steps solve this problem:

1. Power off your Silhouette.
2. Close Silhouette Studio®.
3. Go to the START menu.
4. Go to the Control Panel.
5. Go to the Printers section.
6. Look for any printer drivers that are greyed out or printers which are no longer hooked up to the computer.
7. Right-click on one of the printer drivers in question and go to the Printer Properties option.
8. In the window that comes up, go to the Ports tab.
9. Locate the port type “File” and check this box.
10. Click “Apply.”
11. Repeat this action for all applicable printer drivers.

This will direct the older unit’s driver, which is no longer present, to stop trying to take up the USB connection and subsequently stop it from confusing your Silhouette machine.

**MY SILHOUETTE DOESN’T STOP WHEN I PRESS “PAUSE”**

If pressing “Pause” does not immediately stop the job, it is because it is waiting to stop the job after it has completed the current continuous line it is working on. For example, if your Silhouette was cutting a series of circles, pressing the Pause button would not stop the cutting action until the Silhouette stopped cutting the circle it was working on when the button was pressed. It would then stop and not move to complete further circles.

It may seem like the machine is not responding to pressing pause, but it should very quickly.

The only immediate method to stop a cut job would be to power off the Silhouette completely. This will abandon the job rather than pause it. If you power off the Silhouette to stop the job, please note that the job cannot be resumed where it left off.

**MY SILHOUETTE PAUSES FOR LONG PERIODS OF TIME DURING A CUT JOB**

If the cutting process pauses for prolonged periods of time (up to several minutes at a time) and the power light flashes, your machine is overwhelmed by the amount of data being sent. This is most common with the Original Silhouette.

This problem is a large data stream is being sent to the Silhouette machine. This is because of:

- The image size.
- The image intricacy (overall line length and number of points or nodes in the job).
The presence of content outside of the cutting area, which is also being processed (even though it is not being cut).

The cut settings in use.

This has nothing to do with the processing speed or ability of your computer, but rather the Silhouette machine itself. The power light flashing indicates that the Silhouette is on standby and will resume cutting after a few moments.

To resolve the concern, remove any additional content that may appear outside of the cutting area and try to cut the job again. Alternately, a brand new document can be started and any content that appears in the cutting area can be copied from the original document and copied into the new document. Make sure to only copy and paste the content that is actually placed inside the cutting area.

If this does not resolve the concern and the Original Silhouette model is in use, slow down the cutting Speed setting to 3 (or lower). Slowing the speed will resolve the issue by sending a slower data stream. The Silhouette should no longer stop in the middle of the job. This only needs to be performed for jobs where your Silhouette appears to stop and goes on standby (the power light flashes) in the middle of the job.

**MY BLADE IS FULL OF GUNK**

If the opening of the blade is obstructed with built up materials and your cuts do not fully cut through, it is time to clean your blade.

During the cutting process, some materials that are fibrous in nature (such as paper and cardstock) may collect fiber strands or pulp as the blade cuts through them. This can build up over time.

Grip the tip of the blade and unscrew it. Gently clean out any debris that has built up by blowing. When you are finished, screw the tip back into place. You should never cut with the tip removed.
MULTIPLE PASSES ARE MISALIGNED
If using the Passes feature found in the Send panel and the secondary cutting pass is not aligned with the initial cut, the material you are cutting is somehow slipping. You should use the Passes feature when you are using a thicker material type. As material thickness increases, the rollers (dependent upon the material type and surface) may not grip as firmly on the media's surface during operation. The resulting misalignment can either be the result of the roller slipping off material's surface or a concern with the cutting mat not holding the material in place properly.

Take the following steps to resolve the concern:

- Go to the Send panel in Silhouette Studio®. Choose your material for your project. Click “Edit Material.” and check the “Track Enhancing” option. This feature will feed the material through your Silhouette several times prior to the cutting operation and create a “track” for the Silhouette to roll on during the job in question. This can help with proper alignment of the secondary passes performed.

- Turn the Speed setting down. This should further ensure the rollers are not slipping during the cutting operation.

- Replace the cutting mat to make sure the adhesive quality is sticky so it can hold the material properly.
MY SILHOUETTE IS CUTTING VERTICAL LINES ONLY

If your cutting mat or material is moved in and out through your Silhouette, but the motor does not move side-to-side during cutting, the following could be your concern:

- The motor is stuck (generally due to unremoved packing tape). Lift your Silhouette’s lid and remove any blue translucent tape that is connecting the motor to the body of the unit or appearing anywhere on the blade carrier. Perform the following steps:

  1. Power off your Silhouette.
  2. Lift your Silhouette’s lid.
  3. Manually push the motor all the way to the left of the machine.
  4. Manually push the motor all the way to the right of the machine.
  5. Power your Silhouette back on.

- The original USB cord (8 ft USB cord) supplied with the Silhouette is not in use.

- There is not a direct connection between the Silhouette and the computer tower/laptop (i.e. the USB cord is being run through a hub, USB extension cord, through a monitor or keyboard USB port, etc.).

Ensure that the original USB cord is in use. If there is not a direct connection, change the connection of the cord from the USB hub (or other indirect connection) and connect it directly to the computer’s tower USB port or laptop USB port.
MY SILHOUETTE IS NOT CUTTING MY MATERIALS PROPERLY

The Cut is Not Visible at All
If there aren’t any cut lines on your material, one of the following is possible:

► There are no cut lines present in the job, meaning there isn’t anything to cut. The blade is not going through any cutting motions because it doesn’t have any information on what or where to cut. If the blade is not going through cutting motions, check the “My Cutting Action Never Starts When I Click ‘Send’” issue to check that there are cut lines present in your job.

► The blade is not lowering properly or at all during the cutting process. Observe the blade to see whether or not it is lowering during cutting process. If it’s not, please make sure you are using the USB cord that came with your machine to connect your Silhouette to your computer.

► The blade is not loaded properly. Ensure that the blade is loaded in the proper direction. When using the Ratchet Blade (the standard blade), you will want to ensure that the adjustment cap has been removed and that the blade is being loaded with the tip pointing downward.

► The blade is not seated all the way down in the holder. Ensure the blade is fully seated in the holder, and that the lock lever has been turned all the way into the Locked position to ensure the blade is providing the correct cutting pressure. To check this, do the following:

1. Unlock the blade.
2. Holding the lock lever in place with one hand.
3. Twist and push the blade down with the other hand making sure that it is seated all the way down in the holder. The collar of the blade should rest flush against the lip of the blade holder receptacle.

► Once the blade has been placed all the way down into the blade holder receptacle, you will want to ensure that the lock lever is turned to the right to lock the blade into place. You may want to make sure the blade’s fin is pointing forward in the 6 o’clock position in order to ensure the fin is not hitting the back of the holder. If using the original Silhouette, ensure that the blade’s fin is pointing to the right in the 3 o’clock position.
**I Can See the Cut, But My Silhouette Is Only Scoring the Material**
If there are lines on your material, but they aren’t cleanly cutting through, one of the following is possible:

- The wrong blade settings are in use. Check the Cut Settings to test if the Force setting (Thickness in older versions) needs to be increased for your material.

- The blade tip is obstructed. During the cutting process, some materials that are fibrous in nature, such as paper and cardstock, may collect fiber strands or pulp as the blade cuts through them. Over time, this can build up within the blade chamber. This can be the cause when your cut appears to not fully cut through, even when you are using the proper settings. Clean the blade tip out. Grip the tip of the blade and unscrew it. Clean out any debris that has built up by blowing around the tip. Screw the tip back into place. You should never cut with the tip removed.

- The blade has dulled over time and requires replacement (if it was previously working properly and the above are not the case).

**The Cut Is Ragged or Torn in Certain Parts**
If you aren’t getting a clean cut, one of the following is possible:

- The wrong blade settings are in use. (If the blade is exposed too high or the Force level (Thickness in older versions) is higher than necessary, the resulting cut may display ragged cutting results, especially around corners or detailed portions of the image.) Check the Cut Settings to test further if the blade level and Force setting need to be decreased for the material type in question.

- The blade has been dulled or damaged by previous attempts to cut non-conducive materials. This issue may come up if you have attempted to cut an overly dense or abrasive in material type that falls outside of the recommended range. If you have attempted to cut material types that fall outside of the recommended range, you would need to replace your blade. We would discourage further use of such abrasive materials as they will require you to replace the blade more frequently. Even with materials that do fall into the expected range, please note that thicker materials will dull the blade much more quickly and may require you to replace the blade more frequently.
Your design is on a smaller scale or is more intricate and is being cut on a thicker material type. The quality of cut depends on the combination of the scale, intricacy, and thickness of material being used. For example, an intricate image cut on a small scale may cut out well in a thinner material such as vinyl, but may not cut out well on the same scale with cardstock. As the scale is decreased and intricacy increased along with thicker material types, you may expect to see lower quality cutting results, especially around corners or detailed areas. If you are cutting a combination of a smaller, more intricate images on thicker material, enlarge the image or use material type that is thinner. Please note that some fonts and images may not be designed for optimal cutting on smaller scales. Silhouette cannot guarantee that every design will cut well with the Silhouette on any scale or any material type.

The blade has been dulled over time and requires replacement.

Try this! If none of the above solve your problem, you can try adding either more cut Passes (Double Pass in older versions) or a Line Segment Overcut. For more on both of these, see page 144 and 146.

Basic Troubleshooting for Cut Condition Issues
If you are not getting a clean cut, try the following from first to last:

- Slow down the Speed and try again.
- Increase the Force setting (Thickness in older versions) and try again.
- Increase the numbers of Passes (Double Pass in older versions) option and try again.
- Manually increase the blade level and try again.
- If all else fails, replace your blade and try again.
I CANNOT FIND THE CORRECT CUT SETTINGS FOR MY MATERIAL

If you are aren’t sure if you are using the correct settings, use the Test Cut feature to test your Cut Settings. The Test Cut is found at the bottom of the Send panel.

The Test Cut will cut where your blade is positioned, usually at the top left-hand corner. Use the blade position arrows to move the blade into a different position over your material to cut a Test Cut wherever it fits best.

When finding the correct settings to produce a clean cut, there are two things to take into consideration:

- The blade level controls how far the blade is exposed in 0.1 mm increments. This should correlate with how thick the material is. For example, a blade level of 1 = .01 mm, a level of 2 = 0.2 mm, etc. If you have a material like cardstock where the actual thickness is 0.3 mm, setting the blade to a higher exposure (such as 0.6 mm or a setting of 6) would mean you are exposing the blade beyond the actual depth of the material. This does not allow the blade to cut better. It just exposes more of the blade and extending beyond the actual thickness of the material can dull down the blade tip much more quickly. This would result in ragged cutting results. From that point on, you would then have to expose the blade to a higher level because a setting of 6 would actually be only exposed 0.3 mm since you had worn down the excess tip beyond the material’s thickness. So, we discourage attempts to overexpose the blade to try and get a “better” cut.

- The Force setting (Thickness in older versions) controls how hard the blade is pressing down. This accommodates for how dense the material may be. For example, a sheet of paper that measures a 0.3 mm depth versus a sheet of denser cardstock that measures the same 0.3 mm depth would require the blade to be pushed down with different Force levels.

If you feel your material may be slightly deeper than the recommended blade setting recommendation, we would recommend that as you raise the blade level, you also in turn lower the Force setting (Thickness in older versions) in the software so that the blade if overexposed is not still being pressed down with the hardest force possible and potentially harming the tip. You may then gradually increase the Force according to further test results.
The key to successful cutting results is to find the lowest blade setting and force setting combination where the Silhouette is still able to cut your material successfully. For example, if a specific material is able to be cut with a blade setting of 3 or 4, you should opt to go with the lower setting that is still allowing you to have a clean final cut. Likewise, if the Force setting works at 28, it would likely also work at 30. However, the lower setting should be selected to avoid over-exerting the blade beyond what is necessary to achieve a clean successful cut.

Cut Settings also includes a Speed level. The speed is generally only necessary to adjust for specific materials that may require the blade to move at slower speeds around corners or intricate detailed parts of the image. Use faster levels to make the overall cutting process faster. You may wish to slow down the Speed level if you are finding that certain parts of the design at corners are not cutting as well, if the material is being lifted from the backing during the cutting process, or if the start/end point of an image is not matching up exactly.

If your Test Cut works but you find there are areas not getting a clean cut on denser materials, you may wish to slow down the Speed and increase the number of Passes (Double Pass in older versions). This will have the Silhouette cut your image twice or more, ensuring any problem areas are given an extra pass during the cut job.

**MY SILHOUETTE STOPS CUTTING BEFORE IT IS FINISHED OR MY SILHOUETTE CUTS A STRAY LINE**

If your Silhouette stops cutting after it has started prior to fully completing the job and reports that the job is complete, or if your Silhouette cuts a stray line through the middle of the job (generally a diagonal line), then the issue probably that a larger packet of information is being pushed from the computer to your Silhouette. The Silhouette is not able to handle the larger stream of information. As such, the Silhouette abandons the job or cuts a stray line since it cannot properly assess the information being received.

Please update Silhouette Studio® with the most current version of the software by going to http://www.silhouetteamerica.com/software#update.

Less commonly, this issue can be caused by the presence of a small bit of un-removed blue packing tape found on the black motor case where the blade is seated. This tape covers certain sensors on the unit that confuses the Silhouette and makes it think the job is completed when it is not. Under and to the left of the blade, if you find a small piece of translucent blue tape that was not initially removed, please remove this tape and discard it.
Chapter Ten: Troubleshooting

Cutting | 323

MY CUT JOB HAS VERTICAL GAPS APPEARING DOWN LENGTH OF THE PAGE
If vertical gaps or stripes of uncut portions appear down the length of the page, your blade is not fully seated and is bumping against the rubber stoppers or white pinch rollers during operation.

1. Remove the blade from your Silhouette by unlocking the blade and pulling it up and out.
2. Place the blade back into the carriage.
3. Prior to locking the blade back into place, twist and push the blade down to make sure it is seated all the way down in the holder (while holding the lock lever in place so that the blade does not tap up and down).
4. Ensure the collar of the blade rests flush against the lip of the blade holder receptacle.
5. Ensure that the blade’s fin is pointing forward (in the 6 o’clock position) in order to make sure that the blade is seated properly.

MY CUT HAS UNCUT PORTIONS IN SPECIFIC AREAS
If your Silhouette goes through and completes the entire cutting process, but part of the image appears to be uncut (not ragged or torn, but simply not cut at all) while others are cut properly, it could be one of the following:

- If one specific side of every image is not cut well or at all, the issue is with the blade itself. Take the blade out of your Silhouette grip the tip of the blade and unscrew it. Please use caution as the blade is sharp. Proceed to carefully make sure the blade swivels or rotates freely. This can be done by carefully taking the blade and pressing the tip lightly onto a firm surface. Rotate the blade a full 360° so that the blade can be confirmed to swivel all the way around. Swiveling the blade around manually should get it unstuck and back into proper working condition.

- If one specific side or area of the mat is not cut well or at all, the issue is with the cutting mat being worn down in that area, or with the cutting strip being cut into in the offending area. This may occur on either side or in the center and be a large or small area that is affected. Lift the lid of your Silhouette and inspect the black cutting strip. If materials have been used without the cutting mat and the Force setting (Thickness in older versions) too high, the cutting strip may have been inadvertently damaged. Such would impair further cutting results. Indentations on this strip are normal and will be experienced. The cutting strip will be naturally indented with the cutting process. Fraying, however, indicates the strip is damaged. The cutting strip typically doesn’t need to be replaced unless it is affecting cutting results. If this is the concern, a replacement cutting strip can be purchased.
THE START AND END POINTS OF MY CUT DON'T ALIGN

If your cut design is not lining up properly or your image appears to be skewed and mis-aligned during the cutting process, then the cutting mat (or material if no mat is in use) is drifting or moving off the rollers.

- Make sure the cutting mat is being used for materials that do not have their own adhesive backing. If using paper or cardstock (or another material type that does not have a pre-adhered backing), load the material onto the cutting mat. Part of the cutting mat's purpose is to hold the material in place to ensure the resulting cut can be aligned properly.

- Make sure the mat or material is being loaded properly. If the material or cutting mat is not lined up correctly with the intended guide mark and is not being initially grabbed between the two white rollers, the material will drift as it is being cut and the image would not be aligned properly.

If your material is on a cutting mat and appears to be drifting or moving around on the mat (even though the mat itself is securely in place) try the following:

- Check the mat to see if the adhesive has worn down. If the mat has lost its adhesive quality (either overall or in select areas of the mat) and is not holding the material firmly in place during the cutting process, the cutting mat will need to be replaced.

- Test to see if the concern is specific to the material type by trying an alternate material. Some thicker specialty materials may experience difficulties when being gripped by the rollers. As material thickness increases, the rollers may not grip as firmly on the media’s surface during operation.

If your material and cutting mat both appear to be gripped properly, but the resulting cut is simply not aligning properly, try the following:

- Make sure the proper loading option is being used to load the material or to load the material on the mat. Choose the corresponding option carefully.

- Make sure the blade setting is correct for the material type in use. You may want to perform a series of Test Cuts to find the lowest blade setting possible that still successfully cuts your material type. If the
blade is at a higher level than necessary, it is possible that the blade is cutting through the material but getting caught on the mat during the cutting process.

▶ Make sure the blade is free from any obstruction and swiveling properly.

▶ Check the edges of the cutting mat. If you are using an older mat where the edges are curling upward, this can catch on the motor and throw off the cutting alignment. If this happens, simply replace your mat.

I WANT TO CUT SEPARATE LAYERS OF AN IMAGE

If you want to cut designs with separate layers, you can do one of the following:

▶ Cut the exact same image multiple times with different color materials. Then mix and match the different parts of the image by layering the different colors on each other.

▶ Separate the image prior to cutting. Then proceed to cut the various image parts in different color materials. Layer the end result by placing layers on top of each other.

1. Select the image after it has been sized.
2. Right-click on the image.
3. Select Ungroup. Some images are compound path images and instead require you to select “Release Compound Path,” which will achieve a similar result.
4. Click outside of the image so that it is no longer selected.
5. Click on any desired line in the image you wish to alter or move. You may wish to Zoom In if you are having problems selecting the desired image portion.
6. Portions of the image may now be dragged onto the inactive gray area so they are ignored and not seen to be cut.
7. Proceed to cut the remaining image portions in the desired color.
8. Repeat steps 5-7 to cut additional color layers.
MY REGISTRATION MARKS ARE NOT BEING READ
OR MY PRINT & CUT IS MISALIGNED

If your registration marks on a Print & Cut job cannot be read properly and the auto-registration mark reading process fails or the alignment is off for cuts in Print & Cut jobs, you may have one of the following concerns:

- The latest version of Silhouette Studio® is not in use.
- The cutting mat settings in the software do not match the actual set up.
- The mat or material is not being loaded properly.
- The material is not being loaded properly onto the cutting mat or is in the wrong orientation.
- The material in use has a color or surface that is not conducive to the optic scanner and so registration marks cannot be read properly on the material type in question.
- The registration marks are not printed clearly or properly.
- The optic scanner is obstructed.
- There is not a good light source for the optic scanner to be able to see the registration marks.
- A portion of the image falls into the hash mark area near the registration marks (the “no print zone”), which causes the optic scanner to think part of the print information is a portion of the registration mark and causes a resulting misalignment.
- The registration marks are not fully or properly printed.
- The registration mark settings have been adjusted to a customized setting that is not actually conducive to proper registration mark reading for the material size in question.
- The printer page settings do not match the settings in the Page Panel.
If your Registration Marks cannot be read (the automated reading process fails), do the following:

1. Update Silhouette Studio® to ensure the most current software version is in use.

2. Make sure the cutting mat settings in the software match the actual set up. Go to the Page icon and check the Cutting Mat settings. If a specialty material is in use that does not require a mat and the cutting mat is being bypassed, ensure the Cutting Mat is set to “None.” If a cutting mat is being used (regardless of what material type is in use), ensure that the correct Cutting Mat setting is selected according to the actual mat size in use.

3. Check the loading method on your Silhouette machine to make sure the correct loading option is being selected. Since the loading methods will feed the mat or material in at differing distances, if the wrong loading method is being used, then the registration marks will not be found.

   - If using the Cameo + cutting mat - Select Load Cutting Mat
   - If using the Cameo without a cutting mat - Select Load Media
   - If using the Portrait + a cutting mat - Select the Load Cutting Mat button
   - If using the Portrait without a cutting mat - Select the Load Media button

1. Make sure the material is being loaded in the proper orientation as shown on screen. If there a cutting mat is not being use, then ensure the material is loaded into the Silhouette in the direction of the arrow shown on the computer screen. If a cutting mat is in use, then ensure the material is placed onto the mat exactly as shown on the computer screen.

2. Make sure the registration marks are printed clearly and properly. The optic scanner is only able to read marks that are clearly printed. The printer may be printing the lines too lightly if the ink or toner cartridge is low, or it is possible that the printing preferences are set to a lower quality. The Silhouette’s optic scanner is also unable to read marks that may have been smudged or have bled into the material in use. This has especially been found with certain cardstock materials. A good test to determine if this is the case would be to re-print the job onto a regular piece of white copy paper and retry the job.
3. Check the material color. There may be an issue with reading registration marks that are printed onto select materials colors. The Silhouette may not be able to read the black registration marks on darker or other select material colors. This is especially true with green and blue tone material colors.

4. Check the Registration Mark Format type. If using the Cameo or Portrait model, then the Type 1 format should be used. If using any other older Silhouette model, the Type 2 format should be used.

5. Set the registration mark thickness as high as it will go. If the marks are larger, the machine might be able to read them better.

6. Make sure the optic scanner is clear of any obstructions. In some cases, a piece of vinyl or other material may have been caught underneath the cutting blade carriage where the optic scanner resides. Check under the blade carriage to see if there are any obstructions covering the optic scanner.

7. Make sure that there is a good light source. The optic scanner is like a small eye that is trying to see the registration marks. It does need enough light to view the marks properly. A well-lit room is recommended. However, caution should be taken when using materials that have a more reflective surface (such as Printable Foil) so that the light source is not shining directly onto the material as a spotlight and causing reflections they may confuse the optic scanner. If you have a lamp shining right on the surface, it will make it difficult for the machine to read the marks.

If your registration marks appear to be read properly but result in misalignment of the cutting contour, try the following:

- Check the material color. There may be an issue with reading registration marks that are printed onto select materials colors. The Silhouette may not be able to read the black registration marks on darker or other select material colors. This is especially true with green and blue tone material colors.

- Check the file to see if any part of the image falls into the “no-print zone.”

- Check to make sure the actual printed registration marks on the printed page are fully present. If they do not appear as shown on screen and part of the mark is not completely present, there may be a concern with the printer margins or page size.
1. Check the registration mark settings to see if any adjustments from the default settings have been performed. It is generally unnecessary to adjust the registration mark settings. The marks will be defaulted into their optimal positions based off the material size selected. If any adjustments have been made, restore to the default settings, re-print the job, and try again to see if the adjusted margins had been causing a problem.

2. Check to ensure the printer settings match the Page Settings. There may be a problem where the page size, orientation, and settings for what the printer are set to over-ride the settings that have been defined in Silhouette Studio®.

Registration marks may not work on textured surfaces, such as textured cardstock, or other select cardstock materials. Silhouette cannot guarantee that registration marks will work on all materials.

Generally, there is an assumption made that if registration marks are read but the cutting alignment is off, then there is a problem with the Silhouette’s calibration. This is rarely the case. Calibration should rarely be necessary. Before attempting to calibrate the Silhouette, review the previous points first regarding misalignment on Print & Cut jobs.
MY CUTTING MAT IS STUCK IN MY SILHOUETTE

If your Silhouette has been powered off in the middle of a cutting job and the cutting mat remains stuck after the Silhouette is powered back on, do the following:

1. Power on your Silhouette.
2. Press “Unload.”
3. If the mat is not fully ejected, continue pressing “Unload” until the mat is fully ejected.

You may alternately power off the Silhouette and gently pull the mat from the machine.

MY CUTTING MAT IS NOT STICKY ENOUGH/TOO STICKY

If you’ve never used your mat and the surface is not sticky at all, make sure the cutting mat’s liner has been removed. If it hasn’t, simply remove it. The liner should be replaced when you are not using the mat to keep it sticky.

Otherwise, we would recommend the following:

- Clean the mat between uses to ensure there are no fibers or other materials which cause papers or other materials to not be gripped as well. You can use a disposable lint roller to clean these fibers from your mat if you’d like. Also, use your Silhouette scraper to push any stray pieces off your mat.

- In addition to cleaning the mat, it is vital to replace the cutting mat’s liner on top of the sticky surface when not in use. If left uncovered while not in use, the mat’s adhesive surface may collect dust or other particles.
You may also want to review what material type is in use. Some materials such as construction paper, handmade paper, or cardstock that has a high fiber strand make-up are not highly recommended to use with the cutting mat. If you are using a specialty material type, you may wish to explore the use of an alternate material known to work with the cutting mat.

Finally, if your mat is older and no longer holding materials well during the cutting process, you may simply need to replace your cutting mat.

If the cutting mat is too sticky, check what material type you are using. While many materials can be used with the Silhouette, some materials may not perform as well and may rip or tear when you attempt to remove it from the cutting mat. As the mat is initial fairly sticky, you may wish to take the mat prior to initial use and “season” it a bit by placing it against a surface that is not overly linty, such as jeans or a cotton tee. This can allow the adhesive to become less aggressively sticky.

However, even as such, some materials may simply be too delicate (such as tissue paper or newspaper). Such material types simply cannot be cut successfully since they cannot be held in place properly by the cutting mat and then successfully removed.

Also, we highly recommend our Silhouette Spatula tool. This tool can aid in the removal of certain more delicate materials and cutout items from the mat.

**MY SILHOUETTE STARTS CUTTING ABOVE MY MATERIAL ON THE CUTTING MAT**
If your machine starts cutting higher than the edge of your material and cuts into the top of the cutting mat, you probably selected “Load Media” instead of “Load Cut Mat” when loading the cutting mat into your machine.

Simply unload the cutting mat and reload the mat by selecting “Load Cut Mat.” It should load your cut mat to the correct placement to start cutting your material.

**MY SILHOUETTE IS CUTTING THROUGH MY MATERIAL AND INTO MY MAT**
If your blade is cutting through your material and into your mat, you might need to adjust your Cut Settings. If you are using the recommended cut settings, then you are probably fine. But, if you adjusted them yourself, lower your settings so you still get a clean cut through your material, but you are not damaging your mat.
MY CUTTING MAT IS DRIFTING DURING CUTTING

If your cutting mat is drifting during the cutting operation and is not held in place properly by both of the white pinch rollers, the concern usually caused by one of the following:

- The cutting mat was not loaded properly. During the loading process, line up the mat with the small guide mark on the far left side of the machine (rather than loading it justified to the left against the blade adjustment receptacle).

- If you are using a Cameo, the right-hand pinch roller is not locked into place. Ensure the white lock lever is pointing upward and that the right-hand pinch roller appears to be fully gripping the edge of the right-hand side of the mat.

- If you are using a Cameo, the pinch rollers are not in the correct position for the size mat or material is use. If using a material size that is smaller on the 12 in. x 12 in. cutting mat, please note that it is still necessary to have the pinch roller in the default position for the 12 in. x 12 in. mat (rather than adjusting the right-hand pinch roller over to the left for a smaller page size).

Please note that the Cameo is the only machine with adjustable rollers. Do not move the rollers on the Portrait! This could break your machine.
MY MACHINE DOES NOT START CUTTING WHEN I CLICK “START”

If you click “Send,” but your job never starts and the program reports immediately that the job was successful, this issue could be one of the following:

▶ There is no cut information present (generally because the image is an external imported file and has not yet had cut lines created). Usually, this is the concern and you simply need to use the Trace feature to create cut lines for your Silhouette to see. For a more info on tracing images, see page 87.

▶ The cut lines are not set to cut. To fix this, go to your Send panel. Make sure “Cut” is selected.

▶ The blade has been manually moved prior to you sending the job, so the option to Cut is instead returning to the origin point and then stopping to await the action to Cut again. The Silhouette needs to start in the default origin point and then cut according to where the image is placed on the screen.

If the image in question was obtained from the Design Store, attempt to right-click and Ungroup the image. If attempts to cut are successful from that point, please report the image ID back to support@silhouetteamerica.com so we can have the original image corrected and the lines enabled by default.
WHEN I PRINT A STUDIO FILE, A BLANK PAGE PRINTS

If you are printing a document from Silhouette Studio® and the page is blank or only has registration marks printed if you have enabled them, there is no print information in the file.

While there appears to be an object on screen to print, there is actually no print information present in the file. Cut lines and print information are handled differently. The Silhouette Studio® software program does not print outlines or cut images unless the lines are specifically enabled to print.

Silhouette Studio® will only print the following:

- Imported raster images that are intended for printing.
- Cut line images that are filled with a color fill or pattern fill.
- Cut lines that have had the line style enabled to print the actual line.

If you want to print your design, try one of the following:

- Fill the image with print information.
  1. Select the image.
  2. Go to the Fill option.
  3. Select the desired color, pattern, or gradient fill.

- Enable the cut lines to be printed.
  1. Select the image.
  2. Go to the Line panel and choose the Line Style tab. Increase the line thickness or change the line color.

A FONT I BOUGHT FROM THE DESIGN STORE HAS A BLANK PREVIEW IN THE LIBRARY

If a font name appears in the Fonts section of the Library as a blank image noting the font name, but has no preview to show the actual font style image, the font was not properly installed. This is usually due to a permissions error where the Operating System needs to allow access to Silhouette Studio® to have permission to install a font onto the computer. The following steps may be taken to resolve this concern:
1. Open Silhouette Studio®.
2. Go to the Library.
3. Go to the Fonts section.
4. Right-click on the font name and click “Install.”

If the previous steps fail on a MAC, please proceed to do the following:

1. Close Silhouette Studio®.
2. Open the Finder.
3. Press Cmd+Shift+G.
4. Type in “/library.”
5. Press “GO.”
6. Right-click (Ctrl+Click) on the FONTS folder.
7. Select “GET INFO” from the drop-down menu.
8. Scroll to the bottom of the Get Info window.
10. If requested, enter the computer administrative user name and password.
11. Select the + near bottom of the Sharing & Permissions section.
12. Select your User Name.
13. Click “SELECT.”
14. Change the permissions associated with your newly added user to “READ AND WRITE.”
15. Select “LOCK” at the bottom of the Get Info window.

This process will only work for fonts downloaded from the Silhouette Design Store. If the font was obtained from another source, it should not be installed into the Fonts section of the Library. Other fonts may simply be installed into the Fonts directory of the computer and then reopen the software.

**THE SILHOUETTE STUDIO® MANUAL WON'T OPEN**

If there is no response when you are trying to access the Silhouette Studio® manual (via the Help menu in the software), there is probably an issue with the PDF reader program on your computer.

Please update or re-install the PDF reader for your computer. If you are unsure of what PDF reader you have or how to re-install the latest version, a good candidate program for viewing PDF files is the free Adobe Reader program.
MY CREDITS ON MY ACCOUNT DISAPPEARED

If your credits disappear from your account, it is because of two main reasons:

- Credits expire 60 days after they are added to your account, no matter if you made a one-time purchase or picked up a subscription. For example, if you have a subscription and credits are added to your account each month, then two months later those credits will expire if you haven’t used them. You can find out when your credits will expire by clicking the credit amount for your account in the Silhouette Design Store.

- Your subscription has expired. But don’t worry! If you renew your subscription within 30 days, the credits that you had are renewed, and all will be well.

If you use all of your credits in a given month, you can still purchase additional designs at the regular rate. For Deluxe, Premium and Diamond subscriptions, you can buy additional designs at a discount.

I CANNOT EDIT TEXT IN MY TEXT DESIGN

If you click on your text and you can no longer edit it as text, you have turned your text into an object. This happens when you weld, ungroup, or release the Compound Path. You can not turn it back into text unless you undo all of your actions until you get back to where you typed your text. If you are editing text, we suggest making a copy and placing it at the side. This way, if you don’t like your end result, you can go back to the original text that is still text and try again.

I RECEIVED “ERROR 560”

If you receive “Error 560,” please perform the following steps:

1. Open Silhouette Studio®.
2. Select the Library tab.
3. Go to the left side of the window and click on your name to show the drop-down menu.
4. Locate your Silhouette username
5. Click on the red “x” icon next to your username.
7. Reopen Silhouette Studio®.
8. Select the Library tab.
9. Select the “click here” link to sign in to your Silhouette account.
The Initial 50 Images Are Missing from the Library

If you open Silhouette Studio® for the first time and the library appears to be empty and the preloaded content included on the Silhouette product box is missing from your library, your Silhouette model has not yet been detected by Silhouette Studio®. The content included with your Silhouette purchase is controlled by what model you have and detected in order to provide proper access to coinciding preload content. The following steps can be taken to resolve the concern:

1. Turn your Silhouette off.
2. Close Silhouette Studio®. Ensure you have the latest version of Silhouette Studio®.
3. Connect your Silhouette to your computer.
4. Turn the Silhouette’s power on.
5. Open Silhouette Studio®.
6. Click the Send tab (this will confirm that the Silhouette is properly detected).
7. Open the Library to confirm the preloaded content is now present.

Once the model is detected, the software will provide the intended preload content according to the specific model owned and detected.

If your Silhouette is plugged in and detected but the preloaded images still do not show up, perform the following steps:

1. Go to the Edit (PC) or Silhouette Studio® (Mac) menu.
2. Go to Preferences.
3. Go to Advanced.
4. Select the “Restore preloaded designs” option.
If you still have issues getting your content, please attempt to use an alternate USB port for the connection to your computer. For example, if the USB cord was connected to a port in the front of the computer, attempt to use an alternate USB port on the back of the computer.

**MY LIBRARY DISAPPEARS WHEN I CLOSE SILHOUETTE STUDIO®**

If you close Silhouette Studio® and then reopen it and My Library appears to be blank, you have a permissions issue.

While still actually present on the computer, the Library cannot be called up by the software due to a permissions issue. Even if My Library contents are recovered, the library appears to be blank again if the software is again re-started. The following steps can be taken to resolve this concern:

1. Open Silhouette Studio®. Update to the latest version if you haven't already.
2. Go to the Silhouette Studio® menu (Mac) or Edit menu (Windows).
3. Select Preferences > Advanced.
4. Select “Set Library Permissions.” Please be patient after clicking on this as it may take a few moments to engage the User Account Control settings for your computer. If for any reason this does not work and you are on Windows Vista, 7, or 8, you may wish to close the program and then re-launch it by right-clicking on the program shortcut and opting to “Run as an Administrator.”
5. Once the program permissions are set, in the Advanced Preferences menu select “Reindex My Library.” Depending on the number of images owned, this may take a few minutes
6. Close and re-open Silhouette Studio® to make sure the Library is displayed properly.
A THUMBNAIL IN THE LIBRARY IS BLANK
If a thumbnail for an image is blank in Silhouette Studio®, there was a concern with the original download due to security settings on the computer, or there was a corruption in the original downloaded file. The image title is present and the image can be opened without concern, but the thumbnail simply does not appear when viewing the library. The following attempts can be performed to explore the concern further:

1. Make sure you are using the latest version of Silhouette Studio®.
2. Restart the computer and reopen the software.
3. Right-click on the blank thumbnail in the library and select the Retry Download option (if present).
4. Reset the Library by doing the following:
   1. Go to the File menu (PC) or Silhouette Studio® menu (Mac).
   2. Select Preferences > Advanced.
   3. Select “Reset Library.”

I NEED TO RECOVER DOWNLOAD CONTENT
If your computer has crashed, has been replaced, or reformatted, the issue is that My Library simply no longer exists and My Library needs to be recovered.

If the concern is that a recent order is not showing up properly in the Silhouette Studio® library, this can indicate that the content was not purchased directly through the software, or that the Silhouette Design Store did not detect that it was being run through the software during the initial download process. It may also indicate an unknown download concern or break in internet connectivity during the original download attempt.

Silhouette America maintains a database of all Silhouette users and their download histories. In the event of a computer crash, computer replacement, or reformatting, after re-loading the software onto the computer, you may recover as follows:

Sync Failure (Silhouette Library):
1. Open Silhouette Studio®.
2. Click on the Store tab.
3. Log in to your user account.
4. Click your account icon located in the upper-right corner.
5. Select Recover All Downloaded Designs.
6. Click Find & Sync Missing Items.
7. Click the Library tab and wait for the sync to finish.
Full Recovery (Computer crash/replacement/reformat):
1. Open Silhouette Studio®.
2. Click on the Store tab.
3. Log into your user account.
4. Go to “My Account.”
5. Go to “Recover All Downloaded Designs.”
6. Enter your account password.

Individual Order Recovery (for specific order issues):
1. Open Silhouette Studio®.
2. Click the Silhouette Design Store icon.
3. Log into your user account.
4. Go to “My Account.”
5. Go to “My Download History.”
6. Select the order number that is needed to be recovered.
7. Click “Recover Order.”
8. Enter your password.
9. Once the password has been submitted, the selected content will be downloaded to the library.

You will need to access the store through the software. The download and recovery process will only download content to the Library when you are downloading or recovering through the Silhouette Design Store through the software.

MY LIBRARY IS MISSING!
If your Library is missing, there is no need to be alarmed. Your library is safe. Keep a hold of the filament every design you purchase and you can migrate your designs to your library in Silhouette Studio®.

Please perform the following steps to fully migrate your library:

1. Open Silhouette Studio®.
2. Select the File menu > Update Library.
3. If needed, authenticate your Silhouette account using your Silhouette credentials.
4. Click “Update Library.” Once updated, all content should be present in your in your Silhouette Studio® library.
If this didn’t work, you may need to migrate your Silhouette Studio® library in an alternate manner. Try the following:

1. Close Silhouette Studio®.
2. Restart your computer.
3. Uninstall Silhouette Studio®.
5. Open Silhouette Studio®.
6. Select the FILE menu > Library > Export Library option.
7. Select the name and save location for the exported library and select “OK.”
9. Download and install the latest version of Silhouette Studio® software.
10. Open Silhouette Studio®.
11. Select the FILE menu > Library > Import Library.
12. Select the exported library from the location previous specified.

Your library will begin uploading to the software. Once completed, you should find all images in your Silhouette Studio® library.
MY SILHOUETTE LIBRARY SHOWS IT IS SYNCED, BUT IT'S NOT FULLY SYNCED

If your library is showing that it is synced, but all the content from your Silhouette Design Store isn’t actively downloaded to your Silhouette Library, you may need to force your library to update. You can see when your library last synced by clicking the Library tab, going to the bottom of the panel on the right-hand side, and looking at the time stamp next to the cloud icon. You can manually sync your library by clicking on the “Sync” button, but if not all of your designs are syncing after pressing this button, you need to do the following:

1. Open Silhouette Studio®.
2. Click the Store tab.
3. Sign in to your Silhouette account.
4. Click your account icon located in the upper-right corner.
5. Select Recover All Downloaded Designs.
6. Click Find & Sync Missing Items.
7. Click the Library tab and wait for the sync to finish.
.studio file: The file format in which Silhouette Studio® saves your design.

3D Print: A 3D object created from a digital model. The object is printed layer by layer using a 3D printer and melted plastic material called filament.

3D relief: The stamp sheet after the Mint prints a design on it. The Mint uses a UV light to burn your design into the stamp sheet. The thermal printing process works in a way similar to light-sensitive paper. The light burns the areas around your design, leaving behind a relief.

Active cut area: The area inside the red border where your Silhouette will cut. Anything outside of this area will not be cut. Anything overlapping this line will be sliced where the red line hits.

Alta: Our 3D printer that creates 3D prints. The Alta can print objects that are about 5 1/2 inches tall and 5 1/2 inches in diameter.

Anti-aliasing: A feature that helps smooth jagged lines as they are created and viewed. Higher sample rates will increase the smoothness of lines. The “off” setting will produce rougher edges, but increases drawing speed. Access this feature through the Preference menu.

AutoBlade: The self-adjusting blade for the CAMEO 3 and Portrait 2.

Base: The hard loading platform Curio uses. The base is adjustable for different material sizes.

Blade level: The number on the blade that controls how far the tip is exposed in 0.1 mm increments. This accommodates for the material’s actual thickness. For example, a blade level of 1 = .01 mm, a level of 2 = 0.2 mm, etc. If you have a material such as cardstock where the actual thickness is 0.3 mm, setting the blade to a higher exposure (such as 0.6 mm or a setting of 6) would mean you are exposing the blade beyond the actual depth of the material. This does not allow the blade to cut better. It just exposes more of the blade and, if extending beyond the actual thickness of the material, can dull down the blade tip much more quickly or in extreme cases break off the tip. This would then result in ragged cutting results. From that point on, you would then have to expose the blade to a higher level because a setting of 6 would actually be only exposed 0.3 mm since you had worn down the excess tip beyond the material’s thickness. We would thus discourage attempts to overexpose the blade to try and get a “better” cut.

Bounding border: The space between two or more objects that the software uses as the edges of the design to align objects. The software will take the far left-side of the left shape, the far right-side of the right shape, the top of the top shape, and the bottom of the bottom shape. This invisible square is the space Silhouette Studio® uses to align objects.

Calibration: The process of adjusting and checking your camera so you can use the PixScan™ feature.

CAMEO: Our cutting machine with the largest cutting area (12 in.). The CAMEO 3 features a dual-carriage.
Carriage: The moving piece that holds your Silhouette tools, like your blade or a sketch pen. The CAMEO 3 and Curio have two tool holders per carriage.

Commercial use: The process of using a digital design in any physical project, product, artwork, etc. that is intended for resale or commercial use.

Compound path: A collection of two or more line sets where inner lines are embedded into the image. Think of it as the lines on top punching through to the lines underneath. A compound path may appear the same as a grouped set of lines, but is quite different in the way it will react to being filled with color.

Curio: Our specialty machine that unlocks etching, debossing and embossing. It also features a dual-carriage, the highest clearance of all machines, stipplers.

Cut: A pass your Silhouette makes with its carriage and tool. A cut does not necessarily need to be made with a blade, as passes with you Silhouette sketch pens or Curio tools are also referred to as cuts.

Cut border: Marked by a red line, the boundary around the outside of your page where your Silhouette can read and cut information. Anything outside of this will not be cut.

Cut job: The information sent to your Silhouette when you click “Start.” This is everything you have marked as “Cut” in the Send panel.

Cut line: A line (default red) in Silhouette Studio® that tells your Silhouette where to cut. When you click on the Send panel, you’ll find that the cut line become thicker, showing you exactly what lines are being sent to cut.

Cutting area/drawing area: The white page in Silhouette Studio®. It is also called the “active cut area.” Only the things in this area will be sent to your Silhouette.

Cutting mat: The mat with a sticky surface that you load into your machine. There are different size cutting mats for different material sizes and machines.

Deboss: A Curio feature where your design will be impressed into the paper, providing indents.

Deep-cut Blade: A 2 mm long blade that cuts through thicker materials than the regular blade.

Despeckle Threshold: This helps eliminate noise in your trace. If you have extra small spots traced that you don’t want to traced, adjust this threshold.

Document tabs: The tabs at the top of your screen that allow you to toggle between documents in Silhouette Studio® or Mint Studio™.

Dual-carriage: A carriage with two tool holders. Curio and the CAMEO 3 both have dual-carriages.


Emboss: A Curio feature where you use an embossing tool to carve into your material so your design has raised edges.

Etch: A Curio feature where you engrave your design onto a material.
**Filament:** A thread-like plastic material that comes on a roll or spool that can be melted and expelled from a 3D printer to create a 3D print.

**Firmware:** Software that is embedded into a piece of hardware. Occasionally, the CAMEO and Curio will have firmware updates available through silhouetteamerica.com.

**Force (Thickness in older versions):** Also known as “hardness,” the setting in the Send panel that controls how hard the blade is pressing down. This accommodates for how dense the material may be. For example, a sheet of paper that measures a 0.3mm depth versus a sheet of denser cardstock that measures the same 0.3mm depth would require the blade to be pushed down with a different Force level.

**Glossy:** A shiny, bright finish.

**Glyphs:** The extra characters included in fonts that you can access through your computer.

**Grouped/Ungrouped:** Lines that are fixed/not fixed in their relative positions, even when moved. You can group things temporarily to move them and then ungroup. Or, things can stay permanently grouped.

**High Pass Filter:** This allows the trace lines to be set beginning from the outside of your image and working towards the inside of the image as the filter setting is adjusted up. If you do not wish to create a frame outline for your image, turn this option off.

**Holding area:** The gray area next to your white page in Silhouette Studio®. You can use this area to hold designs not being sent to your Silhouette.

**Layering:** Organizing objects into different sections (or layers) that can interact together or separately.

**Line segment overcut:** A feature that cuts lines slightly farther than the edge of the intended cut. Selecting the “Off” option will have all lines cut normally. Selecting the “On” option will have all straight corners cut with a slight overcut.

**Lined media:** A material that has its own lining attached. Examples are vinyl or adhesive cardstock. Lined media does not require the use of a cutting mat, but cutting mats may still be used.

**Load/load media:** The two different options to load your machine. Use “load” when you are loading a material on your cutting mat and choose “load media” when you are loading material that comes with its own backing and is not placed on a cutting mat.

**Low Pass Filter:** This allows the trace lines to begin at the center of your image and then work outwards as the filter setting is adjusted up.

**Magnet Trace:** A tracing feature that allows you to manually trace an object. Your tracing circle will cling like a magnet to the shape.

**Material fasteners:** Small plastic pieces to hold your material onto your Curio base.

**Matless cutting:** Feeding lined media into your machine without a mat. Some material comes with its own backing and doesn't require you to use a cutting mat.

**Matte:** A dulled, soft finish.
Media: The different kinds of materials that you can use with your Silhouette, such as vinyl, cardstock, heat transfer, wood, metal, and chipboard.

Media Layout View: A view available in Business Edition of Silhouette Studio® where you will see a side-by-side view of your design screen and a screen that shows what your Silhouette will actually cut. Through this view you can access additional business features like Tiling, Nesting, and Matrix Copy.

Mint: Custom stamp maker. Using Mint Studio™, it allows you to design and print custom stamps.

Nesting: Fitting smaller objects into larger ones. Generally, it is fitting your objects into the smallest cutting space possible to save material.

Operating system (OS): The software that runs your computer's basic functions. The two operating systems our software is designed for are Mac® and Windows®. Make sure you download the compatible software, or the program will not install properly.

Page: The white portion of your workspace. Any design on your page is live, meaning that it can be sent to your connected Silhouette.

Passes: A feature where the Silhouette will cut through all lines in your cutting area by the number set. Some materials automatically include two passes. If your material is thicker increase the number of passes

PixScan™: A feature in Silhouette Studio® that lets you take a picture of your design, upload it to your computer, and make exact cuts around the image.

Platform: The raised surfaces that you build to place on your base when you are using your Curio. Different materials will require a different number of platforms.

Portrait: The electronic cutting machine with a 8.5 in. x 11 in. cutting space.

Print & Cut: An image with two parts. There is a design you will print with your home printer and corresponding cut lines you will cut with your Silhouette. The cut lines will not be printed.

Print & Emboss: The act of printing your project to your home printer, loading your printed sheet into your Curio, and embossing lines on the design.

Print border: The thin gray rectangle that shows the boundary the printer you have connected to your computer can print within.

Ratchet blade: The standard blade for your Silhouette. It can be adjusted using the ratchet adjuster built into your machine or a ratchet cap.

Ready, Set, Make: The section in the Design Store where you can find dozens of ready-made projects with instructions to help you create the featured project. When you purchase a project from Ready, Set, Make, you get all of the included designs at a discounted price.

Registration marks: Marks you can activate to print around the border of your workspace. They will be read by your Silhouette's optic scanner prior to cutting so that the Silhouette can triangulate according to where these marks are located and know exactly where the cut lines are defined around your printed images. Registration marks are only used when printing images for Print & Cut jobs.
**Regular cut:** A cut with your blade made by your Silhouette.

**Release lever:** The lever on the right-hand side of the roller bar in the CAMEO. You must release the lever to move the roller bar and lock the lever to cut.

**Reverse weeding:** A technique where you place transfer tape over your vinyl as soon as you cut it out. Transfer the vinyl to the transfer tape and flip it over. Then, weed the vinyl while it is on the transfer tape. This is helpful for small or intricate designs.

**Roll feeder:** A product that holds a roll of vinyl in place while your machine is cutting your design. This will save you from holding your roll and trying to feed it in straight while a long design is cutting.

**Roller bars:** The bar in the CAMEO and Portrait that material rolls under when being cut.

**Score & Emboss:** A feature where you first lightly cut your material (or score) and then you use that line to get a more pronounced emboss. You will load both a blade and an embossing tool into your Curio.

**Seasoning your mat:** A technique where you rub your mat against your pants, a cotton tee, or even on the floor. This will stop your media from over-sticking to your mat if it is new and very adhesive.

**Sheet:** A single piece of media in a predetermined size (such as 12 in. x 12 in. or 8.5 in x 11 in.). Many of the Silhouette products, like adhesive cardstock or vinyl, are available for sale are sold in packs with a specific number of sheets included.

**Silhouette Library:** A computer server that stores your data in an off-site location and syncs it to your devices so that all of them are up to date with the latest content, file structure, etc. The Silhouette Library allows you to share Silhouette Design Store files, your own files, and your folder structures between devices.

**Silhouette Connect™:** A plug-in available for those who want to cut directly from Adobe Illustrator® or CorelDraw®. Once the plug-in is purchased and installed, you can send your design to your Silhouette directly from your design program without ever opening Silhouette Studio®.

**Silhouette cutting machines:** The Silhouette CAMEO®, the Silhouette Portrait®, and the Silhouette Curio™. We group Curio with the other cutting machines because in addition to its specialty features like embossing or etching, it also cuts.

**Silhouette Design Store:** An ever-growing marketplace full of thousands of designs you can use with your Silhouette. These range from simple shapes to intricate patterns, fonts, and designs.

**Silhouette Link:** The program that runs in the background of your computer, connecting your Silhouette to your wireless device.

**Silhouette Studio® Mobile:** Our mobile app. Download Silhouette Studio® Mobile onto your Android or IOS device and start designing. Using Silhouette Library, you can share designs between five devices.
Slicing: A process that converts a digital model into layers so that the 3D printer knows where it needs to expel filament to create a 3D print.

Stamp sheet: The media that gets inserted into your Silhouette Mint™. It is an adhesive-backed, rubber sheet that reacts with a UV light inside the Mint to create your design. This stamp sheet is unique to Silhouette.

Standard media: Media that is not lined. Regular cardstock is an example of standard media.

Stamping: A Curio feature where you create a design with clustered dots instead of a continuous line. The Stippling & Etching tool works best with Silhouette Metal Stippling sheets or on media like paper or canvas with a felt-tipped marker.

Test Cut: The little triangle within a square cut so you can try out your Cut Settings. Using a Test Cut will save on media waste by perfecting your cut settings in a tiny area before you cut your entire design.

Threshold: This determines how broadly the trace filter is applied to your image beginning with the darkest colors for low settings.

Tiling: The feature that cuts or tiles your large design into pieces so cutting-area sized pieces are sent to your Silhouette. This is available in Business Edition.

Track enhancing: A feature that moves the mat or other material back and forth through the Silhouette prior to the actual cutting process. As material thickness increases, the rollers (dependent upon the material type and surface) may not grip as firmly on the material’s surface during operation. In such cases, it may be recommended to enable the Track Enhancing option. The action of feeding the material through the Silhouette several times prior to operation creates a “track” for the Silhouette to roll on and gain a better grip during the job in question.

Transfer paper/tape: A lightweight paper or tape to use when transferring your design from its liner to your project.

Vellum: Thin, translucent white paper.

Version: The particular form of the software you are using. New software versions are released to keep the program up-to-date and to fix any bugs or glitches. When you are prompted to update your software, you are installing a new version.

Weed lines: The lines placed in your design that makes it easier for you to weed. Add lines so when you are pulling your vinyl, it can break in sections instead of trying to weed your entire design at once.

Weeding: The process of removing the excess material from the design.

Welding: The process of merging two shapes into one.
# Silhouette Studio® Shortcuts

## Document

<table>
<thead>
<tr>
<th>Action</th>
<th>PC</th>
<th>MAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Document</td>
<td>ctrl + n</td>
<td>cmd + n</td>
</tr>
<tr>
<td>Open Document</td>
<td>ctrl + o</td>
<td>cmd + o</td>
</tr>
<tr>
<td>Save Document</td>
<td>ctrl + s</td>
<td>cmd + s</td>
</tr>
<tr>
<td>Print</td>
<td>ctrl + p</td>
<td>cmd + p</td>
</tr>
<tr>
<td>Cut</td>
<td>ctrl + x</td>
<td>cmd + x</td>
</tr>
<tr>
<td>Copy</td>
<td>ctrl + c</td>
<td>cmd + c</td>
</tr>
<tr>
<td>Paste</td>
<td>ctrl + v</td>
<td>cmd + v</td>
</tr>
<tr>
<td>Undo</td>
<td>ctrl + z</td>
<td>cmd + z</td>
</tr>
<tr>
<td>Redo</td>
<td>ctrl + shift + z</td>
<td>cmd + shift + z</td>
</tr>
<tr>
<td>Zoom In</td>
<td>ctrl + =</td>
<td>cmd + =</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>ctrl + -</td>
<td>cmd + -</td>
</tr>
<tr>
<td>Drag-zoom Tool</td>
<td>z</td>
<td>z</td>
</tr>
<tr>
<td>Pan Tool</td>
<td>spacebar</td>
<td>spacebar</td>
</tr>
<tr>
<td>Fit to window</td>
<td>ctrl + 1</td>
<td>cmd + 1</td>
</tr>
</tbody>
</table>

## File

<table>
<thead>
<tr>
<th>Action</th>
<th>PC</th>
<th>MAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save as</td>
<td>ctrl + shift + s</td>
<td>cmd + shift + s</td>
</tr>
<tr>
<td>Save to Library</td>
<td>ctrl + alt + r</td>
<td>ctrl + cmd + r</td>
</tr>
<tr>
<td>Close Document</td>
<td>ctrl + w</td>
<td>cmd + w</td>
</tr>
<tr>
<td>Quit</td>
<td>ctrl + q</td>
<td>cmd + q</td>
</tr>
</tbody>
</table>

## Tools

<table>
<thead>
<tr>
<th>Action</th>
<th>PC</th>
<th>MAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td>v</td>
<td>v</td>
</tr>
<tr>
<td>Freehand Lasso</td>
<td>b</td>
<td>b</td>
</tr>
<tr>
<td>Edit Points</td>
<td>a</td>
<td>a</td>
</tr>
<tr>
<td>Line</td>
<td>\</td>
<td>\</td>
</tr>
<tr>
<td>Polygon</td>
<td>p</td>
<td>p</td>
</tr>
<tr>
<td>Curve</td>
<td>c</td>
<td>c</td>
</tr>
<tr>
<td>Arc</td>
<td>shift + a</td>
<td>shift + a</td>
</tr>
<tr>
<td>Rectangle</td>
<td>r</td>
<td>r</td>
</tr>
<tr>
<td>RoundedRectangle</td>
<td>shift + r</td>
<td>shift + r</td>
</tr>
<tr>
<td>Ellipse</td>
<td>e</td>
<td>e</td>
</tr>
<tr>
<td>Regular Polygon</td>
<td>shift + p</td>
<td>shift + p</td>
</tr>
<tr>
<td>Freehand</td>
<td>f</td>
<td>f</td>
</tr>
<tr>
<td>Smooth Freehand</td>
<td>shift + f</td>
<td>shift + f</td>
</tr>
<tr>
<td>Text</td>
<td>t</td>
<td>t</td>
</tr>
<tr>
<td>Eraser</td>
<td>shift + e</td>
<td>shift + e</td>
</tr>
<tr>
<td>Knife</td>
<td>k</td>
<td>k</td>
</tr>
<tr>
<td>Eyedropper</td>
<td>i</td>
<td>i</td>
</tr>
<tr>
<td>Eyedropper</td>
<td>ctrl + click</td>
<td>ctrl + click</td>
</tr>
</tbody>
</table>

## Object

<table>
<thead>
<tr>
<th>Action</th>
<th>PC</th>
<th>MAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>ctrl + g</td>
<td>cmd + g</td>
</tr>
<tr>
<td>Ungroup</td>
<td>ctrl + shift + g</td>
<td>cmd + shift + g</td>
</tr>
<tr>
<td>Make Compound Path</td>
<td>ctrl + e</td>
<td>cmd + e</td>
</tr>
<tr>
<td>Release Compound Path</td>
<td>ctrl + shift + e</td>
<td>cmd + shift + e</td>
</tr>
</tbody>
</table>
**Silhouette Studio Shortcuts**

### Arrange

<table>
<thead>
<tr>
<th>Action</th>
<th>PC</th>
<th>MAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bring to Front</td>
<td><code>ctrl + shift + ]</code></td>
<td><code>cmd + shift + ]</code></td>
</tr>
<tr>
<td>Send to Back</td>
<td><code>ctrl + shift + [</code></td>
<td><code>cmd + shift + [</code></td>
</tr>
<tr>
<td>Bring Forward</td>
<td><code>ctrl + ]</code></td>
<td><code>cmd + ]</code></td>
</tr>
<tr>
<td>Send Backward</td>
<td><code>ctrl + [</code></td>
<td><code>cmd + [</code></td>
</tr>
</tbody>
</table>

### Replicate

<table>
<thead>
<tr>
<th>Action</th>
<th>PC</th>
<th>MAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate Left</td>
<td><code>ctrl + ←</code></td>
<td><code>cmd + ←</code></td>
</tr>
<tr>
<td>Duplicate Right</td>
<td><code>ctrl + →</code></td>
<td><code>cmd + →</code></td>
</tr>
<tr>
<td>Duplicate Below</td>
<td><code>ctrl + ↓</code></td>
<td><code>cmd + ↓</code></td>
</tr>
<tr>
<td>Duplicate Above</td>
<td><code>ctrl + ↑</code></td>
<td><code>cmd + ↑</code></td>
</tr>
<tr>
<td>Row of 3</td>
<td><code>ctrl + shift + →</code></td>
<td><code>cmd + shift + →</code></td>
</tr>
<tr>
<td>Row of 4</td>
<td><code>ctrl + alt + →</code></td>
<td><code>cmd + alt + →</code></td>
</tr>
<tr>
<td>Column of 3</td>
<td><code>ctrl + shift + ↓</code></td>
<td><code>cmd + shift + ↓</code></td>
</tr>
<tr>
<td>Column of 4</td>
<td><code>ctrl + alt + ↓</code></td>
<td><code>cmd + alt + ↓</code></td>
</tr>
<tr>
<td>Fill Page</td>
<td><code>ctrl + shift + f</code></td>
<td><code>cmd + shift + f</code></td>
</tr>
<tr>
<td>Mirror Left</td>
<td><code>alt + shift + ←</code></td>
<td><code>alt + shift + ←</code></td>
</tr>
<tr>
<td>Mirror Right</td>
<td><code>alt + shift + →</code></td>
<td><code>alt + shift + →</code></td>
</tr>
<tr>
<td>Mirror Above</td>
<td><code>alt + shift + ↑</code></td>
<td><code>alt + shift + ↑</code></td>
</tr>
<tr>
<td>Mirror Below</td>
<td><code>alt + shift + ↓</code></td>
<td><code>alt + shift + ↓</code></td>
</tr>
<tr>
<td>Rotate 1 Copy</td>
<td><code>ctrl + shift + F1</code></td>
<td><code>cmd + shift + fn + F1</code></td>
</tr>
<tr>
<td>Rotate 2 Copies</td>
<td><code>ctrl + shift + F2</code></td>
<td><code>cmd + shift + fn + F2</code></td>
</tr>
<tr>
<td>Rotate 3 Copies</td>
<td><code>ctrl + shift + F3</code></td>
<td><code>cmd + shift + fn + F3</code></td>
</tr>
<tr>
<td>Rotate 5 Copies</td>
<td><code>ctrl + shift + F5</code></td>
<td><code>cmd + shift + fn + F5</code></td>
</tr>
</tbody>
</table>

### View

<table>
<thead>
<tr>
<th>Action</th>
<th>PC</th>
<th>MAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Design Page</td>
<td><code>ctrl + shift + d</code></td>
<td><code>cmd + shift + d</code></td>
</tr>
<tr>
<td>Show Store</td>
<td><code>ctrl + alt + s</code></td>
<td><code>cmd + alt + s</code></td>
</tr>
<tr>
<td>Show Library</td>
<td><code>ctrl + alt + l</code></td>
<td><code>cmd + alt + l</code></td>
</tr>
<tr>
<td>Show Send Page</td>
<td><code>ctrl + F2</code></td>
<td><code>cmd + fn + F2</code></td>
</tr>
<tr>
<td>Show Grid</td>
<td><code>g</code></td>
<td><code>g</code></td>
</tr>
<tr>
<td>Grid Panel</td>
<td><code>ctrl + F4</code></td>
<td><code>cmd + fn + F4</code></td>
</tr>
<tr>
<td>Page Panel</td>
<td><code>ctrl + F1</code></td>
<td><code>cmd + fn + F1</code></td>
</tr>
<tr>
<td>Print Border</td>
<td><code>ctrl + shift + p</code></td>
<td><code>cmd + shift + p</code></td>
</tr>
<tr>
<td>Cut Border</td>
<td><code>ctrl + shift + l</code></td>
<td><code>cmd + shift + l</code></td>
</tr>
<tr>
<td>Center of Rotation</td>
<td><code>o</code></td>
<td><code>o</code></td>
</tr>
<tr>
<td>Registration Marks Window</td>
<td><code>ctrl + F3</code></td>
<td><code>cmd + fn + F3</code></td>
</tr>
<tr>
<td>Media Layout View</td>
<td><code>ctrl + shift + v</code></td>
<td><code>cmd + shift + v</code></td>
</tr>
</tbody>
</table>

### Modify

<table>
<thead>
<tr>
<th>Action</th>
<th>PC</th>
<th>MAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weld</td>
<td><code>ctrl + shift + w</code></td>
<td><code>cmd + shift + w</code></td>
</tr>
</tbody>
</table>

### Other

<table>
<thead>
<tr>
<th>Action</th>
<th>PC</th>
<th>MAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registration Marks</td>
<td><code>m</code></td>
<td><code>m</code></td>
</tr>
<tr>
<td>Cut Style = Cut</td>
<td><code>ctrl + t</code></td>
<td><code>cmd + t</code></td>
</tr>
<tr>
<td>Cut Style = No Cut</td>
<td><code>ctrl + shift + t</code></td>
<td><code>cmd + shift + t</code></td>
</tr>
<tr>
<td>Ruler</td>
<td><code>ctrl + r</code></td>
<td><code>cmd + r</code></td>
</tr>
<tr>
<td>Crosshairs</td>
<td><code>ctrl + h</code></td>
<td><code>cmd + h</code></td>
</tr>
<tr>
<td>Edit Object</td>
<td>Double Click</td>
<td>Double Click</td>
</tr>
<tr>
<td>Scroll Left/Right</td>
<td><code>ctrl + scroll wheel</code></td>
<td><code>cmd + scroll wheel</code></td>
</tr>
<tr>
<td>Zoom In/Out</td>
<td><code>alt + scroll wheel</code></td>
<td><code>alt + scroll wheel</code></td>
</tr>
</tbody>
</table>
Index

Active Cut Area 34, 343-344
Adjustable Rollers
   See Rollers
Align 48, 69, 102-103, 105, 153, 161-162, 186, 227, 275, 324
AutoBlade
   See Blades
Barcode Scanning 12
Base 17-18, 242-243, 276, 343
Basic Edition
   See Silhouette Studio®
Blades
   Adjusting 239, 273
   AutoBlade 11, 13, 15-16, 31, 149, 237-238, 273, 343
   Deep-Cut 14, 238, 344
   Fabric 238, 287
   Level 239, 343
   Ratchet 237-238, 346
Bluetooh 11-12, 14-16
Bounding Border 103, 343
Business Edition
   See Silhouette Studio®
Calibration 75, 343
Cameo 11-14, 237-238, 242-243, 343
Carriage 13, 18, 237, 280, 344
Center of Rotation 123, 154
Club Silhouette 141
Commercial Use 344
Compound Path 53, 55, 116, 344
Connect™
   See Silhouette
Convert to Path 63, 228
Credit Boost 136
Crop 114, 231
Curio 17-20, 237, 240
Cut Border 71
Cutting Area
   See Active Cut Area
Cutting Mat 70, 242
Deboss 19, 119-120, 344
Deep-Cut Blade
   See Blades
Designer Edition
   See Silhouette Studio®
Designer Edition Plus
   See Silhouette Studio®
Design Store
   See Silhouette
Detach Lines 115
Divide 113
Document Tabs 34, 344
Dual Carriage 12-13, 18, 280, 344
Emboss 17, 19-20, 119-120, 290, 344
Embroidery Files 171
Eraser 66-67, 230
Etching 19, 299, 344
Fabric Blade
   See Blades
Firmware 345
Flip 107
Font Creation 180-183
Glyphs 100-101, 345
Gradient 80
Grid 72, 108
Group 49-50, 193, 228, 345
Hinge Method 310
Intersect 114
Knife 67-68, 126, 155
Layers 167-168, 177-178, 345
Library 28, 40, 42, 126, 139-140, 226, 347
Lined Media 345
Line Segment Overcut 146, 345
Load 18, 345
Load Media 345
Magnet Trace 158, 231-232
Material Fasteners 295, 345
Matless Cutting 278, 345
Matrix Copy 185
Index

**Media Layout**
- View 184-185, 346

**Merge** 42

**Mint** 23-24, 225-226, 230, 234, 254, 346

**ModelMaker™** 205-210, 213, 216-217, 219-220, 222

**Monogram** 99

**Multiple Undo/Redo** 179

**Nesting** 161-162, 185, 346

**Object on Path** 111

**Offset** 53, 115-116

**Panels** 34-36

**Passes** 120, 144, 346

**Pattern** 82-83, 133, 156

**Perforated Lines** 85

**Pixscan™** 74-75, 242, 302, 346

**Point Editing** 56, 59, 228

**Pop-up** 116-117

**Portrait** 15-16, 237, 346

**Print Border** 71, 346

**Print & Cut** 44, 73, 90, 134, 165, 303, 346

**Print & Emboss** 120, 346

**Quick Access Tool Bar** 34, 48

**Ratchet Blade**
- See Blades

**Ready, Set, Make** 132, 346

**Redo** 45-46, 192

**Registration Marks** 73, 123, 346

**Replicate** 109, 111, 185

**Rhinestones** 134, 166, 173-175, 304

**Rollers** 12-13, 137, 274

**Roll Feeders** 241, 347

**Rotate** 106-107, 110, 161, 227

**Rulers** 153

**Scale** 105, 230

**Score & Emboss** 119, 347

**Send Panel** 40, 142

**Shadow** 159, 164

**Shear** 159

**Silhouette**
- **Connect™** 179, 347
- **Design Store** 28, 39, 129, 131, 133, 135, 138

**Silhouette 3D™** 21-22, 189-193, 195-197, 200-204, 247, 285, 296-298

**Silhouette Studio®**
- **Basic Edition** 28, 32, 41, 163
- **Business Edition** 27, 178-179, 183-184, 186-188
- **Designer Edition** 153-166
- **Designer Edition Plus** 171-174
- **Mobile** 347

**Sketch** 20, 134, 163-164, 256, 281

**Spell Check** 101-102

**Stamp** 226, 233-235, 242, 300, 309, 348

**Sticky Notes** 65

**Stipple** 19, 117-118, 295, 348

**Subtract** 113

**Subtract All** 98

**Test Cut** 145

**Text Tool** 29, 65, 92-93, 103, 228

**Text to Path** 97

**Threshold** 88, 348

**Tiling** 187, 348

**Trace** 87, 89, 157

**Tracing a Photo** 89

**Track Enhancing** 146, 348

**Transfer Paper/Tape** 26, 310, 348

**Transfer Properties** 155-156

**Undo** 45-46, 192

**Ungroup** 49-50, 122, 193, 228, 345

**Version** 27-28, 348

**Weed** 61, 183, 348

**Welding** 52, 112, 348